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Foreword

The U.S. Army Corps of Engineers’ Hydrologic Engineering Center Data
Storage System, or HEC-DSS, is a database system designed to
efficiently store and retrieve scientific data that is typically sequential.
Such data types include time series data, curve data, spatial-oriented
gridded data, and textual data (such as this manual). The system was
designed to make it easy for users and application programs to retrieve
and store data. HEC-DSSVue (HEC-DSS Visual Utility Engine) is a
graphical user interface program for viewing, editing, and manipulating
data in HEC-DSS database files.

HEC-DSS originated at the Hydrologic Engineering Center in 1979 under
the direction of Dr. Art Pabst. Since that time, many have worked on the
development of the HEC-DSS software and the HEC-DSS uitility
programs, including William Charley, Al Montalvo, Carl Franke, Paul Ely,
Robert Carl, Dennis Huff, Mike Perryman and numerous others.

Mr. William Charley led the software design and development team, as
well as created the main interface screen and other components.
Resource Management Associates (RMA) of Fairfield, California, under
the direction of Dr. John DeGeorge, aided in the development of HEC-
DSSVue. The RMA staff included Richard Rachiele, who translated the
DSSMATH functions into Java, Mark Ackerman, who wrote the math
function screens and plug-in capabilities, Shannon Newbold, who was
responsible for the graphics and Peter Morris, who designed and
implement the graphical editor. Mike Perryman of HEC led the
development of the scripting capabilities.

Dr. Cassie Carter, under contract with RMA, wrote the initial draft of this
manual. Shannon Larson, William Charley, and Mike Perryman wrote
updates for the current version of this document. Amanda Waller and
Penni Baker tirelessly reviewed, corrected and formatted the document
for publication.
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CHAPTER 1

Introduction

The Hydrologic Engineering Center's (HEC) Data Storage System Visual
Utility Engine (HEC-DSSV ue) is a graphical user interface program for
viewing, editing, and manipulating datain the HEC Data Storage System
(HEC-DSS) database files. With HEC-DSSV ue, you may plot, tabulate,
and edit data, as well as manipulate data with over fifty mathematical
functions. Along with these functions, HEC-DSSV ue provides severd
utility functions that allow you to enter datasets into a database, rename
dataset names, copy data sets to other HEC-DSS database files, and delete
datasets.

Typicaly, you will select datasets from a sorted/filtered list of namesin a
HEC-DSS database file. HEC-DSSV ue also incorporates the "Jython"
standard scripting language that allows you to specify a routine sequence
of stepsin atext format and then execute the sequence from a user-defined
button or a"batch" process.

HEC-DSSV ue was written using the Java programming language that
allowsit to be run under avariety of different operating systems. Fully
supported systems include Microsoft Windows, Sun Solaris (UNIX),
RedHat Linux and other systems (contact HEC for the availability of
these.)

1.1 Overview of the HEC Data Storage System

HEC-DSS is a database system designed to efficiently store and retrieve
scientific datathat istypically sequential. Such datatypesinclude, but are
not limited to, time series data, paired (curve) data, spatia-oriented
gridded data, and textual data (such asthis manual). The system was
designed to make it easy for users and application programsto retrieve and
store data.

1.1.1 Background

HEC-DSS was the result of aneed that emerged in the late 1970s. Before
HEC-DSS, most hydrologic studies were performed in a step-wise fashion
by passing data from one analysis program to another in a manua mode.
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1.1.2

While this was functional, it was not very productive. Programs that used
the same type of data, or that were sequentially related, did not use a
common dataformat. Also, each program had to have its own set of
graphics routines or other such functionsto aid in the program's use.

The Kissimmee River study was performed by HEC for the Jacksonville
District beginning in 1978 and required an orderly approach to properly
manage the study data and analysis results. A large number of aternative
plans and conditions were to be processed in this project. This study gave
birth to thefirst version of HEC-DSS. The basic design provided for the
storage of datain a standard form that was independent of any particular
program. The datawould be provided to the programs when it was needed
and results would be stored in the same independent form for use by
utilities and other applications programs. The early design of HEC-DSS
was concelved to support files containing up to a few thousand data sets.
Asthe use of HEC-DSS expanded into real-time data storage applications,
datafiles were written to manage hundreds of thousands of data sets.

The current HEC-DSS version is designed for rapid storage and retrieval
of datasets from files containing as few as forty to fifty datasetsto files
containing more than severa million data sets. HEC-DSS Version 6-Qx
and later can have database files up to 8 Gigabytes.

HEC-DSS Contrasted with Other Database Systems

HEC-DSS is designed to be optimal for storing and retrieving large sets,
or series, of data. HEC-DSS incorporates a modified hashing algorithm
and hierarchical design for database accesses. This agorithm provides
quick access to data sets and an efficient means of adding new data setsto
the database. Additionaly, HEC-DSS provides aflexible set of utility
programs and is easy to add to a user's application program. These are the
features that distinguish HEC-DSS from most commercial database
programs and make it optimal for scientific applications.

HEC-DSS is designed specifically for the storage and retrieval of large
sets, or series, of data. These include daily flow values, hourly

preci pitation measurements, rating tables, and pages of text information.
HEC-DSS is not optimized for dealing with small data sets or single data
values, nor isit effective at conditional data searches common to relational
database systems. In contrast, most commercial databases are designed
for small sets of elemental data. Such elemental data includes employee
records, accounting data, and inventory of stock.

Commercia databases usually employ arelational model in which datais
stored in arelated manner. A relational database can be viewed
essentialy as acollection of tables. Thistype of system requires the
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construction of adata definition or data dictionary file. Although a
relational database requires someinitial setup, it can effectively store short
data sets comprised of both characters and numbers. Relational database
systems use the ANSI ratified Structured Query Language (SQL) to access
data.

While relational databases areideal for elemental data sets, they are not as
practical for longer series of data. HEC-DSS, however, is designed for
such sets of data. HEC-DSS database files are not defined by a data
definition file like the relational model requires so thereis no set up
required by the user. (HEC-DSS datais defined by the pathname and
conventions used.) Thetype of data generally stored in HEC-DSS does
not lend itself well to a query language such as SQL athough the selective
catal og feature has some similar capabilities.

Also unlike many commercia database systems, the HEC-DSS was
designed to be easily added to a user’ s application program. In traditional
"C" and FORTRAN programs, only two or three function calls are needed
to accessdata. Those callsidentify the database, the pathname, and atime
window (if desired). Besides these languages, an extensive set of classes
are available in both C++ and Java languages (including some access
through Visual Basic), which are the languages used to develop most HEC
programs.

1.2 General Concepts for HEC-DSS

HEC-DSS uses a block of sequential data as the basic unit of storage.
This concept results in a more efficient access of time series or other
sequentially related data. Each block contains a series of values of a
single variable over atime span appropriate for most applications. The
basic concept underlying HEC-DSS is the organization of datainto
records of continuous, applications-related elements as opposed to
individually addressable dataitems. This approach is more efficient for
scientific applications than a conventional database system because it
avoids the processing and storage overhead required in assembling an
equivaent record from a conventional system.

Datais stored in blocks, or records, within afile and each record is
identified by a unique name called a "pathname”. Each time datais stored
or retrieved from the file, the data's pathname must be given. The data
and information about the data (e.g., units) is stored in a"header array".
HEC-DSS automatically stores the name of the program writing the data,
the number of times the data has been written to, and the last written date
and time. HEC-DSS documents stored data completely viainformation
contained in the pathname and stored in the header so no additional
information is required to identify the data. The self-documenting nature
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1.2.1

of the database allows information to be recognized and understood
months or years after data has been stored.

The pathname is the key to the data's location in the database. HEC-DSS
analyzes each pathname to determine a "hash" index number. Thisindex
determines where the data set is stored within the database. The design
ensures that very few disk accesses are made to retrieve or store datasets.
One data set is not directly related to another so there is no need to update
other areas of the database when a new dataset is stored.

Because of the self-documenting nature of the pathname and the
conventions adopted, there is no need for adata dictionary or data
definition file as required with other database systems. In fact, there are
no database creation tasks or any database setup. Both HEC-DSS utility
programs and applications that use HEC-DSS will generate and configure
HEC-DSS database files automatically. Thereis no pre-allocation of
space; the software automatically expands the file size as needed.

A HEC-DSS database file has a user-specified conventional name with an
extension of "dss'. As many database files as desired may be generated
and there are no size limitations, apart from available disk space. Corps
offices have HEC-DSS files that range from a few datasets to thousands.
HEC-DSS adjusts internal tables and hash algorithms to match the
database size so as to access both small and very large databases
efficiently.

HEC-DSS database files are "direct-access" binary files with no published
format. Only programs linked with the HEC-DSS software library can be
used to access HEC-DSSfiles. Direct accessfiles allow efficient retrieval
and storage of blocks of data compared to sequential files.

A principal feature of HEC-DSSis that many users can read and write
datato asingle database at the same time. This multi-user access
capability isimplemented with system record locking and flushing
functions. Thereisno daemon or other background program managing
accesses to adatabase. A database may exist on a Windows or UNIX
server machine, which can be accessed by users on PC's or other
computers viaNFS or the Microsoft network, as long as locking and
flushing functions are implemented.

Pathnames

HEC-DSS references datasets, or records, by their pathnames. A
pathname may consist of up to 391 characters and is, by convention,
separated into six parts, which may be up to 64 characters each.
Pathnames are automatically translated into al upper case characters.
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Pathnames are separated into six parts (delimited by slashes /") labeled
"A" through "F", asfollows:

IAIBICIDIE/F/

The naming convention for pathname partsis listed in the table below:

Part Description
A Project, river, or basin name
B Location
C Data parameter
D Starting date of block, in anine-character military format
E Timeinterval
F Additional user-defined descriptive information

An example pathname for regular-interval time series might be:

/RED RIVER/BEND MARINA/FLOW/01JAN1995/1DAY/0BS/

1.2.2 Catalogs

HEC-DSS utility programs, including HEC-DSSV ue, will generate alist
of the pathnamesin a HEC-DSSfile and store that list in a"catalog" file.
The catalog fileis alist of the record pathnamesin the file, their last
written date and time, and the name of the program that wrote that record.
The catalog is usually sorted alphabetically by pathname parts. Each
pathname has a record tag and a reference number, either of which may be
used in place of the pathname in several of the utility programs. The name
given to the catalog file is the HEC-DSS file's name with an extension of
".dsc".

A special catalog file, the "condensed catalog”, is useful mainly for time
seriesdata. In thistype of catalog, pathname parts display in columns, and
pathnames for time series data, differing only by the date (Part D), are
referenced with oneline.

1.2.3 Data Conventions

HEC-DSS can store data of most types using a pathname of any structure.
To facilitate the ability of application and utility programs to work with
and display data, standard record conventions were developed. These
conventions define what should be contained in a pathname, how datais
stored, and what additional information is stored along with the data. For
regular-interval time series data (e.g., hourly data), the conventions
specify that datais stored in blocks of a standard length, uniform for that
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time interval, with a pathname that contains the date of the beginning of
the block and the time interval. The conventions identify how a pathname
for the data should be constructed. Conventions have been defined for
regular and irregular interval time series data, paired (curve) data, gridded
data (such as NEXRAD radar data), and text (a phanumeric) data.

Regular-interval time series datais data that occurs at a standard time
interval. Thisdatais divided into blocks whose length depends on the time
interval. For example, hourly data is stored with a block Iength of a month,
while daily datais stored with ablock length of ayear. Only the date and
time of thefirst piece of datafor ablock is stored; the times of the other
data elements are implied by their location within the block. If adata
element, or a set of elements, does not exist for a particular time, amissing
dataflagis placed in that element’slocation. Data quality flags may
optionally be stored along with aregular-interval time series record.

Irregular-interval time series data does not have a constant time interval
between values. Thistype of datais stored with a date/time stamp for
each element. The user-selectable block size is based on the amount of
datathat isto be stored. For example, the user may select ablock length
of amonth or ayear. Because a date/time stamp is stored with each data
element, approximately twice the amount of space is required compared
with regular-interval time series data. Data quality flags may optionally
be stored along with an irregular-interval time series record.

A convention for paired data has been defined for data that generally
definesacurve. Paired dataisfor rating tables, flow-frequency curves,
and stage-damage curves. One paired data record may contain severa
curves within it aslong as the record has a common set of ordinates. For
example, a stage-damage curve will contain a set of stages and may have
associated residential damages, commercial damages, and, agricultural
damages; however, a stage-damage curve and a stage-flow curve cannot
be stored in the same record.

Conventions for spatially gridded data can be found in the "GridUtil"
User's Manual. Text conventions are reviewed in Section 1.4.

1.3 Time Series Conventions

This section covers the conventions for both regular- and irregular-interval
time seriesdata. There are four data types that are recognized by DSS,
and are listed in the table (see following page).
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Data Type Example
PER-AVER Monthly Flow
PER-CUM Incremental Precipitation

INST-VAL Stages
INST-CUM Precipitation Mass Curve

1.3.1 Default Pathname Parts

Both regular- and irregular-interval time series record pathnames have the
same A, B, C, and F parts. Datablocks are labeled with asix part

pathname. The parts are referenced by the characters A, B, C, D, E, and F,
and are separated by aslash "/", so that a pathname would look as follows:

IAIBICIDIE/F/

The default conventions for the pathname parts are outlined in the
following sections:

Part A— Group

Part A isrequired for regular- and irregular-interval time seriesdataand is
used as away to group records. Usually thisinformation is a watershed
name, study name, project, river, or basin name; a name that allows the
user to group associated records.

Part B - Location

Part B isrequired for regular- and irregular-interval time seriesdataand is
the basic location identifier, which is generally the site name. A similar
identifier, such asaproject ID, USGS gage ID, or NWS station ID may be
used. Part B isrequired.

When a hydrograph is routed from one location to another, the
recommended Part B isLOC1.LOC2, where LOC1 istheidentifier to
which the flows are routed, and LOC2 is an identifier for the location from
which flows are routed. The second location (.LOC2) isoptional. For
example, Part B may be left out in situations where thereis only one
routed hydrograph for alocation.

Part C — Parameter

Part C identifies the basic data parameter for regular- and irregular-
interval time seriesdata. A dash is used as a sub-separator if further
identification is needed. Additional information about the parameter, such
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as how it was obtained (e.g., OBSERVED), should be given in Part F.
Examples of valid parameters are:

FLOW

ELEV

PH
PRECIP-INC
STAGE
TEMP-AIR
TEMP-WATER

Recommended C-parts for flows associated with stream locations are as

follows:
Part C Description
FLOW Total flow
FLOW-LOC Local flow; that is, flow generated only from the

subbasin that has an outlet at the specified location.

FLOW-CUM LOC Cumulative local flow. Thisistheflow from all
subbasins downstream from the nearest upstream

reservoirs.
FLOW-COMB Combined flow. Thisisthetotal flow minus the local
flow.
FLOW-DIVERT Flow diverted out of theriver at thislocation.
FLOW-mod mod is a user-specified modifier for the flow. For

example, FLOW-POWER would designate a
hydrograph from a power plant, and, FLOW-IN would
be for a component of reservoir inflow.

FLOW-IN Reservoir inflow.
FLOW-OUT Reservoir outflow.
ELEV-RES Reservoir elevation.
STORAGE Reservoir storage.

Part D - Block Start Date
Part D identifies the starting date of the data block. For Part D the

conventions are different for regular-interval (see Section 1.3.2) and
irregular-interval (see Section 1.3.3) time series data.

Part E - Time Interval or Block Length

Part E defines the timeinterval for regular-interval data (see Section
1.3.2), or the block length for irregular-interval data (see Section 1.3.3).
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Part F — Descriptor

Part F is used to provide any additional information about the regular- and
irregular-interval time series data. The use of Part F may vary from
application to application as appropriate, and may contain several
additional qualifying pieces of information separated by adash "-". If
several forms of data exist, such as OBSERVED or FORECAST, PLAN A
or TEST 2, they may be reflected in Part F. Generally, the order of multi-
descriptors of Part F should be from most to least significant.

1.3.2 Regular-Interval Time Series Conventions

Regular-interval time series datais stored in "standard size" blocks whose
length depends upon the timeinterval of the data. For example, daily time
interval data are stored in blocks of one year (365 or 366 values) while
monthly values are stored in blocks of ten years (120 values). If data does
not exist for aportion of the full block, the missing values are set to the
missing data flag "-901.0".

The starting and ending times of a block correspond to standard calendar
conventions. For example, for period average monthly datain the 1950's,
Part D (date part) of the pathname would be 01JAN1950, regardless of
when the first valid data occurred (e.g., it could start in 1958). The 1960's
block starts on 01JAN1960.

Average period data values are stored at the end of the period over which
the datais averaged. For example, daily average values are given atime
label of 2400 hours for the appropriate day and average monthly values
are labeled at 2400 hours on the last day of the month. If values occur for
times other than the end-of-period time, that time offset is stored in the
header array. For example, if daily average flow reading's are recorded at
6:00 a.m. (i.e, the average flow from 6:01 a.m. of the previous day to
6:00 a.m. of the current day), then an offset of 360 (minutes) will be
stored in the header array.

Part D - Block Start Date

Part D should be a nine-character military style date for the start of the
standard data block (not necessarily the start of the first piece of data).
Valid dates include 01JAN1982, 01MAR1982, and 01JAN1900 for daily
data, hourly data, and yearly data. Invalid dates include 01JANS82 (seven
characters) and 14APR1982 for daily data (14APR1982 is not the start of a
standard daily block).
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1.3.3

Part E - Time Interval

Part E consists of an integer number and an alphanumeric time interval
specifying the regular datainterval. Valid alphaentriesare MIN, HOUR,
WEEK, MON, and YEAR. Thevalid intervals and block lengths are:

Valid Data I ntervals Block Length
IMIN, 2MIN, 3MIN, 4MIN, 5MIN, oneD
6 MIN, 10MIN, 12MIN nebay
15MIN, 20MIN, 30MIN, IHOUR,
2HOUR, 3HOUR, 4HOUR, One Month
6HOUR, 8HOUR, 12HOUR
1DAY OneYear
IWEEK, IMON, SEMI-MONTH,
TRI-MONTH One Decade
1YEAR One Century

Examples of regular-interval pathnames are:

a. Daily USGS observed flow for station 0323150 for calendar year

1954 might be named:
/USGS/0323150/FLOW/01JAN1954/1DAY/0BS/

b. Six-hourly forecasted flow may have a pathname of:
/RED RIVER/DENISION/FLOW/01JUN2010/6HOUR/FORECAST/

Irregular-Interval Time Series Conventions

Theirregular-interval time series conventions are similar to the regular-
interval conventions except that an explicit date and timeis stored with
each piece of datawhereasin regular-interval time series the date and time
are implied by the location of the data within the block. Irregular-interval
datais stored in variable length blocks while regul ar-interval datais stored
in fixed length blocks. The block lengths are days, months, years, decades,
and centuries.

The number of values that may be stored in one record is indefinite
although it is prudent to choose a size that will be less than 3,000. The
user selects the appropriate block length. For example, if the datato be
stored occurred once every one to two hours, a monthly block would be
appropriate. 1f data were recorded once or twice a day, use a yearly block.
One would not want to store data that occurred eight or more times a day
in ayearly block (about 3,000 values) because that may exceed dimension
limitsin some DSS programs.
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All data are stored in variable length blocks that are incremented a set
amount when necessary. Initial space for 100 data valuesis allocated and
additional increments are for fifty data values unless otherwise set. (When
the 101st data value is added to the record, a new record with alength of
150 values is written.)

Part D - Block Start Date

Part D should be a nine-character military style date for the first day of the
standard data block (not necessarily the start of the first piece of data).

For example, data stored in adaily block beginning on March 23, 1952 at
3:10 p.m. would have aPart D of 23MAR1952. If the same datawere
stored in amonthly block, Part D would be 01MAR1952. The same data
in ayearly block would have aPart D of 01JAN1952, and as a decade
block, 01JAN1950.

Part E - Block Length

Part E indicates the length of the time block for irregular-interval data,
whether it isaday, amonth, ayear, decade, or a century. For irregular-
interval data, Part E consists of | R- concatenated with the block length:

IR-DAY
IR-MONTH
IR-YEAR
IR-DECADE
IR-CENTURY

The same data may be stored in blocks of different lengths. DSS stores
these as different records and treats them as a completely different dataset.

An example of a pathname for irregular-interval datais:

/SANTA ANA/PRADO/FLOW/01JAN2008/ IR-MONTH/0BS/

1.4 Paired Data (Curve Data) Conventions

Paired datais a group of datathat represents atwo variable relationship.
Typical examples are data that make up a curve (e.g., arating table or a
flow-frequency curve). Severa curves may be stored in the same record if
one of the variablesis the same. For example severa frequency-damage
curves may be stored in the same record, where the curves may be
residential, commercial, etc. A scale associated with the variable may be
one of threetypes: linear, logarithmic, or probability. The pathname part
identifiers are as follows:
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Part A— Group

Part A for paired datais used as away to group records. Usually this
information is a watershed name, study name, project, river, or basin
name; a name that allows the user to group associated records.

Part B — Location

Part B is the basic location identification of the paired data and could be a
control point, damage reach ID, station ID, or other identifier.

Part C — Parameters

Because paired data represents a rel ationship between two parameters,
Part C should contain the two parameter names separated by a hyphen (-).
Examples of parameters are:

ELEV-DAMAGE
ELEV-FLOW
FREQ-FLOW
STATION-ELEV

In the above examples, ELEV, FREQ, and STATION arereferred to asthe

first, independent variable while DAMAGE, FLOW and ELEV are the
second, dependent variable.

Part D - Optional Descriptor
Part D of the pathname is used to provide any further descriptions of the

data. Part D may vary from application to application as appropriate, and
is often null.

Part E - Time Descriptor

Part E of the pathname is used only if the paired datais representative of a
specific point in time.

Part F - General Descriptor
This part identifies a unique descriptor of the data such as the situation,
condition, or alternative plan name associated with the data. This part is

included in labeling of datain some output utilities.

An example of a pathname for paired datais:

/ALLEGHENY/NATRONA/ELEV-DAMAGE//2020/FLOOD PROOF PLAN B/
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1.5 Text Data Conventions

Text datais defined as generic apha-numeric lines of text where each line
is preceded by a carriage return character and ends with aline feed
character. It does not, at thistime, include other types of characters such as
those that would be used to create a graphical display. There are no
definitive size limitations for a DSS text record but it is recommended that
arecord contain no more than about 1,000 lines of text. There are no
conventions set for the structure of the pathname; however, it is
recommended that the pathname parts be labeled in a descending order of
importance and that the pathname indicate that the record contains text
data and not one of the other types of data.

1.6 General FILE Conventions

Files of a certain type can be stored in an HEC-DSS database file. The
allowable types are: .jpg files, .mp3files, .pdf files, .xIsfiles, and .doc
files. Thisallowsthe storage of various metadata along with regular data.
Photographs, fact sheets, sounds, and other metadata can be presented
along with time series and paired data.

In HEC-DSSV ue on Microsoft Windows computers, assessing these types
of metadata will launch the native application associated with the
extension of that dataset. For example, accessing a.pdf dataset will
launch Adobe Acrobat, a .xIs data set will launch Excel, and so forth. One
exception is that an image file will launch a Java window with the image

displayed.
Part A— Group
Part A for "file" datais used as away to group records. Usualy this

information is a watershed name, study name, project, river, or basin
name; a name that allows the user to group associated records.

Part B — Location

Part B isthe basic location identification of the "file" data If the "file" isa
photograph, it is the location of the picture.

Part C — File Name

Part C contains the filename of the "file" data and excludes directory
information.
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Part D — Meta Data Type

This part of the pathname can only be either FILE or IMAGE to reflect
what the metadatais.

Part E — File Extension

Part E contains the original extension of thefile.

Part F - General Descriptor

The F part identifies a unique descriptor about what the file contains.

Example pathnames that include "file" data are listed below:

/SACRAMENTO/SHASTA/ IMG_0009.JPG/ IMAGE/JPG/SPILLWAY — AUG 2006/
/LOWER COLORADO/TRAVIS/TRAVIS.PDF/FILE/PDF/FACT SHEET/

/STONES/NO SECURITY/GIMME SHELTER.MP3/FILE/MP3/CARLS FAVORITES/
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CHAPTER 2

Using HEC-DSSVue: An Overview

With HEC-DSSV ue, you can access, view, and manipulate data stored in
HEC-DSS database files using a variety of utilities and functions available
from the main HEC-DSSV ue screen, shown in Figure 2.1.

BaldEagleHist. dss - HEC-DSS¥ue

Menu Bar — | File Edit uiew Display Groups DataEnkry  Tools  Advanced  Help
ToolBar —» | & | JdZEEd 7~ Xﬂl
Current File Name: | C:DssFilesiBaldEagleHistdss
File Pathnames Showen: 442 Pathnames Selected: 4 Pathnames in File: 733 File Size: 225 ME
File Tabs —> | HourlyTestData,dss X DailyLocals.dss X i BaldEagleHist. dss X ! forecast.dss X |
i Sl e .
Search | search A | | o v E| v
Boxes I iByPﬂrts: B | ~| D | ~| F | v
f Murnber Part A Part B Part C Patt D | range Part E Part F
49 BEECH Hwy PRECIP-STAMND DEY [26Maw1993 - 04Dec1 993 1 HOLUR =B *
al BEECH JCT FLOW 2aMov1 993 - 040ec1 993 1HOUR EE
DSS a1 EEECH JCT FLCh 25hoy1 993 - 06Dect 993 1HOUR CALIERATED
Pathnames < 52 i BEECH JCT FLCWY 01 Mowd 993 - 1 HOLUR GBS
I _ BEECH JCT FLOWY 25Mow1993 - O 1HOUR 5|
EBEECH JCT FLOW-SIh 2aMoy ] 993 - 1HOUR EE
BEECH JCT FLOW-SIM 25Mov1 993 - 040ec1 993 1 HOUR =B
BEECH JCT =STAGE 01 Mow1 993 - 510ec19593 1HOUR CBS
BEECH JCT QUTF... FLOW-REG 26Moy1 993 - 040ec] 993 1HOUR EEG
BEECH JCT QUTF... FLOW-REG 26Mov1 993 - 040ec] 993 1HOLUR EEM
BEECH JCT QUTF... FLOW-REG 2EMov1 993 - 040ec1 993 1HOUR EE=
K BEECH JCT QUTF... FLOW-REG 26Mov1 9935 - 040ec1 953 1HOUR SES i
Selection BalcEagleHist des: MBEECH JCTFLOWYI2SM oW1 9935 - 04Dect 9931 HOURISES %
—> BaldEagleHist s s MBEECH JCTFLOWDT Mow1 993 - 31Dect 98931 HOURIOES)!
Area
B |
Selection
—p Select De-Select Clear Selections Restore Selections Set Time Windos
Buttons = = = =
Message Bar —p | M Mo time window set.

Figure2.1 HEC-DSSVue Main Window

This chapter provides an overview of the HEC-DSSV ue's main window
components and their basic functions.

2.1 HEC-DSSVue Main Window

The main window of HEC-DSSV ue (Figure 2.1) consists of aMenu Bar,
Tool Bar, Current File Information, Files Tabs, Search Boxes, alist of
DSS Pathnames, Selection Area, Selection Buttons, and M essage Bar .

The following sections describe these features in detail.
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2.1.1

Menu Bar

Main menu options in HEC-DSSV ue (Figure 2.2) alow you to search for,
select, and edit HEC-DSS data sets; control the display of pathnames and
access plots and tables among other tasks. The HEC-DSSV ue main menu
options are as follows:

|File Edit  “iew Display Groups DataEntry  Tools Scripts Advanced  Help
Figure2.1 HEC-DSSVue Menu Bar

File

Edit

View

Display

Groups

Data Entry

Tools

File menu commands include New, Open, Close DSS
File(s), Print Catalog Preview, Print Catalog, and
Exit. Thefile menu aso liststhe last six opened files.

Edit menu commands are Tabular Edit, Graphical
Edit, Edit in Excel, Select All, Rename Records,
Delete Records, Undelete, Duplicate, Copy To, and
M erge Records.

The View menu allows you to customize the display of
HEC-DSS pathnames, refresh the catalog and search
pathnames. Available commands are Pathname List,
Pathname Parts, Condensed Catalog, No Pathnames,
Unsorted List, Search pathnames by string, Search
pathnames by parts, and Refresh Catalog.

Use the Display menu to view data. Optionsin this
menu are Plot, Plot Individual Data Sets, Tabulate,
Tabulatein Excel, Display Data Options,
Supplemental Information, Time Window, Charts,
and NC DWR Duration Hydrograph.

Use the Group menu to organize selected records into
groups or view and edit existing Groups. Group menu
commands include Save Selected, Get, Plot, Plot
Individual Sets, Tabulate, Math, and Merge.

The Data Entry menu is used to add data and files to
records. Commands include Manual Time Series,
Manual Paired Data, Manual Text, Import, and
Export.

The Tools menu provides tools for manipulating DSS
records. Thesetoolsinclude Math Functions,
Compare, Search for Value, Check File Integrity,
Squeeze, Script Editor, and Script Selector.
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Custom (Optional) If your office has written their own plug-ins,

those plug-ins can be made available under the Custom
menu. The menu nameis set from the plug-in. See the
Writing Plug-ins Appendix for more information.

Scripts (Optional) If you use scripts, you can activate the

Scripts menu from the Script Editor (under Tools) and
have quick access to your selected scripts from this
menul.

Advanced Through the Advanced menu you can cregte, view, or

print a Condensed Disk Catalog, Abbreviated Disk
Catalog, or aFull Disk Catalogs. Additional options
are Console Output, DSS Output, Status, Debug, and
Program Options.

Help The Help menu contains the About option, which

2.1.2 Tool Bar

displays the HEC-DSSV ue version information and
gives access to the terms and conditions of the software.

The Tool Bar buttons provide shortcuts to frequently used menu
commands:

'}

=y

h

A"

fx

Opens the Open HEC-DSS File browser that allows you to select
and open aHEC-DSSfile. This button would be equivalent to
selecting Open in the File menu.

Plots the selected data, equivalent to selecting Plot in the Display
menul.

Displays the selected datain atable, equivalent to selecting
Tabulatein the Display menu.

Graphically edit the selected data, equivalent to selecting
Graphical Edit in the Edit menu.

Open the Math Functions dialog with the selected data, equivaent
to selecting Math Functionsin the Tools menu.

(Optional) Open the selected records in Microsoft Excel, equivalent
to selecting Tabulatein Excel in the Display menu. This function
relies on the Excel plug-in to beinstalled.
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2.1.3

2.1.4

2.15

File Tabs

Multiple DSS files can be opened and viewed in HEC-DSSV ue at the
sametime (Figure 2.3). Each time you open anew dssfile, atabis
created with the name of the dssfile shown on it. The pathnames

HourlyTestData.dss % | Daiylocals.dss ¢ | BaldEagleHist.dss X | forecast.dss X

Figure2.2 FileTabs

displayed are from the selected tab's DSSfile. If more than onefileis
opened, selected pathnames will include the name of the DSS file they are
from. For example:

BaldEagleHist.dss://BALDE/FLOW/01DEC1993/1HOUR/BB/.

Current File Name

The Current File area displays the information of the selected tab’s DSS
file. The File Name box (Figure 2.4) displays the file name and location
of the selected HEC-DSSfile.

File Name: |C./DssFiles/BaldEagleHist.dss
Pathnames Shown: 733 Pathnames Selected: 0 Pathnames in File: 733 File Size: 2.4 ME

Figure 2.3 File Name Box

Tip: If you know the exact location and name of the HEC-DSS
database file you wish to open, you can type it directly into the
File Name box (Figure 2.4) and then click the Enter key to
openit.

Beneath the File Name box (Figure 2.4) is statistical information on the
pathnames contained in that file. Pathnames Shown displays the number
of pathnames available in the DSS file and shown in the DSS Pathname
list. Pathnames Selected provides the number of pathnames currently
selected from thefile. Pathnamesin File shows the total number of
recordsin the file, including files and images. And findly, File Size
displays the amount of disk space the file uses.

Search Boxes

Searches of the DSS pathnames can be made by full pathnames or by
pathname parts. These search methods are set through the View menu.
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The selected search method will display a

Display Groups DataEn

checkmark next to the menu option, see Pathname List
Figure 2.5. i v Pathname Parts

I Condensed Catalog
To search and display al pathnames | Mo Pathnames
containing a specific text, from the View Unsorted List

menu click Sear ch pathnames by string
(Figure 2.6). Then type the text into the
Sear ch Pathnames box and click Search.
The pathnames in the file that contain the § -Reheshueataing
text will be displayed in the DSS Pathname Time Window...
table, see Figure 2.6. LT
Figure2.5 View Menu
To search using DSS parts, select from the View menu click Search
pathnames by parts (Figure 2.7). Six Search By Partsfilter boxes will

Search pathnares by string

w Search pathnames by parts

=TT

Search Pathnames: |baldeagle

Murmber Part A Park B Part C Part D Part E Pa...
1|BALDEAGLE EalL DE FLCWN-BASE 01 WON 9. [THOUR =B ~
2|BALDEAGLE Bl DE FLCWN-BASE 01 DECT 8995 [1HOUR SE |

Figure 2.6 Search Pathnames by String

display, one for each DSS part. The available part names contained in the
selected DSSfile arelisted in the filter boxes. When apartisselected ina
filter box, only the pathnames that contain the filter text are shown in the
DSS Pathname table (Figure 2.7).

Search A |BALDEAGLE w| oo [ELEy v| E: [1tHour v
By Parts: B [SavER | D |DINOV1993 v| F: [oBs |
Murnber Part & Part B Part Patt D Part E Patt F |

1|BALDEAGLE  |SAVER [ELEV | mcre1 993 [THOUR logs |

Figure 2.7 Search Pathnames by Parts

2.1.6 List of HEC-DSS Pathnames

Once you have opened an HEC-DSSfile, its pathnames appear in a pane
beneath the Sear ch By filters (Figure 2.8). The pathnames can be
displayed as a pathname sorted list (Pathname List), by DSS Parts
(Pathname Parts), in the Condensed Catalog format, with No
Pathnames* displayed, or asan Unsorted List*. These options are
selected from the View menu (Figure 2.5), as described in Section 2.5.1.
An example of Pathname by Partsis shown in Figure 2.8.
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Murnber Part A Part B Part C Part O Part E Part F
1|BALDEAGLE  |BALDE FLCW-EASE 01MONYV1993  [THOUR SE |
2[BALDEAGLE  |BALDE FLOW-BASE 01DEC1 995 1HOUR, SE 2|
JBALDEAGLE  |BALDE FLOWY-DIRECT  [01MNOY1985  [1HOUR GE
4 BALDEAGLE  |BALDE FLOW-DIRECT  [01DEC15993 1HOUR BE
SBALDEAGLE  |BALDE FLOW-DIRECT  [01MOY%19953  [AHOUR CALIBRATED
GEALDEAGLE  |BALDE FLOW-DIRECT  [01DEC1993 1HOUR CALIERATED
7BALDEAGLE  |BALDE FLOW-DIRECT  [01MOY1995  [1HOUR SE
GEALDEAGLE  |BALDE FLOW-DIRECT  |01DEC1 853 THOUR, S6
3BALDEAGLE  |BALDE PRECIP-EXCESS [01MOY1933 [HOUR BE

10BALDEAGLE  |BALDE PRECIP-EXCESS [01DEC15993 1HOUR BE
11 BALDEAGLE  |BALDE PRECIP-EXCESS [01MOY1995 [THOUR CALIERATED
12BALDEAGLE  |BALDE PRECIP-EXCESS |01DEC1S993 THOUR, CALIBRATED | = |

Figure 2.8 List of HEC-DSS Pathnames by Parts

*Note: The No Pathnames option istypically used to access
very large databases using only scripted functions. The
Unsorted List option can be used to view pathnamesin very
large databases without the time required to sort the
pathnames.

2.1.7 Selected Pathnames

When you select a pathname (see Section 2.6), it appears beneath the list
of al pathnamesin the Selection Area (Figure 2.9). It includes the name
of the DSSfile followed by the full DSS pathname. Y ou can change the
height of the Selection Area by grabbing the separator line between the
two lists with your mouse, and moving it up or down. Y our mouse pointer
will change to a double ended arrow when you are over the separator line,
indicating you can slide the line up or down.

<>
>

BaldEagleHist dss /BALDEAGLE/BALDEFLOW-DIRECT/01NOY1 9931 HOUR/CALIBRATED!
BaldEagleHist dss. /BALDEAGLEBALDEFLOW-DIRECT/O1NOV1993M HOUR/SE!

Figure2.9 Selected Pathnames

Y ou can also Quick Select pathnames if the Selection Area is empty by
just highlighting pathnames from the main list with your mouse, and then
selecting afunction such as plot or tabulate. The Selection Area must be
empty to use Quick Select.

2.1.8 Selection Buttons

There are five buttons located bel ow the Selection Area (Figure 2.10).
They are asfollows:

Select Y ou add a pathname to the selection list by
highlighting it and then clicking the Select
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Select De-Select Clear Selections Restore Selections Set Time Wincowy

Figure2.10 Select, De-Select, Clear Selections, Restore Selections, and Set Time
Window Buttons

button. The Select button will remain inactive
until a pathname is highlighted.
Tip: You can also select pathnames by
double-clicking on a pathname in the list
or clicking on a pathname to highlight it,
then click and hold the right mouse key
and drag the pathname to the Selection
Area.

De-Select To remove a pathname from the Selection
Arealist, highlight the pathname in the
Selection Area then click the De-Select
button.
Tip: You can de-select by double-
clicking on a pathname in the Selection
Area list.

Clear Selections  You can remove al pathnames from the
Selection Arealist by clicking the Clear
Selections button.

Restor e Sdections The Restor e Selections button restores all
selections you have cleared or de-selected
from the Selection Area list.

Seat TimeWindow Y ou can set the time window of the datato
view with the Set Time Window button.

2.2 Message Bar

The Message Bar (Figure 2.11) appears at the bottom of the DSSVue
main window and displays the current status. Messages displayed in the
bar include information on current processes or information regarding

L Time window: 27 Nov 1993, 23:00 to 30 Nowv 1993, 24:00

Figure2.11 Message Bar

settings within the current DSSV ue main window, such asthe Time
Window. For example, if the Time Window is set, the Time Window
range will be displayed or if you are copying alarge amount of data, the
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2.3

status of the copy will be displayed in the M essage Bar during the copy
process.

Drag and Drop

HEC-DSSV ue supports avariety of Drag and Drop operations. Y ou can
drag pathnames from the main screen to any open table or plot to add
those data sets to the table or curve. Y ou can copy datafrom one DSSfile
to another by dragging the pathnames of the data sets you want to copy to
the tab of the file you want to copy to, or to the main window of another
instance of HEC-DSSVue. An exampleisshownin Figure 2.12.

forecast. dss - HEC-DSSVue
File Edit View Display Groups DataEntry Tools Scripks  Advanced Help

= I! EE Ig fx Precision

File Name: \C [forecastdss
Pathnames Shown: 1651 Pathnames Selectect & Pathriames in File: 2921 File Size: 942 MB

forecast.dss X ‘mydss.dssl\g(

Search & | v o v B -
ByParts: B | v| o | v| v
Mumber Part & Part B Part C Part D f range PartE PartF

BARTO-SAWAG FLOWY 272001 - 01 Aug2001 AHOUR PODD

BARTO-SAWAG FLOWY 2712001 - 01 Aug2001 THOUR =000

BARTO-SAWAG

FLOWY-IN

01Jul2001 -

31 Aug2001

o ENIFIIeY

BARTO-SAWAG

]
]
J
J
J
J

07Jul2001 -

31 AL

Hyy -
12 BARTOMN HA ET-POTEMTIAL 272001 - 01 Aug2001 THOUR: S000
13 BARTOMN HA ET-S0IL 272001 - 01 Aug2001 THOUR: FODO
14 BARTON HA ET-S0IL 272001 - 01 Aug2001 HOUR 2000
15 BARTON HA FLOW 02001 - 31 Aug2001 HOUR FODO
16 BARTON HA FLOW 02001 - 31 Aug2001 1HOUR 2000
17 BARTON HA FLOW-BASE 272001 - 01 Aug2001 1HOUR FODO
18 BARTON HA FLOW-BASE 272001 - 01 Aug2001 1HOUR 2000
19 BARTON HA FLOW-DIRECT 272001 - 01 Aug2001 1HOUR: FODO

A

~

De-Select Clear Selections Restore Selections Set Time Vindow

. Time window: back 5 days to ahead 2 hours

Figure 2.12 Copying datafrom one DSS file to another using Drag and Drop

Y ou can import datainto a DSS file by dragging the data or files from
Windows Explorer onto the HEC-DSSV ue screen. If you have aplug-in
loaded that recognizes the file extension, that data will automatically be
imported. For example, you can drag a".shef" file or ".ncdc" fileto
import shef data or import climate data from the National Climatic Data
Center.

Y ou can drag regular files onto HEC-DSSV ue and they will be stored in
the FILE convention in that DSSfile. For example, you can drag a .pdf
fileor .xlsfile onto HEC-DSSV ue to be stored in the DSS file. When you
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plot or tabul ate those data sets, HEC-DSSVue will launch the native
application for that data set.

Y ou can also drag pictures (e.g., ".jpg") files on to the main screen to store
them, and then view them back as a slide show.

2.4 File Menu Operations

HEC-DSSVue's File menu allows you to create aNew HEC-DSSfile,
Open an existing HEC-DSSfile, Close DSS File(s) you have opened,
show the Print Catalog Preview, Print Catalog, open arecently viewed
file, and Exit the program. If you are running HEC-DSSVue in aclient-
server mode, you can Open a Remotefile or create aNew Remotefile.
The following sections discuss these operations in detail.

2.4.1 Creating a New HEC-DSS File

To create anew HEC-DSS database file, from the File menu, click New.
When the Create new HEC-DSS File dialog box opens (Figure 2.13),
select where you would like to create the file using the L ook in list or file
icons. Typein aname for the new filein the File name box and then click

Create new HEC-DSS File X
Lock in: | ) DssFiles v ”|E||E|

m BaldEagleHist. dss

___J m DailyLocals,dss

Recent &) Forecast.dss
m HourlyTestData, dss

hy

Deskiop

)

My Documents

\m

-
._.._,!-'
My Computer

5 e |

My Metwork

Places Files of bype: | # dss w

Figure 2.13 Create new HEC-DSS File Dialog Box
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the Create button. A new HEC-DSSVuefilewill be created in the
location you selected. Data can then be added using the tools located
under the Data Entry menu, copied in through the many different plug-ins
available, or copied from other DSSfiles*.

*Note: If you copy records from an existing file, a new DSSfile
will be created automatically if one does not already exist.

2.4.2 Opening an HEC-DSS File

To open aDSSfile, from the File menu, click Open. The Open HEC-
DSS File browser will display, shown in Figure 2.14.

Open HEC-DSS File X
Lookin: | (5 DssFiles v ¥ ”|E||E|

m BaldE agleHist, d=s

__J |£] DailyLocals.dss

|£] forecast.dss
|£] HourlyTestData,dss

My Docurments
-
53
My Computer
:.g File narne: |
Ty Metwork,
Flares Files of type: | # geg w

Figure 2.14 Open HEC-DSS File Browser

Note: If you know the name of the HEC-DSS database file you
wish to open, you can type the file name (including the path)
directly into the File Name box on the main DSSVue window
(see Figure 2.1, page 2-1).

From the Open HEC-DSS File browser, use the standard Windows
controls to browse to the HEC-DSS file that you wish to open, click
Open.

The name of the file you have selected will now appear in the File name
box (see Figure 2.1, page 2-1), and the pathnames of the records contained
inthefilewill display inthe List of HEC-DSS Pathnames.
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2.4.3 Closing an HEC-DSS File
To close the currently selected HEC-DSS database file, from the File
menu, click Close. Thiswill allow some older MS-DOS based programs
to access the file or for you to rename or delete the file. HEC-DSS will
automatically close un-accessed file files after about aminute. They will
be automatically re-opened on the next access.

Note: HEC-DSSisa multi-user database system. Some older
MS-DOS programs exclusively locked HEC-DSSfiles. HEC-
DSSwill automatically close un-accessed file files after about a
minute. They will be automatically re-opened on the next
access.

2.4.4  Printing the Catalog

Y ou can print the catalog of a DSSfile directly (Print Catalog) or you
can preview what the catalog will look like before you print (Print
Catalog Preview). For further printing of DSS catal ogs, see Chapter 4.

A catalog for the DSSfile consists of alist of the pathnames contained in
thefile, similar to what is displayed in the DSS Pathnamelist area. From
the View menu the user can determine how the catalog will display the
pathnames. For example, the catalog could be displayed as a sorted list or
by pathname parts. The catalog for the currently selected DSSfile can be
printed or viewed in a separate window.

To preview the catalog in a separate window and then print:

Header/Footer || Table Title

1. From the File menu,
click Print Catalog
Preview, aProperties
dialog box will open
(Figure 2.15) that is

Crientation

by
(%) Portrait () Landscape

specific for setting up a
report for printing. The
Properties dialog box
offers various print
options, on three
separate tabs.

2. The Pagetab allows
you to specify the page
Orientation, Scaling,
and Selection; you can

Scaling

All columns on one page
Selection

(3) Entire Table () Selected Cells
Prink

ASCI
Gridines

Repeat Headers

[ Preview

] [ Cancel

also choose to print the  Figure 2.15 Properties Dialog Box
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table as ASCI 1, Repeat Header s on every page, and print the
Gridlines.

3. Onthe Header/Footer tab, you can type in the header and footer
you want to appear on your printed pages.

4. The Table Title tab offers a default title for the table based on the
data source. Y ou may edit thistitle.

5. Oncethe user has the report setup, click Preview, the Print
Preview dialog box will open (Figure 2.16).

Print Preview

i Close  [100% w
C:/DssFiles/BaldEagleHist. dss ~
umnbar Fart & Fart B A Fart [ art E Fartt F

1 AR FRECIF D1ND1953 |THOUR DB%

z AR FRECIP D1DEC1993 [1HOUR 0B3

3 BALDE FLOW D1NDY1953 [1HOUR BB

L BALOE F Loy 01DEC1993 [1THOUR HE

] BALOE F Loy 0 WOW993 [THOUR CALIB...

5] BALOE F Loy 01DEC1993 [1THOUR CALIB...

T BALOE F Loy 0 WOW993 [THOUR 5B

g BALOE F Loy 01DEC1993 [1THOUR 5B

q BALOE FLOW-BASE 0 WOW993 [THOUR HE
10 BALDE FLOW-BASE 01DEC1993 [1HOUR BE
11 BALDE FLOW-BASE 01WNO%1993 [1THOUR CALIB...
12 BALDE FLOW-BASE 010DEC1993 [1HOUR CALIB...
13 SN OWS PRECIP 01WNO%1993 [THOUR OB% v

< >

Figure2.16 Print Preview Dialog Box

6. To print the catalog, click Print, a Print dialog box will open,
click OK, and the report will print to the selected printer.

To preview the catalog in a separate window and then print:

1. From the File menu, click Print Catalog, a Properties dialog box
will open (see Figure 2.15, page 2-11) that is specific for setting up
areport for printing. The Properties dialog box offers various
print options, on three separate tabs.

2. From above, review Steps 2 thru 4 for available print options.

3. Click Print, aPrint dialog box will open, click OK, and the report
will print to the selected printer.

2.4.5 Exiting HEC-DSSVue

To exit HEC-DSSV ue, from the File menu, click Exit. (If you have
opened HEC-DSSV ue from another application, such as CWMS or
ResSim, click Close from HEC-DSSV ue's File menu.)
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2.5 View Catalog

The View menu alows you to change the appearance the catalog that is
associated with a DSSfile.

2.5.1 Choosing a Display Mode for HEC-DSS Pathnames

To specify the display mode for HEC-DSS Pathnames, choose Pathname
List, Pathname Parts, Condensed Catalog, or No Pathnames or
Unsorted List from the View menu. A Pathname List of HEC-DSSfiles
displayed is shown in Figure 2.17.

Mumber Pathnarne

355 |/BALDEAGLEFIS-BAL OUTFLOWIFLOW-REGO1DEC1 8934 HOURSSES! ~
399|/BALDEAGLEFISH HAFLOWMTMOY1 9331 HOUREEB! i
360 /BALDEAGLEFISH HWiFLOWINT DECT 9831 HOUREBE!

361 BALDEAGLEFISH HWIFLCWINT MO 393 HOURCALIBRATEDS
362|/BALDEAGLEFISH HAFLOWMTMOY1 9331 HOURSSE!

363 BALDEAGLEFISH HWiFLOWINT DECT 9831 HOURISES
364/BALDEAGLEFISH HAWIFLOW-BASEDT MO 9931 HOUREES

365 |/BALDEAGLEFISH HFLOW-BASEN DEC1 8851 HOURGE!

366 |BALDEAGLEFISH HWFLOW-BASEDT MO 3934 HOURICALIERATEDS
367 |BALDEAGLEFISH HAFLOW-BASEDT DECT 9931 HOUR/CALIBRATEDS
365 | BALDEAGLEFISH HWIFLCW-BASEDT NOW 9931 HOURISES

369 /BALDEAGLEFISH HAFLOW-BASED DEC1 993531 HOURSES

Figure2.17 HEC-DSSV ue - Data Selection List window, Pathname List displayed

Y ou can aso view the pathnames as a Pathname Parts List (Figure 2.18).

Mumber Part & Part B Park i Part D Part E Part F
1|BALDEAGLE  |BALDE FLOW-BASE D1MON1993 HHOUR =B |
2|BALDEAGLE  |[BALDE FLOW-ELASE 01DEC1995 1HOUR =5 =l
JBALCEAGLE |BALDE FLOW-DIRECT  |O1MON1895 [THOUR EE
4 BALDEAGLE  |BALDE FLOW-DIRECT  |01DEC1993 1HOUR BB
S|BALDEAGLE  |[BALDE FLOW-DIRECT  |[O1MCNW1895  [THOUR CALIERATED
GBEALDEAGLE |[BALDE FLOW-DIRECT  |O1DEC1993 THOUR CALIERATED
7IBALCEAGLE  |BALDE FLOW-DIRECT  |[0TMON15895  [THOUR =]

S BALDEAGLE  |BALDE FLOW-DIRECT  |01DEC13593 1HOUR =B
9BALCEAGLE |BALDE PRECIP-EXCESS |01MCH1895 [THOUR EE
10(BALDEAGLE  |BALDE PRECIP-EXCESS |01DEC1993 THOUR EE
11 |BALDEAGLE  |BALDE PRECIP-EXCESS |[D1MON1393  MHOUR CALIBRATED] |
12|BALDEAGLE  |BALDE PRECIP-EXCESS |01DEC1993 1HOUR CALIBRATED | » |

Figure 2.18 HEC-DSSV ue - Data Selection List window, Pathname Parts displayed

The Condensed Catalog style (see Figure 2.19, page 2-14) abridgestime
series data sets so that the date span for the entire data set displaysin place
of the"D" part.

The Unsorted List style (see Figure 2.20, page 2-14) displays the
pathnames without sorting them. Thisis useful to see the pathnamesin a
very large database without using the overhead of sorting. Thisisalso the
fastest method to show the pathnames in a database.
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Mumber Part A Part B Part C Part D [ range PartE Part F
355|BALDEAGLE  |MILES Hyy PRECIP-EX.C... |26Mov1993 - 04Dec! 993 THOUR =B A
359|BALDEAGLE  |MILES HWy PRECIP-INC 26Mov1 8993 - 04Dec! 993 THOUR EE
SE60BALCEAGLE  |MILES Hyw PRECIP-IMC 26Mov1 893 - 06Dec! 995 THOUR CALIBRATED

361 |BALDEAGLE  |MILES Hy PRECIP-IMNC 26Manvd 883 - 04Dec1 993 THOUR SB
352 BALDEAGLE  |MILES Hy PRECIP-STA... |26Mow] 993 - 04Dec1 993 THOUR EE
363 |BALDEAGLE  |MILES HY PRECIP-STA... |26Mow1993 - 06Dec1 993 THOUR CALIERATED

364 BALDEAGLE  |MILES HWY PRECIP-STA,... |26Mow1 993 - 04Dec! 993 THOUR SB
363|BALDEAGLE  MILES JCT FLOA 25Mand 883 - 04Dec1 993 THOUR (]3]
366|BALDEAGLE  |MILES JCT FLOA 25Mand 893 - 06Dect 993 THOUR CALIERATED

367 |BALDEAGLE  |MILES JCT FLOW 01Mov15893 - 310ec1 993 THOUR OBS

368 BALDEAGLE  |MILES JCT FLOWY 25Monv1 8993 - 04Dec! 993 THOUR SB
J69|BALDEAGLE  MILES JCT FLOW-SIM 25Manvd 883 - 04Dec1 993 THOUR EE |

Figure 2.19 HEC-DSSV ue - Data Selection List window, Condensed Catalog displayed

Mumber Pathnarne

EALDEAGLEMILES HAWFLOWIDT MO 393 HOURMC ALIBERATEDS ~
80N EMAIPRECIPAOM DEC1 9931 HOURIOES! )
BALDEAGLESAYERPRECIP-EXCESSMT MO 955 HOURICALIERATEDS
BALDEAGLEBEE-FIS QUTFLOWFLCAW-REGN DEC19931 HOURBES!
BALDEAGLEBEECH HWIFLCW-BASED DEC1 9934 HOURC ALIBRATEDS
BALDEAGLEFISH HWPRECIP-EXCESSMTMNOY1 9831 HOURSES
NTYROMPRECIP-CUMIDT MOY 9353 HOURMCDCS

WEPRCR JCTFLOWMD1DECT 993 HOURICALIBERATEDS
BALDEAGLESAYERPRECIP-STAND DEVID1DECT 9931 HOUREE!

10)BALD EAGLE CREEMALAKE TO LOCK HANISTATION-FLOWWIDTDECT 993:1 300/EBMNS
11 | X EMAPRECIPAO DEC1 99531 HOURMOESY

12|WBALDEFLOWMT MO 95531 HOURICALIERATEDS |

Figure 2.20 HEC-DSSV ue — Data Selection List window, Unsorted List displayed

W=~ |m &0k =

w

2.5.2 Searching and Filtering HEC-DSS Pathnames

With HEC-DSSV ue, you can select specific data sets from alist of
pathnames (or catalog) in the database. Y ou can refine thelist by
searching for either a string in the pathnames or for pathname parts. The
following sections describe searching and filtering options.

Searching Pathname Strings

The Sear ch Pathnames by String feature allows you to search for
records whose pathnames contain specific strings of characters. For
example, if you search for "FLOW" thelist will display only pathnames
containing the string "FLOW" in the pathname.

To Search Pathnames by String:

1. From the View menu, click Search Pathnames by string.

2. Inthe Search Pathnames box (see Figure 2.21, page 2-15), type
the character string you want to filter the pathnames with.

3. Click Search.
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Search Pathnames: |

Figure2.21 Search Pathnames Box

Filtering HEC-DSS Pathnames by Parts

The Sear ch by Parts feature | ets you choose specific pathname parts from
those available in aHEC-DSSfile.

To Search by Parts:

1. From the View menu, click Search

| PLOW ~| H
pathnames by parts. o i
2. Click on the down arrows beside the m': FLOW
pathname parts you want to search. | ow ommect
This alows you to view lists of I |PRECIP-EXCESS
available namesinthefile (Figure b rrecipstan pev
2.22). 2501983 - 0TI 393

3. When you have a pathname part list ~ Figure 2.22 Selecting Pathname
open, you can scroll through the list Parts
to locate the pathname part you want.

4. Click on apathname part to select it.

5. Toreturn to the previous list, click on the blank field at the top of
thelist.

2.5.3 Refreshing the Catalog

The catalog automatically refreshes whenever you add, delete, or rename
records. For very largefiles or network files, adialog box will be shown
asking if you want to create anew catalog. When the catalog is refreshed,
it re-inventories all records on disk to get a pathname for every record. To
generate anew catalog manually, click Refresh Catalog from the Edit
menul.

2.6 Selecting Pathnames

Once you have filtered a HEC-DSSfile for the pathnames you want, you
select specific pathnames to visualize data for or perform a utility function
on. When you select a Pathname, it will appear in the Selected
Pathnames List.

There are several ways to select pathnames:
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2.7

2.8

m Double-click on anindividua pathnameinthe HEC-DSS
Pathname List.

m Highlight a pathname in the HEC-DSS Pathname List then click
Select (Figure 2.10). Until you select a pathname, the Select
button remains inactive.

m Click and drag your mouse to select a series of pathnames, and
then click Select. You can aso use Ctrl+click to select multiple,
non-consecutive pathnames.

m Hold down the Ctrl key and click on pathnames to highlight
them, or hold down on the shift key to highlight all pathnames
between mouse clicks, and then click Select.

m If youwishto select al of the pathnames, click Select All from
the Edit menu.

m If no pathnames are selected, you can just highlight one or more
pathnames and then perform the function that you intended. 1f
pathnames have already been added to the selection box, those
pathnames will be used instead of the highlighted ones.

De-Selecting Pathnames

To de-select a pathname currently in the Selected Pathnames List:

1. Click the record's pathname in the Selected Pathnames List to
select it.

2. Click De-Select, the pathname will no longer appear in the
Selected Pathnames List.

Y ou can also de-select pathnames by double-clicking on a pathname in the
Selection Area list.

To remove all pathnames from the Selected Pathnames Ligt, click Clear
Selections. To restore selections you have cleared, use Restore
Selections.

Visualizing HEC-DSS Data with Plots and Tables

Once the Selected Pathnames List contains al the pathnames you wish to
display, you can generate plots and tables.

To create aplot or table from the Display menu, click Plot or Tabulate.
Y ou can also click the Plot |.d button or the Tabulate g button.

From a plot window, you can aso tabulate data using the Tabulate
command in the plot's File menu. Likewise, to open a plot from atable,
you can use the Plot command in the table's File menu.
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Examples of the plots and tables HEC-DSSV ue can produce are shown in
Figure 2.23.

/MY BASIN/RIVERSIDE/STAGE/O1MAR1990/1HOURY... (2 |[E)(X]
File Edit

View

= o] IMY BASIN/RIVERSIDE/STA... [= [B)[X)

File Edit

Wiew

RIVER... | RIVER...
Crdinate Date | Time STAGE FLOMY

Stage (1)
zzgpag
o T B
};"’I’

1o OBS OB
0000 LIniits FEET CFS | m
BN Type INST-WaL | IMST-wal
B0 1(01 Mar 90, 01:00| 12,740 33,880

o 40000 2|01 mar 20, 0z:00|  12.760] 34,120

g' iﬁz\k’ 3(01 Mar 90, 0300 12,770 34,240

2 ] 4|01 Mar 90, 04:00| 12,770 34,240

5|01 Mar 90, 05:00|  12.760( 34,120

v i (01 Mar 90, 06:00|  12,750( 34,000
Wariaa 7|01 Mar 90, 07:00|  12.690( 33,230

8|01 Mar 90, 05:00|  17.690| 33,780

RIERSIDE OES STMGE

in]

01 Mar 20, 09:00 12.610 32,320
01 Mar 90, 10:00 12,680 33,160
01 Mar 90, 11:00 12,750 34,000
01 Mar 20, 12:00 12,740 33,5830
01 Mar 20, 13:00 12,710 33,520 %

—_
=)

—_
—_

—
-J

—
L]

Figure 2.23 Example Plot and Table

HEC-DSSV ue plots are highly customizable. Y ou can add titles, specify
colors and patterns of backgrounds and lines, change line styles, add
markers and callouts, add borders to labels, and customize legends, axes,
and tic marks. For more information refer to Chapters 6.

2.9 Groups

Data sets can be assembled together in Groups. Groups provide easy
access of plotting, tabulating, and editing frequently accessed records
without having to search for them in the DSS file. The Groups capability
is often used when the same time series data sets with different time
windows are accessed frequently. The Group information is stored in a
text filein the User's Application Data area, under HEC-DSSSV ue.

The Groups menu option gives you the ability to create groups and access
previously created groups. The following sections describe the Groups
menu options in detalil.
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2.9.1 Creating and Saving Groups
To create a Group:

1. Select all the records you would like in the group in the Selected
Area. If you set atime window, that will be saved along with the
group

2. From the Groups menu, click Save Selected. The Input dialog
will appear (Figure 2.24). Type the group's name in the Enter
group name box and click OK.

Enter group name

" "
\"tf) |Eartu:un |

[ oK H Cancel ]

Figure 2.24 Input Dialog Box

3. The Saved Group message (Figure 2.25) will appear when the g
has been saved. Click OK.

Saved Group

1 ) Group Barkon saved.

Figure2.25 Saved Group Message

4. The group will be saved and listed in the Groups submenus, see
Figure 2.26.

Data Entry  Tools  Scripks Adw

|- 'f Gek [
— Cumberland -
ast,
; Flot Individual Sets » |_
Tabulate »  Red
Math B miss
] Manage...

v| ¢
Figure2.26 Group Submenus
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2.9.2  Selecting Groups

When aGroup is selected, all the records contained in the group are
added to the Selected Pathnames List. To select a previously created
Group, from the Groups menu, point to Get, select the name of the
Group.

2.9.3 Plotting Groups

To plot agroup, from the Groups menu, point to Plot, select the name of
the group. A plot window will appear plotting all the records contained in
the group as shown in Figure 2.27 below.

IAAATAXEMAJPRECIP/O1DEC1993/1HOUR/OBS/ =3

File Edit  Wiew

6.5

(8

o
& @
m o

1 1

Frecip (in)
z
o
1

00 /,_.-—’ B e
& 5004 -~
E 7 rd
E 400 1
o _ ——— L —
300 T T T T T
2 3 4 il =]
[Dec1993
£ 2|

——— AXBWA 0B PRECIP BEECH HW CALIBRATED FLOW-BASE

SPRCR JCT CALIBRATED FLOWW

Figure 2.27 Group Plot

If you would like to plot agroup, but only display one record at atimein
the plot, from the Groups menu, point to Plot I ndividual Sets, then the
name of the group. A plot window will appear that has a Select Data Set
list (see Figure 2.28, page 2-20), listing al the recordsin the group. The
first record in the group will be selected in the Select Data Set list and the
records datawill be plotted. To plot adifferent record in the group,
simply select the record in the Select Data Set list and the current datain
the plot will be replaced with the newly selected data.
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=S

File Edit ‘Yiew

Selected Data Set: | JGREEN RIVER/GLENFIRFLOW/01APR 1992/ 1 HOURJEDIT/ v

L) 1 of 3]0

40,000

Eltd

35,000+

30,000

25,000

20,000

Flomy {cfs)

15,000+

10,000

5,000

L e s I I I Y Y B
23 025 27 029 1 3 &5 F 9 11 13 15 17 19 21

Anrl 982 | Myl 892
GLEMFIR EQIT FLOWY

Figure 2.28 Individual Data Set Plot

2.9.4  Tabulate Groups

To tabulate a group, from the Groups menu, point to Tabulate, select the
name of the group. A tabulate window will appear tabulating all the
records contained in the group.

2.9.5 Math Groups

Y ou can open the Math Functions Editor for a particular group of
pathnames (data set) to perform math operations on the data sets within
the group. For more detailed information on the Math Functions Editor,
see Chapter 7. To usethe Math Functions Editor, from the Groups
menu, point to M ath, select the name of the group. The Math Functions
Editor will open with the group's pathnames popul ating the Selected
Data Set list.

2-20



HEC-DSSVue User's Manual Chapter 2 - Using HEC-DSSVue: An Overview

2.9.6 Manage Groups

Groups can be edited in the Manage Groups Editor (Figure 2.29). Inthe
Manage Groups Editor you can delete groups, add pathnames to a group,
change the order of a group's pathnames, remove pathnames, and rename
groups. To access this editor, from the Groups menu, click Manage, the
Manage Groups Editor will open.

Manage Groups
File Edit
Group Time window Pathname File name
Cumberland  |T-5D, T+2H HICUMBERLANDYELEY 27 JUlZ001 - 01AugZ001{ 1HOURS000M0; C:ifforecast.dss
JICUMBERLAMDYFLOW/011ul2001 - 314002001/ 1HOUR,PODONDS C:fforecast.dss
JICUMBERLAMNDYSTAGE/D1 JUIZ001 - 31Aug2001) 1HOURPODOND) C:ffarecast.dss
JCUMBERLAMDYSTAGE-REG/271ulz001 - 014092001/ 1HOUR/PODONOBOED C:ffarecast.dss
Bartan NEARTOM/FLOW 01 Jul2001 - 314092001 1HOURPODOMNDS i fforecast.dss
HEARTOM/FLOW 27012001 - 01 Aug2001} THOUR/S000ND] C:ffarecast.dss
HEARTON/FLOW-CUMLOCIZ7I0I2001 - 01A0g2001) THOUR/PODOND C:ffarecast.dss
HBARTOMJFLOW-CUMLOC)27IUIZ001 - 01 AugZ001/ 1HOUR/S000M0] Cifforecast.dss
Red JRED CLAY CREEK/STANTON, DE/FLOMW0100E 1955 - 305ep2007) 104 USES] i frydss.dss
JRED CLAY CREEK/STANTON, DE/FLOMW - NO SLOPE ADNO310nz000 - 17Aug2008) 104y 1USES) i fmydss.dss
JRED CLAY CREEK/STANTON, DE{STAGE - NO SLOPE ADJ/031un2000 - 174002008/ D&Y JUSES)  |C:fmydss.dss
iiss JLITTLE MILL CREEK/ELSMERE, DE/FLOMW|010ct 1963 - 3052p 1980/ 1D4Y 1USES] i frydss.dss
JLITTLE MILL CREEKNEWPORT, DE/FLOW010ct 1990 - D2Naov1 998/ 108 /USES] i fmydss.dss
MISSISSIPPI RIVER/ST, LOULS, MOJFLOW01Janz007 - 12Mov2007/ 108 USES] Cifmydss.dss
JMISSISSIPPI RIVERSST, LOUIS, MOSSTAGE - OBSERVATION AT §:00 AM{011an2007 - 12Nov200.., |C:fmydss.dss
Save ] [ Cancel

Figure 2.29 Manage Groups Editor

2.10 Data Entry

The Data Entry menu provides tools to add datato HEC-DSSfiles.
Commands available through this menu allow you to manually create and
add time series, paired and text data, and Import or Export data setsto
and from an HEC-DSSfile.

2.11 Utilities

The Edit menu provides a means for renaming, deleting, duplicating and
copying data sets. Data sets that have been deleted before the HEC-DSS
fileis squeezed can be recovered from the Un-delete dialog in the Edit
menu. Two HEC-DSS files can be merged into one using the Merge
feature.

The Tools menu facilitates additional tools to help manipulate and manage
the data contained in HEC-DSS files. Thesetoolsinclude: Math
Functions, Data and File Comparing, Search, Integrity Check, and
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2.12

2.13

Scripting. You can aso remove excess disk space and optimize the file
with File Squeeze.

The Advanced menu provides access to the traditional HEC-DSS
catalogs. From here you can generate, view, and print an abbreviated
catalog, a condensed catalog or a complete catalog. Y ou can aso view the
output log, reset the program defaults, and set HEC-DSS options, as well
as severa interna tools.

Custom and Scripting Menus

Menus can be added to HEC-DSSV ue's main menu for plug-ins and
scripting. The Script Editor has a checkbox to activate the Script menu
and add the script you are editing to that menu. Thisisaconvenient way
to access alarge number of scripts that are used frequently.

If you have several customized operations that are preformed through
plug-ins, you can have those functions show up on a menu that you name.

Plug-Ins

HEC-DSSV ue has the capability of accepting Javajar plug-ins. A plug-in
is essentially compiled Java code that has been written to extend the
capability of HEC-DSSVue. Itissimilar to ascript, but can be more
powerful and more customizable. For example, a plug-in might retrieve
data, decode it and store it into aHEC-DSS file. Another use might be to
perform sophisticated math functions on data selected from the main
screen.

Plug-ins are added by placing the jar plug-in filein the HecDssV ue/
Plugins directory. When HEC-DSSV ueis executed, it searches this
directory for available plug-ins and loads them into the program. Most
plug-ins will add a button to the main toolbar, adjacent to any script
buttons. To remove aplug-in, simply removeits jar file from the Plugins
directory.
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CHAPTER 3

Displaying & Editing Data

HEC-DSSV ue allows you to plot, tabulate, and edit datain HEC-DSS
files. This chapter covers setting a time window to access and view time
series data with, tabulating time series and paired data, editing data and
displaying supplemental data associated with adataset. Plottingis
covered in the chapter "Customizing Plots”.

For HEC-DSSVue Version 2.0, you can "drag" data sets from the main
window onto aplot or table to add that data set to the plot or table. The
file that you are dragging from does not need to be the same as where the
origina data came from; in fact you can drag a data set from a different
instance of HEC-DSSV ue.

3.1 Setting a Time Window

Y ou can specify the time window for data you want displayed in plots and
tables and to perform math functions on. For example, if you have a set of
HEC-DSS records ranging from October 1, 1993, to December 30, 1993,
you can specify anarrower time window such as 050CT1993 to
250CT1993 for plots, tables, and operations with math functions.

To set the Time Window:

1. From the Display menu, click Time Window. The Set Time
Window dialog box will open (see Figure 3.1, page 3-2).

2. You may select no time window, which will retrieve all the data
for adata set, enter specific dates and times, use a time window
relative to the current time, or access data by water year.

3. To access dl datain adata set, select No Time Window (see
Figure 3.1, page 3-2).

4. To set a specific time window, select Specific Time Window.

a. If you wish, you can set the fields to the current time by
clicking Set Current Time and then change what you want
manually.

b. To specify dates and times:

i. Enter the Start Date and End Date (see Figure 3.1, page
3-1). Although avariety of formats will be recognized for
the date, the typical format isDDMMMYYYY.
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B Set Time Window

) Mo Time YWindow

Start Date: | 27 Nov 1983,

EndDate: | 30 Mov1933[.

Start Time; | 23:00

End Time: | 24:00

’ Clear

l

’ Set Current Time

() Relative to Current Time
Go Back:

Go Forward:

() By Individual YWater Year

Start Date of Water Year:

[ Retain Between Sessions

[

” Zancel H Apply

Figure3.1 Set Time Window Dialog Box

ii. Enter the Start Time and End Timein 24-hour format
(e.g., for 2:00 PM, type "1400").

c. You may select the starting and
ending dates from the calendar
tool, From the Start Date box,
click on|...]. The calendar tool
in amonthly format will open
(Figure 3.2). You may scroll
through months or years by
using the appropriate arrow
key at the top of the box.

5. To set atime window relative to
the current time, select Relative to
Current Time (Figure 3.1).

a. Select the units you want to go
back and forward from the
current time. Y ou can select
hours, days, months, or years.

b. Enter the Go Back and Go
Forward units.

c. If you do not set aunit, No
Time Window will be set.

1 [ 4 5 &
il & o 11 12 13
14| 15

21| 22 24| 25 26| 27

17| 18 19 20‘

28| 29

Ok Cancel

Figure 3.2 Calendar Tool
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6. Accessing DSS data by water year, from the Set Time Window
dialog box select (see Figure 3.1, page 3-2) Individual Water
Year. You can change the default start date of the water year from
October first by setting a new date in the Start Date of Water
Year box. Thiswill read al the datain adata set and then separate
itinto individual data sets by water year. This setting is primarily
useful when using math functionsin HEC-DSSVue. If you plot
data when this setting is selected, you should choose Plot
Individual Data Sets.

7. To keep your settings for the next time you run HEC-DSSV ue,
select Retain Between Sessions. The next time you execute HEC-
DSSVue, your time window will be set.

8. Click OK the Set Time Window dialog box will close (see Figure
3.1, page 3-2), and the time window settings will be applied.

3.2 Display Data Options

Two options are provided as a quick way to compare time series data sets
for different time periods or for different amounts. The options are turned
on or off by selecting and un-selecting them from the Display menu, point
to Display Data Options, and the two available options are - Nor malize
and Synch data set timesto first.

Normalize will subtract the differences between the values of first and the
second or subsequent data sets from the corresponding data set, so that the
curves all start at the same value (which is the value of the first data point
in thefirst dataset). Thisis often used to compare cumulative
precipitation curves, which usually start at different values.

Synch data set timesto first will subtract the differences between the
times of first and the second or subsequent data sets from the
corresponding data set, so that the curves all start at the same time (which
isthetimein thefirst data set). Thisis often used to directly compare
hydrographs for different years or time periods.

Each option will remain on until you turn it off or the program exits. The
options can be used in combination with each other. For example, if you
want to compare cumulative precipitation curves for different years, set
each option to on. Figure 3.3 shows such an example of normalized
cumulative precipitation for years 1986 and 1995, synched to the same
start time.
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" JFEATHER RIVER/PARADISE/PRECIP-CUM/01JAN1 986/1DAY/0BS/ [= (B[]
File Edit View

120

100 jJ

20

Frecip (in)

20

0 T T T T T
Jan hdar Tl 3y Jul Sep Mo

| 1986

|— PARADISE OBS PRECIP-CLUM —— PARADISE OBS PRECIP-CLR

Figure 3.3 Normalized and Time Synched Precipitation Datafor Y ears 1986 and 1995

3.3 Viewing Tabular Data

An example table produced using HEC-DSSVue is shown in Figure 3.4.
Tables allow you to view and edit HEC-DSS datain a vertical scrolling

IBALDE/FLOW/01NOV1993/1HOUR/CALIBRATED! (2 |[B)[X]

File Edit ‘Wiew
EALDE SPRCR
Crdinake Dake | Time FLOW FLOW
CALIBRATED BB
Units CF5 CFS | &
Type INST-VAL INST-VAL|
1 27 Mow 93, 23:00 205.7 40.8
2 27 Mow 93, Z4:00 3229 49,6
3 28 Moy 93, 01:00 471.0 91.8
4 28 Mow 93, 02:00 641.6 1959
=1 28 Mow 93, 03:00 8506 387.7
o] 28 Mov 93, 04:00 1,109.5 711.0
7 28 Moy 93, 05:00 1,414.7 1,115.5
=] 28 Moy 93, 06:00 1,604.9 1,517.5
a 28 Mow 93, 07:00 1,914.0 1,872.3
10 28 Mow 93, 05:00 2,072.2 2,1531.0
11 28 Moy 93, 0200 2, 150.5 Z,284.4
12 28 Moy 93, 100 2,289.6 2,357.4 \;

Figure 3.4 Example Tabulation from HEC-DSSVue
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window that shows the ordinate (starting from the start date/time), the date
and time stamp, and the values for the selected data sets. From the File
menu of atable dialog box (see Figure 3.4, page 3-4), you can view the
tabular datain plot format by clicking Plot. Respectively, you can
tabulate data displayed in a plot dialog box, from the File menu, click
Tabulate.

3.3.1 Accessing Tables

To access tables, first select the pathnames of the records you wish to
view. There are several waysto select pathnames:

m Double-click on an individua pathname inthe HEC-DSS
Pathname list.

m Highlight a pathname in the HEC-DSS Pathname list then click
Select. Until you select a pathname, the Select button remains
inactive.

m Click and drag your mouse to select a series of pathnames, and
then click Select. You can also use Ctrl+click to select multiple,
non-consecutive pathnames.

m If you wish to select all of the pathnames, click Select All from the
Edit menu.

m If no pathnames arein the selection list, individual pathnames can
just be highlighted for quick selection.

m Drag additional datasets from the main screen onto the table to add
them to the table.

Once you have selected the pathnames you want to visualize, you can
open atable by clicking the Tabulate[] button from the Tool Bar, or
from the Display menu click Tabulate.

3.3.2 Customizing the Display of Tabular Data

From atabular data dialog box, from the View menu, you can choose to
display commas in numbers by clicking Commas. Y ou can reverse the
order of the table by clicking Reverse Order. For time series data, this
option will show the latest valuesfirst. The date and time of the data can
be tabulated in separate columns by clicking Date and Time Separ ately.
To have the dates display the years with four digits, click Date With 4
Digit Years. You can set the precision of decimal places for your data by
pointing to Show Decimal Places and then clicking the number of
decimal places you wish to display (see Figure 3.5, page 3-6). You can
also change how missing values are displayed by pointing to Show
Missing As and then by clicking blanks (the default), -901.0, M, or -M-.
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=

W _ammas

Reverse Order

Hil Date and Time Separately  [Time
Date with 4 Digit Years

Show Decimal Places 4 % auko
L Show Missing &s 2 a. u
. 0.0

0.a0

0.000a
0.0000a
0.00aacg

|DID|D|DID|D|D|

[ W O YTV N

o L M =

Figure 3.5 HEC-DSSVue Tables have Several
Options for Displaying Data

3.3.3 Searching for Values

Y ou can search for specific valuesin your W
dataset, from atabul ate dialog box (see Allow Edting

Figure 3.4, page 3-4), fromthe Edit menu |

click Find (Figure 3.6), or pressthe F3

key. Using either option will open the ° Copy Ctrl+C
Find dialog box (Figure 3.7). — F
Inthe Find what box (Figure 3.7), enter | e Sra
the item that you are searching for in your R ——— )
dataset. When you click Find Next D

(Figure 3.7), the next value that matches ~ F19ure 3.6 Tabulate Edit Menu
will be highlighted. Y ou can search up from where your cursor is, or

Find X]
Find what: |345| |
Search:

[]Makeh whale wiord only

[[] search date/time also

Figure 3.7 Find Dialog Box

search down. You have the option of searching for the exact number or
part of that number. You can aso search for adate or time.
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3.3.4 Comparing Datasets

If you tabulate two or more similar time r
g File: Wi

series data sets, you can compare values o Edic

from both sets from the table. From a | AlowEdind .

tabul ate dialog box (see Figure 3.4, page i

3-4), from the Edit menu, click Compare Copy Chrl+C
data sets (Figure 3.8) — -
. , . i lect Al A L
A message will appear displaying the [ ] i;:ct 3 E;r A i
number of values that differ in the pe——— ;

selected data sets (Figure 3.9) and the - ; ks
differences between the two data setswill  Figure 3.8 Compare Data Sets
be highlighted in red, as show in Figure
3.10.

ol ) 11 walues are different

For more information and options to
compare datasets, see Chapter 4, Section

a.1. Figure 3.9 Display of the number of
valuesthat vary

I/BEECH CREEK HW/FLOW/01SEP2001/1HoUR/Foco/ (2 |[B)[X]

File Edit Wiew
BEECH CREEK HW | BEECH CREEK HW
Crdinate [ate Time FLC FLCAY
FOCO S0C0
134 26 Sep 2001 12:00 1,998.6 1,998.6 A
135 26 Sep 2001 13:00 2,375.9 2,375.9
136 26 Sep 2001 14:00 Z,821.5 2,821.5
137 26 Sep 2001 15:00 3,304.1 3,304.1
138 26 Sep 2001 16:00 3,770.9 3,770.9
139 26 Sep 2001 17:00 4,243.0 4,103.6
140 26 Sep 2001 18:00 4,310.4 4,353.0
141 26 Sep 2001 19:00 4,377.8 4,557.5
142 26 Sep 2001 Z20:00 4,445,2 4,T46.4
143 26 Sep 2001 21:00 4,485.6 4,892.6
144 26 Sep 2001 22:00 4,477.9 4,942.2
145 26 Sep 2001 23:00 4,470.1 4,869.3
146 26 Sep 2001 24:00 4,435.0 4,728.3
147 27 Sep 2001 01:00 4,348.5 4,567.3|
148 27 Sep 2001 0z:00 4,262.0 4,407.4
149 27 Sep 2001 03:00 4,175.5 4,253.0
150 27 Sep 2001 04:00 4,104,0 4,104,0
151 27 Sep 2001 05:00 3,960.3 3,960.3
152 27 Sep 2001 06:00 3,821.8 3,821.8
153 27 Sep 2001 07:00 3,688.1 3,688.1
154 27 Sep 2001 05:00 3,559.3 3,559.3 2
—= L FET T

Figure 3.10 Comparison of Two Data Sets
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3.4 Editing Tabular Data

In HEC-DSSV ue, you can edit data directly in tables, but first you must
set the table to allow editing.

From atabulate dialog box (see Figure 3.4, page
3-4), from the Edit menu, click Allow Editing
(Figure 3.11). Thiswill set the table editable Allow Editing
and allow you to manually edit the listed data.
When this option is checked, the background of
non-editable table cells display grey and the Copy
Cut, Paste, Insert Rows, and Delete Rows i I
commands become available from the Edit
menul.

ChrlHC

| Select all Chrl+8 |
- Find... F3

If the Allow Editing option is disabled (grayed- Figure3.11 Edit;\/llenu -
out), you may not have permission to write to Allow Editing
thefile or the table was started from adialog

that does not have access to write to the file (such as a plot window).

Changes made to atable can be saved, from the File menu, click Save or
click Save As. If you do not save your data before you close the table
window, HEC-DSSVue will prompt you to save your changes before it
closes the window.

3.4.1 Selecting Table Cells

To select an individual table cell, smply click on it. cuk
Copy
To select several consecutive cells, click, hold down Paste

and drag your mouse over the cells. You can aso
hold down the Ctrl key and click to select multiple,

Clear

non-consecutive records. Fill...
. i Select all
If you wish to select all rowsin atable, from the
Edit menu, click Select All. Print. ..
Prink Preview. ..
Y ou can also use shortcut menu items to edit Expatt...

multiple selected cellsin tables (Figure 3.12).

Sum Selecked Cells
Surm Entire Calurmn

Figure 3.12 Shortcut

3.4.2 Cutting and Pasting Data Menu

The Cut command removes data from the cell and placesit on the
computers clipboard in ASCII format. For regular-interval time series
data, the Cut command will set the emptied cell to the missing data flag.
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Y ou can cut data from one set of cells and paste it into another set of cells
(in the same table or another table). To do acut and paste:

1. From the View menu, click Allow Editing.

2. Select the cells you want to Cut the data from.

3. From either the View menu or the shortcut menu (see Figure 3.12,
page 3-8), click Cut.

Select the cells where you want to Paste the data.

From either the View menu or the shortcut menu (see Figure 3.12,
page 3-8), click Paste.

o &

Tip: The keyboard shortcut keys, Ctrl + x and Ctrl + v
also work for cut and paste.

3.4.3 Copying and Pasting Data

The Copy command copies selected cell dataand placesit on the
computers clipboard in ASCII format.

Y ou can copy data from one set of cells and paste it into another set of
cells (in the same table or another table). To do a copy and paste:

1. From the View menu, click Allow Editing.

2. Select the cells you want to Copy the data from.

3. From either the View menu or the shortcut menu (see Figure 3.12,
page 3-8), click Copy.

4. Select the cells where you want to Paste the data.

5. From either the View menu or the shortcut menu (see Figure 3.12,
page 3-8), click Paste.

Tip: The keyboard shortcut keys, Ctrl + x and Ctrl + v also
work for cut and paste.

3.4.4  Clearing Table Cells

To delete and remove data from table cells use the Clear command.
Cleared datais not saved to the computer's clipboard, so you will not be
able to paste the data back into the table. However, for time series data,
the Clear command will remove the data from the cell and add a missing
flag to the emptied cell. To clear table céells:

1. From the View menu, click Allow Editing.
2. Select the cells you want to clear.
3. From the shortcut menu (see Figure 3.12, page 3-8), click Clear.
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3.4.5

Adding and Inserting Rows

Depending on what type of datais being edited in atable, rows can be
inserted, appended, or added to the beginning or end of the table.

Appending rows is automatic when Allow Editing is set. When Allow
Editing is selected, two blank rows automatically appear at the end of the
table. When ever you enter datain arow at the bottom of the table, an
additional blank row will be appended. When you save the data, any
blank rows at the end of the table are removed automatically.

For regular interval time series data, rows can only be inserted at the
beginning or end of the data set. For irregular interval time series data and
paired data, rows can be inserted between any existing table rows. To
insert arow into the table:

1. Using your mouse pointer, click on the row you would like to

insert rows next to and then from the Edit menu, click Insert
Rows.

. The Extend Data Set dialog box will open (Figure 3.13). This

dialog may be different from what's pictured in Figure 3.13
depending on what type of datais displayed in the table.

Extend Data Set @

Insert before 25 Mow 1993, 24:00
Mumber Fows; 7% Interwval:

Skart Date: 25 Mow 1993, ] Time: 17:00

Append after 05 Dec 1993, 02:00
Mumber Fows; n% Interwval:

End Date: 05 Dec 1993, Time: 0z:00

I oK l [ Cancel ]

Figure 3.13 Extend Data Set Dialog Box for Regular Interval Data

. For irregular interval time series data (see Figure 3.14, page 3-11),

you have the option to Insert between the selected dates, I nsert
beforethefirst date, and Append after the last date. Regular
interval data can only have datainserted before and after the
existing time steps. Each choice requires you to enter the number
of rowsthat will be added. From the Number Rowslist, enter or
select the number of rows that will be added to the table at the
given area.

3-10
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Extend Data Set

Insert bebwesan 01 Moy 1993, 06:00 and 01 Mow 1993, 07:00

]

Mumber Rows: b= Interval: LTHOUR
Set the date and kime For each row

Insert before 31 Ock 1993, 24:00

Mumber Rows: 0% Interval: LTHOUR W
Skart Date: 31 0ock 1993, Tirme: 2400
Set the dake and kime For each row

Append after 31 Dec 1993, 23:00

Mumber Rows: 0= Interval: LTHOUR

End Date: 31 Dec 1993,.) Tirne: 2300
Set the date and time For each row

[ oK l [ Cancel

]

Figure 3.14 Extend Data Set Dialog Box for Irregular Interval Data

4. Irregular interval time series datarequires an interval to be

selected. From the Interval list, select an interval, default is
1HOUR. If you would like the data and time filled for each
inserted row, be sure Set the data and timefor each row is

sdlected.

5. For apaired datatable, all that is required is entering the number of
rows you would liketo insert. From the Edit menu, click I nsert
Rows, the Insert Rows dialog box will open (Figure 3.15). Inthe
Number to insert box, enter the number of rows you would liketo
add. Paired datatables aso allow you to add additional columns,

from.

Insert Rows

Murmber ta insert:

[ oK l [ Cancel

Figure 3.15 Insert Rows Dialog Box

6. Once you are done entering information for the insert, click OK.
7. The entered number of blank rows will be inserted at that row,

moving the original row that you selected down.
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3.4.6

3.5

3.5.1

Deleting Rows and Columns

Y ou may delete rows from atable when working with irregular-interval
time series data and paired data. To delete arow from atable, select the
row and then from the Edit menu, click Delete Rows.

If you are working with regular interval time series data, you will not be
ableto delete rows; instead, the Delete Rows function will change the data
valuesto missing. Thisisthe same as clicking Clear (see Figure 3.12,
page 3-8) from the shortcut menu.

In a paired data table you can delete acolumn. To delete apaired data
column, select the column and then from the Edit menu, click Delete
Column. The Delete Column message box will open (Figure 3.16),
requiring you to verify you would like to delete the entire column. Click
Y esto finish deleting the column.

Delete Column

‘-?r/ fre wou sure you want to delete the entire column?

Figure 3.16 Delete Column Message Box

Printing, Copying, and Exporting Tables

HEC-DSSV ue tables offer several commands that allow you to print, copy
or export data and then paste tables into other applications such as
Microsoft Excel and Word. The following sections describe each in
detail.

Printing Tables

Y ou can access the Print and Print
Pr eview commands from either the

£ JGREEN RIVER/OAKVILLEfELEVAT... [T)[E
FIEN Edit Wiew

File menu (Figure 3.17) or from the
shortcut menu (see Figure 3.18, page Save ne e | B
3-13) of the table window. mprmtprevie oS
Export... 1?;00 911:
. . . 18:00 911.
In atable, the Print and Print Preview Flot 1e00 o1t
X . Close ChrlHi 20:00 311.
commands open the Properties diaog 15 oZWay1SEl 2100 il
H 46 02 Mgy 1992 22:00 911
box (see Figure 3.19, page 3-13), Figure 317 Filé Menu - Tabuldte
which offers options on three tabs. Dialog Box
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The Page tab allows you to specify the page Cut
Orientation, Scaling, and Selection. You can Copy
also choose to print the table as ASCI |, Repeat Pacte
Header s on every page, and print the Gridlines, Clear
On the Header/Footer tab you can type in the Fill..
header and footer you want to appear on your celect Al
printed pages.
Frint...
The Table Title tab offers a default title for the Print Preview. ..
table based on the data source, which you can Export...
change. Sum Selected Cells
o , ire Col
On the Properties dialog box, the Print M Enfire &almn

Figure3.18 Print Shortcut

command performs two functions, depending on Menu

whether you arrived at the dialog box viathe
Print command or the Print Preview command.

Orientation

L, i
() Partrait () Landscape

Scaling

All calumns on one page
Selection

(%) Entire Table () Selected Cells

Prink
ASCII Repeat Headers
Gridiines
[ Presview ] [ Cancel ]

Figure 3.19 Properties Dialog Box - Printing

If the Properties dialog box was opened using the Print Preview menu,
the Preview button on the Properties dialog box opensa Print Preview
dialog box that allows you to view the table as it will look wheniitis
printed, see Figure 3.20 (see page 3-14). You can click Print in the Print
Preview dialog box to print your table.

From the Print command, the Print button on the Properties dialog box
opens aWindows-style print dialog box where you can choose your
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Print Preview

Print Close |m

(FSPRCR JCT(FLOWR LK RSy THOLR A

SPACACT
FLrW

E
E3
i
i
®
=
0

e

Figure 3.20 Print Preview Dialog Box - Table

printer, set printer properties, and specify the number of copiesto print.
Y ou can also print your tableto afile instead of to aprinter.

3.5.2 Exporting Tables

Tables can be exported and converted into a*.txt file. Oncethetableisin
the form of a*.txt file, it can be opened in adifferent application such as

Microsoft Excel or Word. .
Table Export Options [‘S_<|

From the shortcut menu or the
File menu, click Export, the -
Table Export Options dialog box | [ Fixed Width Columns

will open (Figure 3.21). [] Quated Strings

Field Delimiter: | THE w |

In the Table Export Options [] Include Calumn Headsrs
dialog box, you can choose a

Field Delimiter (TAB, SPACE,
COMMA, COLON, or SEMI- [ Print GridLines
COLON), specify Fixed-Width

_ [ Print Tidles | |
Columns, choose to display
Quoted Strings, Include [ OK | [ Cancel ]
Column Headers, and opt to Figure 3.21 Table Export Options Dialog Box

Print Gridlinesand aTitle.
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3.5.3 Copying Tables to the Clipboard for Use in Other
Applications

To copy atableto the clipboard, from atable dialog box, from the Edit
menu, click Copy (Figure 3.22). Y ou can also right-click inside the table
and click Copy from the shortcut menu (Figure 3.23). To copy the entire

{ISPRCR JCT/ELOW/OTHOV1 993/1HOI
File Bl ‘iew

Alloow Editing
ChrgC Dake [ Time
| Select all Chrl+A
20 Mo
— Find. .. F3 —_——
n ; 20 Mo
3 20 Mo

20 Bl

4
Figure 3.22 Edit Menu - Table Dialog Box

table from the shortcut menu, click Select All and cut
then click Copy. Y ou can then paste the table as Copy
tab-separated values into another application such Pasts
as Microsoft Excel or Word. Only thedatais
copied to the clipboard; the table gridlines are not
copied. (Usethe export options when you want Select Al
to copy table gridlines.) Print. ..

Prinkt Prewviews, ..

Clear

Fill. ..

Expork...

Y ou can aso highlight a portion of the table and
then click Copy. Thiswill copy the portion of Sum Selected Cells

. . . Sum Entire Colurnn
the table that you highlighted to the clipboard. Figure323 Shortout

Menu - Copy

3.5.4 Tabulate and Editing using MS Excel (Optional)

If the Excel plug-in isloaded, you can tabulate (or export) datain
Microsoft Excel and edit time seriesdatain Excel. Simply select the data
sets you wish to tabulate as you normally would and then either press the
Excedl tool in the toolbar, or from the Display menu, click Tabulatein
Exce (assuming you have Microsoft Excel installed). Figure 3.24 (see
page 3-16) shows how the datais displayed in Excel.

To edit datain Excel, select your data sets and from the Edit menu, click
Edit in Excel. Thiswill load the selected data into an Excel spreadsheet
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E3 Microsoft Excel - HecDssExcel2573074382946914707.xls

File Edit Yiew Insert Format Tools Data ‘Wwindow Help Adobe PDF ;lilﬂ
DEeEs S0V §BR T o- A2l il BT O
= 5
Al ~| =| A

A B C D E F =
1] A MY BASIN WY BASIN MY BASING MY BASING
2 B RIWVERSIDE RMWERSIDE RMWERSIDE RMNWERSIDE
3 C FLOWY PRECIP-INC STAGE TEMP-AIR
4 E
5 F OES OBS 0OBS OBS
B Units CF3 INCHES FEET DEG-F
7 Type IMNST-WAL PER-CLIM INST-WAL  INST-WAL
g 1 01kari®30 0100 33880 0.00 12740 22600
9 20 01mMart@30 0200 34120 0.00 12760 21.200
10 3] 01mMart@30 0300 34240 0.00 12770 20,600
11 4/ 01Mart@30 0400 34240 0.00 12770 19.800
12 5 O1hart390 0500 34120 0.00 12760 18.500
13 B O1hart3390 0600 34000 0.00 127580 17.800
14 70 01Mart990 0700 33280 0.00 12,690 17.100
15 8 01hart990 0300 33280 0.00 12,690 21.200
16 9 D1Mart290 0900 32320 0.0o 12610 25,700
17 100 01har1290 1000 33160 0.00 12680 29.6500
18 11 01har1290 1100 34000 0.00 12750 31.600
19 120 01har1290 1200 33830 0.00 12740 35.200
20 130 01har1290 1300 33520 0.00 12710 37.000
21 14 01har1290 1400 33280 0.00 12,690 40.800
22 15 01har1290 1500 32800 0.00 12650 42.300
23 160 01har1390 1600 32320 0.00 12610 44100
24 17 01har1 390 1700 31960 0.00 12680 44100
25 18 01har1390 1800 31600 0.00 12650 41.600
2R 19 01har1 390 1900 31120 0.00 125610 37.000
27 200 D1Mar1990 2000 30560 0.00 12 460 35.800
28 21 0D1Mart930 2100 30230 0.00 12430 31.500
29 220 D1Mar 990 2200 30010 0.00 12410 29.500
30 23 D1Mar1990 2300 29680 0.00 12.380 28.200
31 24 02Mar1990 0000 29790 0.0o 12390 27.000
32 25 0D2Mar990 0100 29790 0.0o 12390 25,700
33 26 D2Mar1990 0200 29630 0.00 12.380
44> M} Sheetl [«]
Ready

Figure 3.24 Tabular Data Exported to Excel

and then read it back to DSS once you have saved it. In this mode, you
may not add or delete rows or columns; you can only change the data.
After you are finished, save the Excel spreadsheet and then click OK or
Cancel from the dialog from HEC-DSSV ue.

Note - Take caution with dates and timein Excel. Excel
shows times as "Beginning of Period", while the HEC-DSS
convention shows times as "End of Period". A data value for
midnight will show up as 2400 hours at the end of the day in
HEC-DSS while Excel will display that as 0000 hours for the
next day. For daily data, the hours might not be shownin
Excel and the data can be misinterpreted to be for the
following day.
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3.6 Graphical Editing

Y ou can view and edit time series datain a combined plot/table using the
Graphical Editor (Figure 3.25) for HEC-DSSVue. To access the HEC-
DSSVue Graphical Editor, select one or more pathnames from the main
HEC-DSSV ue screen, from the Edit menu, click Graphical Edit or from
the toolbar click the Graphical Edit [Ed button. Only time series data can
be edited through the graphical editor.

Displayed Table Values
Graphical Editor
File Edit Yiew
HBE & [45F 7 N\
Selected Data Set: | [{SPRCR/FLOW/D1NGY1993/1HOUR/BE/ v
re— Current Selected Row
1200 . Al
[Q]
1.100 -
A & 10- 1
200
a4
wm @ 0600 B 1200 1500 1200
2Nt | 29H o 1930 ‘
< |
Origiral -~ EsdmacdEnmy — Ravlsea
DatejTime Original Estimate/Entry Revised ‘
(CFS) (CFS) (CFs)
29Nov1933, 06:00 | 1,183.46] | 1,183.48] |
29Nov1993, 07:00 | 1.140.42| 1,139.02| 1,140.42 |
29Novw1993, 08:00 | 1,098.95| 1,100.00| 1,098.95| |
29Nov1993, 09:00 | 1,088.%8| 1,090.00| 1,058.98 |
29Nov1993, 10:00 | 1,020.47| 1,070.00| 1,020.47| |
29Novw1993, 11:00 983.35| 999.00 2983.35] |
29Nov1993, 12:00 247. 52| I 947.53 |
29Nov1953, 13:00 EETTET I sis.13] |
29Nov1993, 14:00 873.92| 879.92 D
| | | (=
29Nov1993,15:00 |  e4v.sz| | = 847.32| ¥
F

Figure 3.25 Graphical Editor

The Graphical Editor displays an editable plot of the data on the top of
the editor and a scrollable table of the data on the bottom of the editor.
The area of the datathat is visible in the table is marked with a green hash
region in the plot. Asyou scroll through the table, the green hash area
moves along with the data that is displayed. When you select a point on
the curve or in the table, ared vertical lineis drawn at that point to show
which value has been selected.

Y ou can edit datain the Graphical Editor by drawing a curve with your
mouse, or by selecting a point on the curve and moving that point up or
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down, or by changing avalue in the associated table. You can also have
the editor linear interpolate missing points, or use the other fill options
associated with tables.

Y ou can only edit one curve at atime, but you can plot other data sets on
the same graph for comparison purposes. Y ou can also select multiple
data sets and scroll through them as you edit. The major components of
the Graphical Editor are shown in Figure 3.25 (page 3-17).

The components of the graphical editor are:

e Current Selected Row shows what data value is selected on the
plot and its corresponding row in the table.

e Displayed Table Valuesindicates the areain the plot that
corresponds to the data showing in the table.

e Selected Data Set field displays the pathname for the data set
being edited.

e Estimate button generates alinear interpolation for selected rows
for missing data or copies the origina datainto the editable field.
The Estimate All button performsthisfor al rowsin the table.
Datamust be in the editable field before the point editor can be
used.

e The Accept button copies data from the Estimate/Entry column
into the Revised column for the selected rows. Thisisfor
intermediate saving of the last data edited. If you want to retain all
changed values, the Accept All button copies all data from the
Estimate/Entry column into the Revised column.

e The Add Data button adds rows for irregular interval time series
data. A dialog will be displayed to set the date and time for the
row added.

e The Delete Data button removes rows for irregular-interval time
seriesdata. Y ou cannot remove regular-interval data; you can only
changeit to missing.

e Original column contains the values of the original dataset. The
values are generally depicted with ared curvein the plot with each
point marked by an 'x'. If the value is the same as the onein the
Revised column, that point will be over drawn with the blue 'x' as
well.
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e Estimate/Entry (edit) column is an empty editable column where
you enter data manually or edit with the point tool. These values
show-up in the plot as magentatriangles. When you are satisfied
with the changes you made in this column, press the Accept or
Accept All button.

e Revised (edited) column contains the final values that will be
saved when Save or Save Asis selected. Thesevauesdisplay asa
blue 'x' in the plot.

3.6.1 Graphical Editor Tools and Buttons

The Graphical Editor contains mouse tools and shortcut icon buttons to
help aid with the editing process. Available mouse tools:

Select Point tool selects a point on the curve to edit by moving the
mouse to that point and clicking the left mouse button.

@ Zoom tool put the mouse in azoom mode. To zoom-in, move the
mouse to one corner of the area you want to zoom-in to, click and
hold down the left mouse button while dragging the mouse to the
opposite corner and the release the button. To zoom-out, click the
right mouse button. The graph is zoomed-out in increments.

Single Point edit tool putsthe mousein a point edit mode, as
described in Section 3.6.3.

Line Draw isamulti-point edit tool that puts the mousein aline
draw mode, as described in the next section.

Available tool bar buttons:

[ | save button saves the datain the Revised column to the DSS file
without changing the pathname.

;| Save As button saves the datain the Revised column to the DSSfile
after allowing you to change one or more of the pathname parts.

Undo button restores the values to the original data set, undoing all
changes.

Plot button plots the original and revised datain a standard plot
window.

£|E | Tabulate button tabulates the original and revised datain a standard
table.
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3.6.2

3.6.3

Editing a Curve with the Line Draw Tool

Y ou can edit data by drawing a curve freehand by moving the mouse from
left to right while clicking on the left mouse button at selected inflection
points. To do this:

1.

10.

11.

Select the data set from the drop down box at the top of the screen
if it isnot selected already.

2. Select the Line Draw (multi-point edit) E’ tool.
3.

Move the mouse to the left-most position of the curve where you
want to start editing.

. Click on the left mouse button to mark the first data point.
. Move the mouse right along your desired curve and press the | eft

mouse button at inflection points. The Graphical Editor will
draw a straight line between points.

. If you make a mistake, you can move the mouse | eft past that point

and insert anew inflection point. Y ou can backup as many points
at one time as you want.

. When you are finished with a curve segment, press the right mouse

button. (That location will not be used as part of the curve.) The
line segments just given will be drawn with magenta triangles, and
those data points are entered in the Estimate/Entry column.

. 'You can draw other curve segments elsewhere on the plot using

the same procedure.

. If you need to remove a curve segment that you have drawn, select

the valuesfor it in the table and press the Estimate button. The
original values will be copied into the Estimate/Entry column.
After completing your curve, press the Accept button or the
Accept All button to accept all edits. Thiswill copy the datafrom
the Estimate/Entry column into the Revised column and will be
ready to save to the HEC-DSSfile.

At the end of all of your edits, press the Save [& or Save As [,
button or select that item from the File menu to store your changes
in the HEC-DSSfile.

Editing a Point with the Single-Point Edit Tool

Y ou can edit single data values by double clicking on the new point that
you want or clicking on the existing point and moving it vertically. To do

this:

1.

2.

Select the data set from the drop down box at the top of the screen
if it isnot selected already.
Click the[®l] Single-Point edit tool.
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3. Find the new value of the point on the graph that you want to edit
and double click the mouse at that location. Thiswill enter the
value that you selected into the Estimate/Entry column.

4. Edit the remaining points that you desire to have changed and
when you are complete, press the Accept button or the Accept All
button to accept all edits. Thiswill copy the datafrom the
Estimate/Entry column into the Revised column and will be
ready to save to the HEC-DSSfile.

5. Attheend of all of your edits, pressthe Save [& or Save As [,
button or select that item from the File menu to store your changes
in the HEC-DSSfile.

Y ou can also grab the point that you want to modify and move it
vertically. To do this:

1. Click the left mouse button on the data point you want to edit. The
table row containing that point will be highlighted.

2. Pressthe Estimate Missing button to provide a value to start from,
unlessthere is aready a value in the Estimate column. A magenta
triangle will be drawn at that point on the curve. To edit existing
points, double click the point and a magentatriangle will appear.

3. Move the mouse over the triangle and press and hold down the | eft
mouse button. Move the mouse up or down to the desired value.

4. Edit the remaining points that you desire to have changed and
when you are complete, press the Accept button or the Accept All
button to accept all edits. Thiswill copy the datafrom the
Estimate/Entry column into the Revised column and will be
ready to save to the HEC-DSSfile.

5. Attheend of all of your edits, pressthe Save [& or Save As [,
button or select that item from the File menu to store your changes
in the HEC-DSSfile.

3.6.4  Editing Data in the Table

Y ou can edit, add, and delete datain an irregular-interval time series table
but you cannot extend the table. Regular-interval values cannot be deleted
or added but you can change valuesto missing. To edit datawithin the
table:

1. Select the data set from the drop down box at the top of the screen
if it isnot selected already.

2. Select the row in the table that you want to edit at, or select the
location on the graph with the mouse after pressing the Select [ ]
tool.

3. Typeinthe new valuesin the Estimate/Entry column. To move
to the next row in the column, press the Tab key or use the up and
down arrows.
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4. Y ou can copy the original valueto the

5. When Compl ete' press the Accept Flgur6326 Shortcut Menu

Estimate/Entry column by selecting Tahle Fill
all data sets you want to change, right- Fill - Linear
clicking and selecting Fill - Linear, as .

shownin Figure 3.26. Youcanthen | Fill- Repeat
changeit by pressing the Estimate or Clear

Estimate All button.

button or the Accept All button to Table Fill
accept al edits. Thiswill copy the data from the Estimate/Entry
column into the Revised column and will be ready to saveto the
HEC-DSSfile.

6. At theend of all of your edits, press the Save [d or Save As [

button or select that item from the File menu to store your changes
in the HEC-DSSfile.

Y ou can repeat values or linearly interpolate between selected values or
delete values by using the shortcut shown in Figure 3.26.

To fill multiple valuesin the table:

1.

Select (highlight) the starting row of the data that you want to fill.
For linear and repeat fill, this marks the starting value to use,
which will not be changed. If the clear fill option is selected, this
isthefirst value to be cleared.

. Mark the ending row. Y ou can do this by holding down the left

mouse button and moving the mouse down the table, or by left-
clicking the mouse on the ending row while holding down the
Shift key.

. Right click the mouse button to bring up the popup window in

Figure 3.26 and then select either Fill — Linear, Fill — Repeat, or
Clear. For Linear, the values between the first and last point will
be linearly interpolated, with the first and last point remaining the
same. For Repeat, the first value will be repeated through the last
value. For Clear, al values within the selected rows will be set to
missing.

When compl ete, press the Accept button or the Accept All button
to accept all edits. Thiswill copy the datafrom the
Estimate/Entry column into the Revised column and will be
ready to save to the HEC-DSSfile.

At the end of all of your edits, press the Save [& or Save As [g
button or select that item from the File menu to store your changes
in the HEC-DSSfile.
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3.6.5 Printing the Table and Graph

Y ou can print the table or graph by using the Print Table or Print Graph
command under the Graphical Editor’s File menu.

The Print Table command opens the Properties dialog (Figure 3.27),
which offers options on three tabs.

Properties

Crrienkation

(®) Portrait A | () Landscape

Scaling

&l columns on one page
Selection
{(#) Entire Table () Selected Cells

Frint
A5 Fepeat Headers
aridlines

Print ] [ Zancel ]

Figure 3.27 Properties Dialog Box - Printing Tables

The Page tab allows you to specify the page Orientation, Scaling, and
Selection. You can also choose to print the table as ASCI |, Repeat
Headers on every page, and print the Gridlines.

On the Header /Footer tab, you can type in the header and footer you want
to appear on your printed pages.

The Table Titletab offers adefault title for the table based on the data
source, which you can change.

When you click Print, a standard Windows-style print dialog box opensto
select the printer and printer options.
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The Print Graph command opens a standard Windows-style print dialog
box to select the printer and printer options for printing the graph. The
printed graph will include the shaded hash area and the current selected
row line.

Y ou can set the page settings for the printed graph. To do this, click Page
Setup from the File menu.

From the File menu, click Page Setup. The Page Setup dialog will open
(Figure 3.28). Here you can set the page Orientation, Margins, Page
Numbers, and Printer Scale properties.

F .

Page Setup §|

Crrientation

(%) Portrait () Landscape () Reversed

Margins

Left: 1.0in Top: 1.010n -
Set Margins

Right: 1.0in  Bottom: 1.00n

Additional Options

[]Page Mumbers

Printer Scale

(%) Maximum Plotting Area

I oK ] [ Cancel

Figure 3.28 Page Setup Dialog Box

The Set M ar gins button opens the Printer Margins dialog (Figure 3.29).

Printer Margins

QK ] ’ Cancel

Figure 3.29 Printer Margins Dialog Box
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3.6.6  Graphical Editor View Options

From the View menu, you can choose to plot the other data sets that you
have selected on the same plot at the same time by clicking Show
Comparison Data. If the datatypes are the same, the data sets will plot
in the same viewport; otherwise they will be plotted in different viewports.

Y ou cannot edit the comparison data sets. To edit comparison data sets,
you must select adata set from the Selected Data Set list.

Y ou can also display a standard table of the selected data, from the View
menu, click Tabulate, or to display a standard plot from the View menu,
click Show Plot. You can set the precision of decimal places for your
data by pointing to Decimal Places and selecting the number of decimal
places you wish to display from thelist in the submenu.

3.7 Supplemental Information

To view supplemental information, from the DSSV ue main window, from
the Display menu, click Supplemental Information, the L ocation and
Supplemental Information dialog box will open (Figure 3.30).
Supplemental information for a pathname includes the following:

Location and Supplemental Information E|
Data Sek: IBALDESGLEIBEECH Hw FLONW-BASE/N1DEC1993) IHOUR CALIBRATED]
Type: 100: Reqular-inkeryal time series
Last Writken: 17 Jun 1998, 15:07:20 | By Program: HECHMS
Recard tag: T330 Version: 1
Precision: Regular Display Precision: Mok Specified
Compression: None Password Protectad:  |pg

Supplemental Info:

Coordinate System:  |pa coordinates set | Coordinate I0: o

Horizontal Crakurn: unsek + | Datum Units: Mot Specified w

* Coordinate: o| ¥ Coordinate: o

Tirme Zone 10 Time Zone Cffset: o
oK Cancel

Figure 3.30 Location and Supplemental |nformation Dialog Box
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Type: Thetype of the datain the data set, such as regular-interval
time series or paired data, etc. The number isthe HEC-DSS
internal number stored with the data.

Last Written: The date and time the latest data was written.

By Program: Displays the name of the program that last wrote this
data set.

Record tag: Tag ID used with legacy programs.
Version: The number of times this data set has been written to.

Precision: Indicates if this data set is single (4 bytes per value) or
double precision (8 bytes per value).

Display Precision: Precision used to view the datain tables. This
number is the number of digitsto the right of the
decimal place to show and is automatically set
when datais entered.

Compression: Displays the type of compression used if the data
record has been compressed.

Password Protected: Displays Yesif the datais password protected.

Supplemental Info: Meta-data set in the user header. Thiscan bea
variety of information, dependent on the
program that stored it. Often, dataisgivenina
key: parameter format.

Coordinate System: Coordinate system identifying the location.
Available coordinate systems include:
L at/long, State Plane FIPS, State Plane
ADS, UTM, or Local (other).

CoordinateID: The UTM zone number, or FIPS SPEC number or
ADS SPCS number.

Horizontal Datum: Horizontal datum can be either: unset, NADS83,
NAD27, WAS84, WAST72, or Local (other).

Datum Units: Units of the datum, including: Not Specified, English,
Sl, Decimal Degrees, or Degrees Minutes Seconds.
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X Coordinate: Longitude, Easting or decimal degrees (negative for
Western Hemisphere).

Y Coordinate: Latitude, Northing or decimal degrees
TimeZonelD: Time zoneidentifier for thislocation

Time Zone Offset: Offset from UTC, in milliseconds.
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CHAPTER 4

Utilities

With HEC-DSSV ue, you can rename, del ete, duplicate, and copy datain
HEC-DSSfiles. You can aso compare data sets and whole filesto
determine differences as well as search for values within files.

Other utilities include verifying the database integrity, "squeezing" a
database to remove unused space, and rebuild tables to make access more
efficient.

HEC-DSSV ue supports Jython (a Python derivative for Java) scripting to
aid in performing repeated tasks and accessing programming level
operations.

4.1 Renaming HEC-DSS Data in HEC-DSSVue
The Rename Recor ds command opens a pathname editor, which alows
you to change the common pathname parts of the selected records. To
rename HEC-DSS records:

1. Select the record or records to rename.

2. From the Edit menu, select Rename Records. The Rename
Recordsto: dialog will open, see Figure 4.1.

B Rename Records to: g|

Pathname: | /BALDEFLOW1HOURS™

A: B: BALDE C: |FLOWy
D: E: F. |*
[ (4 ] [ Cancel ]

Figure4.1 Rename Recordsto: Dialog Box

3. You may change one or more pathname parts or the entire record.
Type the new Pathname Partsintothe A:, B:, C:, D:, E:, and F:
boxes. Note: You cannot change the D or E partsfor time series
data (use Math Functions to accomplish this).
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4.2

4.3

4.

5.

For multiple records, pathname parts that are the same for all
records will show up inthe dialog. Where parts differ (such as
having pathnames with C parts of FLOW and ELEVATION), the
part will be displayed with an asterisk (*).

When you are finished changing the pathnames, click OK to close
the Rename Records to: dialog and save your changes.

Deleting Records

When you delete data from a HEC-DSSfile, the datais marked as missing
but it is not actually removed from the file until you run a Squeeze of the
file. You can recover deleted records with the Undelete command
described in the next section. Once afile has been squeezed, records
cannot be undeleted. To delete records from aHEC-DSSfile:

=

Select the record or records to delete.

From the Edit menu, select Delete Records. A dialog box will
confirm that you want to delete those records. If the number of
data setsisfour or less, their pathnames will be displayed in the
diaog.

Click OK. A confirmation message will appear, stating that the
records have been deleted.

Undoing Deletions

Deleted records may be recovered as long as the HEC-DSS file has not
been squeezed. When afileis squeezed, all deleted records are physicaly
removed.

Y ou can undel ete records in three ways: undelete all recordsin thefile,
select the records to undelete from alist, or undelete the records that you
just deleted.

To undelete records from aHEC-DSSfile:

1. From the Edit menu, point to Undelete.
2. Toundelete al records click All. A dialog box will appear to

confirm that you want to undelete all of the recordsin thefile.
Click OK. A confirmation message will appear that states the
records have been undel eted.

. To undelete the records that you have just deleted clickL ast

Deleted. A dialog box will confirm that you want to undel ete the
records that you just deleted. Click OK. A confirmation message
will appear that states the records have been undel eted.
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4. If you click Select, alist of the previously deleted pathnames will
open, as shown in Figure 4.2.

" | Undelete Records

Select Record

IGREEN RIVERANWALNUTIFLOW-RES OUTIOT MAY1 992 HOURCEBS!
IGREEMN RIVERAALNUTIFRECIP-IMCIO1APR1 9921 HOURIOBS!
IGREEN RIVERMAWALNUT/IPRECIP-IMCIO1 MAYT 9821 HOUIRIOBS!
IGREEMN RIVERMAALNUTISTORAGEDTAPRTS92M HOUROBSS
IGREEN RIVERAWALNUTISTORAGEDT MAY1 9921 HOURIOBS!

ity BASIN/DEER CREERISTAGE-FLOWIILISGSS

Ity BASINMRIVERSIDEFLOWIII APRT 990/ HOURIOBS!

ity BASINRNMERSIDEFLOWVIID MART 990 HOURIOBS!

P8, IV O Y ) ] ol O LR O IS O Y

| selectan || unselectan | [ ok || appiy || cancel |
Figure 4.2 Undelete Records Dialog Box

w

100 0|FR|E OO

5. Check the boxes next to the records that you want to undel ete, or
click Select All to undelete all recordsin thelist. Y ou can unselect
the checked records by clicking Unselect All. Once you have
made your selection, click OK to undelete those records and close
thedialog. Alternatively, you can click Apply to undelete the
records and leave the dialog box open. A confirmation message
will appear stating that the records have been undel eted.

4.4 Duplicating Records

The Duplicate command duplicates records in the same HEC-DSSfile,
giving the new records different pathnames. To duplicate records:

1. Select the record or records to duplicate.

2. From the Edit menu, click Duplicate Records. The New
pathname partsfor duplicate 5ecords dialog box will open,
Figure 4.3.

New pathname parts for, duplicate records: PX|

Pathname: |IIEIF-.LD ESFLOWIFT HOLIR™ |

A: | | B:|BALDE | Cr|FLow |
D | | E: | | F: |* |
[ K ] [ Zancel ]

Figure 4.3 New pathname parts for duplicate records: Dialog Box
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3. Typethe new Pathname Partsinto the A:, B:, C:, D:, E:, and F:
boxes. Y ou cannot change the D or E parts for time series data (use
Math Functions to accomplish this).

4. For multiple records, pathname parts that are the same for all
records will show up inthe dialog. Where parts differ (such as
having pathnames with C parts of FLOW and ELEVATION), the
part will be displayed with an asterisk (*).

5. When you are finished changing the pathnames, click OK to close
the New Pathname Partsfor Duplicate Records dialog and save
your changes. A confirmation message will appear stating that the
records have been duplicated.

4.5 Copying Records into Another HEC-DSS File

To copy records into another HEC-DSSfile:

1. Select the record or records to copy.
2. From the Edit menu, click Copy To. The Copy Recordsinto
HEC-DSS File browser will open, Figure 4.4.

Copy Records into HEC-DSS File X

Lockin: || DssFiles ¥ I 2 EE

) m BaldE agleHist.dss
’_J m DailyLocals.dss
m forecast,dss

Recent
m HaourlyTestData, dss

My Documents
=
58
My Compuker
:!} File name:
Ty Mebworlk,
Flaces Files of type: [ #* des v

Figure 4.4 Copy Recordsinto HEC-DSS File Browser

3. Inthe File name box, type in anew HEC-DSS filename or select
an existing HEC-DSS File you want to copy the record into and
click Open. A confirmation message will appear stating that the
record has been copied to the HEC-DSS file you selected.

4. If therecord(s) aready exist in that file, a message box will appear
asking if you want them to be overwritten, Figure 4.5 (page 4-5).
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HecDssVue P§|

Record(s) already exisk;
[GREEM RIVER /GLEMFIRFLOM (01 MAR 1992/ 1HOUR JCES
Cverwrite existing record(s)?

Mo | Cann:el|

Figure 4.5 Message Box - Overwriting Existing Records

If the number of pathnamesis four or less, their names will be
displayed in the message box; otherwise they will be printed in the
log screen.

4.6 Merging HEC-DSS Files

Merging copies all of the recordsin the currently opened HEC-DSSfile
into another. Thisissimilar to selecting al records then using the Copy
Recor ds option, but is much more efficient. However, this option will
overwrite any records with the same pathnames and will not splice
together time series records. To merge the current HEC-DSSfile into
another:

1. From the Edit menu, click Merge (copy). The Merge (copy all
records) into HEC-DSS File browser (Figure 4.6) will open.

Merge (copy all records) into HEC-DSS File
Look in: |lii'l DssFiles V| 2 ,?|E||E|

m BaldEagleHist. dss=
m DailyLocals,dss

m forecast,dss

m HourlyTestData.dss

I
L ¢
o
g I

N
—

[
m
un
=
(=]
-

\$

My Documents

@

=
=
n]
o
=

puker

o NEE:\IJDrk File marne: || | [ Opern ]

Places Files of type: | # 4oz w Cancel

Figure 4.6 Merge (copy al records) into HEC-DSS File Browser
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2. Inthe File Name box, select an existing HEC-DSS File into which
you want to copy al of the recordsinto and click Open. A
confirmation message will appear stating that the records have
been copied into the HEC-DSS file you sel ected.

4.7 Comparing Data Sets

If you have similar time series data sets, you can compare them and find
the differences. The Compare functions will tell you how many values are
different and highlight them in atable. You can set optionsin the
compare functions to allow atolerance between values or compare only
where there are valid values for the same times.

Y ou can compare data sets from the ri'e Wi

Compar e data sets menu option from Allows Editing
the Edit menu (Figure 4.7) of atable
dialog box. Also, from the DSSVue

and selecting on of the available options.

. . . 9 Copy Chrl4C
main window, by selecting the L L
pathnames for those data sets and from i conn |
the T ools menu, pointing to Compare Erd s ;

[ il

Compare data sets

To compare data sets from atable dialog Figure4.7 Edit Menu

box:

1. At least two pathnames must be selected for comparing data sets to
work. Select the records you would like to compare from the
Selected Pathnames List. Open atable dialog box, from the Edit
menu, click Compar e data sets.

2. A message box will open displaying the number of values that
differ in the selected data sets (Figure 4.8) and the differences
between the two data sets will be highlighted in red, as show in
Figure 4.9 (page 4-7).

Ll
\14) 11 values are different

Figure 4.8 Number of Different Values
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I/BEECH CREEK HW/FLOW/01SEP2001/1HOURIFocor [= |[8)X]

File Edit Wiew
BEECH CREEK HW | BEECH CREEK HW
Crdinate [ate Time FLCAY FLCAY
FOCO S0C0
134 26 Sep 2001 12:00 1,998.6 1,998.6 A
135 26 Sep 2001 13:00 2,375.9 2,375.9
136 26 Sep 2001 14:00 2,821.5 2,621.5
137 26 Sep 2001 15:00 3,304.1 3,304.1
138 26 Sep 2001 16:00 3,770.9 3,770.9
139 26 Sep 2001 17:00 4,243.0 4,103.6
140 26 Sep 2001 18:00 4,310.4 4,353.0
141 26 Sep 2001 19:00 4,377.8 4,557.5
142 26 Sep 2001 Z0:00 4,445,2 4,746.4
143 26 Sep 2001 21:00 4,485.6 4,892.6
144 26 Sep 2001 2200 4,477.9 4,942.2
145 26 Sep 2001 2300 4,470.1 4,869.3
146 26 Sep 2001 24:00 4,435.0 4,728.3
147 Z7 Sep 2001 01:00 4,348.5 4,567.3|
145 27 Sep 2001 0z:00 4,262.0 4,407.4
149 Z7 Sep 2001 03:00 4,175.5 4,253.0
150 Z7 Sep 2001 04:00 4,104.0 4,104.,0
151 Z7 Sep 2001 0500 3,960.3 3,960.3
152 27 Sep 2001 0&:00 3,821.8 3,821.8
153 Z7 Sep 2001 0700 3,688.1 3,688.1
154 27 Sep 2001 0g:00 3,559.3 3,559.3 2
— - —

Figure 4.9 Highlight of Differences Between Two Data Sets

To compare data sets from the DSSV ue main window:

1. At least two pathnames must be selected for comparing data sets to
work. Select the records you would like to compare from the
Selected Pathnames List. From the T ools menu, point to
Compare, click Data Sets, the Compar e Data Sets message box
will open (Figure 4.10).

Compare Data Sets

a9y 11 values are different
ol Showe complete bable with differences highlighted ar

show partial table with only the walues that are different?

)

£ Show Full Table

| [Shnw Only DiFFerences] [

Cancel

Figure 4.10 Compare Data Sets Message Box

2. Toview acomplete table of the data sets, click Show Full Table.
To view atable of only the values that differ, click Show Only
Differences, as shown in Figure 4.11 (page 4-8).
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H/BEECH CREEK HW/FLOW/01SEP2001/IR-MONT.... [= )[B1]X]

File Edit Wiew
BEECH CREEK HWw | BEECH CREEE HW
Ordinate Dake Time FLOW FLOWyY
FoZo S0C0
Units _F5 ZF5
Type INST-WAL IMNST-WAL
1 26 Sep 2001 17:00 4,243.0 4,103.6
z 26 Sep 2001 15:00 4,310.4 4,353.0
3 26 Sep 2001 19:00 4,377.8 4,557.5
4 26 Sep 2001 20:00 4,445,2 4,746.4
5 26 Sep 2001 21:00 4,455.6 4,892.6
-] 26 Sep 2001 22:00 4,477.9 4,942.,2
7 26 Sep 2001 23:00 4,470.1 4,869.3
g 26 Sep 2001 24:00 4,435.0 4,728.3
] 27 Sep 2001 a1:00 4,348.5 4,567.3
10 27 Sep 2001 0z:00 4,262.0 4,407 .4
11 27 Sep 2001 03:00 4,175.5 4,253.0

Figure4.11 Display Only the Differences in the Data Sets

Comparing data sets can be customized to include tolerance levels,
ignoring of missing data, and set to compare only values with matching
time steps. To use these options, you must compare data sets from the
DSSVue main window:

1. At least two pathnames must be selected for comparing data sets to
work. Select the records you would like to compare from the
Selected Pathnames List. From the Tools menu, point to
Compare, click Data Setswith Options, the Compar e Options
dialog box will open (Figure 4.12).

3

Compare Options

Ignore Missing Yalues

[] Caincident Times Only

Allowable Difference
G. Exack

® Percent Difference
L I:l Amount Difference

.

Figure 4.12 Compare Options Dialog Box

Cancel ]

2. Toignore al missing values during the compare, check Ignore
Missing Values. To only compare values at match time steps,
check Coincident Times Only.
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3. Inthe Allowable Differ ence area of the Compar e Options dialog,
you can change the allowabl e tolerance for the comparison. By
default the comparison uses no tolerance; the Exact option is
selected. Instead of using the exact value, you can choose to alow
a percent by selecting Per cent Differ ence and entering a percent
value from 0-100 in thefield. To set anumerical difference, select
Amount Difference and enter avauein thefield.

4. When you are finished selecting Compar e Options, click OK.

5. The Compar e Data Sets message box will appear displaying the
number of values that differ in the selected data sets (Figure 4.13).

Compare Data Sets E]
P 11 values are different
-l Showe complete bable with differences highlighted ar

show partial table with only the walues that are different?

ShowFul Table | [Shnw only DiFFerences] [ Cancel ]

Figure 4.13 Compare Data Sets Message Box

6. To view atable of only the values that differ, click Show Only
Differences. To view a complete table of the data sets, click Show
Full Table.

4.8 Comparing HEC-DSS Files

Two HEC-DSSfiles can be compared to determine the differences of
records contained in each file. Thisisuseful in determining if a new
version of a program gives the same answers as an older one. Individual
or groups of records within the HEC-DSS files can be compared to
determine the differences between their data. Options to compare are
found under the Compar e command.

To compare two HEC-DSS Files:

1. The current selected HEC-DSS file, displayed on the selected tab
and in the File Name field, will be compared to a selected HEC-
DSSfile you will choose using afile browser. From the Tools
menu, point to Compare, click Files, the Compareto HEC-DSS
File browser open.

2. The Compareto HEC-DSS File browser will appear. Usethefile
browser to select the comparison HEC-DSSfile. Once you have
selected afile, click Open.

3. A message box will display (see Figure 4.14, page 4-10) ,
summarizing the number of records contained in both of the HEC-
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There are 519 records in C;/Temp,/Forecast_b,dss that are not in Cf Temp)forecast_a.dss,
There are 229 records in common conkain the same data,
There are 3 records in commen that have different data.

9

i

[ Show Differences | l Cancel l

Figure 4.14 File Comparison Result Message Box

DSSfiles. Toview alist of the different records, click Show
Differences.

4. The Differences window will appear listing all the records that are
different between the two filesasin Figure 4.15.

Differences between C:fTempfforecast_a.dss and C:fTempfforecast_b. dss
Find

X

File

Records in C:/Temp/forecast b.dss that are not in C:/Temp/forecast_a.dss: -

FBALD
SBALD
SBALD
FBALD
SBALD
FBALD
FBALD
SBALD
FBALD
JBALD
SBALD
FBALD
SBALD
SBALD
FBALD
SBALD
FBALD
FBALD
/BALD
<

EAGLE
EAGLE
EAGLE
EAGLE
EAGLE
EAGLE
EAGLE
EAGLE
EAGLE
ELGLE
EAGLE
EAGLE
EAGLE
EAGLE
EAGLE
EAGLE
EAGLE
EAGLE
EAGLE

CREEE
CREEK
CREEK
CREEE
CREEK
CREEE
CREEE
CREEE
CREEE
CREEE
CREEE
CREEE
CREEK
CREEE
CREEE
CREEK
CREEE
CREEE
CREEE

LAEE
LAEE
LAFE
LAFE
LAEE
LAFE
LAFE
LAEE
LAFE
LAEE
LAEE
LAFE
LAEE
LAEE
LAFE
LAEE
LAFE
LAFE
LAEKE

LOCK
LOCK
LOCK
LOCK
LOCK
LOCK
LOCK
LOCK
LOCK
LOCK
LOCK
LOCK
LOCK
LOCK
LOCK
LOCK
LOCK
LOCK
LOCK

HaY//3TATION-ELEY//203EP2001
HAY//3TATION-ELEY//215EPZ001
Hav//STATION-ELEV//225EP2001
HAY//STATION-ELEY//233EP2001
HAY//3TATION-ELEY//245EPZ001
Hay//STATION-ELEV//255EP2001
HAY//STATION-ELEY//263EP2001
HAY//3TATION-ELEV//273EP2001
Hay//3TATION-ELEV//285EP2001
HAY//3TATION-ELEY//293EP200L
Hav//3TATION-ELEV//303EP2001

2300/30C0TO50/
Z300/30C0TO50/
2300/30C0T050/
2300/30C0TO50/
Z300/30C0TO50/
2300/30C0TOS0/
2300/30C0TO50/
2300/30C0T050/
2300/30C0TOS0/
2300/ 30C0T050,/
2300/30C0T050/

HAY//STATION-ELEY//PEAE_FLOWS /30COTOS0S

HAY//3TATION-FLOW/ /205EPZ00L
Havy//3TATION-FLOW//215EP2001
HAY//STATION-FLOW/ /223EP2001
HAY//3TATION-FLOW/ /235EPZ001
Hay//STATION-FLOW/ /245EP2001
HAY//STATION-FLOW/ /253EP200L
HAY//3TATION-FLOW/ /263EPZ001

Z300/30C0TO50/
2300/30C0T050/
2300/30C0TO50/
Z300/30C0TO50/
2300/30C0TOS0/
2300/30C0TO50/
2300/30C0T050/

>

Figure 4.15 Comparing Files - List of records that are different between files

5. The Compar e Records dialog box will open (Figure 4.16) that
lists records in common between the two files that contain different
values. If you want to set atolerance to compare values with,
press the Options button.

Compare Records
Select Recard

_f,rs.wERs POOLJELEY/01SEF2001 [ 1HOUR/S0COTO]

1 ISAYERS-POOLFLOW-0LT/01SEP2001/ HOURS0C0TO)
D 1 ISAVERS-POOLSTOR/01SEP2001 ) 1HOUR/SOCOTO]
’ Select Al " Unselect: All ” Options ] [ Compare Records i ’ Cancel l
Figure 4.16 Compare Record Dialog Box
6. The Compare Optionsdialog box (see Figure 4.17, page 4-11)

allows you to set options to compare values by ignoring missing
values (where both values are non-missing) for the same times,
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Compare Options

[] Ignore Missing Yalues

[] oincident Times Cnly

Bllowable Difference
@. Exack

O I:I Percent Difference
O I:I Amount Difference

L I

Cancel

Figure 4.17 Compare Options Dialog Box

compare values for coincident times only (where there are valid

valuesin both data sets at the same time), and set a tolerance to

compare between numbers. For the tolerance, you can set a
percent amount that values can differ by or an absolute value that

they can differ.

7. When you select the records that you want to compare and press
the Compar e Recor ds button, a table showing the differences for

each pair will be displayed. Valuesthat are different are

highlighted in red for the file that you are comparing to, as shown

in Figure 4.18.

C:fMempfforecast_a.dss verses C:fTemp/fforecast_b. dss

EEX

Figure 4.18 Comparison of Data Sets

File Edit View
SAYERS-POOL SAYERS-POOL
Crdinate Date [ Time ELEY ELEY
S0C0TO S0C0TO
Type TNST-YAL 25
1 20 5ep 2001, 23:00 630,66 630,66
2 20 Sep 2001, 24:00 630.66 630,66 —
3 21 Sep 2001, 01:00 630.66 630,66
4 21 Sep 2001, 02:00 630,66 630,66
5 21 Sep 2001, 03:00 630,66 630,66
=} 21 Sep 2001, 04:00 630,66 630,66
7 21 Sep 2001, 05:00 630,67 530,67
=3 21 Sep 2001, 06:00 630,67 530,67
el 21 Sep 2001, 07:00 630,66 £30.66
10 21 Sep 2001, 05:00 756.80 63067
11 21 Sep 2001, 09:00 756.80 63067
12 21 Sep 2001, 10:00 756,83 630.69
13 21 Sep 2001, 11:00 756,80 630.67
14 21 Sep 2001, 12:00 756,80 630.67
15 21 Sep 2001, 13:00 756,82 630.68
15 21 Sep 2001, 14:00 756,82 630.68
17 21 Sep 2001, 15:00 756.80 630.67
15 21 Sep 2001, 16:00 756.80 630.67
19 21 Sep 2001, 17:00 756.80 630.67
20 21 Sep 2001, 15:00 756.80 630.67 3z
e i —
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4.9 Searching for a Value

Y ou can search for avaluein time series and paired data sets. Y ou can set
atolerance to search within or you can search for values less than or
greater than a specified number.

Y ou can tabulate the records that match your specifications. Those values
will be highlighted inred. To search for avalue:

1. Select the data sets that you want to search. From the T ools menu,
click Search for Value, the Enter Valueto Search for dialog box
will open (Figure 4.19).

Enter, Value to Search for g|
Search For: 20| Within + - :
() Equal

() Less Than
(") Greater than or Equal ta

(") Less than or Equal ta

[ o] 4 ] [ Cancel ]

Figure 4.19 Enter Value to Search for Dialog Box

2. From the Enter Valueto Search for dialog, enter the value you
would like to find in the Search for box. If you would liketo
search within atolerance for this value, enter the range in the
Within +- box.

3. By default, the search is set to find the exact value, give or take the
Within value. However, you can choose to search for values
Greater Than, Less Than, Greater than or Equal to, or Less
than or Equal to the

Search for value. Found Values E3
4. Once you are finished P 2 data sets found with walue(s) greater than 20
selecting your search <
criteria, click OK. HaREMAIFLOW015SEP2001) 1HOUR fOBS)
5. The Found Values JTHOUSE Hi{FLOW01SER2001 IHOUROES]
message t:)OX will Tabulate data?
appear (Figure 4.20) _ .
listing all selected data oves J[ w
sets that meet your _
search criteria. Figure 4.20 Found Values Message Box
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6. To tabulate the search findings, click Y es on the Found Values
window. A tablewill display listing all values that meet the search
criteriain red, see Figure 4.21 below.

HAXEMA/FLOW/01SEP2001/1HOUR/0BS/ [ |[B][X)
File Edit iew

Crdinate Dake [ Time

24 Sep 2001, 15:00
24 Sep 2001, 16:00
24 Sep 2001, 17:00
24 Sep 2001, 15:00
24 Sep 2001, 19:00
24 Sep 2001, 20:00
24 Sep 2001, 21:00
24 Sep 2001, 22:00
24 Sep 2001, 23:00
24 Sep 2001, 24:00
25 Sep 2001, 01:00
25 Sep 2001, 02:00
25 Sep 2001, 03:00
25 Sep 2001, 04:00
25 Sep 2001, 05:00
25 Sep 2001, 06:00
25 Sep 2001, 07:00
25 Sep 2001, 03:00
25 Sep 2001, 09:00
25 Sep 2001, 10:00
25 Sep 2001, 11:00

Figure 4.21 Found Valuesfrom Search

4.10 Checking File Integrity

Y ou can check to see if a database has been damaged. Generally, thisis
rare but occasionally afile can be damaged from disk problems, errant
programs lost file links or other situations. Checking file integrity is
similar to a"Check Disk" in Microsoft Windows.

In addition to checking for damage, checking file integrity will tell you if
you can improve efficiency by squeezing the database. However, itis
usually faster just to squeeze the database than to check for it.

Checking file integrity is a thorough and comprehensive process, so it will
take time.
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To check the integrity of an HEC-DSSfile:

1. Open an HEC-DSSfile, from the T ools menu, click Check File
Integrity.

2. For larger files, the Database Integrity Check dialog box (Figure
4.22) will open providing the status of the operation. There are
four major stepsin the operation. Y ou can cancel at anytime
without hurting anything. Generally, the process goes faster once
the first step has been completed.

Database Integrity Check El

File: C/BigDss/nnn. dss

Proecss:  Step 2 of 4, Verifying Records
Status: 9154 of 10000

Tirne Left:  00:00:00 Task Tirne: 00:00:01
Total Time: 00:00:01

Bt Creerall ]

| Skip Task |[ Cancel ]

Figure 4.22 Database Integrity Check Dialog Box

3. A status report message window will open (Figure 4.23) after the
integrity check has finished. To view the integrity report, click
View Log.

y Dakabase integrity check completed.

Mo errors detected,

| ok || Viewiog |

Figure 4.23 Status Report Message Window

4. If any errorsin the database are detected, a message window
saying so will be displayed (see Figure 4.24, page 4-15). Dueto
the comprehensive nature of the check, an error is usually reported
for severa processes within the check, so the total number of
errors reported can be substantially more than there really are.

If an error is detected, it is recommended that you make a backup
of your file and then squeeze the file. Squeezing rebuildsthefile,
using a brute force approach that should retrieve al data possible
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HEC-DSSVue X

Database inteqgrity check completed.,
. 17 errors detected,

Sgueeeze file ko repair errors?

| Squeeze | [ Cancel ]

Figure 4.24 Error from Database I ntegrity Check

within thefile. You should review any critical data after you have
sgueezed it, as the same event that broke links within the file may
have changed data values a so.

5. If you have alot of unused space due to deletions or other actions
or the internal tables are not suited well to the number of data sets,
amessage will be displayed saying so. (Figure 4.25) Itis
recommended that you squeeze the file to remove unused space
and rebuild the internal tables.

HEC-DSSVue X

i Database inteqgrity check completed.
\2 Mo errors detected,
However, file efficiency can be improved by squeezing.
Inactive space: 37% = 25%
Squeeze?

[ Squeeze | ['-.-'iew Lu:ug] [ Cancel ]

Figure 4.25 Status Report Message After Data Sets are Deleted

4.11 Squeezing an HEC-DSS File

When you delete or rename records, a HEC-DSS file will accumulate
inactive space. The Squeeze command removes inactive space by
copying all valid datato a new file then renaming the new file to the old
filename. The Squeeze command will also automatically re-adjust
internal HEC-DSS table sizes to optimize accessto thedata. Thisis
similar to de-fragmenting your file system. Once a squeeze has been
accomplished, deleted data cannot be recovered.

To squeeze an HEC-DSSfile:

1. Open an HEC-DSSfile, from the Tools menu, click Squeeze. A
window will appear indicating the status of the squeeze process.

2. If you wish, you may cancel the squeeze prior to completion, by
clicking Cancdl.
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4.12

3. When the process is complete, a confirmation will appear (Figure
4.26).

\14) D135 File : DssFiles/BaldEagleHist . dss squeezed.

Figure 4.26 Squeeze Confirmation Window

Scripting

Y ou can use Jython scripts that you or others write to perform math
functions, create custom plots or tables, and automate repetitive tasks. To
edit, test, and select scripts, use the Script Editor (Figure 4.27). To
access the Script Editor, from the Tools menu, click Script Editor.

Script Browser EJ@I g|

File Edit Options

'Aéj SE;"::S Dest || Label: [poT 1§ [ Display Seript on Toolbar
-{5) HecDssYue

- 8] ABS 3CAPE: | C: {HecDSSYueDev /HecDssVue scripts/DDT. py E]

- [a8] ACC

- (8] AMERG Icon: | -Mone- % | Test Arguments:

8] CMA

(3] CONIC Description:

- 8] CORR

[ COUNT These sample methods are designed to demonstrate the use of some of the HEC methods and classes

- [a8] DECP&R.

.. [a8] DIFF

- 48] EXTLIN From hec.script impart * A

- |an] EXTPPT from hec.hecmath import *

. [a] FMA from hec.dssgui import ListSelection

. [an] GEMTSR from hec.io import TimeSeriesContainer

.l GENTSR2 From java,awt impart *

- 8] LAST_INT_LOG_LOG1D from java.aut.event import. *

From java.util impart *
- (] MATE import javax.swing as sshwing
- [38] MAK_MIN_MEAN impart os, sys, shutil, traceback, types, string, time, StringIO, stat, rma, hec, java, javax, jxl, mat
- 8] MER(G
- ] MRGPZ baseDirectory = "%PATHTODSSFILE%: \examples\DSsFilesimastdb, dss"
o [a] MUSK message = sshwing, ITextareal"Dss file name is: ",1,45)
[ MINT message, setBackground(sshwing, JPanel), getBackground())

[ OLY message, setEditable()

- 8] PERCON_POLY def TDDT( :
- 3] PERCON_POLYZ w
- ] PLILS The Following exarmple uses the DOT Function to convert storage into change in storag
- ] RTABLZ The macro in kotal converts pool elevation to storage, taillwater stage to outflow, and
.. ] RTABLE_RTAELR 2

[ SCRN1_SCRMZ #
b < >
S crcu cwcu
[ Edit ] [ Save and Test ] [ Save
ScriptsfHecDssYue/DDT Modified 1:1 Insert

Figure 4.27 Script Editor

To run scripts that have already been setup, use the Script Selector dialog
box (Figure 4.28). To access the Script Selector dialog box, from the
Tools menu, click Script Selector. For more information, refer to the
chapter on Scripting.
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4.13

HecDssVue Scripts D@@

Scripk

Figure 4.28 Script Selector Dialog Box

Catalogs

Thelist of pathnames on the main screen is amodified version of the
HEC-DSS Catalog. A catalog is essentialy alist of record pathnamesin a
DSSfile, organized in one of several ways. Because acatalog is separate
and not really part of the DSSfile, it only reflects the state of the DSSfile
the last time it was updated. Whenever you add a new record to the
database, the catalog becomes out of date; the catalog is not updated as it
would be prohibitively slow.

The new version of HEC-DSSV ue retrieves an interna listing of
pathnames to show in the main window. However, sinceit takestimeto
sort and order them, a cache disk fileis usually saved, and only updated
when it is detected to be out of date. For larger DSS files, HEC-DSSVue
will ask the user if they want to spend the time to have it updated when it
becomes out of date.

This section covers the three primary forms of catalogs that can be stored
on disk and viewed or printed. A full catalog isalisting of al record
pathnames in the file, along with their last written date and time, their
version, the number of data they contain and the type of datait contains.
An abbreviated catalog contains just the record pathnames and a
condensed catalog groups dates for time series data and just shows a date
gpan for the date part of atime series data set.
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4.13.1 Condensed Disk Catalog

A condensed catalog isalist of pathnames where the dates of time series
data are grouped together and show a date span instead of a date D part for
each record.

To create a condensed catal og:

1. Open an HEC-DSSfile, from the Advanced menu, point to
Condensed Disk Catalog, click New.

2. A message box will appear stating the catalog has been updated
and the number of recordsit contained (Figure 4.29).

Zatalog file updated,
255 records cataloged,

Y

Figure 4.29 Catalog File Update Message Box
To view a condensed disk catalog:

1. Open an HEC-DSSfile, from the Advanced menu, point to
Condensed Disk Catalog, click View.

2. A text dialog box will open (Figure 4.30) displaying the condensed
disk catalog.

EC:!TempISample.dsd &|
File  Find
| -
HECDSS Condensed Catalog of Record Pathnawes in File C:/Tewp/Sawple.dss
Catalog Created on May 3, 2009 at 14:53 File Created on Now &, 2007
Muwher of Records: 151 D33 Wersion 6-0C, File 6-0E
Sort Order: ABCFED
Tag 4 Part E Part C Part F Part E Part I Part
PAR-FLOW COLORADO RIVER PARFER DAM, AZ-C4 FLOW USGS 1D&T O1JAN1997 - 0LJANZ006
GLE-FLOW GREEN RIVER GLENFIE FLOW EDIT LHOUE. OLAPR1S9E - OIMAT1S9Z
GLE-FLOW - - - - - - - - - = - - = - - - - - - - - - 0ES LHOUE. OLAPR1S9E - OIMAT1S9Z
GLE-FREC - - - - - - - - - - - - - - - - PRECIP-INC 0ES LHOUE. OLAPRIS9E - OLJUN1SS9Z
0AE-ELEV - - - - - - - - OAFVILLE ELEVATION 0ES LHOUE. OIMAY1992
OAE-ELEV - - - - - - = = - = - - = - - - - - - - - - Z LHOUE. OIMAY1992
OAE-ELEV - - - - - - = = - = - - = - - - - - - - - - ZZ LHOUE. OIMAY1992
OAE-FLOW - - - - - - - - - - - - - - - - FLOW-RE3 0UT OB3 LHOUE. OIMAY1992
OAE-PREC - - - - - - - - - - - - - - - - PRECIP-INC 0ES LHOUE. OIMAY1992
OAE-3TAG - - - - - - - - - - - - - - - - STAGE-0UT 0ES LHOUE. OIMAY1992
WAL-FLOW - - - - - - - - WALNTT FLOW-RE3 0UT OB3 LHOUE. OLAPR1S9E - OIMAT1S9Z
WAL-PREC - - - - - - - - = - - - - - - - PRECIP-INC 0ES LHOUE. OLAPR1S9E - OIMAT1S9Z
WAL-3TOR - - - - - - = = = - = - - - - - STORAGE 0ES IE-MONTH O0lAPR1992 - O1MAY1992
WAL-3TOR - - - - - - = = = - = - - - - - - - - - - - - - - LHOUE. OLAPR1S9E - OIMAT1S9Z
5T.-FLOW MISSISSIPPI RIVER 5T. LOUIS, MO FLOW USGS 1D&T O1JAN1900 - 0LJANZ006
DEER-ET MY BASIN DEER. CREEE STAGE-FLOW USGS (mall) (nall)
RIV-FLOW - - - - - - - - RIVERZILDE FLOW 0ES LHOUE. OIMAR1S90 - OLMAT1S990
RIV-PREC - - - - - - - - - - - - - - - - PRECIP-INC 0ES LHOUE. OIMAR1S90 - OLMAT1S990
RIV-5TAG - - - - - - - - - - - - - - - - STAGE 0ES LHOUE. OIMAR1S90 - OLMAT1S990
RIV-TEMP - - - - - - - - - - - - - - - - TEMP-ATE. 0ES LHOUE. OIMAR1S90 - OLMAT1S990
<

Figure 4.30 Condensed Catalog Text Output
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3. You can print the catalog from the text dialog, from File menu,
click Print.

4. From the text dialog, you can perform several file management
functions. Insert .txt, Save As.txt, change the Font, and Print
Setup. It aso contains a Find menu that can facilitate a search of
the catal og displayed.

To print acondensed disk catalog:

1. Open an HEC-DSSfile, from the Advanced menu, point to
Condensed Disk Catalog, click Print.

2. A Print dialog box will open (Figure 4.31); click OK to send the
catalog to the printer.

B print @El

Printer

(VPO FISIONSHF Laserlet P3005 PCL 5z RS
Status: Ready

Type: HF Lazerlet P3005 PCL e
Wherer  216.100.254.211_5

Cammet: [ Frint ta file
Frint range Copigs
& al Murnber of copies: 1 i
L
[ O, ] [ Cancel

Figure 4.31 Print Dialog Box

4.13.2 Abbreviated Disk Catalog

An abbreviated catalog is a sorted list of record pathnamesin aHEC-DSS
file.

To create an abbreviated catal og:

1. Open an HEC-DSSfile, from the Advanced menu, point to
Abbreviated Disk Catalog, click New.

2. A message box will appear stating the catalog has been updated
and the number of records it contained (see Figure 4.29, page
4-18).

To view an abbreviated catalog:
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1. Open an HEC-DSSfile, from the Advanced menu, point to
Abbreviated Disk Catalog, click View.

2. A text dialog box will open (Figure 4.32) displaying the
abbreviated disk catalog.

EC:J’TeranSample.dsc @

File  Find
| ~
HECDS3 Complete Catalog of Record Pathnames in File C:/Tewp/Sanple.dss

Catalog Created on May 3, 2009 at 14:53 File Created on Now &, 2007
Mumber of Records: 151 D35 Version 6-QC, File 6-0K
Sort Order: ABCFED

Ref.
Nunber Tag Record Pathname

PAR-FLOW /COLORADD RIVER/FPARKER DAM, AZ-CA/SFLOW/O0LTAN1S37/1DAY/TSGES
PAR-FLOW /COLORADD RIVER/PARKER DAM, AZ-CA/SFLOW/O0LTANLS9SG/1DAY/TSGES
PAR-FLOW /COLORADD RIVER/PARKEER DAM, AZ-CA/FLOW/01TAN1939/1DAY/USGE/
PAR-FLOW /COLORADD RIVER/PARKEER DAM, AZ-CA/FLOW/01LTANZOOO/1DAY/USGE/
PAR-FLOW /COLORADD RIVER/PARKEER DAM, AZ-CA/FLOW/01LTANZOOL/1DAY/USGE/
PAR-FLOW /COLORADD RIVER/PARKEER DAM, AZ-CA/FLOW/01LTANZOOZ/1DAY/USGE/
PAR-FLOW /COLORADD RIVER/PARKER DAM, AZ-CA/FLOW/01LJANZOO3/1DAY/USGE/
PAR-FLOW /COLORADD RIVER/PARFER DAM, AZ-CA/FLOW/0LJANZOO4/1DAY/TUSGE/S
PAR-FLOW /COLORADD RIVER/PARKER DAM, AZ-CA/SFLOW/0LTANZOOS/1DAY/TSGSES
10 PAR-FLOW FCOLORADO RIVER/PARFEER DAM, AZ-CA/FLOW/DLJANZOOG/1DAY/UIGE/
11 GLE-FLOW /GREEN RIVER/GLENFIR/FLOW/01APR1S99Z/1HOUR/EDIT/

12 GLE-FLOW /GREEN RIVER/GLENFIR/FLOW/01MAY199Z/1HOUR/EDIT/

13 GLE-FLOW /GREEN RIVER/GLENFIR/FLOW/01APR1592/1HOUR/0BS/

14 GLE-FLOW /GREEN RIVER/GLENFIR/FLOW/01MAY1S92/1HOUR/OBS/

15 GLE-PREC /GREEN RIVER/GLENFIR/PRECIP-INC/0LAPR1992/1HOUR/OBESS

16 GLE-PREC /GREEN RIVER/GLENFIR/FRECIP-INC/0LMAYT1992/1HOUR/OESS

17 GLE-PEEC /GREEN RIVER/GLENFIR/PRECIP-INC/0LJUN1%9&/1HOUR/OESS

15 O0AE-ELEV /GREEN RIVER/0AKVILLE/ELEVATION/0LMAY199Z/1HOUR/0BS/

19 O0AE-ELEV /GREEN RIVER/0AKVILLE/ELEVATION/0LMAY199Z/1HOUR/Z/

20 O0AE-ELEV /GREEN RIVER/0AKVILLE/ELEVATION/O0LMAY199Z/1HOUR/ZZ/ v

< 4

Figure 4.32 Abbreviated Catalog Text Output

[F= T R O R, I SRV N ]

3. You can print the catalog from the text dialog, from File menu,
click Print.

4. From the text dialog, you can perform several file management
functions. Insert .txt, Save As.txt, change the Font, and Print
Setup. It aso contains a Find menu that can facilitate a search of
the catalog displayed.

To print an abbreviated catal og:
1. Open an HEC-DSSfile, from the Advanced menu, point to
Abbreviated Disk Catalog, click Print.

2. A Print dialog box will open (see Figure 4.31, page 4-19); click
OK to send the catalog to the printer.

4.13.3 Full Disk Catalog

A Full Catalog isalisting of al record pathnames in thefile, along with
thelir last written date and time, their version, the number of data they
contain and the type of datait contains.

To create afull catalog:
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1. Open an HEC-DSSfile, from the Advanced menu, point to Full
Disk Catalog, click New.

2. A message box will appear stating the catalog has been updated
and the number of records it contained (see Figure 4.29, page
4-18).

To view afull catalog:

1. Open an HEC-DSSfile, from the Advanced menu, point to Full
Disk Catalog, click View.

2. A text dialog box will open (Figure 4.33) displaying the full disk
catal og.

EC:ITEmpISample.dsc @

File Find

| A
HECDH% Complete Catalog of Record Pathnames in File C:/Tewp/Sample.dss
Catalog Created on May 3, 2009 at 14:54 File Created on Nov &, 2007
Munber of Records: 151 D55 Version £-0QC, File &-0OK
Sort Order: ABCFED

Ref. Last Written

MNumber  Tag Program Date Time Type Vers Data Record Pathname
1 PAR-FLOU Dss¥ue 2G0CTO7 21:12 RTS & 365  /COLORADD RIVER/PARKER DAM, AZ-CA/FLOW/01JAN1997/1DAT/USGS/
2 PAR-FLOW DssWue 230CTO7 21:12 RTS 5 365 /COLORADO RIVER/PARKER DAM, AZ-CA/FLOW/01JAN1385/1DAY/USGS/
3 PAR-FLOW DssWue 230CTO7 21:12 RTH 5 365 /COLORADO RIVER/PARKER DAM, AZ-CA/FLOW/OlJANLD999/LDAY/USGE/
4 PAR-FLOU Dss¥ue 230CTO7 21:12 RTS 5 366  /COLORADD RIVER/PARKER D&M, AZ-CA/FLOW/0LJANZO00,1DAT/USGS/
5 PAR-FLOW DssWue 230CTO7 21:12 RTS 5 365 /COLORADO RIVER/PARKER DAM, AZ-CA/FLOW/01JAN2001/1DAY/USGS/
& PAR-FLOW DsgsWue 230CTO7 21:12 RTH 5 365 /COLORADO RIVER/PARKER DAM, AZ-CA/FLOW/O0lJANZOOZ/LDAY/USGH/
7 PAR-FLOU Dss¥ue 230CTO7 21:12 RTS 5 365  /COLORADD RIVER/PARKER DAM, AZ-CA/FLOW/0LJANZO03/1DAT/USGS/
& PAR-FLOW DssWue 230CTO7 21:12 RTS 5 366 /COLORADO RIVER/PARKER DAM, AZ-CA/FLOW/01JAN2004/1DAY/USGS/
9 PAR-FLOW DsgsWue 230CTO7 21:12 RTH 5 365 /COLORADO RIVER/PARKER DAM, AZ-CA/FLOW/O0lJANZOOS/LDAY/USGH/
10 PAR-FLOW Dss¥ue 230CTO7 21:12 RTS 5 365  /COLORADO RIVER/PARKER DAM, AZ-CA/FLOW/0LJANZO06/1DAY/USGS/
11 GLE-FLOW DssWue 230CT07 Zl:12 FRTH 5 720 /GREEN RIVER/GLENFIR/FLOW/0LAPRL382/1HOUR/EDIT/
12 GLE-FLOW DssWue 230CTO07 Zl:12 RTH 5 744  /GREEN RIVER/GLENFIR/FLOW/01MAY1992/1HOUR/EDIT/
13 GLE-FLOW DssWue 230CT07 2Z1:12 RT3 8 720 /GREEN RIVER/GLENFIR/FLOU/01APR1992/1HOUR/OBS/
14 GLE-FLOW DssWue 230CT07 Zl:12 RT3 9 744  /GREEN RIVER/GLENFIR/FLOW/01MAY¥1352/1HOUR/OBS/
15 GLE-PREC DssWue 230CTO07 Zl:12 RTH 5 720 /GREEN RIVER/GLENFIR/PRECIP-INC/0lAPR1992/1HOUR/OBS/
16 GLE-PREC DssWue 230CT07 zZ1:12 RT3 7 744  /GREEN RIVER/GLENFIR/PRECIP-TINC/01MAY¥1932/1HOUR/0BS/
17 GLE-PREC DssWue 230CT07 Zl:12 RT3 4 720 /GREEN RIVER/GLENFIR/PRECIP-INC/01JUN1952/1HOUR/OBS/
18 OARK-ELEV DssWue 230CTO07 Zl:12 RT3 7 744  /GREEN RIVER/OAKVILLE/ELEVATION/OLMAY¥1992Z/1HOUR/OES/
19 O0ARE-ELEV DssWue 230CT07 2Z1:12 RT3 6 744  /GREEN RIVER/OAKVILLE/ELEVATION/01MAY1932/1HOUR/Z/
20 OAK-ELEV DssWue 240CT07 06:42 RT3 4 744  /GREEN RIVER/OAKVILLE/ELEVATION/O0LMAY1952/1HOUR/ZZ/
21 DAE-FLOW DssVue 240CTO7 06:42 RTS 4 744  /GREEN RIVER/DARVILLE/FLOW-RES OUT/01MAY1992/1HOUR/OBS/
22 OME-PREC DssWue 240CT07 06:42 RT3 4 744  /GREEN RIVER/OAKVILLE/PRECIP-INC/0IMAY1992/1HOUR/OBS/ v

< >

Figure 4.33 Full Disk Catalog Text Output

3. You can print the catalog from the text dialog, from File menu,
click Print.

4. From the text dialog, you can perform several file management
functions. Insert .txt, Save As.txt, change the Font, and Print
Setup. It aso contains a Find menu that can facilitate a search of
the catalog displayed.

To print an abbreviated catal og:
1. Open an HEC-DSSfile, from the Advanced menu, point to Full
Disk Catalog, click Print.

2. A Print dialog box will open (see Figure 4.31, page 4-19); click
OK to send the catalog to the printer.

4.14 Viewing the Console Output

Asthe HEC-DSSV ue application is running, it generates application
runtime and DSS file output. To view the output for the current instance of
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the HEC-DSSV ue application, from the Advanced menu, click Console
Output. The Console Output dialog box will open (Figure 4.34).

Console Output B .

File Search Format

Filename: C:%DOCUME~1% SRLARS~1.RMAYLOCALS~1Y Tenph HEC-D3SVue’ Console. log

Wersion stampis 2,0.0,1813C date 2009.04,07.01,20 A
05 Mame is Windows kP

HEC-DSSWue: Yersion 2.0.07, March 2009

Library build: 2,0,0,1813C Build date:  2009.04.07.01,20

Java Version is 1.6,0_12

Mo D55 File given

Debug off; no logging properties file: 1:\HecDS5Yueley configipropertiesflogger . properties

loadPluglns:loaking Far Manifest entries starking with HecDss\uePlugin

loadPluglns: found jar PluginsVCDEC. jar

Main Class = hec,dssgui.plugins . cdec, CdecControlPlugin

loadClass: Found main method public static void hec,dssgui. plugins .. cdec, CdecControlPlugin, maindjava. lang. Object[])
loadPluglns: Found jar PluginshChartPlugin, jar

Main Class = hec.dssgui.plugins. chart, ChartPlugin

loadClass: Faund main method public static void hec.dssgui. plugins.chart, ChartPlugin maindjava.lang. Object[ 1)
loadPluglns: found jar PluginshCROMNOS, jar

Main Class = nc.denr, dwr, cronos, CronosControlPlugin

loadClass: Found main method public static void nc,denr.dwr.cronos, CronosControlPlugin.main{java.lang. Object[T)
loadPluglns: Found jar Plugins\Dssutlimport. jar

Main Class = hec,dssgui.plugins, DssutlImportPlugin

loadClass;: Found main method public static void hec,dssgui. plugins . DssutlimportPlugin, maindjava.lang, Object[T) b
<

Figure 4.34 Console Output Dialog Box

4.15 Viewing HEC-DSS File Output

To view the output generated by HEC-DSS file interaction, from the
Advanced menu, click DSS Output. A basic text dialog box will open
(Figure 4.35) displaying application process information on the DSSfile.

\DOCUME-~1\SRLARS ~1.RMAM OCALS~ 13\ TempAHEC-DS5Vue\HEC-DSS. log
File  Find

————— D33---Z0PEN: Existing File Opened, File: C:/DssFiles/BaldEagleHist.dss R
Tnit: 71:; D33 Versions - Software: 6-0QC, File: 6-QA
————— D35---Z0PEN: Existing File Opened, File: C:/DssFiles/forecast.dss
Tnit: 72: D53 Versions - Software: 6-0QC, File: 6-EE

————— D&%--- Parameters Set for Existing File Ignored

ZREAD Unit 7l; Vers. Z:  //BALDE /FLOW/01NOW1993/1HOUR/CALTERATED /
-----D&8%--- EREAD TUnit T2 WVers. //BALDE /FLOW/01NOV1995 / 1HOUR /CALIERATED /
-----D&8%--- EREAD TUnit 7l; Vers. J/SPRCE JCT/FLOW/01DEC1S93/ 1HOUR /CALTERATED /
-----D&8%--- EREAD TUnit T2 WVers. J/SPRCE JCT/FLOW/01DEC1S93/ 1HOUR /CALTERATED /
-----D&8%--- EREAD TUnit 7l; Vers. J/SPRCE JCT/FLOW/01NOV1993/ 1HOUR /CALTERATED /
ZREAD Unit T2 WVers. J/SPRCE JCT/FLOW/01NOV1993/ 1HOUR /CALTERATED /
ZREAD Unit 7l; Vers. //BALDE /FLOW/01DECL1995 / 1HOUR /CALIERATED /
IREAD Tnit  72: Wers. #/BALDE /FLOW/01DECLI993 /1HOUR /CALIBRATED /
ZREAD Unit 7l; Vers. //BALDE /FLOW-BASE /01DEC1993 / 1HOUR /CALIERATED /
ZREAD Unit T2 WVers. //BALDE /FLOW-BASE /01DEC1993 / 1HOUR /CALIERATED /
ZREAD Tmit  71; Wers. //3PRCE/FLOW/01DECLS93 / 1HOUR,/CALIERATED /
-----D&8%--- EREAD TUnit T2 WVers. A /ASPRCE/FLOW/0O1DECL995 / 1HOUR /CALIERATED /
-----D&8%--- EREAD TUnit 7l; Vers. A /ASPRCE/FLOW/01INOV1995 / 1HOUR /CALIERATED /
-----D&8%--- EREAD TUnit T2 WVers. A /ASPRCE/FLOW/01INOV1995 / 1HOUR /CALIERATED /
-----D&8%--- EREAD TUnit 7l; Vers. A/ SPRCR/FLOW-BASE /O0LDEC1993 / 1HOUR /CALIERATED /
-----D&8%--- EREAD TUnit T2 WVers. A/ SPRCR/FLOW-BASE /O0LDEC1993 / 1HOUR /CALIERATED /
-----D&8%--- EREAD TUnit 7l; Vers. A/ SPRCE/FLOW-BASE /OLNOV1993 / 1HOUR /CALIERATED /
-----D&8%--- EREAD TUnit T2 WVers. A/ SPRCE/FLOW-BASE /OLNOV1993 / 1HOUR /CALIERATED /
ZREAD Unit 7l; Vers. S /SPRCR/PRECIP-EXCESS/01DECL 995/ 1HOUR,/ CALIERATED /
ZREAD Unit T2 WVers. S /SPRCR/PRECIP-EXCESS/01DECL 995/ 1HOUR,/ CALIERATED /
ZREAD Tnit  71: Wers. #/SPRCE/PRECIP-EXCESS/01NOV1993/ 1HOUR CALIBRATED /
ZREAD Unit T2 WVers. A /ASPRCE/PRECIP-EXCESS /01NOV1 995 /1HOUR,/ CALIERATED /
ZREAD Unit 7l; Vers. A/ SPRCR/FLOW-DIRECT /01DECL1995/1HOUR /CALIERATED /
ZREAD Tmit  72; Wers. //3FRCE/FLOV-DIRECT/01DECLS93/1HOUR,/CALIERATED /
ZREAD Unit 7l; Vers. S /ASPRCR/FLOW-DIRECT /01NOV1993/ 1HOUR /CALIERATED /
ZREAD Unit T2 WVers. S /ASPRCR/FLOW-DIRECT /01NOV1993/ 1HOUR /CALIERATED /

ST AT, TToga R, PP Tt R ottt A TRR R A MR AR e AR (00 1A AR T = A N A

Figure 4.35 DSS Output Dialog Box
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4.15.1 Program Options

During the process of using HEC-DSSV ue, properties are saved to
maintain a memory of HEC-DSSfile history, Ul settings, and user
preferences. Program Options alow you to re-set any such properties
back to the default settings that were set when HEC-DSSV ue was first
installed. Other Program Optionsinclude required files to import/export
SHEF data. For more information on the SHEF tab, see Chapter 5.

To reset al default properties for HEC-DSSV ue:

1. Open an HEC-DSSfile, from the Advanced menu, click Program
Options, the Options dialog box will open (Figure 4.36).

General | SHEF

[ Reset To Pragram Defaults ]

I O l ’ Canicel ]

Figure 4.36 Options Dialog Box - General Tab

2. Onthe General tab, click the Reset To Program Defaults button.
3. A Reset all Program to Default message box will appear (Figure
4.37), verifying you would like to reset the defaults. Click Yes.

Reset Program to Defaulis g|
f» | Reset all program settings ko original defaulks?
3 You will need to exit the program to complete this,
|. ............ T | o |

Figure 4.37 Reset Program to Defaults Message Box

4. Once the program defaults have been set, a message will open
asking you to exit HEC-DSSV ue to compl ete the reset process
(Figure 4.38). Clicking Yeswill close HEC-DSSV ue, or you can
choose to exit HEC-DSSV ue later by clicking No. If you select
No, some program settings may remain.
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HEC-DSSVue X
] HEC-D55Yue reset ko original defaulks,
~ You must exit now to keep the defaults,
Exit now?
Eoyes [ Mo

Figure 4.38Reset Program to Default Confirmation
Window

4.16 Advanced Functions

The following sections provide internal information, generally only for
internal use. They involve examining and modifying internal file structure
and settings, changing the trace and output levels, and setting internal
flagsin HEC-DSS. They are not intended for general use.

4.16.1 Memory Monitor

A set amount of memory is allocated for use during the HEC-DSSV ue
application runtime. The Memory Monitor (Figure 4.39) displaysthe
real-time memory used by the HEC-DSSV ue application in relation to the
memory the program has allocated. To accessiit, from the Advanced
menu, point to Status, click Memory Monitor.

Mermory Monitar
A2 allacated

A
— ==

. i
AT L—"'-|I_JI '1hr‘-_|

24564 nsed

Figure 4.39 Memory Montior

4.16.2 Open List of HEC-DSS Files

A report listing the current open HEC-DSS filein HEC-DSSVueis
available from the Advanced menu, point to Status, click DSS Files
Opened. Thereport, Figure 4.40 (page 4-25), liststhe DSS Trace date
and time and how many files were accessed. It also contains access
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E HecDss File Manager, Status g@@
.S

Chjects accessing file: 2
First Access: 16 April 2009, 13:24:59
Last fdccess: 17 April 2009, 11:08:33
Mumber of Accesses: 26

File: : /DssFiles/BaldEagleHist . dss
Open: true

Chjects accessing file: 17

First Access; 16 April 2009, 13:25:01
Lask Access: 17 April 2009, 11:45:19
Mumber of Accesses: GAG

File: J:/dev/appsjwatershedibase/ACF/rss/Base??_1939-1993 dss
Cpen: false

Chjects accessing file: 1

First Access: 17 April 2009, 10:52:39

Lask Access; 17 April 2009, 11:07:45

Mumber of Accesses: 10

File: 1:fdev appswatershedibase ACF s/ TestImporter, dss
Cpen: false
Objects accessing file: 2 A

£ >
Figure 4.40 HecDSS File Manager Status

information for each file, the number of records accessed, how many of
these records are currently selected, the file path to the HEC-DSSfile that
contains the file access information, and the number of records accessed
for the current session of HEC-DSSV ue.

4.16.3 Viewing the DSS Header List

The DSS Header List displays all the database variables and their values
used for the current HEC-DSSfile.

To view the header list:

1. Open an HEC-DSSfile, from the Advanced menu, point to
Status, click DSS File Header .

2. A dialog box will open (see Figure 4.41, page 4-25) listing al the
headers set for the current HEC-DSSfile.

4.16.4 HEC-DSS File Internals

HEC-DSSV ue offers tools to aid in viewing information on the current
HEC-DSS file and debugging problems that might occur during runtime.
These tools include increasing the Message L evel, DSS ZSET, DSS
ZINQIR, and Debug/Examine File. The Debug options are intended to
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be used internally only. For more information see the separate HEC-DSS
Programmer’s Manual.

Message Levels

M essage L evels control the detail of the messages written out to the HEC-
DSSVue Console Output. The higher the Message Level, the more
messages and detail will be written. A normal setting is four; above that
provide debugging output. This setting isintended to be used by
programmers only. For more information on the M essage L evels, see the
separate HEC-DSS Programmer’s Manual.

DSS ZSET
DSS ZSET isatool for programmers to set file parameters. For more

information on the DSS ZSET, see the separate HEC-DSS
Programmer’'s Manual.

DSS ZINQIR
DSS ZINQIR isatool for programmers to query file parameters. For

more information on the DSS ZINQI R, see the separate HEC-DSSVue
Programmer’'s Manual.

Debug/Examine File

The Debug/Examine File displays the internal contents of a HEC-DSSfile
for internal use. Modifying valuesin this dialog can damage files.
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CHAPTERS

Data Entry, Import and Export

HEC-DSSV ue has several components to enter datainto HEC-DSSfiles.
Y ou can enter data manually, paste datafrom the clipboard into a data
entry from, or import datafrom avariety of formats. The formats include
Microsoft Excel spreadsheet, the National Center for Climatic Data
(NCDQC), or directly from web pages, such as from the USGS NWIS
database or the North Carolina CRONOS database.

Most of the import functions are provided as "plug-ins'. Plug-insare
separate components that communicate with HEC-DSSV ue and can be
added, removed, or updated by the user. Plug-ins are added or updated by
simply copying the appropriate plug-in .jar file to the Plugins directory.
Generally, aplug-in is accessible from a menu option and is not apparent
to the user that afunction is being provided by a plug-in instead of HEC-
DSSVue. Plug-ins can be updated without having to update the HEC-
DSSVue program itself. Refer to the HEC-DSSV ue plug-ins web page for
updates at: http://www.hec.usace.army.mil/software/hec-dss/plug-ins.htm

HEC-DSSV ue can aso import and store virtually any other kind of filein
HEC-DSSfiles, including .jpg, .pdf, .doc, and .mp3 files. When you select
the pathname for a generic file and "plot” or "tabulate” the file, HEC-
DSSVue will launch the native application associated with the file
extension. For example, if you select a.doc file and then press the plot or
tabul ate button, Microsoft Word will be launched to read the file.

Y ou can aso import files with the appropriate extension by simply
"dragging and dropping" them from Windows Explorer onto HEC-
DSSVue with an open HEC-DSSfile. For exampleif you have SHEF
datain afile with an extension name of ".shef", you can ssimply grab that
filein Windows Explorer and drag it on top of HEC-DSSV ue and it will
be automatically imported.

HEC-DSSV ue can aso export datato a variety of formats, depending on
which plug-ins are loaded. For example, if you have time-series data, you
can select your pathnames. From the HEC-DSSV ue main window, from
the Data Entry menu, point to Export, click SHEF. From the Save
browser choose the file you want to export to, and your datawill be
written in SHEF format to that file.

Data Entry, Import and Export capabilities are accessible from the Data
Entry menu.
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5.1 Entering Data Manually

Time series data, paired data and text data can be manually entered using
the Manual Data Entry Editors available from the Data Entry menu. The
following sections discuss al optionsin detail.

5.1.1 Entering Time Series Data Manually
To enter time series data manually:

1. From the Data Entry menu, click Manual Time Series. The
Time Series Data Entry dialog box will open (Figure 5.1).

B Time Series Data Entry g|
Pathname Parts
Al |GREEM RIVER B: |GLENFIR Co | FLOWY
D: E: [ 1DAY » F:|DBS

Pathname: |{SREEM RIVER/GLENFIRIFLOWS1 DAY/OBS/

Start Date: |20JUL2Z005 Units: |CFS
Start Time: | 2400 Type: |PER-AVER e
Manual Entry | ukomatic Generation
Ordinate Date Time Yalue
1 20Jul2005 24:00 Y
2 21Jul2005 24:00
3 Z2Jul2005 24:00
L
’ Plot ] ’ Graphically Edit I ’ Save I ’ Cancel l

Figure5.1 Time Series Data Entry Dialog Box

2. Type the Pathname Partsinto the A, B, C, and F boxes, then
select the appropriate time interval for the E box. The complete
pathname will automatically appear in the Pathname box.
Alternatively, you can enter the pathname into the Pathname box
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and the parts will appear in the Pathname Parts boxes. You
cannot enter the "D" (date) part, asthisis set according to your
Start Date.

3. Enter the Start Date (e.g., 25Mar2002) and Start Time (e.g.,
1400).

4. Enter the Units (e.g., CFS).

5. From the Typelist, select adatatype. Options are PER-AVER,
PER-CUM, INST-VAL, and INST-CUM.

6. For regular interval time series data, the Date/Time cellsin the
table will fill automatically, starting with the start date and time
you entered. For irregular interval data, you will need to enter a
date and time for each data value.

7. Typethe data valuesinto the Value column.

8. Toview the datain plot form, click Plot.

9. To graphically edit the data you have entered, click Graphically
Edit.

10. To save the new time seriesrecord, click Save.

Y ou can paste data on the clipboard from another application by clicking
Paste. Thisalows you to copy datafrom various applications like
Microsoft Excel into HEC-DSS. When you paste datainto HEC-DSS, the
tab characters and carriage return characters in the program that you are
copying from must match the data entry table. Tab characters move to the
next column to the right, while carriage return characters move to the next
row down. These are the default characters used in Excel.

For regular interval time series data, the data must be in a columnar format
(e.g., acolumn from Microsoft Excel) and should contain data values
only. For irregular interval data, the date and time must precede each data
value, with tab characters separating them. For paired data, al values for
each ordinate must be separated by atab character. To enter datausing
the paste capability:

1. Complete steps 1 through 5 above.

2. Select your data set from the other applications and Copy it to the
clipboard.

3. Click Paste, you should see the data from the clipboard appear in
thetable.

Y ou can also automatically generate regular-interval time series data.
Thiswill fill in asingle number for atime window. To generate this data:

1. Complete steps 1 through 5 above.

2. Select the Automatic Generation tab.

3. Enter the End Date and End Time for the data

4. Enter the Fill Value, which isthe single value for the specified
time window.
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5. Click Generate, thiswill return you to the Manual Entry tab,
where you can plot, save, or further edit the data.

5.1.2 Entering Paired Data Manually
To enter paired data manually:
1. From the Data Entry menu, click Manual Paired Data. The

Manual Paired Data Entry dialog box dialog box (Figure 5.2)
will open.

Manual Paired Data Entry

Pathname Patts
A WHITE B: |DAKVILLE C: |BTAGE| - DAMAGE

o E: 2020 Fi|PLAM A

Pathname:  |[WMHITEQAKVILLEISTAGE-DAMAGENZO20/PLAN A

Mumber of Curves: |2 % Horizontal Axis: &% (Y
* Units: feet Y Units: |[&1000
H Type: |Linear W | Y Type: |Linear W

[] Add Rating Table Data

u] 1
Crdinate * parameter
Labels RESIDEMTIAL COMMERCIAL | o
1 ] u] u]
2 12,5 2.6 u]
3
4
~
Plot ] ’ Save ] [ Cancel

Figure5.2 Manual Paired Data Entry Dialog Box

2. Typethe Pathname Partsinto the A, B, C, D, E, and F boxes.
The complete pathname will automatically appear in the
Pathname box. You can also enter the pathname into the
Pathname box; the parts will appear in the Pathname Parts
boxes. Be surethe"C" part contains both an X parameter and a’Y
parameter, separated by a hyphen (e.g., STAGE-FLOW or ELEV-
DAMAGE).
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3. From the Number of Curveslist select the number of curvesto be
entered. Also, from Horizontal Axis, select X or Y.

4. Inthe X Units box, enter the units for X (belonging to the first
parameter) and in the Y Units box, enter the unitsfor Y (belonging
to the second parameter).

5. Fromthe X Typeand Y Typelists, select the type for the
respective parameters. Available options are Linear, L og, and
Probability.

6. Inthetable, the Y parameter columns will split into individual
columns according to the number of curves you specified.

7. Enter the data values into the X parameter and Y parameter
columns.

8. Toview the datain plot form, click Plot.

9. To save the new time seriesrecord, click Save.

Y ou can paste data on the clipboard from another application by clicking
Paste. Thisallows you to copy datafrom various applications like
Microsoft Excel into HEC-DSS. When you paste datainto HEC-DSS, the
tab characters and carriage return characters in the program that you are
copying from must match the data entry table. Tab characters move to the
next column to the right, while carriage return characters move to the next
row down. These are the default characters used in Excel. For paired
data, al values for each ordinate must be separated by atab character with
acarriage return character at the end of each row. To enter data using the
paste capability:

1. Complete steps 1 through 6 above.

2. Select your data set from the other applications and Copy it to the
clipboard.

3. Click Paste, you should see the data from the clipboard appear in
the table.

5.1.3 Manual Text Entry

HEC-DSS has atext convention format. Y ou can enter data by manual
text data entry and type or paste text into the text editor, or you can import
atext file. You cannot import text files into the HEC-DSS text format by
dragging and dropping a .txt file; thiswill save a .txt file in the generic file
format.

To enter text data manually:

1. From the Data Entry menu, click Manual Text. A diaog box
will open (see Figure 5.3, page 5-6).

2. Type or paste the text datainto the text dialog box. You can
change the font, but the font will not be stored with the text.
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File  Find

X

|

[

Cancel ] [ Save s,

Figure 5.3 Dialog Box used to Enter Text

3. From the File menu you can insert a
text file (.txt). You can also save your
text asa.txt file, save as an HEC-DSS
file, or print your file (Figure 5.4). You
can aso change the font of the text, but
that will not be retained. (Note: You
can also import text data directly from a
.txt file from the HEC-DSSVue main
window. From the Date Entry menu,
point to Import, click Text from File.)

4. After the text has been entered, click
Save Asto save the datato aDSSfile.
Also, from the File menu you can click
Save or Save Asto save thedataas a

Save Chel4+5

Save As...

Save bs txk ..

Insert bxk file, .

Figure5.4 File Menu

DSSfile. Either method opens the Save As dialog box (Figure

Fonk. .. Chrl+F
Prinkt Setup...

Prink. .. Chrl4+P
Close Chrl

5.5).
Save As El
Pathname: |/GREEN RIVER/GLENFIRIOUTLET NOTES/20JAN2004/F RANKS |
A: \GREEN RIVER | B: GLENFIR | C:|OUTLETNOTES |
D | 20JAN2004 L E| | F FRANK |
Save to: |C:,|'Temp,|'5ample.dss vl [ Brawse ]
0K ] [ Cancel ]

Figure5.5 Save AsDialog Box
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5. Enter the Pathname Partsinto the A, B, C, D, E, and F boxes.
The complete pathname will automatically appear in the
Pathname box. You can also enter the pathname into the
Pathname box; the parts will appear in the Pathname Parts boxes
(see Figure 5.5, page 5-6).

6. To savetherecord, click OK.

5.2 Import/Export Files

Y ou can import and export text files, image files and other types of files
into HEC-DSS files from the Import or Export menu items on the Data
Entry menu.

5.2.1 Import Text Files

HEC-DSS has atext convention format. Y ou can enter data by manual
text data entry and type or paste text into the text editor, or you can import
atext file. You cannot import text files into the HEC-DSS text format by
dragging and dropping a .txt file; thiswill save a .txt file in the generic file
format.

To import atext file:

1. From the Data Entry menu, point to Import, click Text from
File.

2. An Open browser will be open (Figure 5.6). Navigate to the
directory and file you wish to import. Select the file and click
Open, you can only import non-formatted regular text.

Open E|

Lookin: ||5) Recipes b 3 E E

My Recent
Documents

Desktop

My Documents
-
L
My Compuker
:L] File name: Tarnrnys.Exk
My Metwork,
Places Files of type:  [# by v

Figure5.6 Open Browser
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3. A dialog box will open (Figure 5.7) displaying the contents for the
selected file. Y ou can make any changes you want to the text.

File  Find

3. Meanwhile, back at the other pan, add the water to the beef, then whisk in the remaining 1 1/4 cups flour. Add
the roux/broth mixture and the other chili ingredients and whisk until blended. Make sure your grated carrot is ch
opped up to the size of rice before you add it.

4, Crank the heat up to nmedium high., Stir often until you see bubbles forming on the surface of the chili. Turn th
e heat dovm to wmedium low, and continue to simwer for 15 to 20 minutes, or until thick. The chili should be calwly
bubbling like lava as it simmers. When it's done cooking, teke the chili off the heat, cover it, and let it sit f
or 30 minutes to an hour before wsing it on the burgers. It should thicken to a tasty brown paste as it sits.

5. To make your hamburgers, you'll first diwide 3 pounds of hamburger into 16 portions of 3 ounces each. Grill the
burgers in a hot skillet or on an indoor griddle for 4 to § minutes per side or until done. Sprinkle some salt an
d pepper on each patty.

6. Build the burgers by lightly toasting the faces of the hawburger buns. Turn them over into a hot skillet or a g
riddle on medium heat.

7. Place one patty onto the bottom bun.

§. Position two slices of cheese on the meat.

9. Place another beef patcy on the cheese.

10. Spoon about 1/3 cup of chili onto the beef patty.

1l. &prinkle about 1 tablespoon of diced onion onto the chili.

12, Arrange 4 to 5 pickle slices on the onion.

13. FPlace a thick slice of tomato on next.

14, fpread mustard over the face of the top bun and top off your hamburger by turning this bun over onto the tomat
o. [(http:/ /. topsecretrecipes. con)

Makes & burgers. (6 cups of chili.)

v

Figure5.7 Dialog Box for Importing Text

4. After the text has been entered, click Save Asto savethe datato a
DSSfile. Also, from the File menu you can click Save or Save As
to savethe dataasa DSSfile. Either method opens the Save As
dialog box (see Figure 5.5, page 5-6).

5. Enter the Pathname Partsinto the A, B, C, D, E, and F boxes.
The complete pathname will automatically appear in the
Pathname box. You can aso enter the pathname into the
Pathname box; the parts will appear in the Pathname Parts boxes
(see Figure 5.5, page 5-6).

6. To save the record, click OK.

5.2.2 Exporting Text Files
To export to atext file:

1. You can export datato atext file by selecting the pathname for the
data set that you want to export, from the Data Entry menu, point
to Export, click Export to File(s). You can only export one text
data set at atime for this convention. (For image and generic files
you can export several at onetime.) This menu option will only
appear for text, image and generic files.

2. A Save browser will open (see Figure 5.8, page 5-9). Navigate to
the directory where you want the file saved, in the File name box
enter the name of thefile, and click Save.

5.2.3 Import Image and Generic Files

HEC-DSS has a convention for storing image (photos, etc.) and other files
inageneric fileformat. For thisformat, the pathname will have a C part
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Save @

Savein: ||Z) Recipes v F EE

]

Recent

My Documents
-
8
My Computer
;£ File: name: Tanrys, bk
My MNetwork,
Places Files of bype: | # byt -

Figure 5.8 Save Browser

that is the name of the file (without directory), aD part that is either
"IMAGE" or "FILE", and an E part that is the extension of thefile (e.g.,
"JPG" or "PDF"). For moreinformation, refer to Chapter 1, Section
1.2.3.

When you select images or files (generic type) in HEC-DSSVue and select
either “plot" or "tabulate”", HEC-DSSVue will launch a photo viewer for
image data, or launch the application associated for that file type. For
example, if thefiletypeis".pdf*, HEC-DSSVue will launch Adobe
Acrobat with a copy of that file loaded into it.

The easiest way to import both image and generic filesis to drag them
from Windows Explorer and drop them into the main screen of HEC-
DSSVue with an opened HEC-DSSfile. A Save Asdiaog box will open
(see Figure 5.5, page 5-6) where you can enter the pathname parts. You
can aso import images and generic files from the Data Entry menu.

To import image or generic filesinto HEC-DSS:

1. From the Data Entry menu, point to Import, either click Images
or Files (Generic type).

2. An Open browser will open (see Figure 5.9, page 5-10). Navigate
to the directory and select the files you wish to import. Select the
filesand click Open. You can import multiple files at one time.

3. The Save As dialog box will open (see Figure 5.5, page 5-6).

Enter the Pathname Partsinto the A, B, and F boxes. The
compl ete pathname will automatically appear in the Pathname
box. You can also enter the pathname into the Pathname box; the

5-9



Chapter 5 — Data Entry, Import & Export

HEC-DSSVue User's Manual

Open

X

Look in: |E] 2008, 10,20.Florida

v 2 EE

My Recent
Documents

9

My Computer

&) ma_o171.0pG 5]
4 ¥ MG_0172.3PG (8] IMG_0187.3PG [E] IMG_0202.0PG
¥ mMG_0173.9PG [£] MG_0188.9PG [E] IMG_0203.JPG

IMG_0174.0PG [tj IMG_01589.JPG
IMG_0175.0PG [tj IMG_0190.JPG
IMG_0176.0PG [tj IMG_0191.0PG
IMG_0177.0PG [tj IMG_0192.3PG
IMG_0175.0PG [tj IMG_0193.0PG
IMG_0179.0PG [tj IMG_0194.3PG
IMG_0180.JPG [tj IMG_0195.0PG
IMG_01581.0PG [tj IMG_0196.JPG
IMG_01582.0PG [tj IMG_0197.JPG
IMG_0183.0PG [tj IMG_0195.JPG
IMG_01584.JPG [tj IMG_0199.3PG
IMG_0185.3PG [tj IMG_0z00.JPG
IMG_0186.JPG [tj IMG_0z01.JPG

v | >
! File name: |?.JPG" "IMG_0168, IPG" "TMG_0169,JPG" "IMG_0170,1PG" [ Open ]
Iy Metwork
Flaces Files of bype: |*.jpg v | Cancel

Figure5.9 Open Browser — Importing |mages and Generic Files

parts will appear in the Pathname Parts boxes (see Figure 5.5,

page 5-6).

4. To savetherecords, click OK. A confirmation window will
appear, see Figure 5.10.

L
\‘1‘) 42 items stored

Figure5.10 Save Files Confirmed

Or, dternatively you can import image and generic files by:

5. From Windows Explorer (Figure 5.11), select the files that you

wish to import.

% Christmas Songs

© File Edt View Favorites Todls Help
C Qe () B D s [ ot | [ X
i Address |E:| C:iMusichChristras MusiciDiana Kral-Claytan-Hamiltan Jazz OrchestralChristmas Son v ‘ Go Links ™
Folders x Mame Size | Type ~
= O chistmas e | ST 320968 13 Fle
15 bsolute Favorite 3,764KB  MP3File
IE bsolute Favorite 4116 KB MP3 File
1 Amy Grant 3,038 KB MP3 File
3 Christmas Collect I 2,922 KB MP3File
= I3 Diana Krall-Clayto 3,355K8  MP3 File
Christmas Sor 2,704KB  MP3 File
123 Jaci velasquez 4,047 KB MP3 File
12 Jewel 4,243 KB MP3 Fil
1) John Tesh 3,900KB  MP3 File
[ Litkle: Towen of Bet! 3,231 KB MP3File _
153 MercyMe ] 3,448 KB MP3 File
15 Michael we. Smith *Albumart_{1507201C-433E- 9KE IPEG Image
|5 Point of Grace | [ Albumért_{1507201C-438E-4... 3KB IPEG Image b
£ | > £ | >
12 objects selected 40,9 MB d Iy Camputer

Figure5.11 Example of Data Selection for Drag and Drop
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6. "Drag" the files onto the main HEC-DSSV ue screen (with a HEC-
DSSfile open).

7. The Save As dialog box will open (see Figure 5.5, page 5-6).
Enter the Pathname Partsinto the A, B, and F boxes. The
complete pathname will automatically appear in the Pathname
box. You can aso enter the pathname into the Pathname box; the
parts will appear in the Pathname Parts boxes.

8. To save the records, click OK, a message window will open (see
Figure 5.10, page 5-10).

9. The actual file names will be displayed in the C part, as shownin
Figure 5.12.

Sample. dss - HEC-DSSVue =]

File Edit Yew Display Groups DataEntry Tooks Advanced Help
=2 g == \2 fx Kl Precision
File Name: |C:Temp/Sample.dss
Pathnames Showr 12 Pathnames Selectec: 0 PathnamesinFils: 205 File Size: 1535 MB
Sample.dss X
Search A (IS C ¥ E: b
By Parts: | ~| o v F v
Humber PatA | PartE Part PartD | PartE Part F
1|mMusIC  [Dlans kraLL 01 JNGLE BELLS.MP3 FILE MPs CHRISTMAS -
2|MUSIC DIANA KRALL 02 LET IT SNOWY MP3 FILE MP3 CHRISTMAS
FMUSIC [DlaNA KRALL 03 THE CHRISTMAS SONG MP3 FILE MP3 CHRISTMAS
!IJMUSIC DIANA KRALL 04 WINTER YWONDERLAND MP3 FILE \MPS CHRISTMAS
SMUSIC [DlaNA KRALL 05 LL BE HOME FOR CHRISTMAS.MP3 FILE MP3 CHRISTMAS
BIMUSIC  [DIANA KRALL 05 CHRISTMAS TIME IS HERE MP3 FILE MRS CHRISTMAS
7Music [Duana KRALL 07 SANTA CLAUS IS COMING TO TOWN.MP3 FILE MP3 CHRISTMAS
BIMUSIC  [DIANA KRALL 08 HAYE YOURSELF A MERRY LITTLE CHRISTMASMP3  [FILE MRS CHRISTMAS
gMUSIC [DlaNA KRALL 09 WHITE CHRISTMAS MP3 FILE MP3 CHRISTMAS
10MUSIC [DIANA KRALL 10 WHAT ARE YOU DOING NEW YEAR'S EVEMP3 FILE MRS CHRISTMAS
TijUsic  [piana KRaLL 11 SLEIGH RIDEMP3 FILE Pz CHRISTMAS &
~
v
Select De-Select Clear Selections Restore Selections Set Time Window
A Mo time window set.

Figure5.12 Imported Filenames Located in the C Part

5.2.4  Exporting Image and Generic Files
Y ou can export image and generic files by:

1. Select the pathnames for the data sets that you want to export, from
the Data Entry menu, point to Export, click Export to File(s).

2. A Save browser will open (see Figure 5.8, page 5-9); navigate to
the directory you want to save thefile, click Save. Theimages or
fileswill be saved with their original names. A confirmation
window will open (Figure 5.13).

\!4) 11 Files written to CHiDocurments and SettingsiBillMy Documents

Figure5.13 Saving Files Confirmation
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5.3

5.3.1

Importing and Exporting SHEF Data

The Standard Hydrol ogic Exchange Format (SHEF) is atext based format
developed by the National Weather Service (NWS) for exchange of real
time operational data with other agencies. SHEF was adopted by mutual
agreement for exchange of data between NWS and the Corps of
Engineers.

The import/export SHEF features are complied into HEC-DSSV ue; they
are not plug-ins and cannot be updated or removed from the program.

SHEF Table Files

The implementation of the import and export of SHEF datain HEC-
DSSVueis based on the prior existing programs SHFDSS and DSSSHF.
These programs, and their implementation in HEC-DSSV ue, use three
reference tables: one for defining SHEF parameter codes (SHEFPARAM),
one for relating SHEF physical element (PE) codes to DSS parameters
(shfdssp), and one for relating station identifiers to observation frequencies
and pathname parts (shfdsss). These files are required to access the
import/export capability; sample files are distributed with HEC-DSSV ue.

The SHEF sampletable files are distributed with HEC-DSSV ue and stored
in the users application directory under HEC-DSSV ue (the location of the
application directory is dependent on the operating system). Y ou can
browse to these files and edit the files, from the Advanced menu, click
Program Options, the Options dialog box will open (Figure 5.14). Click
the SHEF tab, information from the dialog box will show the location of
the SHEF sample tablefiles. If you have existing files from SHFDSS, you
can use thosein HEC-DSSV ue.

General | SHEF
ShefParm Files | C:\Documents and SettingsiBilh application Data\HEC-DSSYUe\SHEFPARM [ Browse.., l [ Edit... ]
Sensor File: Ci\Documents and SektingsiBilh Application DatalHEC-DSSYuelshfdsss [ Browse.., l [ Edit... ]
Parameter File: |C:\Documents and SettingsiBillapplication Data\HEC-DSSYuelshfdssp [ Browse... ] [ Edit... ]
Defaults
a4 ] [ Cancel ]

Figure5.14 Options Dialog Box — SHEF Tab
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SHEFPARM

The SHEFPARM file contains SHEF PE (Physical Element) codes and the
metric - English conversion factor. Generaly, the supplied file should be
sufficient unless newer PE codes are being used. To edit the SHEFPARM
file, from the Options dialog box, with the SHEF tab clicked (see Figure
5.14, page 5-12), click Edit that is next to the ShefParm File box. A
dialog box will open (Figure 5.15), which will allow the user to edit the
SHEFPARM file. Inthistable, the first column contains the PE code and
the second column contains the Metric to English conversion factor, if
thereis no factor, set thiscell to 1.0.

EOX

Fil=  Edit
SHEF Metric to English Section Mame
PE Code | Conversion Fackor

*1 PE CODES AND COMYVERSION FACTORS |9
Al 1.0

AF 1.0

A3 1.0

A 1.0 b

[ Save to Disk ] [ Cancel

Figure5.15 SHEFPARM File Dialog Box

Parameter File — shfdssp

The parameter file linksthe HEC-DSS "C" part (the parameter), the data
units, and type to the SHEF parameter (PE). To edit the parameter file,
from the Options dialog box, with the SHEF tab clicked (see Figure 5.14,
page 5-12), click Edit that is next to the Parameter Filebox. The SHEF
Parameter File dialog box will open (Figure 5.16), which will allow the
user to edit the parameter file. From the SHEF PE Code column of the

SHEF Parameter File C:/HecDSSVueDev/config/Shefishfdssp (=13
File Edit
SHEF Part Units Tvpe Factaor
PE Code {optional)

IHG STAGE FEET INST-WaL ~
IF‘U PRECIP IMNCHES INST-WaAL
IHL ELEW FT-M3L IMNST-WaL
IHF‘ ELEY FT-MsL INST-WaL
IHT STAGE FT-M3L INST-waL
IH‘\!'\II ELEY FT-M3L INST-waL
IF‘C PRECIP IMNCHES INST-CUM
IPP PRECIP-IMC IMNCHES

PR PRECIP-RATE IN/DAY IMNST-WaL -

[ Save ko Disk ] [ Cancel

Figure5.16 SHEF Parameter File Dialog Box
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5.3.2

table edit the PE code; from the Part C column (see Figure 5.15, page
5-13) edit the C Part of the DSS pathname, the units for the PE code can
be edited in the Units column, the type of for the PE code can be edited in
the Type column, and from the Factor column, an optional factor to
multiply the data by (e.g., kilo-cfs might have a factor of 1000.0 and store
the datain HEC-DSS as cfs) can be entered. The sample parameter file
that is distributed with HEC-DSSV ue should be relatively complete.

Sensor File — shfdsss

The SHEF sensor file links the SHEF gage ID to the HEC-DSS A, B, and
F parts. To edit the parameter file, from the Options dialog box, with the
SHEF tab clicked (see Figure 5.14, page 5-12), click Edit that is next to
the Sensor Filebox. The SHEF Sensor File dialog box will open (Figure
5.17), which will alow the user to edit the sensor file. For each Gage ID
and PE code, arow should exist with the Gage ID in column 1, the PE

B SHEF Sensor File C:/HecDSSVueDeviconfig/Shefishfdsss =3
File Edit
SHEF SHEF Interval Part & Part B PartF
Gage ID PE Code {mins, optional) {optional) (optionaly {optionaly
HYS PU Arnerican Huysink CDEC b
GkS FU American Greek Store CDEC
BLC PU Arnerican Blue Caynon CDEC
SER PU Arnerican Sugar Pine CDEC
GT FU American Pacific House CDEC
PFH PU Arnerican Georgetown CDEC
FRM P Ametican Farni Ridge CDEC
SOBT1 QR &H MISSISSIPPI CBION TOTAL
SRDA4 QR &H MISSISSIPPI ROSEDALE TOTAL
Save to Disk ] [ Cancel

Figure5.17 SHEF Sensor File Dialog Box

code in column 2, an optional timeinterval in column 3, the A part (basin)
in column 4, the B part (location) in column 5, and the F part (version) in
column 6. If notimeinterval isgiven, the datainterval is assumed to be
irregular. If atimeinterva is provided, is should end with "M" for
minutes (e.g. 15M), or "H" for hours (e.g., 6H). If an entry does not exist
for the data type being imported, default values are used.

Importing SHEF Data

Once the SHEF tables are setup, you can import SHEF data by either
dragging SHEF files with an extension of ".shef" or “".shf" from Windows
Explorer and dropping them into the main screen of HEC-DSSV ue with
an open HEC-DSSfile or from the Data Entry menu.

To import SHEF datafilesinto HEC-DSS:
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1. From the Data Entry menu, point to Import, click SHEF.

2. An Open browser will open (see Figure 5.6, page 5-7), navigate to
adirectory and select the files you wish to import. Select the files
to import, click Open. You can import multiple files at one time.
The file extensions do not matter for this option (the files do not
need to end with “.shef").

3. A message window will open (Figure 5.18); this window will
display how many values were stored from the SHEF data sets.

Y ou can view the SHEF process log by clicking View L og.

HEC-DS5Vue [X]

\11) 3546 values stored in 2 data sets,

| ok || Viewlog |

Figure5.18 SHEF Import Status Message Window

Or, alternatively you can import SHEF filesif they have the extension
".shef" or ".shf" by:

1. From Windows Explorer, select the ".shf" or ".shef" files that you
wish to import (Figure 5.19).

8% Local Disk (C:) E][E|PZ|
© File Edit Wiew Favorites Tools  Help i
P ) Back ~ [ ? P ! Search H_ “ Folders El' x
| Address < Ciy v . Go o Llinks P
Folders s Mame Size | Twpe ~
1 Visual Studio 2005 ~ 40KB SHF File
= } My Computer 40KB SHF File
[= G== Local Disk {C:) 41 KB SHF File
() Bigbss 49KB  SHF File
|2 Borland 45 KB SHF File
|2 CwMs2.0 49KB SHF File
I Docs 46 KB  SHF File
I2) Documents and Settings 44 KB SHF File
|5) Drivers 62KB SHF File
[ HecDsSYusDey ] regegs.txt 10KE  Text Document
53 Imageviewer &TimeWindowDialog.java Z7KB  JAvAFile
[ Java My sample dss I0KE DSS File
[ JavaCam COED.BUP 4KB ELP File
I2) MagellanDrivers v COED.REC 1KB RealOne Recordir s
< > < S
9 objects selected 412 KB 4 My Computer

Figure5.19 Selection of .shf or .shef Filesto Drag and Drop into DSSV ue

2. "Drag" the files onto the main HEC-DSSV ue screen (with your
HEC-DSS file that you want to import to opened.)

3. Thedataisimported and a message window will open (Figure
5.18), this window will display how many values were stored from
the SHEF data sets. Y ou can view the SHEF process log by
clicking View L og.
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5.3.3

5.4

Exporting SHEF

Y ou can export SHEF data by:

1. Select the pathnames for the data sets that you want to export, then
from the Data Entry menu, point to Export, click SHEF.

2. A Save browser will be open (Figure 5.20), navigate to the
directory where you want the exported SHEF data to be, type the
name of filein the File name box, click Save. All datawill be
saved in onefile.

Save
Save in:
Recent
F__?j

Desktop

My Documents

-

53

My Computer
4

My Metwark,

Plaras:

I dsswue files

Marne

forecast. dsc

|ﬂ forecast dss
lake . dsc

m lake dss
sample.dsc

m sample.dss
waterquality.dsc
m waterquality dss

<
File name: GreenRiver, shf
Files of type: | all Files

«| T

Size

131 KB
38,244 KB
1 KB
2,761 kB
& kB
5,370 KE
G5 kB
3,454 KB

7 [EE

3

Type

DSC File
D55 File
D5C File
D55 File
DS File
D35 File
DSC File
D55 File

>

Cancel

Figure5.20 Save Browser - SHEF Data

Importing and Exporting Microsoft Excel and ".csv"

Data

Importing, exporting and editing data with Microsoft Excel is
accomplished in HEC-DSSV ue by the "plug-in Excel.jar", stored in the
HEC-DSSVue Plugins directory. Plug-ins can be updated without having
to update the HEC-DSSV ue program itself. Refer to the HEC-DSSVue
plug-ins web page for updates at:
http://www.hec.usace.army.mil/software/hec-dss/plug-ins.htm.

At thistime, only time-series data can be imported into HEC-DSS. Check
the web site above for updates. Both time series and paired data can be
exported to Excel but only time-series data can be edited in Excel.
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5.4.1

Y ou can also import time-series data in a comma separated format (.csv)

or data separated by blank spaces, using the same procedure with the

"Time Series Wizard". Thisplug-inisin adevelopment stage; check the
plug-ins web page for updates.

Note: Excel uses beginning of period dates, whereas HEC-DSS uses end

of period. Thus, the average datafor aday will show at 0000 hoursin

Excel and 2400 hoursin HEC-DSS. This can cause atime shift by a day
if the datais not imported or exported carefully; Check your data after the

operation. Y ou can shift datato the correct times by using the Time

Functionstab in the Math Functions screen.

Exporting Data to Microsoft Excel

To export datato Excel, simply select the data sets you want to export and
then press the Excel Icon|x€] on the tool bar, or from the Display menu,
click Tabulatein Excel. An example of datatabulated in Excel is shown

in Figure 5.21. Y ou can then save the Excel file to the name that you
desire. Currently you cannot format the datain a different manner.

E3 Microsoft Fxcel - HecDssFxcel1B32997272370710343.x1s (=19

File Edit Wiew Insert Format Tools Data Window Help Adobe PDF ;lilﬂ
DEEg SRAY iR - ez A SO B U
L S| | @ snagit Window -
Al [=] =/ A

A B c 8] E F =
1 Al GREEN RIVER GREEN RIWVER GREEM RIVER GREEM RIVER I
2 [5] OAKNYILLE QAKVILLE OAKVILLE QAKYILLE
3 c ELEVATION FLOW-RES OUT  PRECIP-ING|  STAGE-OUT
4 E
5 F OBS 0BS OBS 0BS
5} Units FEET CF3 INCHES FEET
7 Type INST-WAL IMST-wAL FER-CUM INST-WAL
g 1) 01hay1932 0100 912.37 1575.0 0.00 3.6500
9 20 Dimay1952 0200 9257 1575.0 0.00 3.6500
1a 3 D1may1992 0300 912.35 1575.0 0.00 3.6500
11 4 01May1992 0400 912.35 1575.0 0.00 3.6500
12 5 DMay1952 0500 912,33 1575.0 0.00 3.6500
13 6 O01hay1992 0600 912.29 1575.0 0.00 3.6500
14 7 DMay1952 0700 912.29 1575.0 0.00 3.6500
15 8 O1may1992 0500 91229 1575.0 0.00 3.6500
16 9 01May1992 0200 ) eper 1575.0 0.00 3.6500
17 100 O1tday1992 1000 927 1575.0 0.00 3.6500
18 11 01May1992 1100 91229 1575.0 0.00 3.6500
19 12) O1tday1982 1200 1575.0 0.00 3.6500
20 13 O1May1992 1300 1575.0 0.00 3.6500
21 14 01May1952 1400 1575.0 0.00 3.6500
22 158 O1tday1992 1500 1575.0 0.00 3.6500
23 16 01May1992 1600 1575.0 0.00 3.6500
24 17 O1tday1992 1700 1575.0 0.00 3.6500
25 18 O1mMay1992 1800 1575.0 0.00 3.6500
26 19 O1tday1992 1500 1575.0 0.00 3.6500
2 200 Dimay1992 2000 1675.0 0.00 3.6500
28 21 01May1992 2100 1575.0 0.00 3.6500
29 22 DMlay1952 2200 1575.0 0.00 3.6500
30 23 Dimay1992 2300 1575.0 0.00 3.6500
H 24| O2hay1952 0000 1575.0 0.00 3.6500
32 25 02mMay1392 0100 91217 1575.0 0.00 3.6500
4 4[» M} Sheetl / |+ e
Ready

Figure5.21 Tabulating Datain Excel

If the Excel icon is not displayed, then you need to download the Excel .jar

file from the web page listed above and save it in the HEC-DSSVue\
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5.4.2

5.4.3

Plugins directory. This capability assumes that you have Microsoft Excel
loaded on your computer or another program that is associated with ".xIs"
files.

Editing Data in Microsoft Excel

Y ou can edit datain Microsoft Excel by selecting the pathnames that need
to be edited. From the Edit menu, click Edit in Excel, an Excel Data
dialog box will open (Figure 5.22), as well as Microsoft Excel. The data
associated with the selected pathnames will be display in the spreadsheet.

Excel Data

h__?/ Press O after wou have saved the Excel file,

ook |[ Cancel ]

Figure5.22 Excel Data Dialog Box

After you have made your changes, save the Excel file, and close
Microsoft Excel. From the Excel Data dialog box click OK, the dialog
box will close and the edits made to the data for those selected pathnames
will be stored in the DSSfile. If you do not want to save your changes
back to HEC-DSS, click Cancel.

Note: You can only change datain Excel when you are editing - you
cannot add or delete data. The data must remain in the same format with
the same number of rows and columns to be stored back to HEC-DSS.

Importing Data from Microsoft Excel or ".csv" files
using Data Entry

Y ou can import time-series datafrom Excel, a".csv" file, or ablank
separated file using the Data Entry dialog box. At thistime, you can only
import time-series data (both regular interval and irregular interval data).
Check the HEC-DSSV ue plug-ins web page for updates.

1. From the HEC-DSSV ue main window open a DSSfile, from the
Data Entry menu, point to Import, click Excel (see Figure 5.23,
page 5-18).

2. If your dataisina".csv' or blank separated file, select Time
Series Data instead of Excel. An example of the browsing window
isshown in Figure 5.24 (page 5-18).
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mydb. dss - HEC-DS5¥ue

File Edit “iew Display Groups EEEENSEM Tools Other Functions Advanced Help
: = Manual Time Series...
: o —_—= |E |
FYETT
E g == u f: X Manual Paired Data...
File Name: |C:Tempirnydb dss | Tandsl Text...
Pathnames Shown: 0 Paihname: SHEF... KE
e » USG5 Web
s X | TN
Search A | Vl C: NCDC... E: ‘ V‘
By Parts: [ | "l o |: FFA file F | v\
Excel
Mumber Part A Part B Part C Dssutl Wirite Data File PartE Part F
CDEC (Weh)
Text from File...
Images...
Files (BLOED. ..
-
v
Select De-Select Clear Selections Restore Selections Set Time Wwincaw
A Mo time window set.

Figure5.23 Importing Excel or .csv Files

Enter data file to import
Look in: |E|Temp v| ¥ ,_?||E
[ 13 &) nsproa
D 3tz [ 14] o7oE24
i 5 test 070824
1T testz [1#] Da.dsc
=) watershed Da.dss
u :: a @m@ @ Opilot,
Desktap |_ﬂ 00rnwpsnaw, J4c Ltﬂ 115_15
00myvpsnow . dss Llﬂ 115_15
=, L] 00snow-2004.csv [E] 11515
[___] ] 00snow-2004_decimal_dearess (2).csv ) 155 07
My Documents | ||'#] 02-10-08 Hidden valley.dsc T 18-000
02-10-05 Hidden Walley. dss 1862h.
- £ 02-10-08 Hidden Yalley.zip 1862h,
'_.il)g |i#] 02_standard_-_JDK.dsc [#] 14-UB-
My Computer 02_Standard_-_IDK.dss 18-UE-
- < | ¥
g' File name: |DDapi|0t,cs\-’ | ’ Cpen ]
My Mebwork
Places Files of type: |,q|| Files ~ | Cancel

Figure5.24 Selection of an Excel or .csv File to import into HEC-DSSV ue

3. Select your fileto import. Data should be in columns, separated by

comma or spaces. ldeally, arow should contain a location or
parameter, and a column should contain date/time.

4. Thefilewill be read into an editable table as shown in Figure 5.25

(page 5-20).

5. For regular-interval time series data, select the column cells that

you wish to import. For irregular-interval data, you need to select
date/time column cells a so.
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Alpha ¥ersion. Time Series Columnar import.

File

Rowe 'y Cal 1 2 El 4 5 &) 7 g 9

1 Date Cannonsyil... | Cannonsvil... | Hale_Eddy Pepacton_... | Pepacton_Loc | Harvard Cooks_Falls EE
z 01/01/1990 0.272021Z,..| 0.9583496,,.| 0.1057679...| 0.1977362...| 0.1518734...| 0.8480854...| 0.1979043...| O,

£ 01)0271920 0.2071692,..| 0.7787844,,,| 0.8069580...| 0.1623684,.,| 0.1238917...| 0.7233786,..| 0.1491335...| 0,

4 010371990 0.1724640...| 0.6025657...| 0.6925772... | 0.1244597... 0.9604457...| 0.5293021...| 0.1245722...| 0.

5 01/04/1990 0,1502901,..| 0.5024237...| 0.6154787...| 0,1023794,,,| 0.7970587...| 0.4218180...| 0.1089046...| O,

] 01)05/1990 0.1439117...| 0.4786601...| 0.6124672... | 0.9446376... 0.7536506,..| 0.3897295...| 0.1036861...| 0.

7 01/06/1990 0,1305215,..| 0.4301590,,,| 0.5540781...| 0.8452076...| 0.6667305,..| 0,3456926,.,.| 0.9454150...| O,

8 01)07/1990 0.1221705...| 0.3980389...| 0.5192869... | 0.7792450... 0.6158618...| 0.3147904...| 0.8880525...| 0.

9 01/08/1990 0,1164005,..| 0.3776519...| 0.49456181...| 0.,7373125,.. | 0.5834322...| 0.2961859,..| 0.8482175...| O,
10 010971920 0,1123354,..| 0.3643%946,,, | 0.4768562... | 0.7100672...| 0.5623094,..| 0,2847310,..| 0.8199797...| O,
11 011071990 0.1279956... | 0.4266657...| 0.5415524... | 0.8314705... 0.6567504...| 0.3409165...| 0.9324525...| 0.
12 011171990 0,1435780,..| 0.4953259,,,| 0.6119693...| 0,.9807919...| 0.7548439...| 0.4024815,..| 0.1049132...| O,
13 011211990 0.1429657...| 0.5019500...| 0.6070792... | 0.9656932... 0.7619302...| 0.4126247...| 0.1033679...| 0.
14 01/13/1990 0,1280681,..| 0.4402253.,,| 0.5392115...| 0.8036754... | 0.6767944,..| 03613237, .| 0.943659G...| O,
15 01)14/1990 0.1193026...| 0.3993102...| 0.5052408... | 0.78468928... | 0.6172832...| 0.3207739...| 0.8764584...| 0.
16 01/15/1990 0,1134263,.. | 0.3744597,..| 0.4019491...| 0.7320134,.. | 0.5767a08,..| 0.2967209,..| 0.6323475...| O,
17 01)16/1920 0,1095868,..| 0.3730120,,,| 0.4863718...| 0,7005711...| 0.5654937,..| 0,2859636,..| 0.8022546...| O,
15 011771990 0.1155381...| 0.3977622...| 0.5005848... | 0.7841191...| 0.6096471...| 0.3232146...| 0.8526495...| 0.
19 01/1871990 0.1428269,..| 0.4896343,,,| 0.5755652.., | 0.9566166,,, | 0.7673901...| 04167479, | 0.1022417...| O,
20 011971990 0.1287979...| 0.4366536...| 0.5214408... | 0.8585724... 0.6851925...| 0.3699552...| 0.919755z2...| 0.
21 01/2041990 0,1186455,..| 0.3936497,..| 0.4670074... | 0.7742949...| 0.6160724,..| 0,3237937, .| 0.6536720...| O,
22 01)21/1990 01121575, 0.3731963... | 0.4670284... | 0.7209345... | 0.5796547,..| 0.2963318...| 0.8116342...| 0.
23 01/2241990 0,1900%61,..| 0.6805094,,,| 0.6592942...| 0,1758670...| 0.1276206,..| 0.6630400,.,| 0.1452964...| 0,
9(4 112311990 N237RM 7.1 DLAIPFNA7. .| N.774RAR32.. ﬂ.IQHHF\RRﬂ... N.1476001 ... 1 NATAZONN. .. | NA797R4T... )ﬂ‘:

[ Impart ] [ Cancel

Figure5.25 Editable Import Table of an Excel or .csv File

6. Pressthe Import button and your selected cells will be entered
into the time series data entry dialog, as shown in Figure 5.26.

Time Series Colur

File

Row | Col 1 4 3 4 1 & 7 3 9 10
1 Date Cannonsvil... | Cannonsvill... | Hale_Eddy Pepacton, Pepactan_Loc | Harvard Cooks_Falls EE_Beaver... | Fish &
2 01/01/1990 0L2720212... | 0,9583496.,. | 0,1057679.., 0,197736Z,..| 0,1516734.,, 0.5480854...| 0.1979043.. | 0.5705389...| 0.2
3 01/02/1530 0.2071692...| 0.7737344...| 0.8065530... 0.1623684...| 0.1235917... 0.7233786...| 0.1491335...| 0.4727258...| 0.1
4 1724640, | 0.6025667... | 0.6923772.. | 0.1244597...| 0.9604457...| 0.5293021...| 0.1245722... 0.3593155...| 0.1
5 L 1502901, | 0.5024237.., 0,1023794,.,| 0,7970587,.,| 0.4Z18160,.,| 0.1089046,..| 0.2943111,.( 0.1
6 1439117, | 0.4738601... 0.9446376... | 0.7536506...| 0.3897295...| 0.1038861...| 0.2738722..| 0.1
7 .1305215...| 0.4301590... 06452076, .. | 0.6667305...| 0.3456926...| 0.9454150... 0.2491355..| 0.9
) 1221705, | 0.398036%... 0,7792450,.,| 0.6158618..,| 0.3147904,.,| 0.883052 0.2282385...| 0.8
9 164005, | 0.3776519... 0.7373125...| 0.5834322...| 0.2961369...| 0.8482175... 0.2152451...| 0.8
10 L1123354...| 0.3643946... 0.7100672,..| 0.9623094,.. 0.2647310...| 0.8199797... 0.2069444...| 0.7
11 1279986, | 0.4268697.., 0,8314705,.,| 0.6567504,,,| 0,3409168,.,| 0.9324525... 0.2438071..| 0.9
12 L 1435730...| 0.4953259... 0.9807919...| 0.7545439...| 0.4024315...| 0.1049132...| 0.2869395...( 0.1
13 . 1429657, | 0.5019500... 0.9856932...| 0.7619302...| 0.4126247...| 0.1033679...| 0.2683526..( 0.1
14 1260681, | 0.4402253.., 08636758, ., | 0.6787944,,,| 0,3613237,.,| 0.9438596,., 0.2538793..| 0.9
15 L 1193026...| 0.3993102... 0.7546928...| 0.6172832...| 0.3207739...| 0.8376455 0.2285215...| 0.8
16 1134263, | 0.3744597... 0.7328138...| 0.5757003...| 0.2967269...| 0.8323476... 0.2131053..| 0.8
17 L 1095868, ., | 0,3730120.., 0,7005711,.,| 0.9654937,,,| 0.2859636,,. 0.80Z2546,.. 0.2085117..| 0.8
18 L11585331... | 0.3977622... 0.7541191...| 0.6096471...| 0.3232146...| 0.8526495... 0.2249676...| 0.8
19 L 1428269, | 0.4896343... 0.9566166...| 0.7673301...| 0.4167479...| 0.102241 0.2659324...| 0.1
20 1267979, | 04368536, 0.8585724,.,| 0.6881925,,,| 0,369985Z,.,| 0.9197552,., 0.2579750.. 0.9
21 1186455, | 0.3938497... 0.7742949...| 0.6180724,.,| 0.3237957...| 0.8538720... 0.2291259...| 0.8
22 1121575, | 0.3731963... 0.7209345,..| 0.5796547...| 0.2963318...| 0.8116342... 0.2116117...| 0.8
23 ,1900961,.,| 0.6805094,,,| 0,659294Z,,,| 0,1758676,..| 0,1278266,., 0.6638460...| 0.1452964.,. 0.4262794...| 0.1
24 ‘DIIZSIIQQD | 0.2328017...| 0.8127097...| 0.7746632...| 0.2036380...| 0.1476901... 0.5127000...| 0.1792647... 0.5223332... D.l;

< | >

Impork I: Cancel

Figure5.26 Selecting and Importing Data

7. Enter the pathname parts, units and type, and then press Save. An
example of the Time Series Data Entry window that appears after
data have been imported is shown in Figure 5.27 (page 5-21).
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Time Series Data Entry

Pathname Parts

A | B

D: | | E DAY

Pathnarme: 400 D&Y

Start Date: [2 January 1980 | units: | |
Start Time: |24:00 | Type: | INST-VAL v |
Manual Enkry | automatic Generation
Ordinate Date Time Yalue
Linits -
Type -
1 03 Jan 1990 24:00 69,238
z 04 Jan 1990 24:00 61,543
3 0% Jan 1990 24:00 61,247
4 06 Jan 1990 24:00 55.403
5 07 Jan 1990 24:00 51.929
6 08 Jan 1990 24:00 49,462
7 09 Jan 1990 Z4:00 47 686
5 10 Jan 1990 24:00 54,155
9 11 Jam 1990 24:00 61,197
10 12 Jan 1990 24:00 60,708
11 13 Jan 1990 24:00 53,071
12 14 Jan 1990 24:00 50.524
13 15 Jan 1990 24:00 43,155 —
14 16 Jan 1990 24:00 48,637
15 17 Jan 1990 Z4:00 E0.036
16 15 Jan 1990 24:00 57,957 ||
’ Plot ] ’ Graphically Edit ] [ Save I [ Cancel I

Figure5.27 Time Series Data Entry Dialog Box

Note: Excel uses beginning of period dates, whereas HEC-DSS uses end

of period. Thus, the average data for aday will show at 0000 hoursin

Excel and 2400 hoursin HEC-DSS. This can cause atime shift by a day

if the datais not imported or exported carefully; Check your data after the
operation. Y ou can shift datato the correct times by using the Time
Functionstab in the Math Functions screen.

5.4.4 Importing Data from Microsoft Excel or ".csv" files

using Time Series Wizard

Y ou can import multiple columns of time-series datafrom Excel, a".csv'
file, or ablank separated file using the Time SeriesWizard. The Time
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SeriesWizard isaplug-in that is distributed in a development stage;
check the HEC-DSSV ue plug-ins web page for updates.

1.

2.

6.

7.

Open your DSS file from the Data Entry men, point to Import,
click and click Excel (see Figure 5.23, page 5-19).

If your dataisina".csv" or blank separated file, click Time Series
Data instead of Excel.

. Select your file to import (see Figure 5.24, page 5-19). Data

should be in columns, separated by comma or spaces. Idedlly, a
row should contain alocation or parameter, and a column should
contain date/time.

. Thefilewill be read into an editable table as shown in Figure 5.25

(page 5-20).

. Select any location, parameter, units, or version, etc. rows by right

clicking on the header row in the first column and selecting the
item, as shown in Figure 5.28. Y ou may also skip any rows that
are not to be imported or used.

B Alpha Yersion. Time Series Columnar import. File: 00apilot.csy

File
Row | Cal 1 2 3 4 5 3 7 3 9
1 Skli;-Rlo-w(s) "“nnnsvil\...|Cannnnsvi\|”. Hale_Eddy Pepacton_... | Pepacton_Loc| Harvard Cooks_Falls EE A
z 720212...| 0.9553496.., | 0.1057679...| 0.1977362..,| 0.1518734...| 0.8480854... 0.1979043...| 0.
3 BUNENCETGETNY  Part A 5 7757544.,. | 0.8069580... | 0.1623684...| 0.1238917...| 0.7233786.., | 0.1491335...| 0.
4 Units Row EOZ5657.., | 0.6923772...| 01244597, | 0.9604487...| 0.5203021..,| 0.1z45722..) O,
5 oyo41eg0 | 0. PAC B snzazar..| 0.6154757... | 0.1023794,.. | 0.7970587... 04218180, 0.1089046...| 0.
6 DOS/1390 | G T D4780691..| 0.6124672...| 0.9446376... 0.7536506...| 0,3097295... 0.1038861...| O,
7 01/06/1590 | 0.1305215...| 0.4301590.., 0.5540781...| 0.8452076... 0.6667305...| 0.3456926...| 0.9454150...( 0.
5 01f07/1950 | 0.1221705...| 0.3980389... 0.5192869...| 0.7792450... 0.615861%...| 0.3147904... 0.8880525..( 0.
9 01/08/1990 | 0.1164005...| 0.3776819.., 0.4946181...| 0,7373125..,| 0,5834322,..| 0.2961369.,.| 0.8482175...| 0.
10 01/09/1990 | 0.1123354...| 0.3643946.., 0.4768562,..| 0.7100672..,| 0,5623094...| 0.2847310...| 0.8199797...| 0.
11 0110/1990 | 0.1279906...| 0.4260697.., 0.5415524...| 0.8314705..,| 0,6567504...| 0,3409188...| 0.9324525...| 0.
12 01/11/1990 | 0.1435750...| 0.4953259.., 0.6119695...| 0.9507919...| 0.75458439...| 0.4024815...| 0.1049132...[ 0.
13 01012{1950 | 0.1429657...| 0.5019500.., 0.6070792...| 0.9656932... 0.7619302...| 0.4126247...| 0.1033879...[ 0.
14 01/13/1990 | 0,1280681...| 0.4402253.., 0.5392115...| 0,8636758.., 0,6787944...| 0,3613237...| 0.9438596...| 0.
15 01/14/1990 | 0.1193026...| 03993102, 0.505240%...| 0.7846928.., 0,6172832...| 0,3207739...| 0.8764534...( 0.
16 01/15/1990 | 0.1134263...| 0.3744597.., 0.4615491...| 0.7320138..,| 0,5767608...| 0.2967269.,.| 0.6323476..| 0.
17 01/16/1990 | 0.1095868...| 0.3730120... 0.4863718...| 0.7005711...| 0.5654937...| 0.2859636...| 0.8022546...[ 0.
15 01017/1990 | 0.1155381...| 0.3977622.., 0.5003645...| 0.7841191... 0.6096471...| 0.3232146...| 0.8526495...( 0.
19 0118/1990 | 0,1428269...| 0.4896343.., 0.5755652...| 0.9566166.., 0,7673901...| 04167479, 0,1022417...[ 0.
20 01/19/1990 | 0,1287979...| 0.4363536.., 0.5214408...| 0,8585724.., 0,6831925,..| 0,3699352.,.| 0.9197552...( 0.
21 01/20/1990 | 0.1186455...| 0.3930497.., 0.4676674...| 0.7742949..,| 0,6160724,..| 0,3237937...| 0.6536720...| 0.
22 01/21/1990 | 0.1121575...| 0.3731963... 0.4670284...| 0.7209345... 0.5796547...| 0.2963315...| 0.5116342...[ 0.
25 01/22/1950 | 0.1900961...| 0.6805094.., 0.6592942...| 0.1753676... 0.1278266...| 0.6633460...| 0.1452964...( 0.
74 nifzsi1ean N.Z3260M7...1 NA127097.. N.774RAR37... | NL2NRASAN. . nA47R901 ... 1 nLR127000.. NA792A47 ... n."
4 ¥

I Import ] [ Cancel ]

Figure5.28 Assigning Locations, Parameters, Units, Versions, etc. to Rows

From the top header row, select any columns that contain dates or
times, as shown in Figure 5.29 (page 5-23).
Y ou can also select individua data columns from the header

popup.

8. Alternatively, you can enter al datainto DSS at one time by right-

clicking the upper left cell and selecting Set All Data Columns, as
shown in Figure 5.30 (page 5-23). The resulting window will look
like the examplein Figure 5.31 (page 5-24).
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RowiCol | 1 - 4 5 6 7 El g
Skip Column
1 Date nmsvil... | Hals Edds |Depacton_ Pepacton_Loc | Harvard Cooks_Falls  [EB A
2 Date and Time Comn |y qoznco 170 151a7ad. . | 0.6460854... | 0.1979043...] D,
3 01/02/19 5t Data Column | 1623654, | 0.1238917...| 0.7233786... 0.1491335...| 0,
Time Column
4 oosfiomn | nazzdew..| o 7T 1.1244597... | 0.9604487... 0.5293021...| 0.1245722...| 0.
'3 olumn
5 01/04/1990 | 0.1502901... | 0. i 11023794, | 0.7970587...| 0.4218180,,.| 0.1089046...| O,
Monkh Calumn
5 01/05/1390 | 0.1438117...| 0. 1.9446376... | 07536506, | 0.3687295.. 0.1036861...| 0.
“ear Column
7 01/06/1990 | 0.1305215...| 0. 1,8452076.., | 06667305, ., | 0.3456526,,. 0.9454150...| O,
Month-Day Column
& OUOTN0 | 012215 | 0 e Colin 1.7792450... | 06158618, .| 0.3147904.,.| 0.8880525...| 0.
a 01j0811990 | 01064005, | 0 porkhvenr conn 17373125, | D.Se3Ez,. | 0.2961869,.. ] 0.8462175...] 0,
10 01/09/1990 | 0.1123354...| 0.5643346...| 0.4768562...| 0.7100672.., | 0.5623094...| 0.2847310,,. 0.8199797...| 0.
11 01/10/1990 | 0.1279986...| 0.4268697...| 0.5415524,., | 0,8314705.., | 0,6567504,..] 0.3409188,,. 0.9324525...| 0.
12 01/11/1990 | 0.1435780...| 0.4953259...| 0.6119695...| 0,9807919..,| 0,7545439,..| 0.4024815,,. 0.1049132...| 0.
13 01/12/1990 | 0.1429657...| 0.5019500...| 0.6070792...| 0,9656932.., | 0.7619302...] 0.4126247,,.) 0.1033879...| 0.
14 01/13/1990 | 0.1280681...| 0.4402253...| 0.5392115..,| 0.8636756.., | 0.678794+...| 0.3613237.,. 0.9438596...| 0.
15 01/14/1990 | 0.1193026...| 0.3993102...| 0,5052408.., | 0.7846928.., | 0.6172832... 0.3207739,..) 0.8764584...| 0.
16 01/15/1390 0.4815491... | 0,732513 3
17 01/16/1590 0,4863718... | 0,700571 0.
18 01/17/1990 | 0.1155361...| 0.3977622...| 0,5003648..,| 0.7841191..,| 0.6096471...| 0.3232146.,. 0.8526495...| 0.
19 01/18/1990 | 0.1428269...| 0.4896343...| 0,5755652.., | 0,9566166..,| 0.7673901... 0.4167479,,.  0.1022417...| 0.
20 01/19/1990 | 0.1287979...| 0.4368536...| 0,5214408.., | 0,8585724..,| 0.6881925...| 0.3699852,,. 0.9197552...| O.
21 01/20/1390 | 0.1186455... | 0.3938497...| 0.4676674..,| 0.7742949..,| 0.6180724...| 0.3237937... 0.8538720...| 0.
22 01/21/1990 | 0.1121575...| 0.3731963...| 0.4670284..,| 0.7209345..,| 0.5796547...| 0.2963318.,. 0.5116342...| 0.
2 01/22/1990 | 0.1900961...| 0.6805094...| 0.6592942...| 0,1756676...| 0.1278266.,. D.6638460...| 0.1452964,..| 0.
2 n1iz3i9an MN2325M7.. 00 NLA127N97 .0 NLFP4RARZ... | NL2N3ARAN. . M.147A90N1. NAZ700N. .. N.A792R47. .. I-I.\_'
< | >

[ Impork ] [ Cancel

Figure5.29 Assigning Dataand Time to Columns

Alpha Yersion. Time Series Coli i : O0apilot.csy

sl 4 5 & 7 g 9

. Cannonsvill,.. | Hale_Eddy Pepacton_... | Pepacton_Loc| Harvard Cooks_Falls EE ~
z 01/01f1990 0.2720212...| 0.9583496...| 0.1057679...| 0.1977362...| 0.1515734...| 0.8480854...| 0.1979043...| 0.
3 01/0zf1990 0.2071652., 0.7757844... 0.1623654... | 0.1238917...| 0.7233786...| 0.1491335...| 0.
4 01/03/1990 0.1724640. 0.6025657 ... 0.1244557... | 0.9604457...| 0.5293021...| 0.1245722...| 0.
5 01041390 0.1502901... | 0.5024237...| 0.6154767...| 0.10237%4...| 0.7970567...| 0.4216180,., 0.1089046... O
& 01/05/1990 01439117, | 0.4788691...| 0.6124672,.,| 0.9446376...| 0.7536506,..| 0,3897295,,,| 0.1038861...| O,
7 01/08/1990 0.1305215,., | 0.4301590...| 0.5540781,..| 0.8452076...| 0.6667305...| 0,3456926...| 0.9454150...| O,
8 01/071990 0.1221705... | 0.3980389...| 0.5192869...| 0.7792450...| 0.6158618...| 0.3147904,..| 0.8880525...| 0.
il 01/08{1990 0.1164005... | 0.3776319...| 0.4946181...| 0.7373125... | 0.583432Z...| 0.2961369...| 0.8432175...| 0.
10 01/09/1990 0.11253354... | 0.3643946...| 0.4768562...| 0.7100672...| 0.562309%4...| 0.2847310...| 0.56199797...| 0.
1 01/10/1390 0.1279986,,. | 0.4268697...| 0.5415524,..| 0.8314705...| 0.6567304...| 0.3409186,.,| 0.9324325... O
12 01/11f1990 0.1435780,,. | 0.4953259...| 0.6119698,.,| 0.9807919...| 0.7545439...| 0.4024815,..| 0.1049132...| O,
13 01/121990 0.1429657,,. | 0.5019500...| 0.6070792,.,| 0.9656932...| 0.7619302...| 0.4126247,..| 0.10336879...| O,
14 01/131990 0.1280681. 0.4402253,.. | 0.5392115...| 0.8636758... | 0.6787944,,.| 0.3013237...| 0.9438596...| 0.
15 01f141990 0.1193026... | 0,3993102...| 0.5052403...| 0.7846028...| 0.617233Z...| 0.3207739...| 0.8764584...| 0.
16 01/15/1990 0.1134263... | 0.3744597...| 0.4515491...| 0.7325158... | 0.5787608...| 0.2967269...| 0.8323476...| 0.
17 01/16/1990 0.10956868,,, | 0.3730120...| 0.4863718,.,| 0.7005711...| 0.5654937...| 0.2899636,..| 0.6022546... O,
18 01/17/1990 0.1155381... | 0.3977622...| 0.5003648,..| 0.7841191...| 0.609&6471...| 0.3232146,.,| 0.8526495... O,
19 01/18f1990 0.1428269,.. | 0.4896343...| 0.5755652, .| 0.9566166...| 0.7673901...| 0.4167479,.,| 0.1022417... O,
20 01/19/1990 0.1287979,., | 0.4368536...| 0.5214408,..| 0.8585724..,| 0.6881925...| 0.3699852,,,| 0.9197552...| O,
z1 01/20{1990 0.1186455... | 0.3935497...| 0.4876674...| 0.7742049...| 0.6180724...| 03237937, 0.8538720...| 0.
2z 01/21/1990 0.1121575... | 0.3731963...| 0.4670254...| 0.7209545...| 0.5796547...| 0.2963316...| 0.56116342...| 0.

23 01/22/1990 0.1900961,,. | 0.6803094,.,| 0.6992942, .| 0.1758670...| 0.1275266,.,| 0.6036460,.,| 0.1452964...| 0.

14 iP5 ean N.2375M7... | NR1P7AN97... | N.7740R37. .. ﬂ.l?ﬂﬁﬁ?F!ﬂ.. N.1476801 ... NLR127000... | N1797R47... )ﬂ?

I Impart ] [ Cancel

Figure5.30 Select all Data and Columns to |mport

9. Thiswill bring up adialog to set additional pathname parts or
units, as shown in Figure 5.32 (page 5-24).

10. Enter additional information desired. To import al the data sets,
click Import Now. A confirmation window will appear, see
Figure 5.33 (page 5-24).

11. Alternatively, if al columns are not to be imported, individual data
set columns can be imported by right clicking on the header row of
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Alpha Yersion. Time Series Columnar import.

File

Row |, Col 1 Z o] 4 8 & 7 g 9

1 ‘Dake Cannonswil,.. | Cannonsyill... | Hale_Eddy Pepacton_,., | Pepacton_Loc| Harvard Cooks_Falls EB ~
z 01/01f1920 0.2720212... | 0.9583496...| 0.1057679...| 0.1977362... 0.1518734...| 0.8480854...| 0.1979043... 0.

3 01/02/1920 0.2071692... | 0.7767044...| 0.6069580...| 0.1623684... 0.1238917...| 0.7233786,..| 0.1491335... 0,

4 01/031990 0.1724640,,. | 0.6025687,..| 0.6923772...| 0,1244597,,. 0.9604487,..| 0.5293021,..| 0.1245722,., 0,

5 01/04/19%0 0.1502901... | 0.5024237...| 0.6154787...| 0.1023794... 0.7970557...| 0.4218180...| 0.1059046... 0.
&) 01/05/1920 0,1439117.,. | 0.4788691,..| 0.6124672...| 0.9446370... 0.7936506,..| 0,3897295,..| 0.1038861... O,

7 01/08/1990 0.1305215.., | 0.4301590,..| 0.5940781...| 0.8452076... 0.6667305... 0.3456926...| 0.9454150... O,

& 01/071990 0.1221705... | 0.3980359...| 0.5192869...| 0.7792450... 0.6158616...| 0.3147904...| 0.8850525... 0.

9 01/08/1920 0.1164005... | 0.3776819,..| 0.4946181...| 0,7373125.,. 0.5834322,..| 0.2961869,,,| 0.8462175.., 0,
10 01/09/1920 0.1123354... | 0.3643946...| 0.4768562...| 0.7100672... 0.5623094... | 0.2847310...| 0.8199797... 0.
11 014101990 0,1279956,,, | 0.4268697,..| 0.5415524...| 0.8314705... 0.6567504...| 0.3409188,..| 0.9324525.., 0,
12 01f11f1990 0,1435780... | 0.4953259,..| 0.6119695,..| 0.9807919.,. 0.7543439...| 0.4024815...| 0.1049132.., 0,
13 01f12f1920 0.1429657... | 0.5019500...| 0.607079Z...| 0.9656032... 0.7619302... 0.4126247...| 0.1033579... 0.
14 01/13/1920 0,1280681... | 0.4402253,..| 0.5392115...| 0.8636758... 0.6767944,..| 0.3613237,..| 0.94385%6... 0,
15 01/14/1920 0,1193026,,, | 0,3993102,..| 0.5052408,..| 0.7846028.,. 0.6172832,..| 0,3207739,..| 0.8764584... 0,
16 01/15/1990 0.1134263... | 0.3744597...| 0.4515491...| 0.7326138... 0.5787605... 0.2967269...| 0.6323476... 0.
17 01/16/1920 0,1095668,,, | 0.3730120,..| 0.4863716...| 0.7005711.,. 0.5654937...| 0.2859636,..| 0.8022546.., 0,
18 01f171990 0,1155381... | 0.3977622,..| 0.5003648...| 0.7841191... 0.6096471...| 0.3232146...| 0.8526495... 0.
19 01/18/1990 0.1426269... | 0.4896343...| 0.5755652...| 0.9566166... 0.7673901...| 0.4167479...| D.1022417... 0.
20 01/19/1920 0,1287979,.. | 0.4368536,..| 0.5214408...| 0.8585724... 0.6881925,..) 0,3699852,..| 0.9197552,., 0,
z21 01/20{1920 0.1186455.., | 0.3938497...| 0.4576674...| 0.7742949... 0.6180724...| 0.3237937...| 0.8538720... 0.
ZZ 014211920 0.1121575... | 0.3731963,..| 0.4670284...| 0.7209345... 0.5796547...| 0.2963318,..| 0.6116342,., 0,
23 01/22f1990 0,1900961... | 0.6805094,..| 0.6592942...| 0.1758676... 0.1278266...  0.6638460...| 0.1452%964.., 0,
7;4 n1t2=019an n7375M17. | nR12TneT. | NFF4AR3Z .| NLPNEARAN... | N14TRAM n.A1pznnn._ | N 7arRe7 >n v,

[ Impark ] [ Cancel

Figure5.31 Window after Selecting Select All Data Columns

Pathname Parts

x)

.»'3«:| | B:|*

D | I A [ E—

Pathnarng: | DAY

Start Date: |01Jan1940 |

Start Time: [24:00 |

Linits: | |
Type: |INST-VAL v
Import Mow ] [ Cancel ] [ (a4 ]

Figure5.32 Import Data Window

Data imported

14 data sets imported.
s Close import table or return to table?

[ Close | [ Return ]

Figure5.33 Import Data Confirmation Window

the column and selecting Set Data Column. Thiswill bring up the
window shown in Figure 5.32.
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12. Fill in the additional information and click I mport Now if you are
finished importing data from thisfile, or click OK to select other
columns. When you have selected all the columns you want to
import, click Import Now, or click Import at the bottom of the
table. A confirmation window will appear (see Figure 5.33, page
5-24).

5.5 Retrieving and Importing USGS (NWIS) Data

Y ou can retrieve and import time-series data from the USGS NWIS
database viathe web using the USGS plug-in tool. The USGS
occasionally updates the NWS database with more information and the
USGS plug-in may be updated to reflect changes; check the HEC-
DSSV ue plug-ins web page for updates.

The USGS dataretrieval plug-in will retrieve daily, hourly and annual
peak flows from the NWIS web site. Daily, real-time and peak data
availability can be obtained from the USGS water web site at:
http://waterdata.usgs.gov/nwis. Hourly data information can be obtained
from the USGS IDA (Instantaneous Data Archive) at
http://ida.water.usgs.gov. The IDA isin adevelopmenta phase and only a
[imited number of stations have historical short-term data available.

To use the USGS plug-in, you must be connected to the internet and the
file USGSjar must be located in the Plugins directory for HEC-DSSV ue.

1. Open your DSSfile, from the Data Entry menu, point to Import,
click USGSWeb. Thiswill open the USGS Download plug-in
interface with an empty station identifier table.

2. You can either open a previousy saved table, manually enter the
station information for the stations that you want, or automatically
popul ate the table with alist of stations available on a state by state
basis. An example of the USGS Download window can be seenin

USGS Download (9[=0(ES
File View Edit Help
i I! == Excel
Data Type: | Daily | Stari Date; o End Date: o
[[] Retrieve Period of Record
Import USGS Basin Name Location Cther Qualifier Availahle Awailahle
Data Station ID's (A Part) (B Parl) (F Part) Start End
|| 077500 [CROOKE O ARRGYD LA JUNTA, CO U85 ~
V] 07123000 |ARKANSAS RIVER LA JUNTA, CO. UsSGS O1Aprigi2 305ep2006
V] 7 00 HORSE CREEK SUGAR CITY, CO. USGS 13Apr1940 308ep1947
¥ 7 75 |HORSE CREEK LAS ANIMAS, CO. USGE 010ct1979 305ep1993
O 7 00 |ARKAMSAS RIVER LAS ANIMAS, CO UG8
[l 7 50 MIDDLE FORK PURG...| STONEWALL, CO. USGS
V] 07124100 |MOLINO CARYON WESTOM, CO UsSGS 08Jun1978 11Aug1981
e 07124120 SARCILLO CANYON SEGUNDO, CO. USGS 06Jun1978 308ep1981
[v] 07124200 |PURGATO\RE RIWER |MADRID, CO. USGS 01mar1 972 2BMarz007
V] 07124210 |MULLIGAN CAMYON  |BONCAREO, CO. UsSGS 09.Juni1978 305ep1981
] 07174770 |REN 1Y CANYOR COKENAIE £ L=6s g
[impottopas | [ selectan | [ Unselectal | [ Getavailable Dates |

Figure 5.34 USGS Download Window
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. To open apreviousy saved table, from the File menu, click Open

Station Table. Browseto the directory and file that you want to
access and then click Open. Optionally, you can select afile from
the most recently used filelist at the bottom of the File menu. To
save atable, from the File menu, click Save Station Table.
Browse to the directory where you want to save your table and
then enter the file name and click Save. Tablesare in text format
and are saved with an extension of ".usgs".

. To manually enter station information, select the USGS Station ID

cell on ablank row. Enter the USGS station ID number and then
fill in the basin or river name, location name, parameter and
version in the subsequent columns or accept the defaults provided
after entering the station ID. If you need to add additional rows,
select the Edit menu and then Insert Rows. Fill in the identifiers
for any remaining stations that you want. Once you have
completed your table, save it using Save Station Table from the
File menu.

. 'You can sort the station table by pressing on the column header of

the column that you want to sort by. A second press of the column
header will perform an inverse sort.

. 'You may find thelist of stations easier to use if you delete those

stations that you are not interested in. To do this, highlight the
rows in the table that you want to delete and then select Delete
Checked Rows from the Edit menu. Y ou can save your table by
selecting Save Station Table from the File menu.

. 'You can query for the starting date and ending date of available

datafor selected stations. To do this, select the check boxes for the
stations that you want and then press the Get Available Dates
button. Each station has to be queried independently, so select
only those stations that you are interested in. The date range for
the selected stations will be displayed in the two right most
columns of the table.

. Toretrieve data from the USGS web site and import into HEC-

DSS, select the Data Type you want (either Daily, Instantaneous
(Hourly), Real Time or Annual Peak Data) from the drop down
selector near the top panel of the screen. If you want daily, you
can enter a start date and end date for the time frame that you are
interested in or select the Retrieve Period of Record check box to
retrieve the period of record data. The date should be entered in
the form of DDMMMYYYY (e.g., 03FEB2005). Selecting the
small box in the date field will provide a calendar tool to aid in
setting the date. Even though you may specify dates, only data that
is available within those dates from the web site can be retrieved.

If you want real time data, enter the number of days back that you
want to retrieve datafor. The USGS offers data for the last thrity-
one days for real time data.
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9. Use caution when selecting atime period for instantaneous
historical data, as you might unintentionally request excessive
number of values. For example, if datais given in 15 minute
intervals, ayear's worth of datawill be 35,040 values, which can
take along timeto retrieve.

10. After the data type and time span have been set, select the stations
from the table that you want data for by checking the box in the
Import Data column for those stations. If you want to retrieve
datafor al stationsin your table, press the Select All button. The
dataretrieval process will begin when you press the Import
button. This operation will take some time, depending on your
connection speed to the internet and how much data you have
requested. A Retrieve Progress dialog box will display the
progress of the process. After data has been retrieved, the main
catalog screen in HEC-DSSVue will be automatically updated.

11. Daily datais stored with an E part of "1DAY". Theinterval for
real-time data will be set based on the frequency of the data
retrieved. If the frequency varies, the datawill be storein an
irregular interval format. Y ou may want to use the interval
modification functions available from the Time Functionstab in
the Math Functions screen to change the datato a desired interval.

12. Data can be directly plotted, tabulated or sent to Microsoft Excel
from the plug-in by selecting the desired data sets and then
pressing the appropriate tool bar button. Y ou do not need to
import the data first; it will be automatically imported and stored in
the HEC-DSSfilefor you. To send the datato Microsoft Excel,
you must have installed the Excel plug-in, available from the HEC-
DSSVue plug-in web page, or you must have an Excel capable
version (currently under development) of the program.

13. Some offices require proxy information to be set to access the
internet. Proxy information can be set by selecting the Options
item from the Edit menu. Thiswill display the screen shown in
Figure 5.35. Fill in the appropriate values and then click OK. The
information will be retained between sessions.

Connection Settings E]

Y Direct Connection to the Internet

(%) Proxy Configuration
Proxy Host: Port: 0
[¥] Reguires Authentication

Froxy Lodin:

Fasswiord:

[ Ok H Apply H Cancal

Figure5.35 Connection Settings Dialog Box
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5.6

5.6.1

14. The USGS plug-in currently has limited error detection
capabilities. If you think that there are problems, you should check
the HEC-DSSV ue log screen for messages. Thelog screenis
usually minimized in your task bar.

The USGS plug-in will indicate when data cannot be retrieved, but
it may not give the reason why. Y ou should check the USGS web
page with a browser to ensure that what you are requesting is
available. Theweb addressis. http://waterdata.usgs.gov/nwis for
daily and real-time data, or http://ida.water.usgs.gov/idafor hourly
data.

Importing NCDC Data

Y ou can optionally import climatic datafrom the National Climatic Data
Center using the NCDC plug-in tool. It cannot retrieve data from NCDC,;
NCDC provides climatic dataviaftp. Thistool will import datain the ftp
file that you received.

The NCDC dataimport plug-in will import datain the following formats:
3200 and 3210 (Daily Climatic Data), 3220 (Monthly Surface Data), 3240
(Hourly Precipitation Data), 3260 (15-minute precipitation data), LCD and
3505 (Local Climatic Data), and the GSOD (Global Surface Summary of
Day). The plug-in will import al data from the data file provided using
default names and units. Users may want to rename parts of pathname
and/or delete unwanted data sets.

Obtaining NCDC Data

Data can be obtained via an ftp download from the NCDC web site at:
http://www.ncdc.noaa.gov/oa/ncdc.html. The 3240 datais found at the
address:

http://ols.nndc.noaa.gov/pl ol store/plsgl/ol store.prodspeci fic?prodnum=C0O
0313-TAP-AQ001.

Y ou can obtain alist of the available stations (near the bottom of the page)
after you click the link in the page above to enter the NCDC store. We
have found it more useful to select stationsin the county you are interested
in and allow it to return the datathat it has. To do this, select the Country.
In that page, select the state and then select Counties and then select your
county(ies) and the date range that you are interested in. We recommend a
comma delimited format with station name.

Check the "Inventory Review" box, enter your email address and then
press "Submit Request”. The server will generate a datafile and email
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you whenitisready. Click onthelink in your email (or the onein the last
page you were on, if you waited long enough). This should display the
datafilein your internet browser. Savethisfileto disk and select it from
the NCDC import plug-in. The plug-in will remove any of the html
format that might be present. Data may be free for some government and
educational internet addresses.

5.6.2 Recognized NCDC Formats

The plug-in has been tested with NCDC 3200, 3210, 3220, 3240 and 3260
formatsin all forms. It has also been tested with LCD, GSOD and 3505
delimited formats. It will not import data from non-delimited LCD,
GSOD and 3505 formats. If you have a choice for your format, we
recommend comma delimited with station names. Many of the parameter
typesin 3200, 3220, LCD, GSOD and 3505 formats do not have the units
or type assigned by the importer and they may need to be edited in later, if
needed.

Examples of these formats are:

1. 3240 Comma Delimited:
COCPI D, CD, ELEM UN, YEAR MO, DA, TI NE, HOURO1, F, F, T ME, HOURD2....
041112, 00, HPCP, HI . 1970, 09, 01, 0100, 00000, g, .0200. 00000, ...
041112, 00, HPCP, Hi, 1970, 09, 04, 0100, 00000, . 0200, 00000, ...
041112, 00, HPCP. Hi, 1970 10, 01, 0100, 00000, g. 0200, 00000, ...

2. 3240 Space Delimited with Station Name:

COOPI D STATI ON NAME CD ELEM UN YEAR MO DATI ME
HOURO1
----041112 BROOKS FARNHAM RANCH 00 HPCP HI 1970 09 01
0100 00000
041112 BROOKS FARNHAM RANCH 00 HPCP H 1970 09 04 0100
00000 041112 BROOKS FARNHAM RANCH 00 HPCP H 1970 10 01
0100 00000

3. 3240 fixed:

HPD04111200HPCPHI 19700900010010100 00000g
HPD04111200HPCPHI 19700900010012500 00000
HPD04111200HPCPH 19700900040011900 00005
HPD04111200HPCPHI 19700900040012500 00005
HPD04111200HPCPHI 19701000010010100 00000g

4. 3240 variable:

HPD04111200HPCPHI 19701000010020100 00000g 2500 00000
HPD04111200HPCPHI 19701000180080400 00003 0500 00010 0600 00012
HPDO04111200HPCPHI 19701000200030100 99999[ 1200 99999] 2500 00000
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5. 3260 Comma Delimited with Station Name and html headings:

<META htt p-equi v=Cont ent - Type content="text/htm ; charset=utf-
8" ></ HEAD>

<BODY><PRE>COOPI D, STATI ON NAME

, CD, ELEM UN, YEAR, MO, DA, TI ME, VALUE, F, F

0408§7:BLUE CANYON , 00, QPCP, HI , 1985, 08, 01, 0015

00000, g,
040897, BLUE CANYON , 00, QPCP, HI , 1985, 08, 01, 2500,
00000, ,
040897, BLUE CANYON , 00, QPCP, HI , 1985, 08, 17, 1500,
00003, ,
040897, BLUE CANYON , 00, QPCP, HI , 1985, 08, 17, 1600,
00008, ,

6. 3260 Variable with html headings:

<I DOCTYPE HTM. PUBLIC "-//WBC// DTD HTML 4.0 Transitional//EN'>
<HTM_><HEAD>

<META htt p-equi v=Cont ent - Type content="text/htm; charset=utf-
8" ></ HEAD>

<BODY><PRE>15M)4089700QPCPHI 19850800010020015 00000g 2500 00000
15MD4089700QPCPHI 19850800170041500 00003 1600 00008 1700 00002
2500 00013

15MD4089700QPCPHI 19850800290051700 00004 1800 00011 1900 00003
2000 00002 2500 00020

15MD4089700QPCPHI 19850800300021200 00001 2500 00001
15MD4089700QPCPHI 19850900010020015 00000g 2500 00000

7. 3260 Fixed with html headings:

<! DOCTYPE HTM. PUBLIC "-//WBC// DTD HTML 4.0 Transitional//EN'>
<HTML><HEAD>

<META htt p-equi v=Cont ent - Type content="text/htm ; charset=utf-
8" ></ HEAD>

<BODY><PRE>15M)4089700QPCPHI 19850800010020015 000009
15MD4089700QPCPHI 19850800010022500 00000

15MD4089700QPCPH 19850800170041500 00003

15MD4089700QPCPHI 19850800170041600 00008

15MD4089700QPCPHI 19850800170041700 00002

8. 3200 Delimited:

COCPI D, WBANI D, Prel i m year, nont h, day, Tnax, Tm n, Tobs, Tnmean, Cdd, Hdd, Pr
cp, Fl ag

042294, 99999, , 1989, 12, 29, 56, 37, 46, 47,0, 18, 0, , ,
042294, 99999, , 1989, 12, 30, 65, 33, 37,49,0,16,0, ,0, ,0
042294, 99999, , 1989, 12, 31, 52, 30, 32,41,0,24,0, ,0
,0,42.8,53.0, 32. 6, 65, 25,0,636,0.03,0

9. 3200 Fixed:

DLY29002201SNWD | 19480399990310118 00005 10218 00005 10318 00012
10418 00016 10518 00016

DLY29002201DYSVWNA19480499990310199- 99999M 0218 01100 10318 01100
10499- 99999M 0518 01100 DLY29002201PRCPHI 19480499990310118 00000
10218 00000 10318 00000 10418 00000 10518 00000
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10. 3210 Fixed:

DLY00003017F2MNMD200401A1990310124 21018 00224 04020 00324 13023
00424 31018 00524 DLY00003017F5SCMD200401A1990310124 21023 00224
05022 00324 13025 00424 31022 00524
DLY00003017FMIMHR200401A1990310124 01810 00224 01258 00324 01341
00424 01551 00524

11. 3210 Fixed:

M.Y04111202CLDD D19859999990060100 00000 0200 00003 0300 00000
0400 00032B M.Y04111202DP01NA19859999990060100 00002 0200 00002
0300 00008 0400 00000 M.Y04111202DPO5NA19859999990060100 00000
0200 00001 0300 00001 0400 00000

12. 3220 Delimited:

COCPI D, VBNI D, CD, ELEM UN, YEAR, A, S, MO, DA,  JAN ,F, F, MO, DA, FEB
,F, F, MO, DA, MAR

--, - -----1041112, 99999, 02, CLDD, D, 1985, 9, 9,01, 00, 00000,
'02,00. 00003, , .03,00, 00000

041112, 99999, 02, DPO1, NA, 1985, 9, 9, 01, 00, 00002, , , 02,00, 00002,
, 03,00, 00008

13. LCD Delimited:

Mont h:, 12/2004
Station Nane:, "LOS ANGELES | NTERNATI ONAL Al RPORT" Call Sign:, LAX
Day, Ti ne, St ati onType, Mai nt | ndi ¢, SkyCondi ti ons, Visi bility, Wat her

Type, Dry Bul b 01, 0050, A2 ,-,CLR ,10SM , -, 46 , 7.8,40

4.3,31 , -.6, 56, 3 , VRB, -, 01, 0150, A ,-,CLR ,10SM ,-, 46
, 7.8,38 , 3.5,27 , -2.8, 47, 0 , 000, -, 01,0250, A , -
,CLR ,10SM ,-,45 , 7.2,36 , 2.3,22 , -5.6, 40, 5

, 010, -,

14. LCD Delimited:

Mont h:, 09/ 2002

Station Name:, ASHEVILLE REGQ ONAL Al RPORT (AVL)

DT,H 1, H2, H3, H4, HS5, H6, H7, HS8, H9, H10, Hr1l1, H 12
H 13, Hr14, Hr15

15,.05,.02,.03,.06,.01,.02,.02, T ,.01,T
..02,.09,.06,.02,.04,.05,.01,T ,.0L,T

15. GSOD Delimited:

STN---  YEARMODA TEWMP DEWP SLP STP VI SI B
WDSP MXSPD 010010 20000501 33.2 8 29.9 8 1013.4 8
1012.3 8 8.6 6 4.5 8 13.0 010010 20000502 29.4 8
26.5 8 1015.0 8 1013.8 8 4.1 6 57 8 12.0 010010
20000503 31.3 8 28.7 8 1015.0 8 1013.8 8 6.0 6

2.2 8 5.1 010010 20000504 32.3 8 29.8 8 1000.4 8
999.2 8 2.4 5 8.3 8 13.0
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16. 3505 Delimited:

5.6.3 Importing

AWS  VBAN YR-- MODAHRWN DIR SPD GQUS CLG SKC L M H VSB WV WV WV W
TEMP DEWP SLP 722280 13876 200301010053 140 11 *** 49 OJ/C *
* % 10.1 00 ** ** x 59 54 1003.8 722280 13876 200301010153 140
13 *** 256 OVC * * * 2.5 63 10 ** * 57 54 1003.7 722280 13876
200301010253 170 14 21 14 ovC* * * 3.0 63 10 ** * 57 55
1003. 7

Y ou use the NCDC plug-in after you have retrieved your NCDC datafiles.
Thefile NCDC.jar must be located in the Plugins directory for HEC-
DSSVue. You can import NCDC data by either dragging NCDC files
with an extension of ".ncdc" from Windows Explorer and drop them into
the main screen of HEC-DSSV ue with an opened HEC-DSSfile or by
selecting NCDC from the I mport menu under the Data Entry men

To import NCDC datafilesinto HEC-DSS.

1. Open your DSSfile, from the Data Entry menu, point to I mport,

click NCDC. An Open browser will open (Figure 5.36).

Lookin: I3 formats v T 2 @EE
Y 4] 010015-99989-2006 0p.ncde 4] 3620Placer2.node 4] valoz space.ncde
I;ﬁ m 3220%10lo2.nede m Ashville.nede m yalo3.name.space.ncde
My Recert  |[4] 3220y0l0l ncde i) AshwilleZ ncde 4] yolod fed nede
Documents —|[i4] 3220v0lo3.nede 4] Bath.ncde 4] yolos varishle ncde
I m 32f0nam.ncde m gsod.nede
La |14] 3260P1acer nede 1] ulcdhourobasciincde
Desktop m 3260Placerd.ncde m ulcdhourprepasciincde
) 14] 3505datnede 4] yolo1 comma.ncdc
My Documents File name:
-
:_!J'g Files of type: v
Save data as: (3 Regularinterval fnormaly O Irregular interval O Irregular interval with no implicit zero values

Figure5.36 Open Browser - Import NCDC Files

2. Navigate to the directory with your datafile, select the file and

then click Open.

3. The plug-in will read the file, parse the data and store it into the

opened DSSfile. This process may take severa seconds to
complete, depending on the amount of data and speed of your
machine. After the import is complete, a confirmation window will
appear, see Figure 5.37 (page 5-33).

Or, alternatively you can import NCDC filesif they have the extension
".ncdc" by:
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NCDC Import

@ Imported 544500 values in 6 data sets,

Figure5.37 Import NCDC File(s) Confirmation

1. From Windows Explorer, select the "ncdc” files that you wish to
import.

2. "Drag" thefiles onto the main HEC-DSSV ue screen (with your
HEC-DSSfile that you want to import to opened).

3. The dataisimported and a message dialog will show how many
values were stored.

5.7 Retrieving and Importing CDEC Data

Y ou can optionally retrieve and import time-series data from the CDEC
(Cdlifornia Data Exchange Center) database viathe web using the CDEC
plug-intool. It can retrieve avariety of hydro-meteorological and
environmental data from CDEC for stations throughout the state of
Cadlifornia. 'Y ou must enter the station information (station 1D, sensor,
duration code, and time window) manually into the plug-in table. The
plug-in has no capability to identify which stations and what datais
available from CDEC. Station ID and data availability can be obtained
from the CDEC web site at: http://cdec.water.ca.gov.

To use the CDEC plug-in you must be connected to the internet and the
file CDEC.jar must be located in the Plugins directory for HEC-DSSV ue.

1. Open your DSSfile, from the Data Entry menu, point to I mport,
click CDEC (Web), thiswill open the CDEC Download dialog
box (Figure 5.38) with an empty station identifier table.

File Edit Options Help
Start Diate: 1.Janzo0s)
Endl Diate: 01Mar2005()
GetData| CDEC APart B Part Sensor CFart Duration F Part
Station D Mumhber Code
O] FLD  [AMERICAN _ |FOLSOM LAKE 45 |PRECIP-ING Daily CDEC |a
B FLD  |AMERICAN _ |FOLSOM LAKE 17 |ATMOSPHERIC FRESSURE Event CDEC
O FLD  |AMERICAN  |FOLSOM LAKE 16 |PRECIF-ACCUMULATED Event CDEC
O FLD  |AMERICAN _ |FOLSOM LAKE 12 |RELATIVE HUMIDITY Event COEC
B FLD  |AMERICAN _ |FOLSOM LAKE 4 [ TEMP-AR Event CDEC
O FLD  |AMERICAN _ |FOLSOM LAKE 10 |WIND DIRECTION Event CDEC
O FLD  |AMERICAN _ |FOLSOM LAKE G |WIND SPEED Event CDEC |,
[ seectan | [ Desetectan |
Get Data

Figure 5.38 CDEC Download Dialog Box
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2. You can either open a previously saved table or manually enter the
station information for the stations that you want. The CDEC
plug-in cannot populate the table; you must manually enter the
station information.

3. To open aprevioudy saved table, select the File menu and then
Open. Browse to the directory and file that you want to access and
then press the Open button. Optionally, you can select afile from
the most recently used filelist at the bottom of the File menu. To
save atable, select the File menu and then Save. Browse to the
directory where you want to save your table and then enter the file
name and press the Save button. Tables are in text format and are
saved with an extension of ".cdec”.

4. To manually enter station information, select the CDEC Station ID
cell on ablank row. Enter the ID and then fill in the basin or river
name, location name and sensor number. For each sensor, a
default C part will be provided; you can change the C part, if
desired. Enter the duration code, which may be "Monthly",
"Hourly", "Daily" or "Event". The duration code must match the
data set offered by CDEC for that location and sensor; it will not
retrieve data that does not have that duration code. (Y ou need to
access the CDEC web site at http://cdec.water.ca.gov to determine
what data sets are offered with what duration codes.) A default F
part of "CDEC" will be set but you can change that, if desired. If
you need to add additional rows, select the Edit menu and then
Insert Rows. Fill intheidentifiersfor any remaining stations that
you want. Once you have completed your table, save it using Save
from the File menu.

5. You can sort the station table by pressing on the column header of
the column that you want to sort by. A second press of the column
header will perform an inverse sort.

6. You can get alist of all sensor numbers, PE Codes and other
information that CDEC has available by selecting Stations
Definitions from the Options menu, as shown in Figure 5.39.
These are the codes that CDEC uses, not necessarily what is
available for each station.

Station Definitions @

Sensor | Sensor | PE Code Descriptian Units Dss D55
Ma. Parameter Units

1 RIV5TG HGHZIZAE | RIVER STAGE FEET STAGE A

2 RAIN PCHZZEZZ |PRECIPITATION-ACCUMULATED INCHES |PRECIPITATION-ACCLL..

3 SMNOWWE | SWHZZZZ | SNOW-WATER CONTENT INCHES

4 TEMP TAHZZZZ | TEMPERATURE-AIR DEGF TEMPERATURE-AIR

g EL CND WCIZZZZ |ELECTRICAL CONDUCTNTY MILLI S |mBiem  [EC UnHO...

B RES ELE |HLHZZZ |RESERVOIR ELEVATION FEET ELEVATION-RESERVOIR

7 REL 5CH |QZ1Z777 |RESERVOIR-SCHEDULED RELEASE [CFS FLOW-RESERYOIR SC...

g FMNF QMIZZZZ | FULL NATURAL FLOWY CFS FLOW-FULL NATURAL

g WIND SP | USIZZZE WIND-SPEED MPH WINDSPEED

10 WIND DR [ UDIZZZE WIND-DIRECTION DEG WINDDIRECTION

11 FUEL M5 |MMIZZZF |FUEL MOISTURE-WOOD ki) v
Close

Figure5.39 List of Station Definitions
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7. To retrieve datafrom the CDEC web site and import into HEC-
DSS, open or fill-in the station table as describe above, and then
enter the start date and end date for the time frame that you want
datafor. (The date boxes cannot be empty like they can for the
USGS plug-in.) The date should be entered in the form of
DDMMMYYY (e.g., 03FEB2005). Selecting the small box inthe
date field will provide a calendar tool to aid in setting the date.
Even though you may specify dates, only datathat is available
within those dates from the web site can be retrieved. Y ou should
check the CDEC web site (at http://cdec.water.ca.gov) to verify
what datais available for the stations that you are interested in.

8. After the data type and time span have been set, select the stations
from the table that you want data for by checking the box in the
Get Data column for those stations. If you want to retrieve data
for al stationsin your table, press the Select All button. The data
retrieval process will begin when you press the Get Data button.
This operation will take some time, depending on your connection
speed to the internet and how much data you have requested. A
Retrieve Progress dialog box will display the progress of the
process. After data has been retrieved, the main catalog screenin
HEC-DSSVue will be automatically updated.

9. Monthly, daily and hourly datawill be stored with an E part of
"IMON", "1DAY", or "IHOUR", respectively. Event datawill be
stored in an irregular-interval format with an E part of "IR-
MONTH". You may want to use the interval modification
functions available from the Time Functionstab in the Math
Functions screen to change the datato adesired interval.

10. The CDEC plug-in currently has limited error detection
capabilities. If you think there are problems, you should check the
HEC-DSSV ue log screen for messages. The log screen isusually
minimized in your task bar.

The CDEC plug-in will indicate when data cannot be retrieved, but
it may not give the reason why. Y ou should check the CDEC web
page with a browser to ensure that what you are requesting is
available. Theweb addressis: http://cdec.water.ca.gov.

5.8 Importing and Exporting DSSUTL Format

Y ou can import HEC-DSS data from the legacy DSSUTL program that
was created using the "Write Data’ WD command and export data from
HEC-DSSVueto the DSSUTL "Write Data' format so that it can be read
into DSSUTL with the "Read Data” RD command. Refer to the DSSUTL
documentation for more information. The function is supplied as aplug-in
and the file Dssutl.jar must be located in the Plugins directory for HEC-
DSSVue.
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5.8.1

An example of the data format from DSSUTL is:

/MY BASIN/RIVERSIDE/FLOW/01MAY1990/1HOUR/OBS/
RTS Ver: 44 Prog:GOES LW:02JUN90 10:09:33 Tag:RIV-FLOW Prec:0
End: 04MAY1990 at 1200 hours; Number: 108

Start: 01IMAY1990 at 0100 hours;
Units: CFS Type: INST-VAL

13190. 13820. 14630. 15080.
15890. 15980. 14540. 14990.
13010. 12200. 11660. 11570.
12380. 12290. 12740. 13010.
13910. 13010. 11930. 10740.
10200. 10660. 10660. 10275.
10275. 10740. 11570. 11390.

15260.
15530.
11930.
12830.
10050.

9975.

10580.

15530.
15170.
11930.
12830.

9750.

15620. 15710. 15800.
14630. 14360. 14000.
11930. 12290. 12290.
13190. 14630. 14900.
9620. 9685. 9685.

9825. 9900. 9975. 10200.

10125.

10425. 10500. 9555.

8150. 9036. 9230. 9295. 9230. 9295. 9230. 9100. 9100.
9100. 8908. 9036. 9100. 9165. 9295. 9425. 10125. 10275.
9825. 9555. 9555. 9750. 9685. 9685. 9620. 9555. 9555.
9490. 9555. 9620. 9750. 9825. 9825. 10125. 10275. 10740.
11220. 11660. 12110. 12470. 12650. 12560. 12560. 12470. 12470.

END FILE

Importing DSSUTL Data

To import data from the DSSUTL format:

1. Open your DSSfile, from the Data Entry menu, point to Import,
click Dssutl Write Data File, the Enter DSSUTL datafileto
import browser will open (Figure 5.40).

B Enter, DSSUTL data file to import

Lookin: |15 Temp

Mame

___j |£] forecast.dss

H GreenRiver.bxb

lﬂ__l] Greetings All.doc

—(l-} grid.dsc
|ﬂ qgrid.dss

My Documents [:J Guad. bt
m Guadhlet.dss
- £
h!_.5 [l GUADMET1.TxT
¥ [Z] GuadMetiooyr bt

My Computer | 1) GuadMet100¥rMad

. ‘
!_.' File name:

Ty Metwork
Places Files of kvpe: | all Files

Greenk

Recent g.dsc
|ﬂ g.dss
gl.dsc
@ m gl.dss
Desktop Graphics Enhancements Desi...

Wkt

iver . bxt

X
v P EE
Size Type Dake Mod
41,410 KE D55 File 41212009 £ m
9KE DSCFile /252009
2,819KE D35 File 3j20{2009
1KE DSCFils 3/25/2009
89KB D55 File 3/25/2009
1,363 KE Adobe Acrobat Doc...  5/14/2009
TKE Text Document 69/2009 -
Z5KE Microsoft Word Doc...  4/2Z7/2009
1KE DsCFile 512&/2009
94 KB D55 File g/2a/z2009
2KE Text Document 6)5/2009 :
18 KE D35 File &/5/2009
OKE Text Document 5/15/2009
24 KB Text Document 5115/2009
2KB Texk Document BS[2009 [
>
Qpen
;

Figure5.40 SelectingaDSSUTL Write Data File to Import

2. Select your fileto import. Data must be produced by the DSSUTL

WD command.
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3. Navigate to the directory with your datafile, select the file and
then click Open.

4. The plug-in will read the file, parse the data and store it into the
opened DSSfile. This process may take several secondsto
complete, depending on the amount of data and speed of your
machine.

5.8.2 Exporting Data to DSSUTL
To export data from the DSSUTL format:

1. Select the pathnames for the data sets that you want to export, then
from the Data Entry menu, point to Export , click Dssutl Write
Data File.

2. A file selection browser will be displayed. Navigate to the
directory you wish to export the data to, type the name of file and
Click Save. All datawill be saved in onefile.

5.9 Importing North Carolina DWR CRONOS Data

The North Carolina Department of Water Resources developed a plug-in
to import datafrom the CRONOS database into HEC-DSS. This plug-in
is supported by North CarolinaDWR. For questions, please contact them
directly. Theweb siteis http://www.ncwater.org/wrisars/dss.

The CRONOS Plug-in, developed by NC DWR, can search and retrieve
the water and weather data for North Carolina and the surrounding states
from NC Climate Retrieval and Observations Network of the Southeast
Database (CRONOS) and store the datainto aHEC-DSS file. The map
and table search engine in Water Resources Information, Storage,
Analysis, and Retrieval System (WRISARS) can be used with the
CRONOS Plug-in to enhance the search capability. An example of the
NC DWR CRONOS Download dialog box is shown in Figure 5.41 (page
5-38).

To import data from CRONOS:

1. In HEC-DSSV ue, create anew DSS file or open an existing one.

2. In the HEC-DSSVue main window, from the Data Entry menu,
point to Import, click NC DWR CRONOS, as shown in Figure
5.42 (page 5-38) the NC DWR CRONOS Download dialog box
will Open (see Figure 5.41, page 5-38).
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NC DWR CRONOS Download 10l x|

File Wiew Edit Help

PR

DataType: |SurFace Water;l DataTabIe:lWater Dain;l Gek Stations by Stake | Get Stations by HLIC| Ird Clear_‘
Import | CROMOS | Basin Mame Skation MName Other Qualifier | Awvailable | Awailable
Data | Station IDs [ Part) (B Part) (F Part) Skark End
™ |n204343500 [Albemarle INTRACOASTAL WATE,.. [CROMNOS-USGS |1995-02-12 [2007-10-03 ﬂ
[T |n2043sza00 (Albemarle PASQUOTANK RIVER M., [CRONOS-USGES |1995-02-01 [2009-03-31 =l
[ 02050160 | Chowan CHOWAN RIVER NEAR.,., |CROMOS-USGS |1974-04-01 |1976-03-31
[ 02053200 |Meherrin POTECAST CREEK MNEA. .. [CROMNOS-USGS |19558-04-01 [2009-03-31
[l 02053244  |Chowan CHOWAN BAT WINTO,,, [CRONOS-USGES |1974-04-01 [1976-03-31
[ 02053400 | Chowan AHOSKIE CREEK MEAR.,., |CROMOS-USGS |1964-07-01 |1973-09-30 v|

[+ Retrigve Period of Record  Stark Date: I 23Marz009 .| End Date: I 23Marz009 . |

Select Parameters and Import | Select all | Unselect All | Refresh Available Dates |

Figure5.41 NC DWR CRONOS Download Dialog Box

test7.dss - HEC-DSS¥ue

File Edit V¥iew Display Groups | DataEntry  Tools Advanced Help

—u = e
= | dZE5
J |_ Manual Paired Data. ..
File Name: IC:nNenIinNnrkanris Manual Text. .

Pathnames Shown: 4 Pathnarme:

Manual Time Series...

Irnpark M

E
Expork
Search A I —
By Parts: [ | x| Text fromFile...
Images. .. —
Mumber Part & Part B [ . I
Files (@eneric type).,, pP——
HA WWHITE QA CR AT G... |FL 0oz -

-
Figure5.42 Importing ND DWR CRONOS Data

3. From the NC DWR CRONOS Download dialog box (Figure
5.41) from the Data Typelist (Figure 5.43), select a datatype for
the data to be imported.

Data Twpe: |al ;I

Figure 5.43 Data Type Selection

4. Set the format for the data that isto be imported, from the NC
DWR CRONOS Download dialog box (Figure 5.41), from thet a
Data Tablelist (see Figure 5.44, page 5-39), select the data table
style.
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10.

11.
12.

13.

14.

15.

16.

17.

18.

Data Table: |\Waker Daily ;I
Waker Daily

3

X Water Pealk

Weather Daily

Draily Percentile

Monthly Percentiles
Z0P Doaily Mormal
0P Monkhly Mormal
Figure5.44 DataTable Selection

From the NC DWR CRONOS Download dialog box (see Figure
5.41, page 5-38), click Get Stations by State, then select a state
from the Select State list, or click Get Stations by HUC, and then
select aHUC. Click OK to search the stations and you will see the
selected stations in the station table.

If you select Clear Stations, then the station table will be cleared
when you select another group of stations.

If you want to do a more specific search, click Use WRISARS
Search Tool, thiswill lead you to the WRISARS search page.

Y ou can save the station table to a .cronos text file by from the
File menu, click Save Station Table.

Y ou can open apreviously saved station table from an existing
.cronos text file, from the File menu, click Open Station Table.

Y ou can open a station table directly by clicking afile name (e.g.
SationTableC.cronos) below the Close section from the File
menu.

Select stations in the station table.

Y ou can click the column title to sort the station table by that
column, e.g. click Available End to sort by the available end
timestamps. The columnsin the table are shown in Figure 5.45.

Import | CROMNOS Basin Mame Station Mame Cther Qualifier | Available | Awvailable
Data | Station IDs & Part) (E Part) (F Part) Stark End

Figure5.45 Column Header Titles

To select or unselect al the rows in the station table, click Select
All or Unselect All, respectively.

Y ou can del ete the checked rows from station table, from the Edit
menu, click Delete Checked Rows.

Y ou can also add rows in front of the current row, from the Edit
menu, click Insert Rows.

If you want to use the Station IDs for B parts, from the Edit menu,
click Set B Part to Station ID.

If you want to use the station names for B parts, from the Edit
menu, click Set B Part to Station Name. The stations names are
used for B parts by default.

If you just want to import a part of the data, then set up the Start
Date and End Date, otherwise select Retrieve Period of Record.
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19.

20.

21.

22.

(You can click Refresh Available Date to get the most accurate
available datesinformation.) See Figure 5.46 for an example of
this toolbar.

¥ Retrieve Period of Record — Stark Date: I Z3Mar2009 ] End Date: I 23Marz009 ..

Figure5.46 Setting the Time Window for Data Retrieval

Click Select Parametersand Import to open the Select
Parameter s window for the selected stations. The descriptions for
the parameters are shown on the right of the window. By default,
all parameters are selected. Click Unselect All or Select, or you
can select afew parameters manually. If you select the upper
checkbox in the All column, then the whole row will be selected
automatically. Click Import to import the data from the CRONOS
database to the DSS file you just opened or created. An example
of the Select Parameter swindow is shown in Figure 5.47.

=101 x|
all | Station ID Station Mame 4 |Agency| Twpe |Subkypeldy_wa|7daw | Column Description
— ¥ | [T |dv_va [Flow (Daily Averaga|
™ [0z089222 [BEAR CREEK MEAR. PAR USG5 |surface v I~ |Fday [7-Dav Average
| i02129000 |PEE DEE R WR ROCKING|USGS  |surface [P |14day |14-Day Average
[~ |D2112000 YADKIN RIVER AT WILK |USGS  |surface ¥ | |30day |30-Day &verage
60day |60-Day Average

Q0day |90-Day Average

tmo  |1-Maonth Average
Zmao |[2-Maonth Average
3mo |[3-Maonth Average |7

Kl I 3| K1 [

Import | Select All | Unselect Al |

Figure5.47 Select Parameters Dialog Box

You can click Plot| 4 , Tabulate=E , or Tabulatein MS Excel |2€]
open the Select Parameter s dialog box, select some parameters,
and then import the data and show the datain a plot, table, or Excel
directly.

From the View menu, click Tabulate, Plot, or Tabulate with
Excel to import the selected station-parameters and show the data
inaplot, table or Excel.

Examine the imported or updated datain HEC-DSSV ue root
window, table, plot, or Excel.
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CHAPTER 6

Customizing Plots

Plots are highly customizable and offer an array of information that will
assist you with reviewing your data. A sample plot illustrating raw and
revised data for stage and flow at alocation called Beech Creek Station is
shown in Figure 6.1.

Title Baw JIBEECH CREEK STA/FLOW-REG--INST/010CT1993/IR-MONTHIDCP-RAW/ =13
Menu Bar ——jpdl File Edit  View

Z.o0om T ool = @

Pointer Tool —ijp

300
250+
@ 200+

150
J %mﬁmgem%mwm

100

Flow (cm:

50

o
m o
1 1

Stage (M)
w
{=]
L

251/

T T T T T T
00:00 12:00 00:00 12:00 00:00 12:00
| 28Noviag3 | 29Moviga3 | 30Mov1993
—e— BEECH CREEK STA DCP-RAW FLOW-REG--INST —8— BEECH CREEK STA DCP-REY FLOW-REG--INST
BEECH CREEK STA DCP-RAW STAGE--INST ~ ------ BEECH CREEK STA DCP-REY STAGE--INST

Figure 6.1 Plot Dialog Box

With the Pointer Tool , YOu can access shortcut menus that alow you
to customize features of your plots using the plot window’ s editing tools.
The following sections discuss these tools in detail.

The Zoom Tool @ allows you to "zoom in" and view data more
precisely at smaller timeintervals. To zoomin, first select the Zoom
Tool, then hold the left mouse button down and pull down to the right
forming a square around the area you wish to zoom in to. The plot will
redraw, magnifying the areain the square when the mouse key is rel eased.
Right-click to zoom out or from the View menu, click Zoom to all.

If you wish to keep the plot window on top of all open windows on your
desktop, from the View menu, click Alwayson Top, acheck mark
indicates this option is active.
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6.1

Customizing Plots: Overview

Plot properties editors alow you to configure default properties for plots
aswell as customize individual plots. The features of plots that you can
configure are shown in Figure 6.2.

Default Piot Praperties

Curves | yiewport | Title | Axis | Legend

IBEECH CREEK STA/FLOW-REG--INST/O10CT1993/IR-MONTH/DCP -RAW/ Properiies

Style | Legend Item | Quality Symbols | Ssiect Wiewport: -]
Missing Value Symbols Curves | Viewport | Title | Avis | Legend | Marker Lines | Layout
[] Drawe Missing Values Symbols Curves ECH CREEK STA DCP-RAW FLOW-REG--TNST 1)
BEECH CREEK STA DCP-REV FLOW-REG-INST i
o ] Draw Curve ] 5haw in Lagend [ Removs cur e
DS5 Path:  (/BEECH CREEK STAFLOW-REG--INST/010CT 1993/IR-MONTH/DCP AW/
ath: c ARG ¥ 4
— ;
J Style | Legend Item | Qusity Symboks
line oint
Gl [Z] braw Points
Color; — - Styler - =
e — Lie Color: | N thue -
ERRE: == L Fil Color: | N bhue >
Fili (3 None
S —— Major ¥ Grid Border
[tmport... | [ Export.., ] Ovaw Mor v Grid ] Drawi Border
Type: O Rel Colort [ ight gray v Color: | NN black  ~
] tnterpolate f Style: = Style: v

Stife: v
Missineg Value 5ymby Weight: [ Welght: [
[ Draw pssing Y
Minor ¥ Grid Minar ¥ Grid

[ [ Draw Minor ¥ Grid [[] raw Minar ¥ Grid
-

—1
oK el

Figure 6.2 Configurable Features of Plots

Title: Optionally, you can add atitle to the plot display.

Panel Background Color: You can specify the background color
of the plot window. By default, the panel uses the same
background color the HEC-DSSV ue application uses.

Curve: You can choose the line and point styles, add alabel, and
specify data quality symbols to curves.

Marker Line: Marker lines can be added on the X and Y axis.
Y ou can customize their line styles and give them labels.
Viewport Spacer: You can specify the distance between
viewports.

Callout: You can add descriptive callouts at specific points aong a
curve. Customizetheir fonts, borders, and backgrounds.
Viewport: You can customize the borders around each viewport,
their background color, pattern, and transparency, and the
appearance of the gridlines.

Label: Label fonts can be customized by color, style, and size.

Y ou can also give labels borders and background colors and
patterns or choose to hide them.

AXis: You can adjust the scale, set aminimum or maximum,
major and minor tic intervals, reverse the axis, switch x and y,
change label styles and text, and customize tic marks.
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m Legend: You can add titles to the plot legend, specify thelegend's
location in the plot window, add left and right blocks of text or
graphics, change the background color, pattern, and transparency,
or remove the legend from the plot window.

6.2 Using Plot Editors

Different plot editors allow you to set specific properties for individual
plots or set default plot properties for all plots. Three examples of these
editors: the Default Plot Properties editor, the Plot Properties editor,
and the Viewport Properties editor are shown in Figure 6.3.

Default Plot Properties
Cuirves || viewport | Ttle || Ais | Legend
Style | Legend Item  Qualty Symbols | Select Viewport: | [EETIEN] -
Missing Valus Symbals Curves | Viewport | Tele | Ak | Legend | Marker Lines | Layout
[_] Draws Missing values Symbals Ll
BEECH CREEK. STA DCP-REV FLOW-REGINST -
& Eltrmicive [l showinLeoend
DSS Patht  |/BEECH CREEK STAJFLOW-REG-INST/010CT1993{IR-MONTH{DCP-RAW/
A— ath: ~INST/OL ¥ X
==
| Style | Legend Ttem | Qualky Symbals
1~ ine it
[ trawtre [0 ol
Color: — St ~ =
Sk ¥ Line Color: NN b >
Yok Fil Color: | NN Ehoe v
Fill: (=) Nons Viewport (1,1) Properties
Major ¥ Grid Mator ¥ Grid L
Import.. Export.. e G -
[[impat... ] [ Epor. ] [ Drawi Major % Grid Draw Major ¥ Grid [] Oraw Border
yoe: O st Color: [ ightgray Color: [ lght gray Color: NN blsck
[ 1nterpoiate Style: 5 Styler = Style: v
. - ‘Weight :
Wissing Yaiue Symb weight: ¥ wieight b _
[ Draw Missing
Minor % Grid Hinar ¥ Grid Background
L [ Draw Minor % Grid [ Draw Minor ¥ Grid [7] Draw Background
=
I [ 1
| |
o]

Figure 6.3 Examples of Plot Properties Editors

6.2.1  Setting Defaults vs. Customizing Individual Plots

Plot editors and tools fall into two categories in terms of function: either

they alow you to specify defaults for all plots you create or they allow
you to customize individual plots.

Across these two functional categories, the plot editors and tools allow

you to edit avariety of plot properties, or they can be specialized editors
that allow you to edit asingle property.

To configure the default appearance of all plots, use the Default Plot
Properties editor and Default Line Styles options editor. All settings you

specify in these editors will apply to future plots you open. Default editors
can only be accessed through the plot's Edit menu.
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6.2.2

To customize individual plots, use the Plot Properties editor and the
Configure Plot editor, accessed through plot windows using the Edit
menu. Y ou can display specific plot property editors by right-clicking on
components displayed in the plot window.

Once you have customized an individual plot, you can export its settings
asaTemplate that can be applied to other plots. See Section 6.12 for
more detail on templates.

Accessing Editors

Y ou can access plot property editors from shortcut menus and from the
Edit menu of the Plot dialog box (Figure 6.4).

cjaﬂlybt =y

BEECH CREEK S5TA DCP-RAW STAGE--INST

Edit Properties

ide Curvi [
:er:;w Czwe //IBEECH CREEK STA/FLOW-REG--
DO:[DD 12;0 Add Callout File B[S View

‘ 29Noy1993 |  Hide Callouts E Plot Properties ...

Clear Callouts ¢
OW-REG--INST —8— pccon URECH O 1A DCF-REY LUV Configure Plot Layout...

AGE--INST ~ ------ BEECH CREEK STA DCP-REY STAG Q

Defaulk Line Styles... -

Default Plot Properties. .. 7

5 zool aaﬁ

Use these menus according to whether you are defining properties for an
individual plot or setting default properties for all plots you create.

Use shortcut menus to edit specific components of an individual plot. For
example, if you want to edit axis label properties on aplot, right-click on
the axis label (see Figure 6.5, page 6-5), then select Edit Propertiesfrom
the shortcut menu.

Figure 6.4 Accessing the Plot Property Editors

Use the Edit menu of a plot window to access the Plot Properties editor,
Default Line Styles options editor, Default Plot Properties editor, and
Configure Plot editor. These editors allow you to edit avariety of plot
properties.
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Figure 6.5 Edit Properties
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6.3 Plot Editors and Tools

The following sections are an overview of the editing tools that allow you
to customize plots. Later sections provide more detailed instructions on
editing specific plot properties using these tools.

6.3.1  Plot Properties Editor

The Plot Properties editor (see Figure 6.6, page 6-6) is accessed from the
Edit menu of aPlot dialog box by clicking Plot Properties. It allowsyou
to configure multiple display properties for the individua plot, including
the Curves, Viewport, Title, Axis, Legend, Marker Lines, and the

L ayout or properties of the plot window panel.

When you customize properties of aplot using the Plot Properties editor,
your changes apply only to the individual plot displayed; unless you
export the plot’s propertiesin atemplate (see Section 6.12).

6.3.2 Individual Plot Property Editors

When you want to edit a specific property of a plot without launching the
Plot Properties editor (discussed in Section 6.3.3), you can use individual
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J/BEECH CREEK STA/FLOW -REG--INST/O10CT1993/IR-MONTH/DCP-RAW/ Properties
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Figure 6.6 Plot Properties Editor

plot property editorsinstead. Theseindividual plot property editors

correspond to the tabs of the Plot Properties editor.

To access an individual plot property editor,
right-click on the component you want to edit
and then select Edit Propertiesfrom the
shortcut menu. For example, if you right-click
inside the gridded plot area, called the viewport,
you will seethe Viewport shortcut menu

Viewoort

Edit Properties
add Marker

b

(Figure 6.7). When you choose Edit
Properties, the Viewport Properties editor will
open (Figure 6.8).

Viewport (1,1) Properties
Major ¥ Grid Majar ¥ Grid EBorder
Dray Major % Grid Draw Major ¥ Grid Drawe Barder
[T Thoht aray ] Cobor [ gt gray v | Color: N black |

Styler | v Style: | v/ Styler | —— fj
Weight: | .:i weight: | v Weight: :’_i
Minor ¥ Grid Minor ¥ Grid Background
[ Drav Minor % Grid [[] Draw Minor ¥ rid [ Draw Background

Menu

X

Figure 6.8 Viewport Properties Editor

Figure 6.7 Viewport Shortcut
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The Viewport Properties editor lets you edit only properties associated
with that particular viewport, using the same options that appear for
viewports in the Plot Properties editor.

Other individual properties editors are the Edit Title Properties, Axis
Properties, Curve Properties, Label Properties, Marker Properties, and
Legend Properties.

The only plot property you cannot edit using an individual property editor
isthe Layout. (See Section Error! Reference source not found. for
more information.)

6.3.3 Configure Plot Editor

The Configure Plot editor (Figure 6.9) is accessed from the Edit menu of
aplot and alows you to customize the data configuration of an individual
plot. You can add and remove axes and add, remove, arrange the order of,
and set the weight of viewports in the plot window.

Configure Plot
Plot  Edit

Selected Data Jets
ﬁ.'ﬁ'iewpnrt l-:.lj-l-} I{Etl%]i"
(= 3t Left v s ()
won BEECH CREEE STA DCP-RAW FLOW-REG--INST
_ -~ BEECH CREEK STA DCP-REY FLOW-REG--INST
F9] viewport (2,1) (50%)
(= 3t Left v s ()
wn BEECH CREEK STA DCP-RAW STAGE--INST
-~ BEECH CREEK STA DCP-REY STAGE--INST

=

b

2K Cancel

Figure 6.9 Configure Plot Editor

When you customize the layout of a plot using the Configure Plot editor,
your changes apply only to that individual plot; unless you create a
template from the plot’s properties (see Section 6.12).

To access the Configure Plot editor, from the Edit menu, click Configure
Plot Layout. See Section 6.11 for more information on this editor.
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6.3.4

6.3.5

Default Line Styles Options Editor

With the Default Line Styles options editor (Figure 6.10), you can specify
the default line and fill styles, aswell aslabels, used across all plotsfor
specific parameters.

* | Default Line Style Options g@gl
File
Ling Styles Line | Label| Defauts |
Line Line Foint
MName Parameter | Type | Mumb LinefFill © None & fiond
= & Custom " Custom
cer Bev  wL Tl 2| oo [ e ] B
Elev Elev ALL w 3 Style ’7—;| ﬁ
Elev Elev ALL ¥ 4] — Weight ’_—;l ﬁ
Elev Elev ALL v 5| —— ’—J
Elev Elev ALL f| —— Fill. & Mone " Below ¢ Above
Elev Elev ALL ¥ 7| — ﬁ
&
Elev Elev ALL v 8| — -—_|
Elev-Zone Elev ALL ¥ T =
Elev-Zone Eley ALL ¥ ] FE T Type: © Stepped  Linear
Elev-Zone Elev ALL - 3| ——————— [ Interpolate between missing values o)
Elev-Zone Elev ALL v 4 === Missing Value Symbols
Elev-Zone Elev ALL v Gl & Mone ,7
Flow Flow ALL - 1| —  Custom
Fl Fl ALL ¥ 2| —
Oy Oy ,ﬁ
Flow Flow ALL ¥ 3 I
Flow Flow ALL - F | ﬁ Sample
Flow Flow AL ¥ 5 — |—<|
Flow Flow ALL ¥ 4 ﬂ
|Opened CiADocuments and Settings\Charley. CEWRC-HEC\WdefaultLineStyles.config Modified

Figure 6.10 Default Line Styles Options Editor

To access the Default Line Styles options editor, from the Edit menu,
choose Default Line Styles.

Refer to Section 6.5.2 for more information on the Default Line Styles
options editor.

Default Plot Properties Editor

The Default Plot Properties editor (see Figure 6.11, page 6-9) allows you
to configure the default display properties of al plots you create.
Properties you can configure include Curves, Viewport, Title, Axis,
Legend, Marker Lines, and L ayout, which include the miscellaneous
properties of the plot window panel.

When you customize plot properties using the Default Plot Properties
editor, your changes will apply to al future plots you create. 1f you would
like to apply them to the plot you currently have open, you will need to
close and then reopen it first.

To access the Default Plot Properties editor, from the Edit menu, click
Default Plot Properties.
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Default Plot Properties
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Figure6.11 Default Plot Properties Editor

6.4

Customizing Plot Titles

Y ou can add titlesto individual plots and configure default properties for

al plot

Toadd

titles.
or edit atitle on an individual plot, you can either:

From the Edit menu, click Plot Properties. When the Plot
Properties editor opens, click the Title tab.

-Or-
Right-click in the blank area above the
plot (below the menu bar) with the
Pointer Tool (%], and then click Edit
Properties from the shortcut menu
(Figure 6.12). The Edit Title
Properties editor will open.

Title:

Edit Properties

i
Figure6.12 Shortcut Menu -
Title Properties

To specify the appearance of titlesfor all of your plots, from the Edit
menu, click Default Plot Properties, then select the Titletab of the
Default Plot Properties editor.

Whether you are using the Plot Properties editor, the speciaized Title
Properties editor, or the Default Plot Properties editor, the worksheet for

editing

plot title propertiesis the same.
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The Edit Title Properties editor is shown in Figure 6.13. This editor

contain
the Def

s the samefields asthe Title tab of the Plot Properties editor and
ault Plot Properties editor.

Edit Title Properties @

Text

Fant
Fonk:

Skyle:

Size:

Shiow Plat Title
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Color | I black

Border
Dialog “ Dravw Barder
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12

Ise Fork Scaling Background
Min Size: |5 w| MaxSize! |1g [] Draw Background
I
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Beech CTeek ]
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Figure 6.13 Edit Title Properties

1.
2.

3.

8.

To specify atitle for the plot, check Show Plot Title.

In the Text field, type the title you want displayed in the plot
window.

In the Font section of the editor, select the font type from the Font
dropdown list. Choose the Style; Bold and/or Italic, Color of the
font, and a Size of your text.

. The Font section also includes the option to set Use Font Scaling.

Checking this option and selecting aMin Size and Max Size, will
set the minimum and maximum size your font can adjust to when
resizing the plot window. If thisoption is not selected, the font
size will remain constant regardless of the window's size.

Below the Font section on the editor is the Alignment setting of
the title. Alignment can display the tile text Center, L eft, or
Right.

The Border section allows you to add a border around the title.

Y ou can specify the Color, line Style and Weight.

The Background section lets you add a background Color and/or
Pattern behind your plot title. It aso allows you to set the
Transparency of the background.

The Sample box provides a preview of your plot title.

Click Apply to save your changes and continue adjusting the appearance

of theti

tle. Click OK to save your changes and close the editor.
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6.5 Customizing Curves

Y ou can customize line and point styles, add |abel's, and specify symbols
to indicate data quality in your plots. Additionaly, you can specify the
parameter-based default curve styles used across al plots.

There are three different ways to edit plot curves, depending on whether
you wish to customize one or more curvesin an individual plot or specify
defaultsfor al plots.

6.5.1 Customizing Curves in Individual Plots

To customize all curvesin anindividual plot, from the Edit menu, choose
Plot Properties. Once the Plot Properties editor opens, select the
Curvestab.

To customize a specific curvein an individual plot, right-click on the line
or curve you wish to edit using the Pointer T ool , then select Edit
Properties from the shortcut menu (Figure 6.14). The Edit Curve
Properties editor will open.

BEECH CREEK 5TA RDCP-RAW STAGE--INST

Edit Properties

Hide Curyve

Remove Curve

! T
0000 12:0  Add Callout
QMo 993 Hide Callouts

Clear Callouts

CWy-REG--INST —8— ocoon creew oA oor-re vy roov-REG--IMST
WGE--INST ~ ------ BEECH CREEK 5TA DCP-REY STAGE--INST

Figure 6.14 Shortcut Menu - Curve Properties

The Curvestab of the Plot Properties editor and the Edit Curve
Properties editor are nearly identical with one exception. At the top of
the Curvestab of the Plot Properties editor, thereisalist of all curves
contained in the plot. In contrast, when you open the Edit Curve
Properties editor, only the selected curve’s DSS Peath is displayed.

Both the Edit Curve Properties editor and the Curvestab of the Plot
Properties editor allow you to edit Style, Label, L egend Item, and
Quality Symbols (you can edit Quality Symbolsonly if the plot has
quality defined data).
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6.5.2

Specifying Parameter-Based Default Curve Styles

To specify parameter-based default curve stylesfor all of your plots, from
the Edit menu, click Default Line Styles. The Default Line Styles
options editor will open (see Figure 6.10, page 6-8).

The Default Line Styles options editor gives you away to edit line styles
from the Line Styles box (Figure 6.15). Y ou can specify the default,
parameter-based curve styles used for al plots.

Line Skyles

Line
Marme Parameter Type Mumber LireFill

Elew Elev aLL

Eles Elev aLL

Elew Elev ALL

Elew Elev ALL

Elew Elev aLL

Ele Elev ALL

Eles Elev aLL

Elew Elev ALL

i i B i i i
Lo == e = T T S VI B S

Elev-Zone Elev aLL

Figure 6.15 Default Line Style Options Editor: Detail of Line Styles Box

The Line Styles table displays typical datatypes with default line and fill
styles predefined.

Y ou can edit al of these fields, change default line and fill styles for
existing types, and add new data types to the list (currently, thereisno
delete option).

The Line Styles table columns are described below in detail:

m Name The Name correspondsto the"C" part of HEC-DSS
pathnames. To edit an existing name, highlight it, and
then type in the new Name.

m Parameter The Parameter iswhat distinguishes data sets and
groups them together in the same viewport. For
example, FLOW-IN and FLOW-OUT have different
Names or "C" parts, but both are Parameter
“FLOW” data sets, so they will be plotted in the same
viewport.

m Type The Typedescribestheregular and irregular interval time
series record data, either INST-CUM (instantaneous
cumulative), INST-VAL (instantaneous value), PER-
AVER (period average), PER-CUM (period cumulative),
or ALL. To changethe data Type associated with a
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Name and Parameter, click the down-arrow and select
from the preexisting list.

m LineNumber TheLine Number column indicates the number of
lines/curves displayed in the viewport and what
style will be associated with that data. For
example, if you have three curvesin aviewport
each with the same Name, Parameter, and Type,
thefirst line will be assigned the Line/Fill
associated with Line Number 1; the second will
use Line Number 2, the third Line Number 3, and
soon. If thereisonly oneline displayed in the
viewport for that data set, it will usethe Line
Number 1 line style. See Adding New Data
Styles below to add more Line Numbersto a
particular data set.

m LineFill TheLine/Fill property determines how curves
associated with a particular Name/Par ameter /Type
combination will appear in all plots. To specify the
Line/Fill, select the row, and then customize the Line
and Point properties as discussed in Section 6.5.4.

6.5.3 Adding New Data Styles

To add anew datatype (i.e. insert arow in the Line Style table):

1. From the File menu of the Default Line Styles options editor,
choose New Parameter. The New Data Type dialog box will
open (Figure 6.16).

New Data Type E|
Porameter: | 7 |

Marne:
Type: LAl v

Mumber of Lines: |

[] ¥ Axis Reversed

(0] Zancel

Figure6.16 New Data Type Dialog Box

2. Select aparameter from the Parameter list.
3. Enter aname in the Name box.
4. From the Type list, select the data type.
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5. Inthe Number of Linesbox, enter the number of curves you want
to add for this new data type.

6. If you want to reversethe Y-axis, select Y Axis Reversed.

7. Click OK to save and close the dialog box.

TheLine Stylestable will display the new data type you have added,
repeated as many times as you specified in the Number of Lines box
(reflected in the Line Number column). Y ou can customize the new data
types as described above.

To save your changes, from the File menu, click Save. To closethe
Default Line Styles options editor, from the File menu, click Close.

6.5.4  Specifying Line and Point Styles of Curves

The curve Line and Point Style worksheet is shown in Figure 6.17. This
worksheet is available from the Curves tabs of the Edit Curve Properties
editor, the Plot Properties editor, and the Default Line Styles options

editor (Section 6.2).
BEECH CREEK STA DCP-RAW FLOW-REG--INST Properties @
Draw Curve Shaw in Legend

D55 Path:  /BEECH CREEK STAJFLOW-REG--INST/010CT 1993/ IR-MONTH/DCP-R AW
Style | Legend Ttem || Quality Symbols
it Faint

Draw Line Draw Paints

Color | I e > Stie: |
Style: — N Line Color: | N tlue v
Weight: — Fil Calor: | N o v
Size! -
Fil: (&) Mone () Below (O Above ? E‘
. () Automatic Symbol Drawing
—— (%) Draw Symbols on Data Paints

Skip
Type: Stepped Linear
ype: (O Stepped ffset
[[] Interpalate for missing values

Missing Yalue Symboals

[] Draw Missing Yalue Symbols

o
——
— Sample

[ K ] [ Cancel ] [ Apply ]

Figure 6.17 Curve Line and Point Style Editing Interface

The Style tab has three main groups, Line, Point, and Missing Value
Symbols which alow you to customize line and point styles, and a
separate symbol that can be shown for missing values. Beneath the Point
group, the Sample box provides a preview of how your line and point
choices will look.
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To defineline styles for curves:

1. IntheLinegroup, click Draw Line.

2. Select aColor, Style, and Weight for the line.

3. You can display lines with fill above or below, or without fill. A
plot with line fill below is shown in Figure 6.18, whereas the same
plot without linefill isshown in
Figure 6.19. To set thisfeature
use the Fill selections; None,
Below, or Above. Then choose
the Fill Color and Fill Pattern for
thefill using the color and pattern
dropdown lists located below the
Fill section. Figure 6.18 Plot with Line Fill

4. In the Type section, select if you want the curve drawn Stepped,
in astair-stepped style, or Linear,
with aline drawn directly between
each point.

5. If you would like to see missing
values, check Draw Missing
Value Symbols and select a Style,
Line Color, Fill Color, and Size
for the missing value points.

Figure 6.19 Plot without Line Fill

To define Point stylesfor curves:

1. Inthe Point group, click Draw Points.

2. Choosethe Style, Line Color,
and Fill Color youwant. The
Line Color isthe “border” around
the point symbol. The Fill Color
isthe color inside the point
symbol. An example of adark
blue Line Color and alight blue
Fill Color isillustrated in Figure

6.20.
3. Inthe Size box, specify thesize of Figire6.20 Example Lineand Fill
the point (in pixels) either by Colors

selecting asize from the list or by
typing in anumber from 1- 45.

4. Automatic Symbol Drawing alows the program to determine the
number of pointsto display on acurve. The program will
automatically calculate how many data points can display on the
curve before they start to overlap one another. Not all points will
be displayed. If the points overlap at the zoom level you view the
plot at, the program will determine how many points can display
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separately on the curve and only display those points. Asyou
zoom in, the plot will draw more and more points, as long as they
do not touch.

5. Draw Symbols on Data Points allows you to specify how to draw
the points so they don’t overlap. If you set the Skip box to one (1),
then it will draw one point, skip the next, then draw the third, etc.
The Offset box allows you to say how many points on the curve to
initially skip before drawing points.

To define missing value symbols for curves:

1. Inthe Missing Value Symbols group, click Draw Missing Value
Symbols.

2. Choosethe Style, Line Color, and Fill Color you want. TheLine
Color isthe “border” around the point symbol, whereas the Fill
Color isthe color inside the point symbol. Figure 6.20 (page 6-15)
shows an example of adark blue Line Color and alight blue Fill
Color.

3. In the Size box, specify the size of the point (in pixels) either by
selecting asize from the list or by typing in a number from 1- 45.

4. Thiswill place the selected symbol on each missing value.

6.5.5 Customizing Curve Labels

The curve L abel worksheet, available from the Curvestabs of the Edit
Curve Properties editor, the Plot Properties editor, and the Default Line
Styles options editor (Section 6.2) are shown in Figure 6.21. This
worksheet allows you to customize curve labels.

JBEECH CREEK STA/FLOW-REG--INST/010CT1993/IR-MONTH/DCP -RAWS Properties

Select Yiewpork: |Viewpnrt (1,1) v |

Curves | Viewport | Title || Axis | Legend | Marker Lines || Layout

[V FEECH CREEK STA DCP-RAW FLOW-REG--INST )
BEECH CREEK 5TA DCP-REY FLOW-REG--IMNST [l

Draw Curve Show in Legend

D35 Path:  /BEECH CREEK STA[FLOW-REG--INST/010CT1993/IR-MONTH/DCP-RANS

Style | Label | Legend Item || Quality Symbals

' |Beach Creek Flow |

Alignment: | Left w |

Position: | fbove w |

Sample
Sample Text

[ [o]4 ] [ Cancel ] [ Apply

Figure6.21 Curve Label Editing Tab
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To customize curve labels:

1. Check the Show L abel checkbox.

2. Enter the text you want to appear in the curve label in the L abel
Text box. You can also usetext substitution for a curve label; see
Section 6.16 for more information.

3. Using the Alignment list to select the horizontal position of the
label on the curve; L eft, Center, or Right.

4. To set the vertical position of the label on the curve, from the
Position list, click Above, Center, or Below.

The Sample box at the bottom of the editor provides a preview of how
your label will display.

6.5.6  Customizing Legend Items

See Section 6.9.3 for information on customizing legend items.

6.5.7 Customizing Curve Quality Symbols

The curve Quality Symbols worksheet, available from the Cur ves tabs of
the Edit Curve Properties editor, the Plot Properties editor, and the

Default Line Styles options editor (Section 6.2) are shown in Figure 6.22.
This worksheet allows you to customize curves for plots that have quality

set for their data.

Select Yiewnort: [yigwpart (1,1)

<

Curves | viewport | Title | Axis | Legend | Marker Lines | Layout

[V 5P CH CREEK ST/ DCP-RAW FLOW-REG--INST

BEECH CREEK ST DCP-REW FLOW-REG--INST L]

Draw Curve Show in Legend Rennove Curve
DS5 Path: {BEECH CREEK STA{FLOW-REG-INST/010CT1993/IR-MONTHDCP-RAW(
Style | Label | Legend Ttem | Quality Symbols

Draw Quaity Symbols

walid GQuestionable
Style: v Style: % -
Line Color: [l aresn + Line Color: | N black v
Fil Color: | [l gresn v Fil Color: | yellow v
Size: - Size: =
g - g -
Rejected Missing
Styls: B v Styls: o v
Line Color: | N r=d v Line Color: | [ magenta v
Fill Color: | R re=d v Fill Color: magenta
Size: i‘ Size: i‘
8 = 8 =

[ oK H Cancel ][ apply

Figure 6.22 Curve Quality Symbols Editing Tab
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6.6

6.6.1

To customize quality symbols:

1. Check the Draw Quality Symbols checkbox.
2. Select asymbol Style, Line Color, Fill Color, and Size for each
quality of data; Valid, Questionable, Rgected, and Missing.

Customizing Viewport Properties

Viewports are the gridded areas in the plot window that contain plot
curves. Y ou can customize the border around the viewport, the
background color and pattern, and the appearance of gridlines.

Customizing Viewport Borders and Background

m From the Edit menu, click Plot Properties. When the Plot

Properties editor opens, click the Viewport tab.
-Or-

m Right-click inablank areainside '
the viewport with the Pointer Tool Lt
, and then click Edit
Properties from the shortcut menu
(Figure 6.23). The Viewport Add Marker — #

Properties editor will open. Figure 6.23 Shortcut Menu -

Viewport Properties

Edit Properkies

To specify the default border and

background of viewports for all of your plots use the Default Plot
Properties editor; from the Edit menu, click Default Plot Properties.
Once the Default Plot Properties editor opens, select the Viewport tab.
Changes made in the Default Plot Properties editor will apply to al
viewports.

The Viewport (#,#) Properties editor, which displays the viewport
number in thetitle bar is shown in Figure 6.24 (page 6-19). This number
reflects the position of the viewport on the Plot dialog box. For example:
if you had two viewportsin you plot, the top viewport’s number will
display as (1,1). The bottom plot would display as (2,1). The worksheet,
accessed from the shortcut menu, contains the same items as the Viewport
tab of the Plot Properties editor and the Viewport tab of the Default Plot
Properties editor. Inthe Plot Properties editor thereis a Select
Viewport list when multiple viewports are displayed in the plot. Select
the viewport you would like to edit using this|list.

The Viewport tab has six main groups. Magjor X Grid, Mgor Y Grid,
Minor X Grid, Minor Y Grid, Border and Background.

6-18



HEC-DSSVue User's Manual

Chapter 6 — Customizing Plots

Yiewport (1,1) Properties @

Major ¥ Grid
Draw Major ¥ Grid
Calor: [ light a...
Style:

‘Wweight:

Minor ¥ Grid

[ Draw Minor ¥ dGrid

Major ¥ &rid

Draw Major ¥ 1Grid

Color:

LRES

Style:

‘Wweight:

Minor ¥ Grid

light g...

LRES

Border
Draw Border
Color:
Skyle:

YWeight:

Background
[] Draw Background

I Gk

W

b

W

1
L1

[

Apply

Lo I
Figure 6.24 Viewport Properties Editor - Patterns Tab

Cancel ] [

To customize the Border and Background of a Viewport:

1. Check the Draw Border checkbox at the top of the Border group
and choose the Color, Style, and Weight for the border line you
want to appear around the selected viewport.

2. Select Draw Background in the Background group and choose
the Color, Pattern, and Transparency you want for the
background.

Click Apply to save your changes and continue adjusting the appearance
of the border and background. Click OK when you are finished.

Customizing Viewport Gridlines

To customize gridlines of viewportsin an individual plot, you can either:

m From the Edit menu, click Plot Properties. When the Plot
Properties editor opens, click the Viewport tab.
-Or-
m Right-click in ablank areainside the viewport with the Pointer
Tool [ %], and then click Edit Properties from the shortcut menu
(see Figure 6.23, page 6-18).

To specify viewport gridlines for all of your plots, from the Edit menu,
select Default Plot Properties. Once the Default Plot Properties editor
opens, choose the Viewport tab.

By default, the plot viewport displays gridlines only for the Major X Grid
and Major Y Grid. Thedefault color islight gray. To change the
appearance of Mgor X and Y gridlines, select the Color, Style, and
Weight of the gridlines located under their respective groups.
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By default, the Minor X Grid and Minor Y Grid are not selected to draw
and do not display in the plot viewport. If you want to display gridlines for
the Minor X Grid and Minor Y Grid, check the Draw Minor X Grid
and Draw Minor Y Grid checkboxes and then make your selections for
Color, Style, and Weight (Figure 6.25).

Minor ¥ Grid Miror ¥ Grid
Drawe Minor % Grid Draws Minar ' Grid
Color: [NEEved | | Cobr: [N green M
Shwle: [ __ | Styler 1
Weight! | — | weight: [

Figure 6.25 Viewport Properties Editor - Gridlines Tab

Click Apply to view your changes without closing the editor. Click OK
when you are finished.

Adding and Customizing Marker Lines

Y ou can add marker lines on your plot's X and Y axes and customize the
appearance of these markers, as displayed in the top viewport in Figure
6.26.

HBEECH CREEK STA/FLOW-REG--INST/010CT199 3/IR-MONTH/DCP-RAW/

File Edit Wiew
SAE B
Y
250
F 200
£
5 1807
=
“ 1004
50
i
4.0
. 35
£
S 3.0
o3
&
254
T T T T T T
nman 12:00 0mon 12:00 0000 12:00
| 268Mov1 993 | 29N vl 993 | 30Nov 993
—&— BEECH CREEK STA DCP-RAW FLOW-REG--INST —8— BEECH CREEK STA DCP-REY FLOW-REG--INST
BEECH CREEK STA& DCP-RAW STAGE--INST — — — BEECH CREEK STA DCP-REY STAGE--INST

Figure 6.26 Adding Marker Linesto Plots
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6.7.1 Adding Markers

To add amarker:

1. Right-click on the location in the :
plot where you want the marker to iiici ﬂ
appear. Edit Properties

2. From the Viewport shortcut menu Add Marker  » IESURSCECI
(Figure 6.27), point to Add On Y-fuis [
Marker, and then click either On Figure 6.27 Shortcut Menu - Aidd
X-Axisor On Y-Axis. Marker

The marker will now appear in the plot.

6.7.2  Deleting Markers

o ) ) Marksr Line
To delete amarker linein aplot, right click

on the plot with the Pointer Tool,[] from Edik:Frapertios
the shortcut menu, click Delete (Figure
6.28).

Figure 6.28 Shortcut Menu - Marker
Line Properties

6.7.3 Customizing Markers
To edit the properties of amarker in an individual plot, you can either:

m From the Edit menu, click Plot Properties. When the Plot
Properties editor opens, click the Marker Linestab. This
worksheet is available only if amarker existsin the plot. Choose
the marker you want to edit from the Marker Lineslist.

-Or-

m With the Pointer Tool | %], right-click on the marker you want to
edit. From the Marker Line shortcut menu, click Edit Properties
(Figure 6.28). The Edit Marker Line Properties dialog box will
open.

To specify the default appearance of markers for all of your plots, from
the Edit menu, click Default Plot Properties. Once the Default Plot
Properties editor opens, choosethe Marker Linestab.

The interfaces for the specialized Edit Marker Line editor and the
Default Plot Properties editor are very similar. However, the Plot
Properties Editor dialog box differsin two ways. First, the Marker
Linesworksheet is available only if amarker existsin the current plot.
Second, at the top of the editing panel thereisaMarker Lineslist
containing all markers that exist in the current plot.
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Y ou can edit the line style and label of a marker through this worksheet.
The Edit Marker Line Properties editor is shown in Figure 6.29. The
Marker Linetabsin the Plot Properties editor and the Default Plot
Properties editor use similar worksheets as well.

Edit Marker Line Properties @

Date

Line

29Nov1993 [ | Time 1300

Label

Diraw Line Draw Label
Calor: I bl=ck b Texk: Release|
Style: [
¥ Forit
Wieight: -
Fonk: Dialog hd
Fill: (@MNone (O Below () Above Shyle: [lBold  []Itaic
| Color | I tlack
|

Size: |1

[]Use Font Scaling
Sample

Sample Text alignment: || afk

Position: Ahove

Cancel

[ o

J( J{

Apply

Figure 6.29 Marker Line Properties Editor - Style Tab

To edit the line style for markers:

1. Select the Color, Style, and Weight
for the marker line.

2. You can display marker lineswith a
Fill Above or Below theline. A plot

with the Fill Above and a hatched Fill
Pattern selected using ared Fill Color
isshown in Figure 6.30.

The Sample box, located in the lower |eft-

hand corner of the worksheet, provides a
preview of the new marker line.

Figure 6.30 Marker Line with
Fill Above

Click Apply to save your changes without closing the editor.

To add alabel to a marker line:

1. Inthe Label group, check the Draw L abel checkbox and type the
label name into the Text field.

2. In the Font section, select the labels Font, Style, Color, and Size.

3. Check Use Font Scaling if you would like to limit the size of the
font when zooming in and out of the plot. Set the Min Sizeand

Max Size limits.
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4. From the Alignment list, select the justification of the label; L eft,
Center, or Right of the marker line.

5. Set the position of the label from the Position list, either Above,
Center, or Below the marker line.

Set the position of the label from the Position list, either Above, Center,
or Below the marker line.

1. If the marker lineis on adate, the
Date field will be displayed on the
top of the worksheet. E Mo [I] E] 1993 E]
2. To change the date, either enter the
date in the format DDMMYYYY
(e.g., 21Dec1993) or click the élipse
buttonl..] to access the Calendar T 8) 9j10) 11} 12} 13
Tool (Figure 6.31). 14] 15[ 16| 17| 18] 19{ 20
3. For the Time value, enter thetimein
24-hour military format (e.g., for 5:08 el Ml el
pm, enter "1708"). EIE
4. If the marker line appearson a
specific value, the Value field will
display at the top of the worksheet

1 2] 3| 4| 5| 6

Mon 29 Moy 1993

instead of the Date field. To change [ o J[ concel
thisvalue, simply enter anew value  Figure 6.31 Caendar Tool
inthefield.

6.7.4  Editing Callouts

Y ou can add descriptive callouts at specific points
along acurve (Figure 6.32). To add callouts: -
e, B

1. Right-click on the location on the curve where Figure6.32 Callout

you want the callout to appear.
2. From the shortcut menu (Figure 6.33), select Add Callout.

l\1 BEECH CREEK 5TA DICP-REV FL OW-REG--INST
Edit Propetties

Hide Curve

Remaove Curve

add Callout

Figure 6.33 Shortcut Menu - Add Callout

3. Inthe Add Callout dialog box (see Figure 6.34, page 6-24), enter
the text you want to appear in the callout, and then click OK.
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Add Callout

P Callout Text

[ K H Cancel ]

Figure 6.34 Add Callout Dialog Box

To hide al callouts on a curve, right-click on the curvein the plot, or in
the legend, and select Hide Callouts from the shortcut menu.

Once you have hidden callouts, Hide Calloutsin the shortcut menu
changes to Show Callouts; allowing you to return callouts to the plot. To
permanently remove all callouts from a curve, right-click on a curvein the
plot, or in the legend, and click Clear Callouts from the shortcut menu.

6.8 Customizing Axes

Y ou can choose either alinear or log axis type, specify the axis scale,
modify tic marks, and customize axis labels. Probability plots are
generated for paired data sets with atype of "PROB", and cannot be
changed without changing the data type.

6.8.1 Changing Axis Type

By default, plots display using alinear scale (Linear Axis), in which the
axisincreases and decreases by x. You can aso use the log scale, which
allows you to view curves that grow exponentially in anear straight line,
because the axis increases or decreases by the log (x). For example, you
might wish to use the log scale when the axis has evenly-spaced major tics
with values of 1,10,100,1000, and so on, such as in a performance history
plot showing many years of data.

To change the axis type of an individual plot, right-click on an axis, then
from the Axis Tics shortcut menu, point to Set Axis Type, click Log Axis
or click Linear Axis; depending on which axistypeisalready inuse. In
Figure 6.35, the axisisusing aL inear Axis, so the choice availableis L og

AXis.
I
A Axis Tics

3| Edit Properties
Set Axis Type P
3 I i
| /

Figure 6.35 Shortcut Menu - Set Axis Type

Log Axis
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6.8.2  Specifying Axis Scale

Y ou can specify the axis scale and tic interval for individual plots. To do
this, select the editor either:

m From the Edit menu, click Plot Properties. When the Plot
Properties editor opens, click the Axistab. From the Axis
worksheet, select the axis you want to edit from the Axislist.

Then select the Scale tab. 0 . e T
-Or- [ Axig Tics
m Right-click on the axis using the : :

Pointer Tool [x] and from the Axis Tics Edit Properties

shortcut menu (Figure 6.36), click Edit [ Set Axis Type b

Properties. When the Axis Properties 1 Ir :

dialog box opens, click the Scale tab. Figure 6.36 ih(_)ft_?_lt Menu -
XIS 1'1CS

The Plot Properties editor with the Axis tab selected and the Scale
worksheet open is shown in Figure 6.37. The Axis worksheets of the Plot
Properties editor and the Default Plot Properties editor are nearly
identical, except for the Axislist on the Plot Properties editor. The Axis
L abel and Tics sub-worksheets are availablein al three editors.

{IBEECH CREEK STA/FLOW-REG--INST/010CT1993/IR-MONTH/DCP-RAW/ Properties

Select Yiewpork: | R

Curves || Yiewpart || Title | A%iS | Legend | Marker Lines | Layout
Bis: | yq W

Scale | Axis Label | Tics

Auko

Mazimumn: 300
Minimum: 0
Yigw Maximum: 300
Yigws Minimum: 0
Majar Tic Interval: 1]
Minot Tic Inkersal: 10

[[] Rewerse (Invert) Axis

[ 0K ] [ Cancel

Figure 6.37 Plot Properties Editor - Scale Worksheet
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6.8.3

With the Scale worksheet, you can specify the range of the scale, the
amount of the scale that isvisible, and thetic intervals.

If the checkboxes under the Auto heading are checked, the plot will
automatically select the scale. Otherwise, as you zoom in and out of the
plot, its view values change while the minimum and maximum scale range
values remain fixed:

m Maximum: enter the value of the maximum range of the scale.
m Minimum: enter the value of the minimum range of the scale.

m View Maximum: enter the maximum visible range of the scale.
m View Minimum: enter the minimum visible range of the scale.

Tic intervas are the distances between tics on the axis sca e

m Major Ticlnterval: specify the distance between each mgjor tic.
m Minor Ticlnterval: specify avalue lessthan or equal to the
major tic value.

Y ou can also choose to reverse the axis and invert the data by selecting
Reverse (Invert) Axis. If the data set is paired, you can switch the X and
Y axis, so what is plotted on the X axis becomes plotted onthe Y axis
instead.

Click Apply to save and view your changes without closing the editor.
Click OK to save your changes and close the editor.

Modifying Tic Marks

Y ou can modify the color of tic marks, choose whether or not major and
minor tic marks display, and specify whether |abels display. (See also
"Specifying Axis Scale" in Section 6.8.2 for information about modifying
ticintervals.)

To modify tic marksin an individual plot, you can either:

m From the Edit menu, click Plot Properties. When the Plot
Properties editor opens, click the Axistab. From the Axis
worksheet, select the axis you want to edit from the Axis list.

Once you have this s&t, click the Ticstab to set tic marks.
-Or-

m Right-click on the axis using the Pointer Tool | * | and from the
AXxis Tics shortcut menu (see Figure 6.36, page 6-25), click Edit
Properties. When the Axis Properties dialog box opens, click the
Ticstab.
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To specify default settings for axisticsin all of your plots, click Default
Plot Propertiesfrom the plot Edit menu. Once the Default Plot
Properties editor opens, choose the Axis tab, then the Tics tab.

The Tics worksheet of the Axis Properties editor is shown in Figure 6.38
above. The Ticsworksheet is nearly identical on the Axis Properties
editor, Plot Properties editor, and Default Plot Properties editor.

Viewport (1,1) - Axis Flow (cms) Properties @

Scale || Axis Label TICS
Tick Marks Tic Labels
Use major tick marks chaw Tic Labels

Use minar tick matks
[l Fant

Fonk: Dialog I
Style! [gald [ Italic

Color | I bl=ck
Sizer |1z

Use Fant Scaling

Min Size: |5 o« | MaxSizer |1g

Sample
1000

[ o l [ Cancel

Figure 6.38 Axis Properties Editor - Tics Tab

However, at the top of the Plot Properties editor isan Axislist containing
all of the axes available for editing in the selected viewport. In the Plot
Properties editor, you must choose an axis to edit before you can make
any changesto thetics.

By default, plot axes display major tic marks with labels. To turn these
defaults off, uncheck the Use major tick marksand Show Tic Labels
check boxes by clicking on them.

Y ou can aso select Use minor tic marks, to display the minor tic marks
in the viewport.

To changethe Tic Label:

1. Thetic and tic labels use the same color. To change their color,
select anew color from the Color listinthe Tic Labels group.

2. Select the label’ s typeset using the Font list. The font can display
as Bold or Italic by checking the checkboxes next to either Style
option.
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3. By default the Sizeisignored, and Use Font Scaling is selected.
Use Font Scaling allows the program to determine the best font
sizeto display, using the Min Size and Max Sizeto limit the range
of the font size.

Click Apply to save and view changes without closing the editor. Once
you are done making changes in the editor, click OK to save the changes
and close the editor.

6.8.4  Customizing Axis Labels

Y ou can add borders and backgrounds to axis labels. To customize axis
labelsin an individual plot, you can either:

m From the Edit menu, click Plot Properties. When the Plot
Properties editor opens, select the axislabel's viewport in the
Select Viewport list at the top of the editor. Then click the Axis
tab. On the Axisworksheet, select the axis you want to edit from
the Axislist, and then click the Axis L abel tab to set axis label

properties.
-Or- g .IUU‘l .-..'Ef
m Right-click on the axis label with the < Axig Label
Pointer Tool [x]. Fromthe Axis Label
shortcut menu (Figure 6.39), click Edit [ Edit Properties
Properties. TheLabel Propertieseditor L
will open. Figure 6.39 Shortcut Menu -

Axis Label

To specify default settings for axislabelsin all of your plots, select
Default Plot Properties from the plot’s Edit menu. Once the Default
Plot Properties editor opens, choose the Axis tab, then the Axis L abel
tab.

The Label Properties editor is shown in Figure 6.40 (page 6-29). The
same worksheet is available on the Axis L abel tabs of the Plot Properties
editor and Default Plot Properties editor, with afew differences. The
Plot Properties editor has an Axislist containing all of the axes available
for editing in the current selected viewport, which is displayed in the
Select Viewport list.

The Axis L abel worksheet has three groups: Font, Border and
Background. The Sample box, located at the bottom left of the editor,
provides a preview of the label changes.

The current label text is displayed in the Text box. To change the
wording, highlight the displayed text in the box and type in the new axis
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Viewport (1,1) - Axis Flow (cms) Properties @

Scale "7\

Shows Axis Label

Text Parameter:

Flow (cms)

Font Border

Fort!  [pialog w [] Draw Border
Stylel [gold [ Italic [
Color | I black
Sizer |12 ——
|Use Fonk Scaling Background
MinSize: |5 | MaxSize! |15 [] Draw Background
[
Alignment: | cenrer o
|
Sample
Flow {crms)
[ OF, ] [ Cancel ]

Figure 6.40 Label Properties Editor

label name. Text substitution can also be used here. See section 6.16 for
more information on text substitution.

The font of the axis label can be customized using the tools located under
the Font group. The text typeset can be changed using the Font list. The
Style of the font can be changed by checking either the Bold or Italic
checkboxes. Choose the color of your font in the Color list. By default
the Use Font Scaling checkbox is set. This option alows the program to
determine the best size of the font, limiting the range between the selected
Min Size and Max Size. Otherwise, you can un-checking the Use Font
Scaling and set a constant font sizein the Size list.

The Alignment list allows you to position the label, Left, Right, or Center,
relative to the axis.

To add aborder around the axis label, check the Draw Border checkbox
in the Border group, and then select the Color, Style, and Weight for the
borderline.

To add abackground to the axis label, check the Draw Background
checkbox in the Background group, and then select a Color, Pattern, and
the Transparency level.

Use the Show Axis Label checkbox to add or remove the axis label from
the plot window.
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6.9

Click Apply to save and view your changes without closing the editor.
Click OK when you are finished editing axis label properties.

Customizing Legends

Asillustrated in Figure 6.41, you can add titlesto a plot legend, add text
and graphicsto the right and left sides of the Legend box, and customize
the curve labelsin the Legend box. You can also specify whether the
legend appears below, to the right, or inside the plot's viewports. The
legend can even be displayed in a separate window or hidden from

display.

Lengend Title Watershed
Demo Plot

LIS Arrmy Corps —e— BEECH CREEK STA DCP-RAVW FLOW-REG--INST ~ —S— BEECH CREEK STA DCP-REY FLOW-REG--MST

of — BEECH CREEK STA DCP-RAW STAGE--INST — —— BEECH CREEK STA DCP-REW STAGE--INST
Engineers

Figure 6.41 Customizing Legends
To add atitle or side blocks to an individual plot’s legend, you can either:

m From the Edit menu, click Plot Properties. When the Plot

Properties editor opens, select the L egend tab.
-Or-

m Right-click in ablank areainside the
legend panel of the plot with the Pointer
Tool [x]. Fromthe Legend Panel
shortcut menu (Figure 6.42), click Edit

Legend Panel

Edit Properties

i . Hide L d
Properties. The L egend Properties _ Ide Legen
editor will open. Figure 6.42 Shortcut Menu -
Legend Panel

To specify default settings for all of your plot legends, from the Edit
menu, click Default Plot Properties. Once the Default Plot Properties
editor opens, select the L egend tab.

Whether you are using the Plot Properties editor, L egend Properties
editor, or Default Plot Properties editor, the worksheet for editing legend
titlesis the same.

The Legend Properties editor is shown in Figure 6.43 (page 6-31). This
worksheet, accessed from the shortcut menu, contains the same fields as
the L egend worksheets of both the Plot Properties editor and the Default
Plot Properties editor.

To remove the legend from the plot window, uncheck the Show L egend
checkbox on the editor, or from the plot window’s View menu select Hide
Legend. If youwould like to add the legend back to the plot window,
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Edit Legend Properties @

[#]5how Tegend  Legend Pasition:  |Bottom of Panel -
Legend Title | | &ft Block | Right Block.

Draw Legend Title

Text Lengend Title

Font Border
Font: | pialag v [] Draw Border
Style! [gold [ Italic ]
Caler | I bk v
Siger |1z “ —

Use Font Scaling Backaround

Min Size: |5 a4 | Max Size: [15 « [] Draw Background
|

Alignment: | cenker w
]
Sample
Lengend Title
Ok, ] ’ Cancel ]

Figure 6.43 Legend Properties Editor

either re-check the Show L egend box on the editor, or on the plot window
from the View, click Show L egend.

Legend Title

To add and customize atitle for the legend:

1. Onthe L egend Titletab, select the Draw L egend Title checkbox.
Then enter the title you want to appear along the top of the legend
in the Text box.

2. Inthe Font group, select the typeset for the title in the Font list.
The Style of the font can aso be changed by checking either the
Bold or Italic checkboxes.

3. By default the Use Font Scaling checkbox is set. This option
allows the program to determine the best size of the font, limiting
the range between the selected Min Size and Max Size.
Otherwise, you can un-checking the Use Font Scaling and set a
constant font size in the Sizelist.

4. Select the Alignment to position thetitle to the L eft, Right, or
Center of the legend.

5. If you would like the title to use a custom border check the Draw
Border checkbox inthe Border group. Then select the Color,
Style, and Weight for the borderline.

Chapter 6 — Customizing Plots
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6.9.2

6.

7.

Similarly, if you would like the title to use a custom background
check the Draw Background checkbox in the Background group.
Then select the Color, Pattern, and Transparency for thetitle's
background.

The Sample box in the lower |eft corner will display a preview of
your title.

Legend Blocks

To add and customize a L eft or Right Block to the legend:

1.

[OSIN\)

First select the L eft Block or Right Block tab in the L egend
Properties editor and check the Draw L eft L egend Block or the
Draw Right Legend Block checkbox; depending on which
workbook you are editing. The workbooks are identical, except for
these Draw checkboxes.

. Typein thetext for the block in the Text box.
. Inthe Font group, select the typeset for the block in the Font list.

The Style of the font can aso be changed by checking either the
Bold or Italic checkboxes.

. By default the Use Font Scaling checkbox is set. This option

allows the program to determine the best size of the font, limiting
the range between the selected Min Size and Max Size.
Otherwise, you can un-checking the Use Font Scaling and set a
constant font size in the Sizelist.

. Select the Alignment to position the block’ s text to the L eft,

Right, or Center of the legend.

. If you wish to display a graphic in the block, under the | con group

either type the exact path* and filename of the image in the File
field, or use the ellipse button ..l to use afile browser to find and
select the image.

. If you would like the block to use a custom border, check the

Draw Border checkbox in the Border group. Then select the
Color, Style, and Weight for the borderline.

. Similarly, if you would like the block to use a custom background,

check the Draw Background checkbox in the Background group.
Then select the Color, Pattern, and Transparency for thetitle's
background.

. The Sample box in the lower |eft corner will display a preview of

your legend block.

To move the legend to a new location, either select the location in the
L egend Position list on the L egend tab of the editor or from the plot
window, from the View menu, click L egend Placement. By default the
legend is placed at the Bottom of Panel. Other options include: Right of

Panedl,

Separate Window, Viewport Upper Left, and Viewport Upper
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Right. If the legend displaysin the viewport, the title and legend blocks
will not appear, (Figure 6.44).

JBEECH CREEK STA/FLOW-REG--INST/010CT1993/IR-MONTH/DCP-RAWS
File Edit VYiew

peluli]

—&— BEECH CREEK STA DCP-RAW FLOWY-REG--INST
—8— BEECH CREEK STA DCP-REY FLOW-REG--INST

= 200 7
1404
100+ EEQEEEEQEEEEQEQEQEEEBEEEEEEEEEEEEQEEEE

240

Flow {cm

a0

=

4.0 —— BEECH CREEK STA DCP-R&W STAGE--INST
— — BEECH CREEK 5TA DCP-REVY STAGE--INST
3.5
= / ~—— ]
o
o 3.0 i
@
25
T T T T T T
0000 12:00 00:00 12:00 0000 12:00
| 2BMov 893 | 29Mov1 993 | A0Mov1 893

Figure 6.44 Viewport Upper Left

If the Legend Position is set for Right of Panel and the legend contains
right and left blocks, the left block will be removed and the right block
will display on the bottom of the legend, (Figure 6.45).

MBEECH CREEK STA/FLOW -REG--INST/010CT1993/IR-MONTH/DCP -RAW S
File Edit Wiew

300 Lengend Title
i ——
250 BEECH CREEK STA DCP-RAWY FLOW-REG--INST
e
= 200 BEECH CREEK STA DCP-REY FLOWLREG--INST
£
§' 1580 BEECH CREEK STA DCP-RAWY STAGE--INST
= .
L 1004 BEECH CREEK STA DCP-REY STAGE--INST
50
1]
4.0

&
n
I

Stage (M)
ol
o]
1

2.8

T T T T T T
00:00 12:00 00:00 12:00 00:00 12:00 watershed
| 28N 993 | 20Ny 993 | 30N 993 Dema Plot

Figure 6.45 Viewport Right of Panel

Click Apply to view your changes without closing the editor. When you
are done making changes to the legend click OK to save your changes and
close the editor.
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6.9.3 Customizing Legend Iltems

By default, the curves display their DSS Pathnames inside the legend.
However, the legend labels, named L egend Items, can be customized for
individual curves.

To change acurve's Legend Item in anindividual plot’s legend, you can
either:

m From the Edit menu, click Plot Properties. When the Plot
Properties editor opens, select the Curves tab, then the L egend

Item tab (Figure 6.46).
BEECH CREEK STA DCP-RAW STAGE--INST Properties |
Shaw in Legend
D55 Path:  J/BEECH CREEK STAJSTAGE--IMST /01O T 1993/ IR -MOMTH/DCP-Raii]
Style | Label | Legend Item | cuality Symbols
Text
Fant Barder
Fort:  |pialog v [] Draw Border
Style: [Jpod [ Italc |
Color | I b=k w —
Sizer |11 w —
Use Font Scaling Background
Min Size: |5 a4 | MaxSize! |15 s [] Draws Background
Sample
]
Sample Text
[] Al Legend Items use the same Font
[ ak ] [ Cancel

Figure 6.46 Legend Item Curve Properties Editor

_Or_
m Right-click onalegend FEECH CREEK 5TA DCP-RAW FLOW-REG--INST
Item (curve label) in the
legend with the Pointer Edit Properties
Tool [x]. Fromthe Hide Curve
shortcut menu (Figure Remove Curve
6.47), sdlect Edit _
Properties. The Curve Hirz Legend Item

Properties editor will Figure 6.47 Shortcut Menu - Legend Curves

open.
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To specify default settings for all plot L egend Items, from the Edit menu,
click Default Plot Properties. Once the Default Plot Properties editor
opens, select the Curves tab, then the L egend Item tab. Whether you are
using the Plot Properties editor, L egend Properties editor, or Default
Plot Properties editor, the worksheet for editing Legend Itemsisthe
same.

To customize aL egend Item:

1. Enter the text you would like to display in the legend for the curve
in the Text box. Text Substitution can also be used here, see
Section 6.16 for more information.

2. Inthe Font group, select the typeset for the legend item in the
Font list. A Style can be used for the font by checking the Bold
and/or Italic checkboxes.

3. By default, the Use Font Scaling checkbox isset. Thisoption
allows the program to determine the best size of the font, limiting
the range between the selected Min Size and Max Size.
Otherwise, you can un-checking the Use Font Scaling and set a
constant font sizein the Sizelist.

4. If you would like the Legend Item to have a custom border around
it, check the Draw Border checkbox in the Border group. Then
select the Color, Style, and Weight for the borderline.

5. Similarly, if you would like the L egend Item to use a custom
background check the Draw Background checkbox in the
Background group. Then select the Color, Pattern, and
Transparency for the item’ s background.

6. The Sample box in the lower left corner will display a preview of
your Legend Item.

7. 1f you would like the font changes to apply to al of the Legend
Items in the plot, click the All Legend Items use the same font
checkbox at the bottom of the worksheet.

Click Apply to save your changes. Once you are done with the editor,
click OK to save the changes and close the window.

6.10 Customizing Window Panels

Y ou can customi ze the background color, size, and viewport spacing the
window plots are displayed in.

To customize panel properties of an individual plot, from the Edit menu,
click Plot Properties. Oncethe Plot Properties editor opens, select the
L ayout tab.
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To specify panel propertiesfor all of your plots, from the Edit menu, click
Default Plot Properties. Once the Default Plot Properties editor opens,
choose the L ayout tab.

Whether you are using the Plot Properties editor or the Default Plot
Properties editor, the L ayout worksheet isthe same. The Layout
worksheet for the Plot Properties editor is shown in Figure 6.48.

M/BEECH CREEK STA/FLOW-REG--INST/010CT1993/IR-MONTH/DCP-RAW/ Properties

Select Yiewport: | T e TN
Curves | Yigwport | Title | Axis | Legend | Marker Lines | Layout
‘Window Size in Pixels  Width:

Height:

Panel Background Color: Default v

Space size in pixels: c i‘
-

[ OF. ] [ Cancel

Figure 6.48 Default Plot Properties Editor - Layout Tab

6.10.1 Customizing the Panel Background Color

To customize the panel background color, select a color in the Panel
Background Color list. The default color is named Default. The
Default color uses the background color set by your computer’ s operating
system.

6.10.2 Customizing the Horizontal Spacer Size

In the Plot Properties editor and Default Plot Properties editor,
horizontal spacer size refers to the space between viewportsin plots with
multiple viewports.

To specify the horizontal spacer size using the L ayout tab of the Plot
Properties editor or Default Plot Properties editor, in the Space sizein
pixelsfield, either manually type in a size between 0 and 50 or use the up
and down arrows to select asize.
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6.10.3 Customizing the Window Size

In the Plot Properties editor and Default Plot Properties editor, on the
L ayout tab enter the Width and Height of your plot window. By default
these values are empty, implying that the program will determine the best
size for each plot window.

6.11 Customizing Plot Layout

The Configure Plot editor (Figure 6.49) displays plot componentsin a

"tree" structure and allows you to customize the layout of an individual

plot. You can add and remove axes as well as add, remove, arrange the
order of, and set the weight of viewportsin the plot window panel.

Configure Plot @

Plot  Edit
Selected Data Sets

2] viewpart (1,1) (50%)
= 3t Left ¥ s ()
.n s~ BEECH CREEE 5TA DCP-RAW FLOW-REG--INST
vy BEECH CREEK, STA DCP-REY FLOW-REG--INST
$o] viewpart (2,1) (50%)
= 3t Left ¥ s ()
eon BEECH CREEK STA DEP-RAW STAGE--INST
fevmyg BEECH CREEK STA DCP-REY STAGE--THST

4

814 Cancel
e —

Figure 6.49 Configure Plot Editor

When you customize the layout of a plot using the Configure Plot editor,
your changes apply only to that individual plot unless you export the plot's
properties (see Section 6.12).

To access the Configure Plot editor, from the Edit menu, select
Configure Plot Layout.

6.11.1 Adding and Removing Viewports
To add anew viewport to a plot, from the Configure Plot editor's Edit
menu click Add Viewport. The new viewport will appear at the bottom
of the "tree" in the Selected Data Sets box.

To remove an empty viewport, you can either:
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m Click on the name of the viewport in the Selected Data Sets
"tree". From the Edit menu, click Remove Viewport.
-Or-
m Right-click on the viewport's name in the Selected Data Sets
"tree". From the shortcut menu (Figure 6.50), click Remove.

add Axis

Move Up

Move Dawn

Figure 6.50 Shortcut Menu - Viewport

| [ E=2H

6.11.2 Setting Viewport Weights

Y ou can customize the relative sizes of viewportsin your plots. To do
this:

1. From the Edit menu of the Configure Plot Layout editor, click
Set Viewport Weights. The Set Plot Viewport Weights dialog
box will open.

2. Inthe Set Plot Viewport Weights dialog box (Figure 6.51); you
can specify the relative size of each viewport as a percentage
value, with al of the weights adding up to 100%. Two viewports
of equal weight at 50% each is shown in Figure 6.51.

Set Plot Viewport Weights E|

Wigwport Weight( %)
Wigwpark (1,10 (50%) 50.0
Wiewpark (2,17 (50%:) 50.0

(8] 4 Zancel |

Figure 6.51 Set Plot Viewport Weights Dialog Box

Click Apply to save and view your changes without closing the dialog box
or click OK save your changes and close the dialog box.
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6.11.3 Adding and Removing Axes

By default, viewports have aleft Y-axis. You can add aright Y-axis,
remove both the left and right Y -axes, and add a new left Y-axisif you
have previously removed it. Viewports can have a maximum of two axes.
Y ou cannot remove an axis when a data set is associated with it.

To add an axisto aviewport, from the Configure Plot Editor you can
either:

m Click on the viewport's namein the tree in the Selected Data Sets
box. From the Edit menu, click Add Axis.
-Or-
m Right-click on the viewports name in the tree in the Selected Data
Sets. From the shortcut menu (see Figure 6.50, page 6-38), click
Add Axis.

The tree now displays another axis for the viewport you sel ected.
To remove an axis that has no data associated with it, you can either:

m Click on the name of the axis you wish to remove in the treein the
Selected Data Sets box. From the Edit menu, click Remove Axis.
-Or-
m Right-click on the axis you wish to removein the treein the
Selected Data Sets box. From the shortcut menu (see Figure 6.50,
page 6-38), click Remove.

6.11.4 Arranging Viewports and Axes

Y ou can rearrange the vertical order of viewportsin aplot window and
move axes (with their associated data sets) to different viewports.

To move aviewport or axis.

1. From the treein the Selected Data Sets box, right-click on the
name of aviewport or axis you want to move.

2. From the shortcut menu, click M ove Up or Move Down.

3. Either click OK or Apply for the change to take effect in the plot
window.

Note that you cannot move individual data sets in the Configure Plot
L ayout editor. Y ou can move only the axiswith which adata set is
associated.
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6.11.5 Reversing Axes (Invert Data)

To reverse the direction of an axis so that the datais inverted, in the
Configure Plot Layout editor, right-click on the name of the axisin the
tree. From the shortcut menu, click Reverse. Either click OK or Apply
for the change to appear in the plot window.

6.12 Saving and Applying Templates

After you have customized a plot, you can save its settings as a template
for usein other plots.

Generdly, you will use templates when scripting plots. For example:
generating aplot of flow, stage, and precipitation via a script every day,
and then apply atemplate that has all of the correct formatting, such as
viewport placement, size, line colors, and fills. For more information
about using templates with scripts, refer to Chapter 8 on Scripting.

To create atemplate from a plot:

1. From the File menu, click Save Template.
2. A Save browser will open (Figure 6.52).

Save g|
Savein: |[) My Documents v | [l E
. m ECupclosez, template B StaciesReportPlok, kemplate
__,J |ﬂ Flow, termplate
Recent |ﬂ my, template
7= B ScatterPlot. template
M } nplate m SRL.kemplate
Deskkop F 3
My Documents | Files of BYpe! | Template Properties (*.template) |+

Figure 6.52 Save Browser

3. Give the template aname in the File name field and click the Save
button. A *.template file will be saved.

To apply atemplate created from a previous plot:

1. From the File menu, click Apply Template.

2. An Open browser will open (see Figure 6.53, page 6-41).

3. Moveto the *.template file's location and select it by clicking on
it.
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3
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>

File name:
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)
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Figure 6.53 Open Browser

4. When you select atemplate, its name will display in the File Name
field.

5. Click Open to apply the template to the current plot.

6.13 Additional Viewing Options for Plots

The File menu of plots (Figure 6.54) contains
several commands that alow you to view plot
datain tabular form, save, copy, paste, and print
plots. Copy can be used to copy the plot into
other applications available on your computer.

6.13.1 Viewing Data in Tabular Form

To view plot datain tabular form, from the File
menu, click Tabulate. A dialog box will open
displaying the datain tabular form (Figure 6.55).
For more information about tables, refer to
Chapter 4 on Utilities.

HBEECH CREEK STA/FLOW-REG--INST/010CT1993/IR-MONTH/DCP-RAW/

File: J=alls

Prink

Close

Wiew

Tabulate

Save fs ...
Save Template ...

Apply Template ...

Copy to Clipboard

Page Setup
Prink Preswview
Print Multiple

— dod ]

WE T

Ctrl+P

Chri+'W
=

Figure6.54 File Menu

File Edit Wiew
BEECH CREEK STA | BEECH CREEK STA | BEECH CREEK STA | BEECH CREEK STA
Ordinate Date [ Time FLOW-REG--INST | FLOW-REG--INST STAGE--INST STAGE--INST
DCP-RA DCP-REY DCP-RAW DCP-REY

Units M5 M5 M M
Type INST-YAL INST-YAL INST-YAL INST-WaL

1 27 MNov 1993, 23:03 22,30 23.68 2.2700 2.2700

2 28 Nov 1993, 00:03 32.56 33.15 2.4100 2.4100

3 28 Moy 1993, 01:03 45,48 46,67 2.5800 2.5800

4 28 Nov 1993, 02:03 G626 71.55 2.,8500 2.8500

5 28 Nov 1993, 03:03 92,61 102,49 3.1400 3.1400

& 28 Nov 1993, 04:03 125.62 141.12 3.4500 3.4500

7 28 Nov 1993, 05:03 153.61 172,70 3.6500 3.6800

g 28 Mov 1993, 06:03 174.36 195.76 3.8300 3.8300

9 28 Nov 1993, 07:03 159.59 212,75 3.9400 3.9400

v

Figure 6.55 Datain Tabular Form
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6.13.2 Saving Plots

Y ou can save a plot as an image as a Windows Metafile (* .wmf),
Postscript (*.ps), JPEG (*.jpg, *.jpeg), or Portable Network Graphics

(*.png).

To save aplot asagraphic file, from the File menu, click Save As. From
the Save browser (Figure 6.56), select the location where you want to save
the plot, enter afilename in the File name box, and select the file type you
want from the Files of typelist, then click Save.

¥id -
Save

e1i] Save in: hD! Ml\;lf Diocuments i ? |_3| = |
kS 1 1) Snaglk ,ﬂ Junction without local flows.prg
o1t} ,,J ) TimeSheets

= Recent 1) USER.

. = ; I WR '

£ Desktop §

I ____/ | Files of typet | portable Metwork Graphics (*,png) v 1

4. wvindows Metafile (*.wmf)

25 / Poskscript (*,ps)

.04 JPEG (* jpg, * jpeg) e

’ Portable Metwork Graphics (*.prg)
2.51

Figure 6.56 Save Browser - Plots

6.13.3 Copying Plots to the Clipboard

6.14

Printing Plots

Use Copy to Clipboard from the
File menu to copy aplot to the
clipboard. Y ou can then paste the
plot as an image into other
applications that are available on Margins

your computer. left:  1.0in Top:  Lain
Set Margins

Right: 1.0in  Bottom: 1.01in

Page Setup E|

Crientation

@ Borfraif (O Landscape () Reversed

Additional Options

[] Page Mumbers

The Print command, available Printer Scale

from the File menu of aplot, opens | @ temum Fiotting Ares
a standard, Windows-style print
dialog box.

From the File menu, click Page
Setup. The Page Setup dialog box T |
will open (Figure 6.57). Hereyou  Figure 6.57 Page Setup Dialog Box
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can set the page Orientation,
Margins, Page Numbers, and
Printer Scale. Set Margins opens
the Printer Margins dialog box
(Figure 6.58).

To view the plot asit will be printed,
from the File menu, click Print
Preview. Anexampleisshownin
Figure 6.59.

Printer Margins @

Taop | 1 |:||| i
Left | 1. ,:,| in
Bickkarn | 1 |:|| in
Right | 1.0 | i

[ ok l [ Zancel ]

Finaly, the Print Multiple command Figure6.58 Printer Margins Dialog Box

allows you to print several plots
on one page. ThePrint
Multiple dialog box (Figure
6.60) shows all of the currently
open plotsin the Available Plots
box. To select plotsfor printing,
double-click on the plotsin the
Available Plots box and the
selected plots will move to the
Selected Plots box. Next, use
the dider bars to specify the
number of plots you wish to
appear horizontally and
vertically on the page. The grid

I /B ECH CREEK STAIFLOW REG - INST/O10CT1 993/ MONTHCR RAW/ preview |
e | Cose  [100% -

-

4 4 1 ' : !
[ e e [0 e o
| When 1) | et I Tt
L e

“

to theright of the sliders reflects
your choices.

Figure 6.59 Example Print Preview of aPlot
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A preview of the plots set up aboveis shown in Figure 6.61. From the
Print Multiple dialog box, you can also use the Page Setup and Print
Preview commands. The two commands are available from the File menu
of the Print Multiple dialog box.

B Print Multiple preview g|

Prink Close 100 % |

-

U
i
[l
1
|
Jp—
E EREREERE
'}

P
i )
©oEoE e s

¢ >

Figure 6.61 Print Multiple Preview Dialog Box (Example€)

6.15 Importing and Exporting Default Plot Properties

Plot property changes made in a plot's Default Plot Properties editor
apply to all plots used within the HEC-DSSV ue application. However, if
you would like to use the same defaults for another HEC application, you
can import or export the properties. The properties must be moved
from/to acompatible HEC "Next Generation" java based software
application.

Examples of compatible software are: HEC-DSSVue, HEC-FIA, HEC-
ResSim, HEC-RAS, HEC-HMS, CWMS, etc.

6.15.1 Exporting Default Plot Properties
Before you can import default plot properties, the properties must first by

exported. By exporting the properties, you create a*.zip file of al the
necessary default plot property files needed.
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To Export default plot properties:

1. In aplot window from the Edit menu, click Default Plot
Properties. Inthe Default Plot Propertiesdialog box, click
Export (Figure 6.62).

Default Plot Properties @

Eﬁ?’i}’éé-j‘ Wiewport | Title | Axis | Legend | Marker Lines | Layouk

Style | Legend Trem || Quality Symbols

Missing Yalue Symbols

[[] Draw Missing Yalues Symbols

2l

o I ]
Figure 6.62 Default Plot Properties Dialog Box

2. A Save browser will open (Figure 6.63). In the Save browser, type
in aname for your default plot properties in the File name field,

then click Save.
Save EI
Save in |[ﬂ Desktap V| T EE
" IEI':'I My Documents
__,J DefaultPlotProps. zip
Recent
=
[
Deskiop

File name: |DefaultF‘IotF‘rops.2ip | [ Save ]

___/ Files of type: | 7ip File (*.2ip) v Cancel

Figure 6.63 Save Browser - Exporting Plot Properties

3. A *.zipfilewill be created containing all the files needed to import
the properties to adifferent HEC application.

6.15.2 Importing Default Plot Properties
Once you have exported the default plot properties from a compatible

HEC application, you can then Import them to a different HEC
application.
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6.16

To Import default plot properties:

1. In aplot window from the Edit menu, click Default Plot
Properties. Inthe Default Plot Propertiesdialog box, click
Import (see Figure 6.62, page 6-45).

2. An Open browser will open (Figure 6.64). Using the Open
browser, select the *.zip default plot propertiesfile, and then click
Open.

2] Open g|
Look in: |[5) Deskkop v T E| E'

Recent

IEI':'l Iy Documents
M| Def aultFlotProps. zip

Diaskbop File namne: DefaultPlatProps. zip
Files of type: | 2ip File (*,zip) e

Figure 6.64 Open Browser - Importing Plot Properties

3. The default propertiesin the *.zip file will be imported and
extracted into the current application. The changes will be
reflected in the Default Plot Properties editor.

Text Substitution

In all locations where the plot properties editors alow you to enter text,
for example: the Plot Title, Legend Title, Axis Labels, Legend L abels,
etc. you can use text substitution. Text substitution is when you set the
text using predefined keywords based on Date/Time and DSS related
information. These keywords will be used as alook-up and replaced when
the text is used in the plot window according to the selected DSS data.

In order for Keywords to be recognized as such, they must be bracketed on
each side by % characters. For example: %BPART% would result in the
"BPART" of the DSS path being written in the final display text. If you
would like to have the actua percentage sign in the display text, use two
% charactersin arow %% and the second one will be displayed.

By default, the first DSS path provided in the plot will be used for the text
substitution. However, adding a colon and integer value to the
substitution keyword will instruct the substitution algorithm to use a
different path. For example %BPART:3% would show the "BPART" of
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the third DSS path provided in the plot. If there were less than three paths
proved in the plot, the last DSS path listed would be used for the

substitution.

Text substitution keywords may be mixed with fixed text.

For example:

Thetext: Fina Results at %BPART%
Would display: Final Resultsfor SHASTA
Using the DSS path: //SHASTA/ELEV/1IHOUR/O01JAN2000/ALT1/

Thefollowing isalist of available text substitution keywords:

DSS Path Parts:

APART
BPART
CPART
DPART
EPART
FPART
DSSPATH

DSSFile

DSS path A part
DSS path B part
DSS path C part
DSS path D part
DSS path E part
DSS path F part
full DSS path

DSSFILENAME DSSfile name only (without .dss extension)
DSSFILEPATH Full path to DSSfile, including file name and

extension

DSSFILEDIR Directory containing DSSfile

Current Date/Time:

CURDATE
CURMON
CURDAY
CURYEAR
CURTIME

Current Date (DDMMMYYYY)
Current Month

Current Day

Current Y ear

Current Time
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CHAPTER 7

Math Functions

The Math functions are available from the T ools menu or | /& |Math
Functions Toolbar button and are organized into six categories.
Arithmetic, General, Time Functions, Hydrologic, Smoothing, and
Statistics. Each category isatab on the Math Functions screen (Figure
7.1). This chapter describes math functions according to these categories.

Title Bar Ve e g@@

Menu Bar | Ele Edit Display

Menu Bar Buttons ] & & |4 F ]
Selected Data Set 9] elected Data Set: | [MISSISSIPPI RIVER/ST. LOUIS, MOFLOW/011AN1 960/ 1DAY/USGS/ v

Arithmetic | General | Time Functions | Hydrologic | Smoothing | Statistics
Catecorv Tabs # . -

Operator: | add v
Onerator List

() Constant

() Data Set
[MISSISSIPPI RIVER/ST. LOUIS, MOJFLOW/01JAN1 960/ 1DAY{USGS]

Function W orksheet

A 4

Comnute Button
Compute

Message Bar # | [No Constant entered.

Figure 7.1 Math Functions Screen

7.1 Math Functions Screen

Figure 7.1 shows the basic appearance of the Math Functions screen.
The HEC-DSSVue Math Functions screen enables the mathematical
manipulation of time series and paired data selected in the HEC-DSSVue
Data Selection List window.

7.1.1 Menu Bar

Menu options in the Math Functions screen allow you to save or rename
data computed with the Math functions, and to display the computed and
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original datain plots and tables. The Math Functions menus are as

follows:
File File menu commands are Save, Save As, and Close.
Edit The Edit menu contains the Restore Original Data command.

Display Usethe Display menu to open plots and tables with the Plot and
Tabulate commands, and set options for datato display with the
Original Data with computed and All Data Sets commands.

7.1.2 Menu Bar Buttons

Menu bar buttons provide shortcuts to frequently used Menu commands:

E Saves computed data to a HEC-DSS file (same as Savein the File
menu).

EE Saves and Renames computed data to a HEC-DSS file (same as Save
Asin the File menu).

|¥ Displays dataas a Plot (same as Plot in the Display menu)

== Displaysdatain Tabular form (same as Tabulate in the Display
menu).

@ Displays datain Microsoft Excel (same as Excel in the Display
menu).

7.1.3  Other Math Features of the Math Functions Screen
The Operator and Selected Data Set items appear for al function types.

Use the Category Tabsto access each of the six categories of math
functions,

To select afunction, use the Operator list.

Use the Selected Data Set list to choose a data set to apply each function.
Thislist contains the names of data sets you have chosen in the HEC-
DSSVue Data Selection List window.

Use the Compute button located near the bottom of the screen to apply a
function to selected data sets. If data on the function screen isincomplete,
the Compute button is unavailable. A message appears in the M essage
Bar at the bottom of the screen indicating which box isincomplete. In
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Figure 7.1, for example, the message indicates that no constant has been
entered.

7.2 Managing Data

Most functions modify the valuesin the selected data. However, the
Math Functions screen retains a copy of the original data, which you may
use for comparison plotting with the computed result or for "undoing" the
compute action. Other functions, such as"Merge Time Series’, may
generate anew data set, which is appended to the data set list in the
Selected Data Set list.

Once adata set has been modified or generated by a function compute,
you can save the datato thefile, plot it, or tabulate it using the menu
options or menu bar buttons located at the top of the Math Functions
screen. A computed data set is not automatically saved to the file until
you explicitly save the operation.

When you exit the Math
Functions screen, if one or more
data sets have been modified but
not saved, you will be prompted

Save Changes

k?f} Data has changed. Save Changes?

with the Save Changes message Mo [ we [ comeel |
shown in Figure 7.2. Savethe
changes by clicking Y es. Figure 7.2 Save Changes Dialog Box

In plots and tables, the F-Part of the pathnameisidentified as
"MODIFIED-". Thisis not retained when the data set is saved to thefile
and saving the resulting data will overwrite recordsin thefile. In Figure
7.3 (page 7-4), the "NATRONA" time series was added to the
"BRADDOCK" time series. Theresulting data set is"NATRONA
MODIFIED".

7.2.1  Selecting Paired Data Curves for Function
Operations

Typicaly paired data has a set of x-values and a corresponding set of y-
values (e.g. astage-flow rating table). However, a paired data set may
have multiple sets of y-values, or curves, which share the same x-ordinates
(e.0. frequency-damage curves for multiple categories). Math functions
that operate on paired data sets allow the user to select one or al of the
paired data curves for the function application. For example, with the Add
function, a number may be added to y-values in one curve or to y-values
in all curves.
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Figure 7.3 Plot of Time Series Data from the"Add" Function

Figure 7.4 shows the appearance of the Math Functions screen when a

paired data set is selected for an "Add" operation.

Math Functions
File Edit Display

FAVET
Selected Data Set: |,I'TRF'.'-.-'-RC-F'OOL,I'TRP.MSII'ELE'\.I'-EXCEEDHNCE,I'1DF'.‘|’: JIDEC1941-04MAYZO09 AL, ., » |
Arithretic | General Hydralogic
Operatar: |,.:.|,:|,:| w |
Select Paired Data Curvel | gy and x w
JUL *
(#) Constant ALl
SEP
(") Data Set T
ITRAY-RC-POOLI TR AMSE[MOY CE/ADAY: 310EC 1941 -04MAY2009/ ALLIOBS]
DEC
Al y )
Al y and x 54

Compute

Mo Zonskant entered.

Figure 7.4 Selection of Paired Data Curve
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7.3

7.3.1

The paired data curve to apply the add function is picked using the Select
Paired Data Curvelist. Thelistisfilled with the paired data curve
labels. In thiscase, thereisacurve for each month of the year. The "All"
selection in the list refers to the option to pick all curves for the function
operation. If the paired data curves are not explicitly labeled in the paired
data set, the curvelist is then filled with the curve numbers. The Select
Paired Data Curvelist only appearsif the selected data set is paired data.

Arithmetic Functions

Add

The Arithmetic tab (Figure 7.5) contains the following functions: Add,
Subtract, Multiply, Divide, Exponentiation, Absolute Value, Square
Root, Log, Log Base 10, Sine, Cosine, Tangent, Inverse,
Accumulation, Successive Differences, and Time Derivative.

File Edit Display
R LT

Selected Data Set: | [{SAVER/FLOW 0 1MOY 1953 1HOURBASEQAO v

Arithmetic | General | Time Functions | Hydrologic | Smoothing | Statistics

Operator: | add “

(¥ Constant

() Data Set

[ISAYERFLOMADLNON1 993 THOUR JBASEDSOOS
HISAYERFLOMW-BASE/DLMNOW1 993 IHOUR [BAS

compute

Mo Constant entered.

Figure7.5 Math Functions - Arithmetic Tab

To Add avalueto each data point in a data set:

1. Select Add in the Operator dropdown list.

2. Click Constant and enter avalue to add in the box to the right, as
shown in Figure 7.6 (page 7-6).

3. Click Compute.
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Eile Edit Display

i |4 SE

Selected Data Seb: | (fSAYERFLOW/01MON 1993 1HOUR/BASEDGDD]

Operator: | add w
() Constant 10|
() Data Set

1S AYERJFLOWO1MOY 1995 1 HOURBASEDGO0,
1S AYERJFLOW-BASE/OINOY1 993 IHOUR/BA/

Arithmetic | General | Time Functions || Hydrologic | Smoathing | Statistics

w

Figure 7.6 Adding a Constant to a Data Set

To Add data sets together (time series data sets only):

1. Select Add in the Operator dropdown list.
2. From the Selected Data Set list, select a data set to apply the
function. This data set will contain the result of the addition

operation.
3. Click Data Set.

4. From the Data Set list, select the data sets to be added. If you
include the data set selected in the top Selected Data Set, it will be
added by itself. See Figure 7.7 for an example.

5. Click Compute.

Math Functions Q@El

File Edit Display

Wk |4F

Selected Data Set: [ [{SAYERFLOW/01MOYL993) 1 HOURBASEDS00]
Arithmetic | Gemeral | Time Functions | Hydrologic | Smookhing | Skatiskics

operatar: | add -

() Constant

(& Pata et
§ISAYERJFLOW /01 NOY 1993 1HOURJBASEDSDD]
1ISAYER FLOW-BASESDIMNOY 1993/ IHOUR/BAS

Compute

Mo Dataset Selected

b

Figure 7.7 Add Data Sets Together

Caution: Do not include the Selected Data Set (at the top of the dialog)
in the lower window unless you want the data set added to itself. Thisisa

common mistake.
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7.3.2  Subtract
To Subtract avalue from each data point in a data set:

1. Select Subtract in the Operator dropdown list.
2. Click Constant and enter avalue to subtract in the box to the right.
3. Click Compute.

To Subtract adata set from anther data set (time series data sets only):

1. From the Selected Data Set list, select adata set to apply the
function. This data set will contain the result of the subtraction
operation.

2. Click Data Set.

3. From the Data Set list, select the data sets to be subtracted. If you
include the data set selected in the Selected Data Set, it will be
subtracted from itself.

4. Click Compute.

7.3.3  Multiply

To Multiply avalue to each data point in a data set:

1. Select Multiply in the Operator dropdown list.

2. Click Constant and enter avalue to multiply by in the box to the
right.

3. Click Compute.

To Multiply data sets (time series data sets only):

1. From the Selected Data Set list, select a data set to apply the
function. This data set will contain the result of the multiply
operation.

2. Click Data Set.

3. From the Data Set list, select the data sets to be multiplied. If you
include the data set selected in the top Selected Data Set, it will be
multiplied by itself.

4. Click Compute.

7.3.4 Divide

The Divide function divides dl valid valuesin atime series or paired data
set by a number, or divides the valuesin a data set by the valuesin one or
more data sets of the same type. For time series data, missing values are
kept as missing.
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7.3.5

When you are dividing data sets, times in the data sets need not match
exactly. Therefore, only values with coincident times will be divided.
Times in the primary time series data set that cannot be matched to times
in the other data set result in missing values for those times. Vauesin the
data set(s) selected from the lower list form the divisor(s). Vauesinthe
resultant data set are set to missing if there is a zero divisor. Missing
valuesin the primary data set are kept as missing. Data sets may be
regular or irregular interval time series.

Presently the Divide function does not allow the division of paired data by
another data set.

To divide all values in the selected data set(s) by a number:

1. Choose the Arithmetic tab of the Math Functions Screen and
select the Divide operator.

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

3. If the data set is paired data, use the Select Paired Data Curvelist
to select asingle paired data curve or all curvesfor the operation
(see Section 7.2.1 for more details). Constants can be divided by
only one paired data set at atime.

4. Click Constant and enter the value to divide by in the box to the
right.

5. Click Compute.

To divide the selected data set by one or more data sets (time series only):

1. From the Selected Data Set list, select a data set to apply the
function. This data set will contain the result of the divide
operation.

2. Click Data Set.

3. From the Data Set list, select the divisor data set(s). . If you
include the data set selected in the top Selected Data Set, it will be
divided by itself.

4. Click Compute.

Exponentiation

The Exponentiation function raises values in atime series or paired data
set to a user specified power, or exponent. For time series data, missing
values are kept as missing.

For exponentiation of the values:
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1. Choose the Arithmetic tab of the Math Functions Screen and
select the Exponentiation operator.

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

3. If the data set is paired data, use the Select Paired Data Curvelist
to select asingle paired data curve or all curves for the operation
(see Section 7.2.1 for more details).

4. In the Power box, enter the value for the power, or exponent.

5. Click Compute.

7.3.6 Absolute Value

The Absolute Value function computes the absol ute value of valuesin a
time series or paired data set. For time series data, missing values are kept
as missing.

To compute the absolute value of values:

1. Choose the Arithmetic tab of the Math Functions Screen and
select the Absolute Value operator.

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

3. If the data set is paired data, use the Select Paired Data Curvelist
to select asingle paired data curve or all curves for the operation
(see Section 7.2.1 for more details).

4. Click Compute.

7.3.7 Square Root

The Squar e Root function computes the square root of valid valuesin a
time seriesor paired data set. If avalueislessthan 0.0, thevalueis set to
missing in the resultant data set. For time series data, if the original value
iIsmissing, the value remains missing in the resultant data set.

To compute the square root of values:

1. Choose the Arithmetic tab of the Math Functions Screen and
select the Squar e Root operator.
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7.3.8

7.3.9

Log

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

3. If the data set is paired data, use the Select Paired Data Curvelist
to select asingle paired data curve or all curves for the operation
(see Section 7.2.1 for more details).

4. Click Compute.

The L og function computes the natural logarithm (log base "¢e") of valid
valuesin atime series or paired data set. If avalueislessthan or equal to
0.0, the valueis set to missing in the resultant data set. For time series
data, if the original value is missing, the value remains missing in the
resultant data set.

To compute the natural logarithm of values:

1. Choose the Arithmetic tab of the Math Functions Screen and
select the L og operator.

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

3. If the data set is paired data, use the Select Paired Data Curvelist
to select asingle paired data curve or all curvesfor the operation
(see Section 7.2.1 for more details).

4. Click Compute.

Log Base 10

The L og Base 10 function computes the log base 10 of valid valuesin a
time series or paired data set. If avalueislessthan or equal to 0.0, the
valueis set to missing in the resultant data set. For time series data, if the
original value is missing, the value remains missing in the resultant data
Set.

To compute the log base 10 of values:

1. Choose the Arithmetic tab of the Math Functions Screen and
select the L og Base 10 operator.
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2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

3. If the data set is paired data, use the Select Paired Data Curvelist
to select asingle paired data curve or all curves for the operation
(see Section 7.2.1 for more details).

4. Click Compute.

7.3.10 Sine

The Sine function computes the sine of valid valuesin atime series or
paired dataset. The resulting data set will bein radians. For time series
data, missing values are kept as missing.

To compute the sine of values:

1. Choose the Arithmetic tab of the Math Functions Screen and
select the Sine operator.

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

3. If the data set is paired data, use the Select Paired Data Curvelist
to select asingle paired data curve or all curvesfor the operation
(see Section 7.2.1 for more details).

4. Click Compute.

7.3.11 Cosine

The Cosine function computes the cosine of valid valuesin atime series
or paired data set. The resulting data set will bein radians. For time
series data, missing values are kept as missing.

To compute the cosine of values:

1. Choose the Arithmetic tab of the Math Functions Screen and
select the Cosine operator.

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.
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3. If the data set is paired data, use the Select Paired Data Curvelist
to select asingle paired data curve or all curvesfor the operation
(see Section 7.2.1 for more details).

4. Click Compute.

7.3.12 Tangent

7.3.13

The Tangent function computes the tangent of valid valuesin atime
series or paired dataset. The resulting data set will bein radians. If the
cosine of avalueis 0.0, the valueis set to missing in the resultant data set.
For time series data, if the original value is missing, the value remains
missing in the resultant data set.

To compute the tangent of values:

1. Choose the Arithmetic tab of the Math Functions Screen and
select the Tangent operator.

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

3. If the data set is paired data, use the Select Paired Data Curvelist
to select asingle paired data curve or all curves for the operation
(see Section 7.2.1 for more details).

4. Click Compute.

Inverse

The Inver se function computes a new value from 1 divided by the value
(Ux) inatime series or paired data set. If avalueisequal to 0.0, the value
is set to missing in the resultant data set. For time series data, if the
original value is missing, the value remains missing in the resultant data
Set.

To compute the inverse (1/x) of values:

1. Choose the Arithmetic tab of the Math Functions Screen and
select the I nver se operator.

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.
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3. If the data set is paired data, use the Select Paired Data Curvelist
to select asingle paired data curve or all curvesfor the operation
(see Section 7.2.1 for more details).

4. Click Compute.

7.3.14 Accumulation

The Accumulation function computes a running accumulation of values
for aregular or irregular interval time series data set. For amissing value
in the time series data, the value in the accumul ation time series remains
constant (i.e., missing values treated as zero).

Note: The datatype of the time series data set governs how values are
added. See aso Accumulation over interval inthe Time Conversion
function Min/Max/Avg/... Over Period.

To compute the running accumul ation of values for time series data sets:

1. Choose the Arithmetic tab of the Math Functions Screen and
select the Accumulation operator.

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

3. Click Compute.

7.3.15 Successive Differences

The Successive Differ ences function computes the difference between
successive valuesin aregular or irregular interval time series data set.

The time series data must be of type "INST-VAL" or "INST-CUM". A
value in the resultant time seriesis set to missing if either the current or
previous value in the original time seriesis missing (need to have two
consecutive valid values). If the datatype of the original dataset is
"INST-CUM" the resultant time series data set is assigned the type "PER--
CUM", otherwise the data type does not change.

To compute the successive differences for time series data sets:

1. Choose the Arithmetic tab of the Math Functions Screen and
select the Successive Differ ences operator.

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
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selected in the top Selected Data Set, the operation on that set will
only be done once.
3. Click Compute.

7.3.16 Time Derivative

7.4

7.4.1

The Time Derivative function computes the successive differences per
unit time for aregular or irregular interval time series data set. For the
time "t",

TS2(t) = (TSL(t) - TSL(t-1)) /DT

where DT isthe time difference between t and t-1. For the current form of
the function, the units of DT are minutes.

A valuein the resultant time seriesis set to missing if either the current or
previous value in the original time seriesis missing (need to have two
consecutive valid values). By default, the data type of the resultant time
series data set is assigned as "PER-AVER".

To compute the time derivative for time series data sets.

1. Choose the Arithmetic tab of the Math Functions Screen and
select the Time Derivative operator.

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

3. Click Compute.

General Functions

The General tab (see Figure 7.8, page 7-15) contains the following
functions. Units Conversion, Set Units, Set Type, Round to Nearest
Whole Number, Truncate to Whole Number, Round Off, Estimate
Missing Values, Replace Specific Values, Screen Using Maximum and
Minimum, Screen Using Forward Moving Average, Merge Time
Series, Merge Paired Data, and Generate Data Pairs.

Units Conversion

The Units Conver sion function converts Sl (metric) unit datato English
units, or English unit datato Sl units. The Units Conversion function may
be applied to either time series or paired data sets.
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File Edit Display
: |4

Selecked Data Set:

HISAVERFLOW 01 MCY 1993 IHOURJBASEDE00) A

Arithmetic | @eneral | Time Functions | Hydrologic | Smoothing | Statistics

Operakar:

Screen using Minimurn and Mazximum e

Mimirnurm Yalue Limnik:
Maximum value Limit:
Change Walue Limit:

Set invalid values ko: Leave blank for missing

[] 5et Guality Flag to:

(%) Single Selected Data Set (abave)

() Multiple Selected Data Sets (below)

Compute

Mo walues entered

Figure 7.8 Math Functions - General Tab

To convert units for time series or paired data sets.

1.

2.

7.4.2 Set Units

Choose the General tab of the Math Functions screen and select
the Time Units Conver sion operator.

Choose the type of conversion by clicking Convert to Sl or
Convert to English.

From the Selected Data Set list, select one or more data sets for
units conversion.

From the Available Data Sets To Convert list you may select
additional data setsfor units conversion. Thislist is affected by
the type of units conversion selected. If Convert to Sl is selected,
only data sets that are currently in English units will appear in the
list. Similarly, if Convert to English is selected only data sets
currently in SI units will appear.

Click Compute to perform the units conversion of the selected
data sets.

The Set Units function sets the unitslabel in the selected data set. 1t will
not convert the data to the new units; unless a conversion multiplier is
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7.4.3

7.4.4

used that correctly converts from the current units to the new units. The
Set Unitsfunction is often used to change the units label in incorrectly
labeled data sets.

To set units for time series or paired data sets:

1. Choose the General tab of the Math Functions screen and select
the Set Units operator.

2. The current units are provided in the Unitsbox. Enter the units
label you want to set the data set to.

3. If you want to convert the data besides just setting the units label,
enter the conversion multiplier.

4. From the Selected Data Set list, select one or more data sets.

5. Click Compute.

6. Save your data using the Save button.

Set Type

The Set Type function sets the type label in the selected data set. It will
not convert the data to the new type; you can use an operator in the Time
Functionstab for that, if appropriate. The Set Type function is often
used to change the type label in incorrectly |abeled data sets.

To set the type for time series data sets.

1. Choose the General tab of the Math Functions screen and select
the Set Type operator.
2. From the Selected Data Set list, select one or more data sets.
3. The current units are provided in the Current Type label. Enter
the type that you want to set the data set to. The type choices are:
a PER-AVER
b. PER-CUM
c. INST-VAL
d. INST-CUM
Click Compute.
Save your data using the Save button.

o &

Round to Nearest Whole Number

The Round to Near est Whole Number function rounds valuesin atime
series or paired data set to the nearest whole number.

The function rounds up the decimal portion of anumber if equal to or
greater than .5 and rounds down decimal values lessthan .5. For example:
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10.5isrounded to 11.
10.499 is rounded to 10.
-10.499 is rounded to -10.
-10.500 is rounded to -10.
-10.501 isrounded to -11.

The x-vauesin paired data sets are unaffected by the function, only the y-
value data are rounded. For time series data sets, missing values are kept
missing.

To round values in time series or paired data sets to the nearest whole
number:

1. Choose the General tab of the Math Functions screen and select
the Round to Nearest Whole Number operator.

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

3. Click Compute.

7.4.5 Truncate to Whole Number

The Truncate to Whole Number function truncates valuesin atime
series or paired data set to the nearest whole number. For example:

10.99 is truncated to 10.
10.499 is truncated to 10.
-10.001 is truncated to -10.
-10.999 is truncated to -10.

The x-valuesin paired data sets are unaffected by the function, only the y-
value data are truncated. For time series data sets, missing values are kept
missing.

To truncate values in time series or paired data sets to the nearest whole
number:

1. Choose the General tab of the Math Functions screen and select
the Truncate to Whole Number operator.

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

3. Click Compute.
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7.4.6

7.4.7

Round Off

The Round Off function rounds values in atime series or paired data set
to a specified number of significant digits and/or power of tens place. For
the power of tens place, -1 specifies rounding to one-tenth (0.1), while +2
rounds to the hundreds (100). For example, 1234.123456 will round to:

1230.0 for number of significant digits = 3, power of tens place = -1
1234.1 for number of significant digits =6, power of tensplace=-1
1234 for number of significant digits=6, power of tensplace= 0
1230 for number of significant digits=6, power of tensplace= 1

The x-valuesin paired data sets are unaffected by the function, only the y-
value data are rounded. For time series data sets, missing values are kept
missing.

To round valuesin time series or paired data sets:

1. Choose the General tab of the Math Functions screen and select
the Round Off operator.

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

3. Inthe Number Significant Digits box, set digits precision.

4. In the Power of 10s Place box, set the magnitude of 10 to which to
round.

5. Click Compute.

Estimate Missing Values

The Estimate Missing Values function linearly interpol ates estimates for
missing valuesin aregular or irregular interval time series data set. Linear
interpolation will occur for those portions of the time series data set where
the number of consecutive missing values exceeds a specified user limit.

If the time series data set has type "INST-CUM", a special check box
appears to optionally enable the following rules intended for cumulative
precipitation:

m If the values bracketing the missing period are increasing with
time, only interpolate if the number of successive missing values
does not exceed the value of the user specified limit.
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m If the values bracketing the missing period are decreasing with
time, do not estimate any missing values.

m If the values bracketing the missing period are equal, then estimate
any number of missing values.

To estimate for missing values in time series data sets:

1. Choose the General tab of the Math Functions screen and select
the Estimate Missing Values operator.

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

3. Inthe Maximum Consecutive Number of Missing box, enter a
value to set the limit for consecutive missing values allowed for
interpolation.

4. If thetime series data set is of type cumulative precipitation, select
I nter polate Cumulative Precip to apply the modified rules for the
interpolation of missing precipitation data.

5. Click Computeto perform the linear interpolation fill of the
missing values in the data set.

7.4.8 Replace Specific Values

The Replace Specific Values function replaces all occurrences of a
specified value with another. For example, you can use this function
to change all occurrences of "1000"" to "2000". If the data set
contains precision information, then values within that precision limit
will be replaced. For example, if the precision of the data set is"1"
(number of digitsto theright of the decimal), then avalue of "12.3"
will replace all values between "12.25" and "12.35". If no precisionis
set, the values have to be exact to be replaced (not necessarily what is
shown in atabulation). This function works on both time-series and
paired data sets.

To replace specific valuesin time series or paired data sets:

1. Choose the General tab of the Math Functions screen and select
the Replace Specific Values operator.

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.
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7.4.9

3.

4.

5.

In the Value to bereplaced box, enter the value in the data sets
that you want to be replaced. If you want to replace missing
values, leave this box empty.

In the Value to replace with, enter the new number that you want
to replace the specified number with. If you want the value to be
replaced to be set to missing, leave this box empty.

Click Compute to perform the operation.

Screen Using Minimum and Maximum

The Screen Using Minimum and M aximum function screens regular or
irregular interval time series data sets for possible erroneous val ues based
on user specified minimum-maximum value limits, and maximum
absolute change. The maximum absolute change is tested only when the
previous time series value is screened as valid. Only onetest need to be
specified.

Data values failing the screening test can be assigned a user specified
quality flag and/or set to a specific value or to missing. The data sets may
or may not contain prior quality flags. If the user specifies setting quality
flags for screened data, they will be added to the resultant data setsif none
dready exists.

1.

2.

Choose the General tab of the Math Functions screen and select
the Screen Using Minimum and M aximum operator.

Select a data set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

. Inthe Minimum Value Limit and/or Maximum Value Limit

boxes, enter the minimum and/or maximum valid value limits,
respectively.

. Inthe Change Value Limit box, enter avalue to set maximum

absolute change alowed from the previous time series value if you
want to test for this.

. Sdlect the Set I nvalid values to checkbox and fill enter the value

you want to replace with for time series values failing the
screening test. To set the value to missing, leave that box empty.

. Select the Set Quality Flag box if the data quality flag isto be set

for data values failing the screening test. If thisbox is checked,
invalid datawill be flagged with the quality selected in the list to
theright. The available quality settings are: R(gected), M(issing)
and Q(uestionable).

. Click Compute.
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7.4.10 Screen with Forward Moving Average

The Screen with Forward Moving Average function screens atime series
data set for possible erroneous val ues based on the change from the
forward moving average computed at the previous point.

Data values failing the screening test are assigned a user specified quality
flag and/or are set to the missing value. The data set may or may not
currently have quality flags assigned. The forward moving average is
computed over a user specified number of values. Missing values and
values failing the screening test are not counted in the moving average and
the divisor of the average is less one for each such value.

To screen data in time series data sets;

1. Choose the General tab of the Math Functions screen and select
the Screen with Forward M oving Aver age operator.

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

3. Inthe Number to Average Over box, enter avalue to set the size
of the moving average interval.

4. In the Change Value Limit box, enter avalue to set maximum
absolute change allowed from the forward moving average.

5. Select the Set Invalid Valuesto Missing box if time series values
failing the screening test are to be set to the missing value.

6. Select the Set Quality Flag box if the data quality flag isto be set
for data values failing the screening test. If thisbox is checked,
invalid datawill be flagged with the quality selected in the list to
theright. The available quality settings are: R(gected), M(issing)
and Q(uestionable).

7. Click Compute to apply the function to the selected data set.

7.4.11 Paired Data Operations

The Paired Data Operations section provides a means of performing
several utility operations on paired data curves. The operationsinclude
which parameter to show on the horizontal axis, an operation to reorder
points in ascending order, re-sampling the curve to contain fewer points,
and swapping the parameters. Generally, only one operation should be
preformed at atime. However, if desired, the order of the operationsis:. 1)
Reorder in ascending; 2) Delete Curve(s); 3) Re-sample; 4) Swap
parameters, and 5) Setting the parameter associated with the horizontal
axis.
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1)

2)

3)

4)

5)

1.

2.

Setting the parameter associated with the horizontal axis. By
default, when a paired data curve is created, the first, or
independent, parameter is displayed on the horizontal axis. This
isthe same as the first parameter in the C Part. For some plotsit
may be more desirable to have the independent parameter display
on the vertical axisinstead of the horizontal axis. Thisflag does
not change how dataisinterpreted by programs; only how it is
displayed in plots and tables.

Reorder pointsto be ascending and removing duplicates. This
operation will take the points in the curve and reorder them so that
the primary parameter is ascending. Any duplicate primary
(independent) parameter values will be removed. The function
will not remove dependent parameters. If you wish to accomplish
this, you should swap the parameter sets, run this function, and
then swap back.

Resample points. This operation reduces the number of points by
resampling the curve according to the number specified to skip. If
the value entered is 2, then every other point will be skipped. If
the value entered is 3, then 2 values will be skipped and the third
kept. If the value entered is one, no points will be skipped. The
first and last points will always be retained.

Swap parameters. This operation moves the X (independent)
ordinatesto the Y (dependent) position and the Y ordinatesto the
X position. The units and type are moved also, as well asthe
namesin the C part. Thisfunctionisonly valid for data sets with
one curve (one dependent parameter).

Delete curve. This operation will delete the specified curves from
amulti-curve data set. To select curves, press the down arrow on
the combination box and click on the curves that are to be deleted.
Selected curves will be shown with a checkbox at the beginning.
Thisfunction is not valid with single curve data sets, nor can you
delete all the curves.

Note: You can aso delete curves, aswell asinsert them, from an edit-
enabled table by selecting a column and then selecting Delete Column (or
Insert Column) from the Edit menu.

To modify a paired data set with these functions:

Choose the General tab of the Math Functions screen and select
the Paired Data Oper ations operator.
From the Selected Data Set list, select one or more data sets.
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3. Select the operation(s) that you want to perform. Itis
recommended to select only one at atime. If you select resample,
enter the number of points you want the new set to correspond to.
If you want to delete a curve(s), select the curve(s) from the pull
down box. For multiple selections, hold down the control key
when you select the curve.

4. Click Compute to perform the operation(s).

7.4.12 Merge Time Series

The Merge Time Series function merges data from one time series data
set with another time series data set. The resultant time series data set
includes all the data pointsin the two time series, except where the data
points occur at the sametime. When data points from the two data sets are
coincident in time, valid values in the primary time series take precedence
over valid valuesin the second selected time series. However if a
coincident point is missing in the primary time series, avalid value in the
second time series will be used for the data point in the resultant data set.

If the value is missing for both time series data sets, the valueismissing in
the resultant data set.

The data sets for merging may be either regular or irregular time interval.
The resultant data set is tested to determineif the times have aregular time
interval. If not, it istyped as an irregular timeinterval data set.

Dataof any type (i.e., "INST-CUM") or units may be merged with data of
any other type or units. The resultant time series receives the data type
and units of the primary time series.

To merge two time series data sets:

1. Choose the General tab of the Math Functions screen and select
the Merge Time Series operator.

2. From the Selected Data Set List, select the primary time series
data set.

3. From the Time Series list, select the second time series data set for
merging.

4. Click Compute to merge the two data sets.

7.4.13 Merge Paired Data

The Merge Paired Data function merges two paired data sets. The
resultant paired data set includes all the paired data curves from the first
data set and a single selected paired data curve or al curves from the
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second data set. The x-values for the two paired data sets must match
exactly.

To merge two paired data sets:

1. Choose the General tab of the Math Functions screen and select
the Merge Paired Data operator.

2. From the Selected Data Set list, select the primary paired data set
for merging.

3. From the Paired Data list, select the second paired data set for
merging.

4. From the Select Paired Data Curvelist, set the curve to be
merged from the second paired data set (see Section 7.2.1 for more
details).

5. Click Compute to merge the two data sets.

7.4.14 Generate Data Pairs

The Generate Data Pair s function generates a paired data set by pairing
values (by time) from two time series data sets. The data pairsin the
paired data set may optionally be sorted by ascending x-value. An
example use of the function would be to mate a time series record of stage
to one of flow to generate a stage-flow paired data set.

Thetimesin the two time series data sets must match exactly. If avalue
for atimeis missing in either time series, no data value pair is formed and
added to the paired data set.

Units and parameter type from the primary time series data set are
assigned to the paired data set x-units and x-parameter type. Unitsand
parameter type from the second time series are assigned to the paired data
set y-units and y-parameter type.

To generate a paired data set by pairing valuesin two time series data sets:

1. Choose the General tab of the Math Functions screen and select
the Generate Data Pair s operator.

2. From the Selected Data Set list, select the primary time series data
set. Time series values from this data set will comprise the x-
values of the resultant paired data set.

3. From the Data Set list, select the second time series data set. Time
series values from this data set will comprise the y-values of the
resultant paired data set.

4. Check the Sorted box if the data pairs are to be sorted by
ascending x-values.

5. Click Compute.
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If time points in the two time series data sets do not match exactly, an

error message will be posted and the function operation will not
performed.

7.5 Time Functions

The Time Functionstab (Figure 7.9) contains the following functions:
Min/Max/Avg... Over Period, Copy in Time, Shift in Time, Change
Timelnterval, Irregular to Regular, Regular toIrregular, To
Irregular using Pattern, and Extract Time Series.

Math Functions g@@

File Edit Display

WEE
Selected Data Set: | f{SAYER/FLOWIO1NOY1993/1HOUR [BASEOSD0]
Arithmetic | General | Time Functions | Hydrologic | Smoothing | Statistics
Operator: | MingMax/dvg)... Over Pe,..
Function Type: Maximurm For Period b
(%) Mew Period Interval: 10aY e
() Custom Period Interval:
[] Save as Irreqular Interval {get time of occurrence).

Block Size:

Sek Time Offset: [ offset

Data Type! INST-¥AL

() gingle Selected Data Set {above)

® Piditiple Selected Data Sets (belowg | Select Al

JISAYERFLOWD1NOY 1993/ 1HOUR/BASEOGD0]
JISAYER FLOW-BASE/0INOV 1993 IHOUR B4/

Figure7.9 Math Functions - Time Conversion Tab

7.5.1  Min/Max/Avg/... Over Period

TheMin/Max/Avg/... Over Period function generates atime series data
set using a variety of functions from an existing irregular or regular
interval time series data set. The functions are:

Interpolate at end of Period
Maximum for Period

Minimum for Period

Average over Period
Accumulation over Period
Volume for Period

Integration over Period

Number of Valid Data over Period
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where "period” is auser selected timeinterval to evaluate the data over.
This function is often used to compute information such as the maximum
or minimum annual flow, total annual precipitation, and maximum and
minimum daily temperatures. (See remarks following regarding
computing values for water years.)

The resulting data can be put in an irregular-interval data set. By doing so,
the date and time of each occurrence will be saved with the data. For
example, if maximum annual flows are computed, the date and time of
that maximum will be provided with an irregular-interval block. You
should choose an irregular-interval block size, so that between 50 and
1,000 values are stored in ablock. Daily data results should use a block
sizeof “IR-YEAR”. Annual results should use ablock size of “IR-
DECADE”".

Besides choosing a standard interval, you can also select a Custom Period
Interval. This provides you the capability to compute information over a
period that is different from a standard storage interval, such as two-day
averages, and maximum or accumulation over 2, 5 or 10 years. To
compute using a custom interval, select Custom Period I nterval and then
enter an integer interval value and select the time increment for that value
from the list further to the right. The time increments include: Minute,
Hour, Day, Week, Month, and Year. If you choose a custom period
interval, the results must be stored in irregular-interval data sets.

The data type of the original time series data governs how values are
interpolated. Datatype"INST-VAL" (or "INST-CUM") considers the
value to change linearly over the interval from the previous data value to
the current datavalue. Datatype "PER-AVER" considers the value to be
constant at the current data value over theinterval. Datatype "PER-
CUM" considers the value to increase from 0.0 (at the start of the interval)
up to the current value over theinterval. Interpolation of the three data
typesisillustrated in Figure 7.10.

X Interpolated value

N S

INST-VAL PER-AVER PER-CUM
Figure 7.10 Interpolation of "INST-VAL", "PER-AVER" and "PER-CUM" Data
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How interpolation is performed for a specific data type influences the
computation of new time series values for the selected function. For
example, if the datatypeis"INST-VAL", the function Maximum for
Period is evauated by:

m Finding the maximum vaue of the data points from the original
time series that are inclusive in the new time period.

m Linearly interpolate values at beginning and ending of the new
time interval, and determine if these values represent the maximum
over theinterval.

Referring to the plotsin Figure 7.10, the Average over Period functionis
applied to atime series by integrating the area under the curve between
interpolated points and dividing the result by the interval time.

Times in the new time series may be shifted (offset) from the regular
interval time by auser specified offset. Asan example, the offset could be
used to shift timesin regular hourly interval datafrom the top of the hour
to 6 minutes past the hour.

Figure 7.11 shows the appearance of the Math Functions screen for the
Min/Max/Avg/... Over Period function.

" | Math Functions

File Edit Display

Selected Data Set. /BEAR CRIAT MCKEE RDIFLOWITT MART 884/ HOURY  ~ |

Arithmetic | General Time Canwersion | Hydrologic | Smoathing | Statistics |

Operator: |uiniawAvgl - Over Perind ~ |

Function Type: |Ma}<imum over Period j

Mews Period Interval: 1YEAR -
Custom Feriod Interval:

¥ Save as Irregular Interval (gettime of occurrence).

Block Size: IR-CEMTURY =
Set Time Offset: [~ Offset

 Single Selected Data Set (above)

+ multiple Selected Data Sets (helow)

Compute

Figure 7.11 Screenfor Min/Max/Avg/... Over Period Function
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7.5.2

To compute the minimum, maximum, average, etc. of time series data
sets:

1. Choose the Time Functions tab of the Math Functions screen and
select the Min/Max/Avg/... Over Period operator.

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

3. From the Function Typelist, select the computation to apply to
the data.

4. From the New Period Interval list or the Custom Period Interval
list, select the interval period to compute values for.

5. If you select a Custom period, enter the integer period interval and
select the minute/hour/day/week/month/year time increment for
that value from the list further to the right.

6. Optionally, you may put the datain an irregular interval time series
data set, which will retain the dates and times of each occurrence.

Y ou should choose an irregular-interval Block Size, so that
between 50 and 1,000 values are stored in ablock. Daily data
results should use ablock size of "IR-YEAR". Annual results
should use ablock size of "IR-DECADE".

7. Optionally, you may specify a Time Offset to offset the new
pointsin time from the standard interval time. For example, if you
select adaily interval for the Time Interval, you may use the option
to offset time pointsto be at 6 am. instead of at midnight. If the
Set Time Offset box is checked, enter an integer number in the
box to the right and select the minute/hour/day/week/month/year
time increment from the list further to theright. If the Set Time
Offset box is unchecked, timesin the resultant data sets will fall on
the regular interval time (typical setting).

8. Click Compute.

Copy in Time

The Copy in Time function copies the data set and sets a new start time
with a specified increment from the original or to start at a specified date
and time. Both the original and the copied data values are not changed,
except where the two data sets overlap. The difference between the Copy
in Time function and the Shift in Time function is that the shift function
deletes the original data before storing the shifted data, whereas the copy
function does not. Data sets may be regular or irregular interval time
series data.

To copy time series data sets to another time:
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1. Choose the Time Functions tab of the Math Functions screen and
select the Copy in Time operator, as shown in Figure 7.12.

Math Functions
File Edit Display

W 4F

Opsrator: | IR
(@) Copy by Amount
() Copyto DatefTime  Date:

() Single Selected Data Set {above)

() Mulkiple Selected Data Sets (belaw)

Shift amount is incomplete

Selected Daka Sek: | [/SAYERFLOW 01 NOV1 993/ 1HOUR BASEDGO0] v

Arithretic | General | Time Functions | Hydrologic | Smookhing || Statistics

Amaount aftime to copy by: Tear W

Compute

EIEX

[ Tirne:

Figure7.12 CopyinTime

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will

7.5.3

only be done once.

In the Copy by Amount box, enter the amount of the timeto
increment the data sets by (integer values only) and then select
Minute, Hour, Day, Week, Month or Year. To increment data
backwards in time, use a negative amount for the time shift.

4. Alternatively, you may select the Copy to Date/Time radio button
and specify the date and time to copy the first value in each data

set to.

Shift in Time

The Shift in Time function shifts the times in time series data sets by a
specified increment or to start at a specified date and time. The original
data values are removed from the file when the shifted datais stored. To
accomplish this, the data sets must be saved immediately following the
operation. For example, if you shift data by one year from 1965 to 1966,
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datawill exist for 1966 and not 1965. To retain the origina data, use the
Copy in Timefunction. Data sets may be regular or irregular interval
time series data.

To shift timesin time series data sets:

1. Choose the Time Functions tab of the Math Functions screen and
select the Shift in Time operator, as shown in Figure 7.13.

" Math Functions E@@

File Edit Display
|d =F

Selected Data Set: |IGREEN RIVERIOAKWVILLEELEVATIONOT MAY1 9921 HOURIOBS! ﬂ

Arithmetic | General Time Gonversion ] Hydrologic | Srmoothing | Statistics |

Operatat: [Shitt in Time =l
" Shift by Amount Time Shift Amount:
' Shittto DatefTime  Date: | 01MAY1992 .|  Time: | 01:00

" Sinole Selected Data Set (above)

IGREEM RIVERIOAKVILLEELEVATIONOTMAYT 9921 HOURIOBSS
IGREEN RIVERIOARVILLEF LOW-RES OUTIO1 MAY1 9821 HOURIOBSS
IGREEN RIVERIOARVILLEFRECIP-INCID1 MAY1982M1 HOURIOBSS
IGREEMN RIVERIOARWILLE/STAGE-OUTIO1 MAY1 99211 HOURIOBS!
IGREEM RIVERIOAKVILLE/STORAGEMD T MAY1 9921 HOURIOBES

Compute

Figure 7.13 Screen for Shift in Time Function

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

3. In the Shift by Amount box, enter the amount of the time to shift
the data sets by (integer values only) and then select Minute,
Hour, Day, Week, Month or Year. To shift data backwardsin
time, use a negative amount for the time shift.

4. Alternatively, you may select the Shift to Date/Time radio button
and specify the date and time to shift the first value in each data set
to.

7.5.4 Change Time Interval

The Change Time I nterval function interpolates or extracts values from
existing regular interval time series data sets to new regular interval time
series data sets with adifferent timeinterval.

7-30



HEC-DSSVue User's Manual Chapter 7 - Math Functions

Whether the time series datatypeis"INST-VAL", "INST-CUM", "PER-
AVER", or "PER-CUM" controls how interpolation is performed.
Interpolated values are derived from "INST-VAL" or "INST-CUM" data
using linear interpolation. Values are derived from "PER-AVER" data by
computing the period average value over the new time interval. Vaues
are derived from "PER-CUM" data by computing the period cumulative
value over the new time interval.

For example, if an original data set is hourly data and the new regular
interval data set isto have a six-hour timeinterval:

m Thevaluefor "INST-VAL" or "INST-CUM" type datais
computed from the linear interpolation of hourly points bracketing
the new six-hour time point.

m Thevaluefor "PER-AVER" type datais computed from the period
average value over the six-hour interval.

m Thevauefor "PER-CUM" type datais computed from the
accumulated value over the six-hour interval.

The treatment of missing value datais also dependent upon data type.
Interpolated "INST-VAL" or "INST-CUM" points must be bracketed or
coincident with valid (not missing) valuesin the original time series;
otherwise the interpolated values are set as missing. Interpolated “"PER-
AVER" or "PER-CUM" datamust contain all valid values over the
interpolation interval; otherwise the interpolated value is set as missing.

To change the time interval in time series data sets:

1. Choose the Time Functions tab of the Math Functions screen and
select the Change Time Interval operator, as shown in Figure
7.14.

"] Math Functions E@@

File Edit Display
Ld E

Selected Data Set [iIGREEN RIVERIOAKVILLE/ELEVATIO MO MAY1 99201 HOURIOBS!  ~ |

Arithmetic] General Time Conversion ] Hydrologic | Smoothing | Statistics

Operator: |Change Time Interval j

Time Interval: 1DAY =
SetTime Offset. [ Offset

¢ Single Selected Data Set (above)

% Multiple Selected Data Sets (helow)

IGREEMN RIVERIOARYILLESELEVATION/OT MAY1 9921 HOURIOBS!
JGREEM RIVERIOAKYILLEFLOW-RES OUTIOTMAY1 982 HOURIOBS!
IGREEMN RIVERIQAKVILLEIPRECIP-IMCIDT MAYT 99211 HOURIQBS!
IGREEMN RIVERIQAKYILLEfSTAGE-OUTIO1 MAY1 9921 HOURSOB S/
IGREEN RIVERIOARYILLEfSTORAGEDT MAYY 9921 HOURIOBS!

Caompute

Figure 7.14 Change Time Interval Function

7-31



Chapter 7 - Math Functions HEC-DSSVue User's Manual

7.5.5

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

3. Fromthe Time Interval list, select the new time interval for the
data sets.

4. Optionally, you may specify a Time Offset to offset the new
pointsin time from the standard interval time. For example, if you
select adaily interval for the Time Interval, you may use the option
to offset time pointsto be at 6 am. instead of at midnight. If the
Set Time Offset box is checked, enter an integer number in the
box to the right and select the minute/hour/day/week/month/year
time increment from the list further to theright. If the Set Time
Offset box is unchecked, timesin the resultant data sets will fall on
the regular interval time (typical setting).

5. Click the Compute button to perform the interpolation.

Irregular to Regular

Thelrregular to Regular function interpolates or extracts values from
existing irregular interval time series data sets to create new regular
interval time series data sets, or "snaps’ (moves) irregular interval datato
the regular times.

For interpolating, whether the time series datatypeis"INST-VAL",
"INST-CUM", "PER-AVER", or "PER-CUM" controls how the
interpolation is performed. Interpolated values are derived from "INST-
VAL" or "INST-CUM" data using linear interpolation. Values are derived
from "PER-AVER" data by computing the period average value over the
new regular timeinterval. Values are derived from "PER-CUM" data by
computing the period cumulative value over the new regular time interval.

For example, if the original data set has data that typically occurs severd
timesin asix-hour period and the new regular interval data set isto have a
six-hour time interval:

m Thevaluefor "INST-VAL" or "INST-CUM" type datais
computed from the linear interpolation of points bracketing the
new six-hour time point.

m Thevaluefor "PER-AVER" type datais computed from the period
average value over the six-hour interval.

m Thevaluefor "PER-CUM" type datais computed from the
accumulated value over the six-hour interval.
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The Snap function derives new regular interval time series by "snapping"”
datato a user specified regular interval timeif the time of the original data
falls within the time window tolerance set by the user. A snap just
changes the time of the data values and does no interpolation. For
example, atime series record from a gauge recorder collects readings six
minutes past the hour. The Snap Irregular to Regular function is often
used to “snap” or shift the time points to the top of the hour.

Times in resultant time series may be shifted (offset) from the regular
interval time by a user specified offset. Asan example, the offset could be
used to shift timesin regular hourly interval datafrom the top of the hour
to 6 minutes past the hour.

By default valuesin the resultant regular interval time series data sets are
set to missing unless matched to timesin the original time series data set
(within the time window tolerance).

To convert irregular interval time series datato regular interval data by
interpolation:

1. Choose the Time Functions tab of the Math Functions screen and
select the Irregular to Regular operator, as shown in Figure 7.15.
Click Interpolate.

Math Functions g@@

File Edit Display
? l.d ==

Selected Diata Set: | (fSAYERFLOW01NOY 1993 IHOUREASECS00) .

arithmetic | General | Time Functions | Hydrologic | Smoothing | Statistics

Operator: | MiERNEArL e

(®) Interpolate  (Fill-in missing walues)

Time Interval: THOUR, A

Set Time Offset: [ Offset

() Snap {do nat fillin missing values)

Time Interval:

Set Time Offset:
Time Back:

Time Forwveard:

(%) Single Selected Data Set {above)

() Multiple Selected Data Sets {below)

Figure7.15 Irregular Datato Regular Data Function
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2.

5.

Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

Fromthe Time Interval list, select the timeinterval for the data
sets.

Optionally, you may specify a Time Offset to offset the new
points in time from the standard interval time. For example, if you
select adaily interval for the Time Interval, you may use the option
to offset time pointsto be at 6 am. instead of at midnight. If the
Set Time Offset box is checked, enter an integer number in the
box to the right and select the minute/hour/day/week/month/year
time increment from the list further to theright. If the Set Time
Offset box is unchecked, times in the resultant data setswill fall on
the regular interval time (typical setting).

Click the Compute button to perform the interpol ation.

To convert irregular interval time series datato regular interval data by
snapping:

1.

2.

Choose the Time Functions tab of the Math Functions screen and
select the Irregular to Regular operator. Click Snap.

Select a data set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

From the Time Interval list, select the regular interval time period
for the resultant time series data sets.

Optionally, you may specify a Time Offset to offset the new
pointsin time from the standard interval time. For example, if you
select adaily interval for the Time Interval, you may use the option
to offset time pointsto be at 6 am. instead of at midnight. If the
Set Time Offset box is checked, enter an integer number in the
box to the right and select the minute/hour/day/week month/year
time increment from the list further to theright. If the Set Time
Offset box is unchecked, timesin the resultant data sets will fall on
the regular interval time (typical setting).

Use the Time Back and Time Forward offsetsto define atime
window around the regular interval time. If atime point from the
selected time series data set falls within the time window, the data
valueis applied to the new regular interval time point. These
offsets are set in the same manner as the Time Offset above.

Click Compute.
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7.5.6  Regular to Irregular

The Regular to Irregular function derives new irregular interval time
series data sets from existing regular interval time series data sets. No
conversion, time shifting, or other operations are applied to the data.
Embedded missing data values are retained in the irregular interval data
sets.

Thelrregular Block Size dictates how the datais stored in the HEC-DSS
file. You should choose an irregular-interval block size, so that between
100 and 2,000 values are stored in ablock. Datathat occurs
approximately on the average of once an hour should use a block size of
"IR-MONTH". Datathat occurs approximately on the average of once a
day should use ablock size of "IR-YEAR". Annual values should use a
block size of "IR-DECADE".

To convert regular interval time series datato irregular interval data:

1. Choose the Time Functions tab of the Math Functions screen and
select the Regular to Irregular operator, as shown in Figure 7.16.

Math Functions E@@
File Edit Display
i |4 E
Selected Data Set: | [{SAVERFLOMW,/01MOY1 993/ 1HOUR [BASEOG00] w

arithmetic | General | Time Functions | Hydrologic | Smaoathing | Statistics

Operator: | TR ETER T,

Irreqular Block Size: | IR-MONTH

(#) Single Selected Data Set (above)

() Multiple Selected Data Sets (below)

Figure 7.16 Regular Datato Irregular Data Function

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

3. Select theIrregular Block Size for the data sets. Choose an
irregular-interval block size, so that between 100 and 2,000 values
are stored in ablock. Datathat occurs approximately on the
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average of once an hour should use ablock size of "IR-MONTH".
Data that occurs approximately on the average of once a day
should use ablock size of "IR-YEAR". Annua values should use
ablock size of "IR-DECADE".

4. Click Compute.

7.5.7 To lrregular using Pattern

TheTo Irregular using Patter n function generates a new time series data
set from an existing irregular or regular interval time series dataset. The
times for the new time series are defined by the times of a second time
series data set. Vauesfor the new time series are computed from the
original time series data using one of seven available functions. The
functions are:

Interpolate at end of Period
Maximum for Period

Minimum for Period

Average over Period
Accumulation over Period
Volume for Period

Integration over Period

Number of Valid Data over Period

where "period” is the time between data pointsin the pattern data set.

The data type of the original time series data governs how values are
interpolated. Datatype"INST-VAL" (or "INST-CUM") considers the
value to change linearly over the interval from the previous data value to
the current datavalue. Datatype "PER-AVER" considers the value to be
constant at the current data value over theinterval. Datatype "PER-
CUM" considers the value to increase from 0.0 (at the start of the interval)
up to the current value over theinterval. Interpolation of the three data
typesisillustrated in Figure 7.17.

X Interpolated value

INST-VAL PER-AVER PER-CUM
Figure 7.17 Interpolation of "INST-VAL", "PER-AVER" and "PER-CUM" Data
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How interpolation is performed for a specific data type influences the
computation of new values for the selected function. For example, if the
datatypeis"INST-VAL", the function Maximum for Period is evaluated
by:

m Finding the maximum value of the data points from the original
time seriesthat are inclusive in the new time interval.

m Linearly interpolate values at beginning and ending of the new
timeinterval, and determine if these values represent the maximum
over theinterval.

Referring to the plotsin Figure 7.17, the Average over Period functionis
applied to atime series by integrating the area under the curve between
interpolated points and dividing the result by the interval time.

The appearance of the Math Functions screen for the Transform to
Irregular interval function is shown in Figure 7.18.

File Edit Display
H 4 =E

Selectad Data Sat: |.fEF RUSSIANC OYOTEF LOWWI0TJARNT 931 1 DAY ﬂ

Arithmetic | General Time Conversion | Hydralagic | Smaoothing | Statistics |

Operator: |Tq regular using Pattern = |

Function Type: Interpolate at end of Period |

Campute

Figure 7.18 Screen for Transforming To Irregular using Pattern Function

To transform to an irregular interval time series data set:

1. Choose the Time Functions tab of the Math Functions screen and

select the To Irregular using Pattern operator.

From the Selected Data Set list, select atime series data set.

From the Data Set for Time Pattern list, select atime series data

set to provide the time pattern for the resultant time series.

4. From the Function Type list, select the method for computing new
time series values.

5. Click Compute.

W
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7.5.8

Extract Time Series

The Extract Time Series function selects/extracts data points from a
regular or irregular interval time series data set based on user defined time
specifications. For example, the function may be used to extract values
observed every day at noon from hourly interval data.

Data may be extracted on the basis of one of the following time
specifications: year, month of the year (January, February, etc.), day of
month, day of week (Sunday, Monday, etc.), or time of day.

The appearance of the Math Functions screen for the Extract Time Series
function is shown in Figure 7.19.

Math Functions g@@

File Edit Display
i | =

Selected Data Set: | [YSAYERFLOWD1NOY1993f IHOUR/BASEOROD) b

Arithmetic | General | Time Functions | Hydrologic | Smoothing | Statiskics

Operator: | Extract Time Series v
) Year to
(") Manth te
(© Bay of Marth 1 v =1 h
() Day of Wesk ta
) Time to

Time ‘Window {minutes);

[]5et as Irregular

Figure 7.19 Screen for Extract Time Series Function

To derive a new time series data set from the selected times of another
time series data set:

1. Choose the Time Functions tab of the Math Functions screen and
select the To Irregular using Pattern operator.

2. From the Selected Data Set list, select atime series data set to
apply the function.

3. Choose one of thetime levels, Year, Month, Day of Month, Day
of Week, or Time of day and complete the boxes to the right.
Entering or selecting avalue in only the left-most box setsatime
specification for data extraction to an individual year, month, day,
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or time of day. Fill in both boxes to specify atime range for data
extraction.

4. Click Year to extract datafor an individual year or range of years.
To extract datafor an individua year, fill the left-most box in with
the desired year. To extract datafor arange of yearsfill the left
box with the beginning year and the right box with the ending year.

5. Click Month to extract data for an individual month of the year or
range of months. Usetheliststo set the month boxes. Thelist
contains the months of the year, JAN to DEC. Set only the left-
most box to extract datafor a single month of the year. Set both
boxes to extract data for arange of months. The range of months
can be set to encompass the end of the year; that is, "OCT to FEB"
isavalid setting.

6. Click Day of Month to extract datafor an individual day or range
of day of month days. The days are set using the two liststo the
right. Asabove, the lists can be used to specify asingle day of
month, using the left-most pull down, or arange of days, using
both lists. The day of month values range from 1 to 31, and
"LastDay", the last day of the month, which may vary by month.
The range of days can be set to encompass the end of the month.
For example, for "27 to 4", datawill be extracted from the 27" of
one month to the 4™ of the next month.

7. Click Day of Week to extract data for an individua or range of
day of the weekdays. Select day from thetwo liststo theright. As
above, you may use the lists to specify one day, using the left-most
list, or arange of days, using both lists. The day of week values
range from SUN to SAT. Therange of days can be set to
encompass the end of the week; that is, "SAT to MON" isavalid
setting.

8. Click Timeto extract data by thetime of day. Anindividua time
is specified by completing the left-most box only. Complete both
boxes to specify atime of day range for data extraction. Thetime
specification employs the standard four-digit military style 24-hour
format (e.g. "2300" or "0310 to 0600"). The time range can
encompass the end of day; that is, 2200 to 0330" isavalid setting.
The optional Time Window box is applied to the time of day
extraction only. The Time Window is an integer value in minutes,
used to extend the beginning and ending of the time of day period
for data extraction. For example, with atime of day extraction
time of "0300" and a Time Window of "10 minutes’, datawill be
extracted from the selected time series if times falswithin in the
period 0250 to 0310.

9. Select the Set asIrregular checkbox (recommended) to ensure the
resultant time series data set isidentified asirregular interval time
seriesdata. If the box is not checked, the function will attempt to
determine if the extracted data set can be classified as regular
interval time series data.
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7.6 Hydrologic Functions

The Hydrologic tab (Figure 7.20) contains the following functions:
Muskingum Routing, Straddle Stagger Routing, Modified Puls
Routing, Rating Table, Reverse Rating Table, Two Variable Rating
Table, Decaying Basin Wetness, Shift Adjustment, Period Constants,
Multiple Linear Regression, Apply Multiple Linear Regression, Conic
I nter polation, Polynomial, Polynomial with Integral, and Flow
Accumulator Gage Processor.

File Edit Display

by L4 =E

Selected Data Set: | /SAVERSFLOW//O1NCY 1993 IHOUR/BASEQED0) b
Arithmetic | General | Time Functions | Hydrologic | Smoothing | Statistics

Operator: | G

Mumber of Reaches:
Muskingum K;

Muskingum g

Compute

Mo Mumber of Reaches entered

Figure 7.20 Math Functions - Hydrologic Tab

7.6.1 Muskingum Routing

The Muskingum Routing function routes aregular interval time series
data set by the Muskingum hydrologic routing method.

1. Choose the Hydrologic tab of the Math Functions screen and
select the Muskingum Routing operator, as shown in Figure 7.20.

2. From the Selected Data Set list, select the time series data set for
routing.

3. Inthe Number of Reaches box, specify the number of routing
subreaches.
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4. In the Muskingum K box, enter the Muskingum "K" routing
parameter (travel time, in hours).

5. Inthe Muskingum X box, enter the Muskingum "x" routing
parameter. The Muskingum "x" value cannot be less than 0.0
(maximum attenuation) or greater than 0.5 (no attenuation).

6. Click Compute to route the selected time series data set.

An error message will be displayed if acompute is attempted using an
invalid Muskingum "x" value, and no routing will be performed.

The set of Muskingum routing parameters entered may potentially
produce numerical instabilities in the routed time series. The parameters
are first checked by the function for possible instabilities before the
routing proceeds. If instabilities are possible, a warning message box will
appear presenting the details of the instabilities. Click the Yesbutton in
the message box to proceed with the compute, or click No to cancel the
operation.

7.6.2  Straddle Stagger Routing

The Straddle Stagger Routing function routes aregular interval time
series data set by the Straddle Stagger hydrologic routing method.

To route atime series data set by the Straddle Stagger hydrologic routing
method:

1. Choose the Hydrologic tab of the Math Functions screen and
select the Straddle Stagger Routing operator, as shown in Figure
7.21.

Math Functions E]@

File Edit Display
é l.d =F

Selected Data Set: |,I',I'SP.\"ER,I'FLOW,I'DINOV1993,!'1HOUR,I'BASEDSDD,I' A

arithmetic | General | Time Functions | Hydrologic | smoothing | Statistics

Murnber ko Average:

Mumber ko Lag:

Mumber of SubReaches:

Campute

Mo Mumber o Average entered.

Figure 7.21 Straddle Stagger Routing Method

2. From the Selected Data Set list, select the time series data set for
routing.
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3. Inthe Number to Average box, enter the number of ordinates to
average over (Straddle).

4. Inthe Number to L ag box, enter the number of ordinatesto lag
(Stagger).

5. Inthe Number of SubReaches box, enter the number of routing
subreaches.

6. Click Compute to route the selected time series data set.

7.6.3 Modified Puls Routing

The Modified Puls Routing function routes aregular interval time series
data set by the Modified Puls hydrologic routing method.

With the Modified Puls method, outflow from arouting reach is a unique
function of storage. The storage-discharge relationship is entered into the
function as a paired data set, where the x-values are storage and the y-
values are discharge.

To route atime series data set by the Modified Puls hydrologic routing
method:

1. Choose the Hydrologic tab of the Math Functions screen and
select the M odified Puls Routing operator, as shown in Figure
7.22.

Math Functions @@

Eile Edit Display
é ld =

Selected Data Jett | fiSAVERFLOW/0LNGY1993] IHOUR/BASE0S00] v

arithmetic | General | Time Functions | Hydrologic | Smoothing || Statistics

Operator: |"-"||:||:|iFiE|:| Puls Routing v |

Mumber of SubReaches: | |

Muskingum %: | |

Storage-Discharge Paired Data Set

Compute

Mo Mumber of SubReaches entered.

Figure 7.22 Modified Puls Routing Method

2. From the Selected Data Set list, select the time series data set for
routing.

3. From the Storage-Dischar ge Paired Data Set list, select the
paired data set containing the storage-discharge table. Only paired
data sets will appear in thislist, and only one data set at atime can
be selected.
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4. Inthe Number of SubReaches box, enter the number of routing
subreaches.

5. Inthe Muskingum X box, enter the Muskingum "x" routing
parameter. The Muskingum "Xx" value cannot be less than 0.0 or
greater than 0.5. Enter 0.0 to route by the Modified Puls method,
or avalue greater than 0.0 to apply the Working R& D method.

6. Click Compute to route the selected time series data set.

7.6.4 Rating Table

The Rating Table function transformg/interpolates values in atime series
data set using the rating table x-y values stored in a paired data set. For
example, the Rating Table function can be used to transform stage values
to flow values using a stage-flow rating table.

The units and parameter type of the resultant time series data set are
duplicated from the y-units and y-parameter type of the rating table paired
dataset. For example, if astage-flow rating table has a y-data parameter
type of "FLOW" and y-units of "cfs", the resultant time series data set will
have the data parameter type “FLOW” and the units "cfs".

To derive anew time series data set from the rating table interpolation
based on the selected time series data set:

1. Choose the Hydrologic tab of the Math Functions screen and
select the Rating Table operator, as shown in Figure 7.23.

Math Functions E]@

File Edit Display

CEAVE:

Selected Data Set: | {/SAVERFLOWHOLNGY1993{ 1HOUR/BASEDE00] v

arithmetic | General | Time Functions | Hydrologic | Smoothing | Statistics

Operatar: F!_.atiru; Table

v)

Rating Table

Compute

Mo Rating Table selected
Figure 7.23 Rating Table Method

2. From the Selected Data Set list, select atime series data set for
rating table interpolation. If the selected data set is not atime
series, the remaining input boxes on the screen will be unavailable.
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7.6.5

3. From the Rating Table list, select the paired data set containing
the rating table information. Only paired data sets will appear in
thislist, and you may select only one data set at atime.

4. Click Compute to perform the rating table interpolation of the
selected time series data set.

Reverse Rating Table

The Rever se Rating Table function transforms/interpolates valuesin a
time series data set using the reverse of the rating table stored in a paired
dataset. For example, the Rever se Rating Table function can be used to
transform flow values to stage values using a stage-flow rating table.

The units and parameter type of the resultant time series data set are
duplicated from the x-units and x-parameter type of the rating table paired
dataset. For example, if a stage-flow rating table has an x-data parameter
type of "STAGE" and x-units of "ft", the resultant time series data set will
have the data parameter type "STAGE" and the units "ft".

To derive anew time series data set from the reverse rating table
interpolation of the selected time series data set:

1. Choose the Hydrologic tab of the Math Functions screen and
select the Rever se Rating Table operator, as shown in Figure
7.24.

Math Functions E]@

File Edit Display
: ld ==

Selected Diata Set: | ({SAYERFLOMWHO1MOY1993/ 1HOUR/BASECS00) w |

arithmetic | General | Time Functions | Hydrologic | Smoothing | Statistics

Operator: F-—-—r'- Rating Tahi

|

Rating Table

compute

Mo Rating Table selected
Figure 7.24 Reverse Rating Table Method

2. From the Selected Data Set list, select atime series data set for
reverse rating table interpolation. If the selected data set isnot a
time series, the remaining input boxes on the screen will be
unavailable.
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3. From the Rating Table list, select the paired data set containing
the rating table information. Only paired data sets will appear in
thislist, and you may select only one data set at atime.

4. Click Compute to perform the reverse rating table interpolation of
the selected time series data set.

7.6.6  Two Variable Rating Table

The Two Variable Rating Table function computes new time series
values from the input of two other independent time series data sets. The
functional relationship is specified by atable of values contained in a
paired data set having multiple sets of x-y curves.

As an example, reservoir release is afunction of both the gate opening
height and reservoir elevation (Figure 7.25).

ITABLE WALUESIELEY-FLOWVWINVARIABLE GATE HEIGHTS!
180000
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Reservoir Elevation (ft)
TABLE WWALUES WAR1ABLE GATE HEIGHTS. ELEW FLOW.

Figure 7.25 Example of two variable rating table paired data, reservoir release asa
function of reservoir elevation and gate opening height (curve labels).

For each gate opening height, there is areservoir elevation-reservoir
release curve, where reservoir elevation is the independent variable (x-
values) and reservoir release is the dependent variable (y-values) of a
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paired data set. Each paired data curve has acurve label. In thiscase, the
curve label is assigned the gate opening height. Using the paired data set
shown in Figure 7.25 (page 7-45), you may employ the Two Variable
Rating Table function to interpolate time series values of reservoir
elevation and gate opening height to develop atime series of reservoir
release.

Times for the two input time series data sets must match. Curve labels
must be set for curvesin the rating table paired data set and must be
interpretable as numeric values.

By default, the units and parameter type of the resultant time series data
set are duplicated from the y-units and y-parameter type of the rating table
paired data set.

The appearance of the Math Functions screen for the Two Variable Rating
Table function is shown in Figure 7.26.

Math Functions EI[EI@

File Edit Display

R T

Selected Data Set: | /jSAYER/FLOWYO1NOY 1993 1HOUR/BASEDGOO] v
arithmetic | General | Time Functions | Hydrologic | Smoathing | Statistics

(001 T Ty Y ariable Rating Table

Compute

Selected Data Set not a Paired Data
Figure 7.26 Screenfor Two Variable Rating Table Function

To derive anew time series data set from the two variable rating table
interpolation of two other time series data sets:

1. Choose the Hydrologic tab of the Math Functions screen and
select the Two Variable Rating Table operator.

2. From the Selected Data Set list, select the paired data set
containing the rating table. If the selected data set is not a paired
data set, the remaining input boxes on the screen will be
unavailable.
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3. From the two lists shown below the Data Set title, select the two
input time series data sets.

m Usethetop list to select the time series data set matching the
x-values parameter of therating table. In Figure 7.26 (page
7-46), thisis atime series data set of reservoir elevation.

m Usethe bottom list to select the time series data set matching
the curve labels parameter. In Figure 7.26 (page 7-46) this
isatime series data set of gate opening height. Y ou may
select only one data set from alist.

4. Once the data sets are selected, click Compute to apply the Two
Variable Rating Table function.

7.6.7 Decaying Basin Wetness

The Decaying Basin Wetness function computes a time series of
decaying basin wetness parameters from aregular interval time series data
set of incremental precipitation by:

TSPar(t) = Rate* TSPar(t-1) + TSPrecip(t)
where Rate is the decay rate and 0 < Rate < 1.

The first value of the resultant time series, TSPar(1), is set to the first
value in the precipitation time series, TSPrecip (1). Missing valuesin the
precipitation time series are zero for the above computation.

To compute atime series of decaying basin wetness parameters:

1. Choose the Hydrologic tab of the Math Functions screen and
select the Decaying Basin Wetness operator, as shown in Figure
7.27.

2. From the Selected Data Set list, select the time series data set of
incremental precipitation.

3. Enter the Decay Rate. Thisvalue must be greater than 0.0 and
lessthan 1.0.

4. Click Compute.

7.6.8  Shift Adjustment

The Shift Adjustment function linearly interpolates values in the primary
time series data set to the times defined by a second time series data set. If
timesin the new time series precede the first data point in the primary time
series, the value for these timesis set to 0.0. If timesin the new time
series occur after the last data point in the primary time series, the value
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Math Functions g@@
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Figure 7.27 Decaying Basin Wetness Method

for these timesis set to the value of the last point in the primary time
series. Interpolation of values with the Shift Adjustment functionis
shown in Figure 7.28.

X Interpolated value

® Original TS data

——3¢
Figure 7.28 Interpolation of Time Series Values using Shift Adjustment Function

Both time series data sets may be regular or irregular interval.
Interpolated points must be bracketed or coincident with valid (not
missing) valuesin the original time series; otherwise the values are set as
missing.

To generate a new time series of shift adjustments:

1. Choose the Hydrologic tab of the Math Functions screen and
select the Shift Adjustment operator, as shown in Figure 7.29

(page 7-49).
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Math Functions g@@
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Figure 7.29 Shift Adjustment Method

2. From the Selected Data Set list, select the primary time series data
set. This data set has the values for the interpolation.

3. From the Data Set for time pattern list, which islocated in the
bottom part of the window, select the second time series data set.
This data set has the times for the interpolation.

4. Click Compute.

7.6.9 Period Constants

The Period Constants function applies values in the primary time series
data set to the times defined by a second time series data set. Both time
series data sets may be regular or irregular interval. Valuesin the new
time series are set according to:

ts1(j) < tsnew(i) < tsl(j+1), TSNEW() = TSI()

wheretsl isthe timein the primary time series, TS1 isthe valuein the
primary time series, tsnew is the timein the new time series, TSNEW is
the value in the new time series.

If times in the new time series precede the first data point in the primary
time series, the value for these timesis set to missing. If timesin the new
time series occur after the last data point in the primary time series, the
value for these timesis set to the value of the last point in the primary time
series. Interpolation of values with the Period Constants function is
shown in Figure 7.30 (page 7-50).

To generate anew time series of period constants:
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X Interpolated value

® Original TS data

Missing Values
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X X

Figure 7.30 Interpolation of Time Series Values using Period Constants Function

1. Choose the Hydrologic tab of the Math Functions screen and
select the Period Constants operator.

2. From the Selected Data Set list, select the primary time series data
set. This data set has the values for the interpolation.

3. From the Data Set for time pattern list, which islocated in the
bottom part of the window, select the second time series data set.
This data set has the times for the interpolation.

4. Click Compute.

7.6.10 Multiple Linear Regression

The Multiple Linear Regression function computes the multiple linear
regression coefficients between a primary time series data set and a
collection of independent time series data sets, and stores the regression
coefficientsin anew paired dataset. This paired data set may be used
with the Apply Multiple Linear Regression function to derive a new
estimated time series (see Section 7.6.11)

For the general linear regression equation, a dependent variable, Y, may
be computed from a set independent variables, Xn:

Y = BO+B1*X1+ B2*X2 + B3*X3
where Bn are the linear regression coefficients.
For time series data, an estimate of the primary time series values may be
computed from a set of independent time series data sets using regression
coefficients such that:

TsEstimate(t) = BO + B1* TSL(t) + B2*TS2(t) + ... + Bn*TSn()

where Bn are the set of regression coefficients and TSn are the time series
data sets.
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7.6.11

All the time series data sets must be regular interval and have the same
timeinterval. The function filters the data to determine the time period
common to all data sets and uses only those points in the regression
anaysis. For any giventime, if avalueis missingin any time series, no
datafor that timeis processed. Optional minimum and maximum limits

can be set to exclude values in the primary time series which fall outside a
specified range.

To compute the set of multiple linear regression coefficients:

1. Choose the Hydrologic tab of the Math Functions screen and

select the M ultiple Linear Regression operator, as shownin
Figure 7.31.

Math Functions g@@

File Edit Display
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Selected Data Set: | [YSAYER JFLOW,01MOY1 993/ 1HOUR /BASECSD0] w
arithmetic | General | Time Functions | Hydrologic | Smoothing || Statistics

(ol Eiple Linear Reqression

Minirnari Limnik:
Mazirnurn Limit !

Independent Time Series Data Sets
JISAYER JFLOW-BASE/O1NOY1993 1HOLUR /BA)

Figure 7.31 Multiple Linear Regression Method

2. From the Selected Data Set list, select primary time series data
set. If the selected data set is not a time series data set, the
remaining input boxes on the screen are unavailable.

3. From the Independent Time Series Data Sets list, select one or
more of the independent time series data sets (by clicking, control-
click or shift-click).

4. Click Compute to derive new a paired data set containing the
linear regression coefficients.

Apply Multiple Linear Regression

The Apply Multiple Linear Regression function applies the multiple
linear regression coefficients computed with the Multiple Linear
Regression function (see Section 7.6.10). The coefficients, stored in a
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paired data set, are applied to a collection of independent time series data
sets to derive anew estimated time series data set.

For time series data, an estimate of the primary time series values may be
computed from a set of independent time series data sets using regression
coefficients such that:

Y = BO+B1*X1+B2*X2 + B3*X3
where Bn are the linear regression coefficients.

For time series data, an estimate of the original time series values may be
computed from a set of independent time series data using regression
coefficients such that:

TsEstimate(t) = BO + B1* TSL(t) + B2*TS2(t) + ... + Bn*TSn(t)

where Bn are the set of regression coefficients and TSn are the time series
data sets.

The number regression coefficients in the paired data set must be one
more than the number of independent time series data sets. The collection
of selected time series data sets should be in the same order as when the
regression coefficients were computed. The displayed list of time seriesis
sorted alphabetically in the dialog. The user should be aware if the names
of the time series data sets used for coefficient generation are substantially
different from the data names used in this function.

All the time series data sets must be regular interval and have the same
timeinterval. The function filters the data to determine the time period
common to all time series data sets and uses only those pointsin the
regression analysis. For any giventime, if avalueis missing in any time
series, the value in the resultant time seriesis set to missing. Y ou can also
set optional minimum and maximum value limits. Computed valuesin the
resultant time series, which fall outside the specified range, are set to
missing.

Names, parameter type and unit labels for the resultant time series data set
are taken from the first time series data set. The "F part” (Version) in the
new data set is set to "COMPUTED.”

To apply aset of multiple linear regression coefficients to derive a new
time series data set:

1. Choose the Hydrologic tab of the Math Functions screen and
select the Apply Multiple Linear Regression operator, as shown
in Figure 7.32 (page 7-53).
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File Edit Display

ETYVE:

Selected Data Seb: | /fSAYERFLOW 01MOY 1993 IHOUR/BASEDGDDS A

arithmetic | General | Time Functions | Hydrologic | Smoothing || Statistics

Qperator:

JISETERFLOH-BASE UYL 05T LHOUR B

compute

Selecked Data Set is not a Paired Data Set

Figure 7.32 Multiple Linear Regression Method

2. From the Selected Data Set list, select the paired data set
containing the regression coefficients. If the selected dataset is
not a paired data set, the remaining input boxes on the screen are
unavailable.

3. From the Independent Time Series Data Setslist, select one or
more of the independent time series data sets. (You can select a
single data set by clicking on it; select multiple contiguous data
sets using Shift+Click, or select multiple, non-contiguous data sets
using Ctrl+Click.)

4. Click Compute.

7.6.12 Conic Interpolation

The Conic Inter polation function transforms values in atime series data
set by conic interpolation using an elevation-areatable stored in a paired
dataset. Thefirst value pair in the paired data set contains the initial conic
depth and the initial storage volume at the first elevation (given in the next
value pair). If theinitial conic depth is missing, one is computed by the
function. Vauesin the elevation-areatable are stored in ascending order.

The Conic Interpolation function can interpol ate a time series of elevation
to derive atime series of storage or area. The function can interpolate a
time series of storage to derive atime series of elevation or area. If the
output time series is elevation, the output units are assigned from the x-
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units of the paired data set. If the output time seriesis area, the output
units are assigned from the y-units of the paired data set. If the output
time series is storage, the output units are undefined.

The appearance of the Math Functions screen for the Conic Interpolation
function is shown in Figure 7.33. The Conic Interpolation functionis
accessed from the Hydr ologic tab of the Math Functions screen.

File Edit Display
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Operator: | [T e e

Conic Interpolation Table

Inpuk Type: Skarage W

Cukput Type: Storage "

Storage Scale: 1
Compute

Mo Conic Inkerpolation Table selected

Figure 7.33 Screen for Conic Interpolation Function
To perform the conic interpolation of aof elevation or storage:

1. Choose the Hydrologic tab of the Math Functions screen and
select the Conic I nterpolation operator.

2. From the Selected Data Set list, select atime series data set. If the
selected data set is not atime series, the remaining input boxes on
the screen are unavailable.

3. From the Conic Interpolation Tablelist, select the paired data set
containing the conic interpolation table. Only paired data sets will
appear in thislist, and only one data set at atime can be selected.

4. From the Input Typelist, select the parameter type of the input
time series data (Elevation or Storage).

5. From the Output Typelist, select the desired output data type
(Storage, Elevation or Area).
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6. In the Storage Scale box, enter factor for the scale of the storage
output values. By default thisvalueis1. Thevalueisused to
scale input (by multiplying) and output (by dividing) storage
values. For example, if the areain the conic interpolation tableis
expressed in sq. ft., the storage scale could be set to 43560 to
convert the storage output to acre-ft.

7. Click Compute to interpolate the selected time series data set.

7.6.13 Polynomial

The Polynomial function computes a polynomial transform of aregular or
irregular interval time series data using the polynomial coefficientsin a
paired data set. Missing valuesin the input time series data remain
missing in the resultant time series data set.

A new time series can be computed from an existing time series with the
polynomial expression,

TS2 (t) = B1* TS1(t) + B2* TS1(t) 2+ ... + Bn* TSA(t) "
where Bn are the polynomial coefficients for term “n.”

Valuesfor the polynomial coefficients are stored in the x-values of a
paired data set. Before the above equation is applied, valuesin the input
time series are adjusted by subtracting off the paired data“datum” value if
defined. The x-units and parameter type from the paired data set are
applied to the resultant time series data set.

To compute the polynomial transform of a selected time series data set:

1. Choose the Hydrologic tab of the Math Functions screen and
select the Polynomial operator.

2. From the Selected Data Set list, select atime series data set. If the
selected data set is not atime series, the remaining input boxes on
the screen will be unavailable.

3. From the Polynomial Coefficientslist, select the paired data set
containing the polynomial coefficients. Only paired data sets will
appear in thislist, and you may select only one data set at atime.

4. Click Compute to perform the polynomial transform of the
selected time series data set.

7.6.14 Polynomial with Integral

The Polynomial with Integral function computes a polynomial transform
with integral of aregular or irregular interval time series data using the
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polynomial coefficientsin a paired data set. Missing valuesin theinput
time series data remain missing in the resultant time series data set.

The polynomia transform coefficients are integrated, with the new time
series values computed from an existing time series by the expression,

TS2 (t) = B1* TS1(t) ¥2 + B2*TSL(t)*/3+ ... + Bn* TS1(t) "Y/(n+1)
where Bn are the polynomial coefficients for term "n".

Valuesfor the polynomial coefficients are stored in the x-values of a
paired data set. Before the above equation is applied, valuesin the input
time series are adjusted by subtracting off the paired data“datum” value if
defined. The x-units and parameter type from the paired data set are
applied to the resultant time series data set.

To compute the polynomial transform with integral of a selected time
series data set:

1. Choose the Hydrologic tab of the Math Functions screen and
select the Polynomial with Integral operator.

2. From the Selected Data Set list, select atime series data set. If the
selected data set is not atime series, the remaining input boxes on
the screen will be unavailable.

3. From the Polynomial Coefficientslist, select the paired data set
containing the polynomial coefficients. Only paired data sets will
appear inthislist, and you may select only one data set at atime.

4. Click Compute.

7.6.15 Flow Accumulator Gage Processor

The Flow Accumulator Gage Processor function computes the time
series period-average flows from aflow accumulator type gage.
Accumulator gage data consists of time series data sets of accumulated
flow and counts. The two input time series data sets must match times
exactly.

A new time series data set is derived from the time series of flow and
counts by:

TsNew(t) = (TsAccFlow(t) - TsAccFlow(t-1)) / (TsCount(t) - TsCount(t-1))

where TsAccFlow is the gage accumulated flow time series and TsCount
is the gage time series of counts.
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In the above equation, if TsAccFlow(t), TsAccFlow(t-1), TsCount(t) or
TsCount(t-1) are missing, TsSNew(t) is set to missing. The new time series
is assigned the data type "PER-AVER”.

To process the flow accumulator type data:
1. Choose the Hydrologic tab of the Math Functions screen and

select the Flow Accumulator Gage Processor operator, as shown
in Figure 7.34.

Math Functions

File Edit Display

W 4EE

Selected Data Set: | //SAYERFLOW,D1NOY 1993/ 1HOUREASEDGO0) v

arithmetic | General | Time Functions | Hydrologic | Smoothing | Statistics

el |y Accumulator Gage Proce, .

Data Set Containing Time Series of Counts
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HISAYERIFLOMW-BASEOLNOY 1993/ IHOUR /BAS

compute

Mo Data Set Containing Time Series of Counts selected

Figure 7.34 Flow Accumulator Gage Processor Method

2. From the Selected Data Set list, select atime series data set.

3. From the Data Set Containing Time Series of Countslist, select
the time series data set of counts.

4. Click Compute.

1.7 Smoothing Functions

The Smoothing tab (see Figure 7.35, page 7-58) contains the following
functions: Centered Moving Average, Olympic Smoothing Average,
and Forward Moving Average. The proceeding segments for this
chapter section contain detailed information on each of these options.
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7.7.1

Math Functions Q@@
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Figure 7.35 Math Functions - Smoothing Tab

Centered Moving Average

The Centered Moving Aver age function computes a centered moving
average of "NAVG" values for regular or irregular interval time series
data. The number of valuesto average over ("NAVG") must be an odd
integer greater than two.

The Only Valid Values option pertains to when the averaging interval
contains missing values. If checked, the option sets the value in the
resultant data set to missing. If unselected, the option computes a
smoothed value from the valid valuesin the interval.

The Use Reduced Number of Values option pertains to the first and last
NAVG/2 valuesin theresultant data. If selected, the option computes
smoothed values at the beginning and ending of the data set from a
reduced number of values of the original data set. If unselected, the option
setsthefirst and last NAV G/2 values in the resultant data to missing.

To compute the centered moving average for time series data:
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1.

Choose the Smoothing tab of the Math Functions screen and select
the Centered M oving Aver age operator, as shown in Figure 7.36.
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Figure 7.36 Centered Moving Average

Select a data set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

In the Number to Average Over box, enter avaueto set the
number of values for the moving average. This number must be an
odd number greater than two (2).

Select the Only Valid Values box to compute a smoothed value
only if all the valuesin the averaging interval are valid (no missing
values). If there are one or more missing values, the value in the
resultant time series datais then set to missing. If the box is not
checked, the value in the resultant time series data is computed
using the remaining valid values in the averaging interval.

Select the Use Reduced Number of Values box to compute a
moving average from areduced number of time series values near
the beginning and ending of atime series. At these locations, the
moving average interval becomes truncated and there are not
“Number to Average Over” values for averaging. If unchecked,
valuesin the resultant time series data at these locations will be set
to missing.

Click Computeto perform a centered moving average smoothing
of the selected data
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7.7.2

Olympic Smoothing Average

The Olympic Smoothing Aver age function uses the same smoothing
scheme as the Centered Moving Average function (see Section 7.7.1),
except the minimum and maximum valuesin the averaging interval are
excluded from the computation. Theinput time series may be regular or
irregular interval. The number of valuesto average over ("NAVG") must
be an odd integer greater than two.

The Only Valid Values option pertains to when the averaging interval
contains missing values. If checked, the option sets the value in the
resultant datato missing. If unselected, the option computes a smoothed
value from the valid valuesin the interval.

The Use Reduced Number of VValues option pertains to the first and last
NAVG/2 valuesin the resultant data. If selected, the option computes
smoothed values at the beginning and ending of the data from areduced
number of values of the original data. If unselected, the option sets the
first and last NAV G/2 values in the resultant data to missing.

The span of the averaging interval, "NAVG", must be an odd integer
greater than two.

Under two conditions there are not NAV G valid values over the averaging
interval: if there are missing values in the averaging interval, or if the
smoothed point iswithin NAV G/2 values of the beginning or ending of
the time series.

For thefirst condition, if the averaging interval contains any missing
values, the option isto set the value in the resultant data set to missing, or
compute a smoothed value from the remaining valid valuesin the interval.

For the second condition, the option isto set the first and last NAVG/2
valuesin the resultant data set to missing, or compute smoothed values at
the beginning and ending of the data set from a reduced number of values.

To compute the Olympic smoothing average for atime series data set:

1. Choose the Smoothing tab of the Math Functions screen and select
the Olympic Smoothing Aver age operator, as shown in Figure
7.37 (page 7-61).

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.
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7.7.3
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Figure 7.37 Olympic Smoothing Average

. Inthe Number to Average Over box, enter avaueto set the

number of values for the averaging interval. This number must be
an odd integer greater than two.

. Select the Only Valid Values box to compute a smoothed value

only if all the valuesin the averaging interval are valid (no missing
values). If there are one or more missing values, the value in the
resultant time series data is then set to missing. If the box is not
checked, the value in the resultant time series data is computed
using the remaining valid values in the averaging interval .

Select the Use Reduced Number of Values box to compute a
moving average from areduced number of time series values near
the beginning and ending of atime series. At these locations, the
moving average interval becomes truncated and there are not
"Number to Average Over" values for averaging. If unchecked,
valuesin the resultant time series data at these locations will be set
to missing.

Click Compute to perform an Olympic smoothing of the selected
data.

Forward Moving Average

The Forward M oving Aver age function computes a moving average of
the last "NAVG" values for regular or irregular interval time series data.
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The number of values for averaging, "NAVG", must be greater than two.
The first NAVG-1 values in the resultant time series are set to missing.

If the averaging interval contains a missing value, the smoothed valueis
computed from the remaining valid valuesin the interval. However, if
there are less than two valid valuesin the interval, the value in the
resultant data is set to missing.

To compute the forward moving average for time series data:

1. Choose the Smoothing tab of the Math Functions screen and select
the Forward Moving Aver age operator, as shown in Figure 7.38.

File Edit Display

5 WEE

Selecked Diaba Seb: | /SAYERFLOW I01MCY 1993 1 HOUR BASEDGDD, w
airithmetic | General | Time Functions || Hydrologic | Smoathing | Statistics

Operator! | [F el e

mumber to Average Over:

(%) Single Selected Data Set {above)

(3 Multiple Selected Data Sets (below)

Campute

Mo Mumber to Average Ower entered.

Figure 7.38 Forward Moving Average

2. Select adata set to apply the function from the Selected Data Set
pull-down list at the top of the screen or multiple data sets from the
list in the lower portion of the screen. If you include the data set
selected in the top Selected Data Set, the operation on that set will
only be done once.

3. Inthe Number to Average Over box, enter the number of values
in the averaging interval. This number must be greater than two
(2.

4. Click Compute.

7-62



HEC-DSSVue User's Manual

Chapter 7 - Math Functions

7.8 Statistics Functions
The Statistics tab (Figure 7.39) contains the following functions. Basic
(statistics), Linear Regression, Cyclic Analysis, Duration Analysis, and
Frequency Plot.
Math Functions
File Edit Display
- WL 45E
Selected Diaka Set: | }/SAYERFLOWD1NOY1993 IHOUR/BASEQEOD] "
arithmetic | General | Time Funckions | Hydrologic | Smoathing | Statistics
Type: |CEETE v
Mumber of Valid Yalues: 231
Mumber of Missing Yalues: 0
Last Valid Walue: 141,75035 | 4t 06DEC1993, 24:00
Minirnum Yalue: Z6.440771 | 4t ZEMOW1993, 24:00
Mean Yalue: 204, 13595
Maximurn Yalue: 21783835 | ot ZEMOW1993, 07:00
Accumulated Amount: 100670.01
Standard Deviation: 285, SE65
Skew Coefficent: 2 BREE00S
Data Type: IMST-YaL
Units: CF5
Figure 7.39 Math Functions - Statistics Tab
7.8.1 Basic

The Basic function computes the basic statistical values for aregular or
irregular interval time series data set. The statistical and informational

values displayed are:

Number of valid values

Number of missing values
Last valid value and date and time
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7.8.2

Minimum value and date and time

Mean value

Maximum value and date and time

Accumulated value for the time series

Standard deviation

Skew coefficient

Datatype ("INST-VAL", "INST-CUM", "PER-AVER", "PER-CUM")
Data Units ("ft", "cfs", etc.)

To compute the basic statistical parameters for atime series data set:
1. Choose the Statistics tab of the Math Functions screen and sel ect
the Basic type.
2. From the Selected Data Set list, select atime series data set.

The statistics are displayed for the time series data set once the data set is
selected.

Linear Regression

TheLinear Regression function computes the linear regression and other
correlation coefficients between two time series data sets. Valuesin the
primary time series data set and the second time series data set are
matched by time to form data pairs for the correlation analysis. Missing
values areignored. Timesfor the two time series data sets must match
exactly. The data sets may be either regular or irregular interval time
series data.

The correlations statistics computed by the function are:

Number of Valid Vaues

Regression Constant

Regression Coefficient

Determination Coefficient

Standard Error of Regression
Adjusted Determination Coefficient
Adjusted Standard Error of Regression

The primary time series data set forms the values of the independent
variable (x-values), while values of the second time series data set
comprise the dependent variable (y-values). The linear regression
coefficients express how values in the second data set can be derived from
valuesin the primary data set:

TS2(t) = a+ b * TSI(t)
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where"a" is the regression constant and "b" the regression coefficient.

To compute the linear regression and correlation coefficients between two
time series data sets:

1. Choose the Statistics tab of the Math Functions screen and sel ect
the Linear Regression type, as shown in Figure 7.40.

File Edit Display

Selected Data Set: | [{SAYER/FLOW/D1NOY1993/ 1HOUR/BASEDEO0] v

arithmetic | General | Time Functions || Hydrologic | Smoothing | Skatistics

IR inear Reares. ..

Dependent Data Set
{ISAYER JFLOMW /01MOY 1993 IHOUR (BASEDSDD]
{ISAYER JFLOW-BASE D 1MNOY 1993/ IHOUR/BA/

Mumber of Yalid Yalues:

Regression Constant:

Regression Coefficient;
Determination Coefficient:
Standard Error of Regression;
Adjusted Determination Coefficient:

adjusted Standard Error of Regression:

Compute

Mothing selected in Dataset lisk

Figure 7.40 Linear Regression Statistics

2. From the Selected Data Set list, select the primary time series data
set for analysis. Time series values from this data set form the
independent variable (x-values) of the correlation analysis.

3. From the Dependent Data Set list, select the second time series
data set for analysis. Time series values from this data set will
comprise the dependent variable (y-values) of the correlation
anaysis.

The correlation statistics are computed automatically once the two data
Sets are selected.
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7.8.3

Cyclic Analysis

The Cyclic Analysis function derives a set of cyclic statistics from a
regular interval time series data set. The time series data set must have a
timeinterval of "1HOUR", "1DAY" or "IMONTH". The function sorts
the time series valuesinto statistical "bins' relevant to the time interval.
Vauesfor the IHOUR interval data are sorted into twenty-four bins
representing the hours of the day, 0100 to 2400. The 1DAY interval data
is apportioned to 365 bins for the days of the year. The IMONTH interval
datais sorted into twelve bins for the months of the year.

The format of the resultant data setsis as a"pseudo” time series for the
year 3000. For example, the cyclic analysis of one month of hourly
interval datawill produce pseudo time series data sets having twenty-four
hourly values for the day January 1, 3000. If the statistical parameter is
the “maximum” value, then the twenty-four values represent the maximum
value occurring at that hour of the day in the original time series. The
cyclic analysis of daily interval datawill produce pseudo time series data
sets having 365 daily values for the year 3000. The cyclic analysis of
monthly interval data will result in pseudo time series data sets having
twelve monthly values for the year 3000.

Fourteen pseudo time series data sets are derived by the cyclic analysis
function for the following statistical parameters:

Number of values processed for each time interva

Maximum value

Time of maximum value

Minimum vaue

Time of minimum value

Average value

Probability exceedence percentiles for 5%, 10%, 25%, 50% (median
value), 75%, 90%, and 95%

Standard deviation

The appearance of the Math Functions screen for the Cyclic Analysis
function is shown in Figure 7.41 (page 7-67).

To compute the cyclic analysis of atime series data set:

1. Choose the Statistics tab of the Math Functions screen and select
the Cyclic Analysistype.

2. From the Selected Data Set list, select atime series data set for
cyclic analysis.

3. Click Compute.

7-66



HEC-DSSVue User's Manual

Chapter 7 - Math Functions

Math Functions

o=1ES

File Edit Display

Selected Data Set:

JMISSISSIPPI RIVER/ST. LOUIS, MOJFLOW/0134N1899] 1DAY(USGS/

Arithmetic | General | Time Functions | Hydrologic | Smoathing | Statistics

Ivpe: | Cyclic Analysis

SIS PlE

Results

Zompute Complete

[MISSISSIPPI RIVERST.
[MISSISSIPPI RIVERST.
[MISSISSIPPI RIVER/[ST.
[MISSISSIPPI RIVER/[ST.
[MISSISSIPPI RIVERST.
[MISSISSIPPI RIVERST.
[MISSISSIPPI RIVER/[ST.
[MISSISSIPPI RIVER/[ST.
[MISSISSIPPI RIVERST.
[MISSISSIPPI RIVERST.
[MISSISSIPPI RIVER/[ST.
[MISSISSIPPI RIVER/[ST.
[MISSISSIPPI RIVERST.
[MISSISSIPPI RIVERST.

W

LOLIS, MOJCOUNT-FLOWD 1IN 1599 1 DAY USGS[01 MAR1992-01 MaY 1992 ]/
LOLIS, MOJDATE-FLOW-MAR 014N 599] 1 DAY USGS[01MAR 1992-01MAY1992]/
LOUIS, MOJDATE-FLOW-MINGO1 JAN1599/1D4Y JUSES[01MAR 1 992-01MAY1992]
LOUIS, MOJFLOW-AYER/D1IAM1599) 1DAY/USGS[01MAR 1992-01MAY 1992 ]
LOUIS, MOJFLOW-MAX01 AN B99/1 DAY USGS[01MAR 1992-01MAY1992])
LOUIS, MOJFLOW-MIN/O1 JAMLE99) 1DAY IUSGS[01MAR 1992-01MaY1992])
LOUIS, MOJFLOW-POS/01 JAN1599/1D4Y JUSES[01MAR 1992-01MAY1992])
LOUIS, MOJFLOW-P10j01 JAN1599/1DAY 1USES[01MAR 1992-01MAY1992])
LOUIS, MOJFLOW-PZ5/01 JAN1§99/1DAY /USES[01MAR 1992-01MAY1992]]
LOUIS, MOJFLOW-PS0/01 JAN1§99/1D4Y /USES[01MAR 1992-01MAY1992])
LOUIS, MOJFLOW-P7S]01 JAN1599/1DAY JUSES[01MAR 1992-01MAY1992])
LOUIS, MOJFLOW-PI0j01 JAN1599/1DAY JUSES[01MAR 1992-01MAY1992])
LOUIS, MOJFLOW-POS/01 JAN1899/1DAY /USES[01MAR 1992-01MAY1992]]
LOUIS, MOJFLOW-SD{011AN1599) 1DAYUSGS[01MAR1992-01MaY 1992]]

Figure 7.41 Screen for Cyclic Analysis Function

Once the compute is performed, the resultant 14-pseudo time series data
sets appear in Results list on the screen (Figure 7.42). One or more data
setsin thislist may be selected (by clicking, control-click or shift-click )
for saving to file, plotting or tabulation by using the Save [& button,
SaveAs I button, the Plot [ .4 button or the Tabulate = button from the

toolbar located immediately above the Resultslist. An example showing
the data plotted is shown in Figure 7.42.

SMISSISSIPPI RIVERUS T, LOUTS, MOJFLOW . MAXADTJANT ESS/TDAY AUSGS[ D1 JANT 899 O6APR 2009 ]/
Fio Edt fiow

0]
@ 1,200,000

1,000,000
800,000

B00,000+

Flow (cfs)

400,000

200,000

Ivar May Jul Sep
| 000
ST LOUS, MO USGS|01.AN1899-08APR2009] FLOW-MIN
—— ET.LOWIS, MO USGE{D1.14N1893-DEAPR2009] FLOW-P10
ST LOUIS, MO USGES|01.1aN 1899 06APR2008] FLOW-PS0
ST LOUIS, MO USGS{01.14N189%-06APR2009] FLOW-PS0

ST LOUIS, MO USGS[01JAN1893-06APR2009] FLOW-MAX
ST, LOUIS, MO USGS(01J4N1899-06APRI009] FLOW-POS
ST, LOUIS, MO USGS(01JANT§93.06APRI009] FLOW.-P25
SGS]01.JAN 1 EF9-06APRI009) FLOW-PTS
USGS01JANTEFS-06APR2009] FLOW-PI5

— ST, LOUIS, k

Figure 7.42 Plot of Data Set Results from Cyclic Analysis
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7.8.4

Duration Analysis

The Duration Analysis function computes the duration curve for aregular
interval time series data set and stores the resultsin a new paired data set.
Flood duration curves are useful in assessing the general low flow
characteristics of astream. For example, if the lower end drops rapidly,
the stream has low ground-water storage and low or no sustained flow.
The overall slope of the curveis an indication of the flow variability in the
stream. Refer to EM 1110-2-1415 Chapter 2 (USACE, 1993) for a
description of duration analysis. Duration analysisis usually applied to
daily flow or elevation or similar data. Thisfunctionisnot Volume
Duration Frequency Analysis, see the program HEC-SSP for this

capability.

HEC-DSSV ue provides two techniques for compute duration curves. The
first method devel ops the curve by ranking all the data and then extracting
points along that curve. The second technique segregates values into
"bins" and then plots the cumulative amount. This technique was used by
the HEC-STATS program and was devel oped to accommodate the small
amount of memory that computers used to have, or when the analysis was
done by hand. Because memory limitations have been removed, the first
technique is more accurate and is recommended.

The data to be analyzed must have aregular time interval of "1DAY",
"IWEEK", "TRI-MONTH", "SEMI-MONTH", "1IMON" or "1Y EAR".
Typicaly the time series data set for the duration analysis spans multiple
years. Thetime series data values are first sorted by time of the year into
periods of "Annual”, "Quarterly”, "Monthly" or "Other Defined". For an
"Annua" period type, all data are assigned to a continuous single duration
period. For a“Quarterly” duration period type, the data values are sorted
by quarter year: 1 January to 31 March, 1 April to 30 June, 1 July to 30
September, and 01 October to 31 December. For the "Monthly" duration
period type, data values are sorted by month. The "Other Defined"
duration period type allows arbitrary duration periods to be defined and
used.

For the standard duration analysis technique, the data values within a
duration period are ranked (ordered by descending value). The ordered
values form the y-values for anew paired dataset. The x-values represent
the percent of time exceeded computed by:

E = 100* [ M /(n+1)] (Weibull plotting positions), percent of the
time the value is equaled or exceeded

M = therank position of the value

n = number of values.
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A curveis computed for each duration period. Thus for aduration period
type "Quarterly", the paired data set has four curves with the curve labels
"Jan-Mar", "Apr-Jun”, "Jul-Sep" and "Oct-Dec".

The set of x-values generated by the duration analysis are dependent upon
the number of valuesin the time series. Typically al values should be
used for plotting the curve. However, this may become unwieldy when
presented in atable form, so values may be a standard set of percentages,
for example: 1%, 2%, 5%, 10 %, etc. If desired, the Duration Analysis
function can sample the analysis results to a standard set of frequency
points, or to a set of evenly distributed x-values. Using log spacing
provides more clarity of the curve at its ends. User defined points can be
specified by entering those pointsin atable after selecting the User
Defined button.

To compute the duration analysis for aregular interval time series:

1. Select the data set from the main HEC-DSSV ue screen and then
select the Math Functions button or Math Functions from the
Tools menu.

2. Choose the Statistics tab of the Math Functions screen and select
the Duration Analysistype, as shown in Figure 7.43.

Math Functions g@gj
File Edit Display
g |4 == 5]
Selected Data Set: | (MISSISSIPPI RIVER)ST. LOUIS, MOJFLOWIOLIAN1E99) LDAY USGES] hd
Atithretic | General | Time Functions | Hydrologic | Smoothing | Statistics
TR ation Analysis (R
(%) Standard Method
() Bin (STATS) Method
Murnber: 40273 Minimurm: - 10000,0 Maximum: 1050000
Start: 01 Jan 1899 End: 06 Apr 2009
Duration Period: | Annual N
Warne Start of Period End of Period
~
~
Eins Flotting Points Horizontal Axis
() Frequency on ¥ axis (&) Linear
() FLOW on % fixis () Probability
(®) all 40273 points
Wertical Axis
() standard (23 points)
Linear
() User Defined: Gu
OLog

Figure 7.43 Duration Analysis Screen for Standard Method

3. Select the time series data set to apply the function from the
Selected Data Set pull down list.
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4. Select either the Standard Method or Bin (STATS) Method for
the analysis technique you wish to use.

5. Set the duration period type using the Duration Period pull down
list.

6. If the duration period type "Other" is selected, the duration periods
are defined in the Duration Period table. Dates entered for the
"Start of Period" and "End of Period" is of the form, "05May".
The duration period "Name" is assigned to the curve label in the
paired data set generated by the duration analysis function.

7. If the Bin method is selected, choose the number of binsto use,
and if those bins should be spaced log arithmetically or linearly
between the minimum and maximum values. Or select User
Defined bins and enter valuesinto the table by pressing the Set
L imits button, as shown in Figure 7.44. User defined limits will
provide greater flexibility to select the parameter values desired.

Math Functions E@gl

File Edit Display
VES
Selected Data Set: || TRAY-RC-POCLTRAMS/ELEY /01 JAN1 942/ 1 DAY /OBS) hd
arithmetic | General | Time Functions | Hydrologic | Smoothing | Statistics
Iype! | Duration Analysis
() Standard Method
(3) Bin (STATS) Methad
Murber: 17745 Minimum: 973,15 Maxirmum: 232,21
Start: 01 Jan 1942 End: 04 May 2009
Curation Period: | Monkhly hd
Mame Start of Period End of Period
~
-
Bins Flatting Paints Harizontal Axis
() Evenly Distrubuted () Frequency on ¥ axis () Linear
BumlEss 23 - () ELEY on ¥ Axis () Prabability
Spacing: L Li (%) All Bins
[Pt O & @ near Wertical Axis
() Standard (23 paints)
User Defined: Linear
0 Uiz Bz () User Defined: ®u
| Set Limits | O Log

Figure 7.44 Duration Analysis Screen for Bin Method

8. The values provided in the table are either those computed using
the number of bins and spacing method selected before, or those
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saved from the previous run. To reset the values to the default
ones, press the Defaults button. Thiswill use the number of
values selected to compute the default values. An example of the
Bin Limitstableis shown in Figure 7.45.

Bin Limits E ”E'E'

Edit
Ordinate Bin Limit

1 972.5 L
Z ]
3 973.5
4 974
5 974.5
=] 975.0
E 975.5
g 976.0
9 976.5
10 Q7.0
11 9Fr 5
12 975.0
13 9758.5
14 979.0
15 979.5
16 950.0
17 980.5
15 251.0
19 951.5
20 952 b

[ Defaults ] [ oK ] [ Cancel ]

Figure 7.45 User Defined Bin Limits Table

9. Select whether you want the Frequency to be on the X axis or the
Parameter on the X axis. Typically Frequency is given on the X
axis. If you display the results in tabular form, you may want to
select the parameter for the X axis.

10. The number of duration points retained for plotting and tabulation
is controlled by the Plotting Points options. Select the All Bins
radio button to retain al the ranked computed duration points.
Select the Standard radio button to interpolate the results to the
traditional set of 23 log points. Y ou may choose your own number
of points by selecting the User Defined radio button and entering
the desired number of interpolation points in the box to the right.
Select either Log or Linear spacing on where to sample those
points.
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11. TheHorizontal and Vertical Axisoptions control the scales for
plotting the duration analysis curves. The Linear scaleradio
button selects alinear plot scale for the both the x and y axes. The
Probability scale radio button selects a probability scale for the x-
axisand alog scale for the y-axis.

12. Click Compute. Note: any change to the plot configuration
requires are-compute of the data.

13. Select the plot button to view the computed duration curve(s). An
example of resulting plots are shown in Figure 7.46 and Figure
7.47.

FWISSISSIPPI RIVER/ST. LOUIS, MOJEXCEEDANCE-FLOW/1DAY: 01.JAN1899-06APR20094].. . E][E|E‘
File Edit \iew

L

1,200,000

1,000,000

600,000

600,000

Flow {cfs)

400,000

200,000

1] T T T T T T T T T
1] 10 20 30 40 50 60 70 80 90 100

Fercent Exceedance

|— ST, LOUIS, MO JAN-DEC MODIFIED-USGS 1DAY: 01JAN1599-064PR2009 0

Figure 7.46 Linear Vertical and Horizontal Axis

/MISSISSIPPI RIVER/ST., LOUIS, MO/EXCEEDANCE-FLOW/1DAY: 01.JAN1899-064PR2005... [2](E]K]
File Edit View

&

1,200,000

1,000,000

800,000

600,000

Flow {cfs)

400,000

200,000

T T T T T T T T
0.9999 0.94 0.4 0.4 01 0.01  0.00

FProbabhility
|— ST. LOUIS, MO JAN-DEC MODIFIED-USGS 1DAY: 01JAR1895-064PR2009 O

Figure 7.47 Linear Vertical and Log Horizontal Axis
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14. You can aso select to view the data as tabular or display in
Microsoft Excel. Thetablein Figure 7.48 below was computed by
using the bin method for monthly periods and tabulating with
Elevation on the X axis.

STRAY-RC-POOLATRAMS/ELEY - EXCEEDANCEADAY : 31DEC1 941 -04MAY 2009/ JAN/OBS/

File Edi View
TRAMS TRAMS TRAMS TRAMS TRAMS TRAMS TRAMS TRAMS TRAMS TRAMS TRAMS TRAMS
Ordinate ELEW Exceed... | Exceed... | Exceed... | Exceed... | Exceed... | Exceed... | Exceed... | Exceed... | Exceed... | Exceed... | Exceed... | Exceed...
JAR FEE MAR APR. MAY aun Jue AlG SEP ocT MO DEC
Lahels JAN FEE MAR APR Mav UM Jue AlG SEP ocT MOV DEC
Units FEET Percent
Type
1 83,00
2 982.50
3 932.00 0.239
4 9581.50 0.533
5 51,00 0,958
6 980.50 0.067 3.411 1.186
7 930.00 0.267 5.925 2,99 0.000
8 979.50 0.467 7.600 +.432 0.133 0.195 1.014
9 979.00 0.600 11.071 6,492 0.667 1.105 1.624
10 976,50 1.067 13.585 10,549 3.803 1,864 2,230 0.070
i1 975.00 1.666 19.090 14,9381 7138 3.249 2,365 0,487
12 977.50 3.803 22.083 20.100 11.608 4.743 2,568 1.045 0.202
13 977.00 7.643 7 a0z 6.671 32.5955 30.699 Z2z2.862 18.908 9.459 6,616 3.434 1.408 4.600
14 976,50 30,456 30016 22,949 60,622 62,110 60,173 53.261 40,149 29,666 25,185 26,831 29,653
15 976,00 47,649 48,824 49,633 77,558 4,519 52,855 73.619 62,027 52,716 41,461 36,944 44,374
16 975.50 67.158 71.238 66.311 86.535 92,509 90.527 85.369 80,203 70.613 61.513 61.761 65,605
17 975.00 80.702 51113 52,655 94,315 96,442 94.930 94.542 80,662 85,308 81.414 79.859 80,396
18 974.50 86491 66,520 90,460 97.726 99,376 9773z 95.971 95,608 91,365 §9.632 §9.014 §9.172
19 74,00 93.965 95,141 97,265 96,384 100,000 100,000 99,220 97,230 95,891 94,545 94,859 95,612
20 973.50 98.947 99,687 99.533 100.000 100,000 100.000 100.000 100,000 100,000 99.798 99.930 100,000
21 973.00 100.000 100.000|  100.000 100.000| 100,000 100.000|  100.000 100,000 100,000 100.000| 100.000| 100,000
22 972,50 100.000 100.000|  100.000 100.000| 100,000 100.000| 100,000 100.000| 100.000| 100.000| 100.000| 100,000

Figure 7.48 Monthly Exceedences for Elevations

7.8.5 Frequency Plot

The Frequency Plot function computes and displays afrequency plot for
apeak annual data from atime series data set. This computation is
intended for period of record (years) of primarily stream flow data. The
data can bein intervals less than year, as annual peaks are automatically
calculated from the data set.

The plot is generated by computing annual peaks from the data set and
then ranking the data and plotting. An optional curve may be drawn for
your data set using the Pearson type |11 transformation equation as
described in Chapter 12 of EM 1110-2-1415 (USACE, 1993).

For adetailed frequency analysis with additional parameter control, the
user isreferred to the program HEC-SSP. The HEC-DSSVue
computation provides aquick evaluation of data.

To compute a Frequency Plot for atime series set:

1. Select the data set from the main HEC-DSSV ue screen and then
select the Math Functions button or Math Functions from the

Tools menu.
2. Choose the Statistics tab of the Math Functions screen and select

the Frequency Plot type, as shown in Figure 7.49 (page 7-74).
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Math Functions
Eile Edit Display

FEYWE

Selecked Data Set: |,|'MISSOURI RIVER/KAMNSAS CITY, MOJFLOW/011AM1928] 1DAY/USGS) b

Arithmetic | General || Time Functions || Hydrologic Smoothing| Statisticsl

IR HFrequency Plot

Show computed curve with observed points

Figure 7.49 Computing a Frequency Curve

3. Select the time series data set to apply the function from the
Selected Data Set pull down list.

4. Select the checkbox Show computed curve with observed points
if you wish to.

5. Press Compute.

6. A plot will be displayed showing the frequency plot and computed
curve (if selected), which is shown in Figure 7.50.

Exceedence Probability

File Edit Wiew
1000000.0
@
[

&

= 100000.0+

S

[=]

[

10000.0 T T T T T T T
0.9999 0.999 0.99 0.9 0.5 0.1 0.m 0.001 0.0001
Frohahility
| ¢ KANSAS CITY, MO USGS 0 Computed 0

Figure 7.50 Frequency Plot and Computed Curve for Daily Flow Data
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CHAPTER 8

Scripting

Scripting provides away to control the operation of HEC-DSSVuein a
non-interactive way. The user can build and save scripts to be executed
later - possibly on different data sets.

This chapter provides an introduction to scripting, describing the
components of the user interface, scripting language and application
program interface (API), and offering examplesillustrating how to use the
API.

8.1 Executing Scripts

HEC-DSSV ue allows the execution of scriptsin interactive and batch
modes. Scripts are executed interactively by starting the HEC-DSSV ue
program and selecting the desired script from the Toolbar or the Script
Selector from the Utilities menu. Scripts are executed in batch mode by
starting the HEC-DSSV ue program with a script file name as a parameter
(e.g. HEC-DSSVue.exe c:\test\myScript.py). Scripts can be launched from
the HEC-DSSV ue program from the Script Menu, or from the Toolbar or
from the Script Selector.

Interactive scripts are not passed any parameters upon script execution. In
ascript executed interactively the variable sys.argv isalist of length one,
with the only element set to the empty string (e.g., sys.argv=[""]).

Scripts executed in batch mode may take parameters from the command
line (e.g., HEC-DSSVue.exe c:\test\myScript.py a b ¢). Inascript
executed in batch mode the variable sys.argv isalist whose length is one
greater than the number of parameters passed on the command line, with
the first element set to the file name of the executing script and the
remaining elements set to the parameters (e.g., sys.argv = ["c:\\test\

\myScript.py", "a', "b", IIC"]).

8.1.1 Script Menu

The Script Menu (see Figure 8.1, page 8-2) can display alist of available
scripts and execute a script by selecting it from the menu. The Script
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Figure 8.1 Running Scripts from the Script Menu

Menu, shown in Figure 8.1, is not made visible on the main HEC-
DSSVue menu bar until scripts are set to be displayed on the menu bar
from the Script Editor, available from the Tools menu. To have a script
displayed in the Script Menu, ssmply edit the script in the Script Editor,
select the Show in Scripts M enu checkbox at the top of the editor (Figure
8.2).

Script Browser
File Edit Options

0 Scripts Label: |Coyvate| |
[=1+{Z) HecDssvue

= lcovote Shows in Scripts Menu Show in Script Seleckor  [] Display Script on Toalbar
- [a] Duration Ana
Folsom

GagePlot
MYR Test Tcon: Tesk Arguments: | |

Figufe 8.2 Show in Scripts Menu Checkbox in Script Editor

Script: |J:,fdev,l’cnde,l’HecDss\n’ue,l’scrlpts,l’(nynte.py |[ ]

8.1.2 Main Toolbar

The main toolbar can display buttons for all the available scripts which
have the Display Script on Toolbar box checked in the Script Editor
(Figure 8.2). Buttons are displayed in alphabetical order. After selecting
the check box, the menu bar will look likeit is shown in Figure 8.3 below.

File Edit Wiew Display Groups DataEnkey  Tools  Scripts  Advanced
- _J == |y f%  Coyote Folsom GagePlot

File Name: |

Figure 8.3 Script Menu Bar

8.1.3 Script Selector

The Script Selector (see Figure 8.4, page 8-3) displays buttons for all the
available scripts which have the Display Script on Toolbar box checked
in the Script Editor (Figure 8.2). Buttons are displayed in alphabetical
order.




HEC-DSSVue User's Manual Chapter 8 - Scripting

To access the Script Selector, select the

Script Selector command from the =

Utilities menu of HEC-DSSVue. Once
the Script Selector isopen, it will

remain open until you closeit.
When you press a button, the Jython
script engine will execute the associated

script.

Figure 8.4 Script Selector

8.2 Script Editor

The Script Editor, shown in Figure 8.5, alows you to add, delete, and
modify scripts.

Script Editor g@g|
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- |a] testPlok dotPat=[z2., 8.]

datasets =[]

dssFile = D55, 0pen("D:fcovate.dss", "01MARZ006 2400, 30MAR2005 2400")

precip = dssFile.read("/EF RUSSIAN/COYOTEPRECIP-ING /01 MARZO06/ 1HOUR/TE™)
datasets, append{precip)

star = dssFile, read("{EF RUSSIAN/COYOTE/STOR-RES EOPJ01MARZ006] THOUR (™)
datasets, append{skor)

tapean = dssFile read("{EF RUSSIAN/COYOTETOP COM STOR/01JAN2006/104Y/[")
datasets, append{topcon)

inflow = dssFile.read("JEF RUSSIAN/COYOTE/FLOW-RES INfO1MARZ006) 1 HOLURSMOOTH
datasets, append(inflow)

autflow = dssFile.read("/EF RUSSIAN/COYOTE/FLOW-RES OUT/01MAR 2006/ THOUR ")
datasets. append{outFlow) o

< ¥

[ Edit ] [ Save and Test ] [ Save ] [ oK ] [ Cancel ]

ScriptsfHecDsshiue fCovote 1:1 Insert

Figure 8.5 Script Editor

Y ou can access the Script Editor from HEC-DSSV ue's Utilities menu by
clicking Script Editor. Alternatively, you can get to the Script Editor
from the shortcut menu of the Script Selector (Figure 8.4). Inthe Script
Selector, right click on a button to access the shortcut menu, and then
select Edit. The Script Browser will open with that script selected and
ready for editing.
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Components

of the Script Editor include the Menu Bar, the Editor

Panel, and the Tree Hierarchy. The following sections describe these

components.

8.2.1 Menu Bar

primary men

script Editor,
The Menu Bar (Figure 8.6) contains three File Edit Options

u items, File, Edit, and Options.
?'| Scripks

Figure 8.6 Menu Bar

File Menu Commands

New

Open

Import

Save

Save As

Delete

Test
Close

Creates a new script stored at the currently selected position.
Available only when afolder node is the selected node in the
scripts tree.

Edits the currently displayed script. Double clicking on the script
also editsthe currently displayed script. Available only when a
script node is the selected node in the scripts tree.

Imports afile into the script browser. If the import is successful the
browser is placed in edit mode. Available only when afolder node
isthe selected node in the scriptstree.

Saves the current script. Available only when a script is being
edited.

Saves the current script, allowing the user to change the label.
Note that the name of the script file does not change. Available
only when a script is being edited.

Deletes the currently opened script. Prompts user for confirmation.
Available only when a script node is the selected node in the
scriptstree.

Executes the currently selected script.
Closesthe Script Editor.

Edit Menu Commands

Cut Script

Copy Script

Paste Script

Cutsthe script at the currently selected tree node to the system
clipboard. Available only when a script nodeis selected in the
tree view.

Copiesthe script at the currently selected tree node to the
system clipboard. Available only when a script nodeis
selected in the tree view.

Pastes the script in the system clipboard to the currently
selected tree node. Available only when afolder nodeis
selected in the tree view.
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Option Menu Commands

Set Font Opens adialog box that allows setting of the font used in the

script text area.  Fixed-space fonts such as " Courier New" and

"Lucida Console" are recommended over proportiona fonts.
Set Tab Size Opens adiaog box that allows setting the number of spaces

that will be displayed in the script text area for each tab
character.

Editor Panel

Y ou can select and edit scriptsin the Editor Panel (Figure 8.7) of the
Script Editor.

Label; [Coyake
Show in Scripks Menu Show in Script Seleckar Display Script on Toolbar

fram hec.script. Constants import TRUJE, FALSE
from hec.hecmath import *

# grid pattern - 2 solid pixels Followed by & blank ones
dotPat =[2., &.]

datasets =[]

dssFile = 055, 0peni Dy fcovote, dss”, "01MARZ2006 2400, 30MARZ006 2400™)

precip = dssFile. read{"/EF RUSSIAM/COYOTEPRECIP-ING01 MAR 2006/ 1 HOUR  TE™)
datasets, appendiprecip)

stor = dssFile.read("JEF RUSSLAM/COYOTEISTOR-RES EOP /01 MARZO06! THOUR ™)
datasets, appendistar)

topcon = dssFile. read({"/EF RUSSIAMICOYOTEITOR CON STOR/OLIANZ006/ 104 ™)
dataseks, appenditopcon)

inflaws = dssFile.read("{EF RIISSIANCOYOTEFLOW-RES IN/O1MARZ006/ 1HOUR [SMOOTH
datasets, appendiinflow)

outFlow = dssFile.read("EF RUSSIAN/COYOTEFLOW-RES OUT/01MAR 2006/ IHOURS ™)
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Figure 8.7 Editor Panel

The L abel field allows you to specify the label displayed on a script's
button in the Script Selector.

Soripts | 3: fdevicode (HecDssyUe scrpts (Coyate. py [I]
Icon; -Mone- % | Teskt Arguments;
Descripkion:

fram hec,scripk import * Ll

datasets. append{outFlow) w




Chapter 8 - Scripting

HEC-DSSVue User's Manual

Script displays the name of the file in which the script is stored.

Selecting Show in Scripts Menu causes the script todisplay in the Scripts
menul.

Selecting Show in Script Selector causes the script to be displayed on the
Script Selector.

Selecting Display Script on Toolbar causes the script to be displayed on
the Toolbar .

The I con field allows you to choose the Icon to display for the script's
button. If you do not select an icon, the script name displays in the script's
button.

The Description field allows you to add a description of the script. The
first line of your description serves as atooltip for the corresponding
button on the Script Selector and Toolbar.

The Script Text field contains the script text itself and serves as an editing
window for creating new scripts.

The script text field has a context menu that can be accessed by right-
clicking in the script text field.

Script Text Field Context Menu Commands

Cut Copies the currently-selected script text to the system
clipboard and removes it from the script.

Copy Copies the currently-selected script text to the system
clipboard and leavesit in the current script.

Paste Copiestext in the system clipboard into the script at the
current cursor location.

Select All Selects all the text in the script.

Find Opens adialog that allows the user to search for specific text

inthe script. If textis currently selected in the script, the
diadogisinitidized with this text.

Find Next Locates the next text in the script that matches the conditions
of the most recently executed find command.

Find Previous Locatesthe previous text in the script that matches the
conditions of the most recently executed find command.

GotoLine Opens adialog that allows the user to cause the cursor to
jump to the beginning of a specified line in the script text.
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8.2.3 Tree Hierarchy

The Tree Hierarchy, as shown in Figure —
8.8, uses aWindows Explorer-style tree T_'__Sc.r'p,jz —
structure to allow you to navigate folders - =l

in your directory structure and access
scripts. Scripts are stored in a"scripts’
directory under the directory where
HEC-DSSVue was installed.

Durakion Ana
Folsom
GagePlot
MYR. Test
Morth_Mara_copy
Cakyillepg
Testshef
getMain

plak

plokz

plok3
prinkArgs
prinkLoc

kab

kesk

kestPlok

The Tree Hierarchy aso has a context
menu that displays Cut Script, Copy
Script, and Edit Script commands for
script nodes and New Script, Import
Script, and Paste Script for folder
nodes. These commands cause the same
actions as the File and Edit menu
commands discussed above.

To access the context menu, point to a
node in the "tree" and right-click with
your mouse.

Figure 8.8 Tree Hierarchy

8.3 Scripting Basics

Scripting in HEC-DSSV ue is accomplished using Jython, an
implementation of the Python programming language designed
specifically for integration with the Java programming language. More
information about Jython can be found at the official Jython website —
www.jython.org.

Python (of which Jython is an implementation) is an interpreted language
with simple syntax and high-level datatypes. This sectionisnot a
comprehensive Python tutorial, but rather a ssmple primer to alow the
creation of simple scripts. This primer does not cover defining classesin

Python.

The official Python website - www.python.org - has links to online Python
tutorials as well as programming books.

8.3.1 Outputting Text

Text information can be displayed in the console window using the print
statement which has the syntax:
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print [iten, item...]]

The items are comma-separated and do not need to be of the same type.
The print statement will insert a space between every specified item in the
output.

Example 1: Outputting Text

print “Testing myFunction, i =", i, “, x =", X

8.3.2 Data Types and Variables

Python has Boolean, integer, long integer, floating-point, imaginary
number, and sequence and dictionary datatypes. Sequences are divided
into mutable (or changeable) sequences called lists, immutable sequences
called tuples. Tuples may be enclosed in parentheses or may be "naked".
Strings are special tuples of characters that have their own syntax.
Dictionaries are like sequences but are indexed by non-numeric values. In
addition, Python also has a special type called None, which is used to
indicate the absence of any value. The only valid values for the Boolean
type are True and False. In certain circumstances these values also
evauate to the integers 1 and O, respectively.

Python variable names consist of an upper- or lower-case letter or the*_”
(underscore) character followed by an unlimited number of upper- or
lower-case characters, digits or underscore characters.

Like many languages, Python uses the single equals sign, "=", to assign
valuesto variables. However, Python allows assignment to multiple
variables from a single sequence, as long as the number of variables on the
left of the equal sign is the same as the length of the sequence on the right
side. If the sequence on theright sideisadictionary, only the dictionary
keys are assigned to the variables on the | eft.

There are situations regarding the HEC-DSSV ue API where it is necessary
or desirable to set atime-series value to "missing” or to test whether a
time-series valueis missing. The hec.script module supplies a constant to
use in these situations.

The currently-defined constants in the hec.script module are:

Constant Type Represents
Constants. TRUE integer True
Constants.FALSE integer False
Constants. UNDEFINED floating-point missing data value

8-8
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Example 2: Variable Types

# set some integer values
i=0

=1

k =-10998

m = True

# set a long integer
n =79228162514264337593543950336L

# set some floating-point values
X =9.375

y = 6.023e23

z=-7.2e-3

t = Constants.UNDEFINED

# set some strings

string_1 = “abc”

string_2 = ‘xyz’

string_3 = “he said \“| won't\""

string_4 = ‘he said “I will not!™

string_5 = “""this is a
multi-line string™”

# set a tuple — tuples are contained within ()

tuple_1 = (1, 2, “abc”, x, None)

# set a list — lists are contained within []
list_1 =11, 2, “abc”, x, tuple_1]

# set a dictionary, using key : value syntax
# dictionaries are contained within {}
dict_1 ={"color” : “red”, “size” : 10, “list” : [1, 5, 8]}

# multiple assignment

a, b, c=string_1

a, b, c ="“abc”

a,b,c,d e=tuple_1

a, b, c,d, e=(1, 2, “abc”, x, None)

a,b,c,de=1, 2 “abc”, x, None # “Naked” tuple assignment
a, b,c,de=list 1

a, b,c,d e=[1, 2, “abc”, x, tuple_1]

a, b, c=dict_1

a, b, c = {“color” : “red”, “size” : 10, “list” : [1, 5, 8]}

Indexing into sequence typesisdone using [i] wherei starts at O for the
first element. Subsets of sequence types (called slices) are accessed using
[i:):K] wherei isthe first element in the subset, j isthe element after the
last element in the subset, and k isthe step size. If negative numbers are
used to specify and index or slice, theindex is applied to the end of the
sequence, where [-1] specifiesthe last el ement, [-2] the next-to last and so
on. If kisomitted in slice syntax it defaultsto 1. If i isomitted in slice
syntax it defaultsto O. If j isomitted in slice syntax it defaults to the length
of the sequence, so list_1 [O:len(list_1)] isthesame aslist_1[:]. Indexing
into dictionaries is done using [X] where x isthe key.

The number of elements in a sequence type or dictionary is returned by the
len() function.

8-9
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Example 3: Sequence Indexing and Slicing
string_4(3] # 4th element
string_4[3:5] # 4th & 5th elements
list_1[0::2] # even elements
list_1[1::2] # odd elements
list_1[-1] # last element
list_1[2:-1] # 3rd through next-to-last element
list_1[2:len(list_1)] # 3rd through last element (also list_1[2:])
dict_1["size"] # value associated with “size” key
i = len(list_1) # length of list_1

8.3.3 Operators

Each of the following operators can be used in the form a= b operator c.
Each can aso be used as an assignment operator in the form a operator=b
(eg.,a+=1,x**=2).

+ arithmetic addition

- negation or arithmetic subtraction
*  arithmetic multiplication

[ arithmetic division

/I integer arithmetic division
** arithmetic power

% arithmetic modulo

& bit-wise and

|  bit-wiseor

~  bit-wise not

AN bit-wise xor (exclusive or)
<< hit-wise left shift

>>  bit-wise right shift

Each of the following operators returns True or False and can be used in
conditional expressions as discussed in Section 8.3.6.

> greater than

< lessthan

>= greater than or equal to
<= lessthan or equal to

I=  not equal to
== equalto

8.3.4 Comments

Python uses the "#"' (hash) character to indicate comments. Everything
from the "#" character to the end of the lineisignored by the interpreter.
Comments may not be placed after a program line continuation ("\")
character on the same input line.
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8.3.5

8.3.6

Program Lines

Unless otherwise indicated, every input line corresponds to one logical
program statement. Two or more statements can be combined on line
input line by inserting the ;" (semicolon) character between adjacent
statements. A single statement may be continued across multiple input
lines by ending each line with the "\" (back slash) character. Comments
may not be placed after a program line continuation ("\") character on the
same input line.

Example 4: Input vs. Program Lines

# multiple statements per line
r=1; pi =3.1415927; a=pi*r** 2

# multiple lines per statement
a=\

pi *\

rx*2

Input lines are grouped according to their function. Input lines forming
the body of a conditional, loop, exception handler, or function or class
definition must be grouped together. Input lines not in any of the
construct comprise their own group. In Python, grouping of input linesis
indicated by indentation. All lines of agroup must be indented the same
number of spaces. A horizontal tab character counts as eight spaces on
most systems. In some Python documentation, a group of input linesis
caled asuite.

Example 5: Input Line Grouping

# this is the main script group

dist = x2 — x1

if dist > 100.:
# this is the “if” conditional group
y =dist/ 2.
zZ=y**2.

else :
# this is the “else” conditional group
y = dist.
z=y**2./15

# back to main script group

a=y*z

Conditional Expressions

Conditional expressions have the form:
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if [not] condition :
i f-group

[elif [not] condition :
elif-group]

[el se :
el se- group]

The™:" (colon) character must be placed after each condition. The
condition in each test is an expression built from one or more simple
conditions using the form:

simple-condition ( and | or ) [not] sinple-condition

Parentheses can be used to group conditions. The simple-conditionin
each expression is either an expression using one of the conditional
operators mentioned before or is of the form:

item[not] in sequence

If the statement group to be processed upon a condition isasingle
statement, that statement may follow the condition on the same line (after
the colon character).

Example 6: Conditional Expressions

if (x <y ory >=2z) and string_1l.index(“debug”) !=-1:
# do something

elif z not in value_listor (x <z * 2.5) :
# do something different

else :
# do something else

Example 7: Simple Conditional Expressions

if X1 < x2 : xMax = x2
else : XxMax = x1

8.3.7 Looping

Python supports conditional looping and iterative looping. For each type,
the body of the loop (the loop-group) can contain break and/or continue
statements.

The break statement immediately halts execution of the loop-group and
transfers control to the statement immediately following the loop.

The continue statement skips the remainder of the current iteration of the
loop-group and continues with the next iteration of the loop-group
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Conditional Looping

Python supports conditional 1ooping with the while statement, which has
the form:

whi | e condition :
loop-group

Conditional looping executes the body of the loop (the loop-group) as long
as the condition evaluates to true.

Example 8: Conditional L ooping

# print the first 10 characters
string_1 = “this is a test string”
i=0
whilei< 10:

print string_1][i]

i+=1

Iterative Looping

Python supports iterative looping with the for statement, which has the
form:

for itemin sequence :
loop-group

[else:
else-group]

Iterative looping executes the body of the loop (the loop-group) once for
each element in sequence, first setting itemto be that element. If the
iteration proceeds to completion without being interrupted by a break
statement the el se-group will be executed, if specified.

Example 9: Iterative L ooping

# print the first 10 characters
string_1 = “this is a test string”
foriin range(10) :

print string_1][i]

# print all the characters

string_1 = “this is a test string”

for i in range(len(string_1)) :
print string_1][i]

# print all the characters (more Python-y)
string_1 = “this is a test string”
for cin string_1:

print ¢
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The range([start,] stop[, increment]) helper function generates a sequence
of numbers from start (default = 0) to stop, incrementing by increment
(default = 1). Thusrange(4) generates the sequence (0, 1, 2, 3).

8.3.8 Defining and Using Functions

In Python, functions are defined with the syntax:

def functionNane([argunents])
function- body

Function names follow the same naming convention as variable names
specified in Section 8.3.2. The arguments are specified as acomma-
delimited list of variable names that will be used within the function-body.
These variables will be positionally assigned the values used in the
function call. More complex methods of specifying function arguments
are specified in Python tutorials and references listed at the official Python
website (www.python.org).

A function must be defined in a Python program before it can be called.
Therefore, function definitions must occur earlier in the program than calls
to those functions.

A function may optionally return a value of any type or a naked tuple of
values.

Example 10: Defining and Using Functions

def printString(stringToPrint) :
“Prints a tag plus the supplied string”
tag = “function printString : “
print tag + stringToPrint

def addString(string_1, string_2) :
“Concatenates 2 strings and returns the result”
concatenatedString = string_1 + string_2
return concatenatedString

testString = “this is a test”
printString(testString)

wholeString = addString(“part1.”, “part2”)
printString(wholeString)
printString(addString(“this is “, “another test”))

8.3.9 Modules, Functions and Methods

A function is a procedure which takes zero or more parameters, performs
some action, optionally modifies one or more of the parameters and
optionally returns a value or sequence of values.
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A classisthe definition of atype of object. All objects of that type (class)
have the same definition and thus have the same attributes and behavior.
Classes may define functions that apply to individual objects of that type.
These functions are called methods.

An object is an instance of a class, which behaves in the way defined by
the class, and has any methods defined by the class.

Python provides many functions and classes by default. In our examples,
we have used functions len() and range() which Python provides by
default. We have aso used the classes list and string, which Python aso
provides by default. We didn't use any methods of the class list, but we
used the string method index() in Example 7 (string_l.index(“ debug” ) !'=
-1). It isimportant to note that the object method index() doesn't apply to
the string class in general, but to the specific string object string_1.

There are other functions and classes which Python does not provide by
default. These functions and classes are grouped into modules according
to their common purpose. Examples of modules are "os" for operating
system functions and "socket" for socket-based network functions. Before
any of the functions or classes in a module can be accessed, the module
must be imported with the import statement, which has the syntax:

from module inmport *

Other methods of using the import statement are specified in Python
tutorials and references listed at the official Python website
(www.python.org). In the Jython implementation, Java packages can be
imported as if they were Python modules, and the Java package java.lang
isimported by defauilt.

Example 11: Using a Function from an Imported Module

# use the getcwd() function in the os module to get
# the current working directory

from os import *
cwd = getcwd()

A module does not have to be imported in order to work with objects of a
class defined in that module if that object was returned by a function or
method already accessible. For example, the Python module "string" does
not have to be imported to call methods of string objects, but does have to
be imported to access string functions.
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8.3.10

Handling Exceptions

Certain errors within a Python program can cause Python to raise an
exception. An exception that is not handled by the program will cause the
program to display error information in the console window and halt the
program.

Python provides structured exception handling with the following
constructs:

try :
try-group

except
except-group

[el se :
else-group]

try :
try-group
finally :
finally-group

In the try-except-else construct, if an exception is raised during execution
of the try-group, the control immediately transfers to the first line of the
except-group. If no exception is raised during execution of the try-group,
the control transfersto thefirst line of the else-group, if present. If thereis
no exception raised and no else-group is specified, the control transfers to
thefirst line after the except-group.

The two constructs cannot be combined into a try-except-finally construct,
but the same effect can be obtained by making a try-except-el se construct
the try-group of atry-finally construct.

Example 12: Exception Handling

try :
try :
string_1.find(substring) # may raise an exception
except :
print substring + “ is not in “ + string_1
# do some stuff that might raise another exception

else :
print substring + “ is in “ + string_1
# do some stuff that might raise another exception

finally :
print “No matter what, we get here!”

More exception handling information, including filtering on specific types
of exceptions, exception handler chains, and raising exceptions, is
provided in Python tutorials and references listed at the official Python
website (www.python.org). In the Jython implementation, instances or
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subclasses of java.lang. Throwable can also be handled as exceptions.
Detailed information can be found at the Java APl website
(http://java.sun.com/javase/6/docs/api/).

8.4 Displaying Messages

It is often useful to display messages to inform the user that something has
occurred, to have the user answer a'Y es/No question, or offer debugging
information to help determine why a script isn’t working as expected.

Text information can be displayed in the console window as described in
Section 8.3.1.

8.4.1 Displaying Message Dialogs

The M essageBox class in the hec.script module, and the M essageDial og
classin the M essageDialog module have several functions used to display
messages in message box dialogs. The dialogs can be one of four different
types: Error, Warning, Informational or Plain. The difference between the
M essageBox functions and their M essageDialog counterparts is the

M essageBox versions are modal, while the M essageDialog versions are
model ess (see Section 8.5.4).

M essageBox and M essageDial og functions with multiple buttons return a
string containing the text of the button that was selected to dismiss the

message box.

Note: Do not use the M essageBox or M essageDialog functions in a script
that is to run unattended since these functions cause scripts to pause for
user interaction. M essageDialog functions should only be used in batch
mode scripts (see Section 8.5.3).

M essageBox and M esssageDial og functions are described in Table 8.1.

Example 13: Display Error Dialog with M essageBox class
from hec.script import *

MessageBox.showError("An Error Occurred”, "Error")

Example 14: Display OK/Cancel Dialog with M essageDialog class

from hec.script import *
import MessageDialog
ok=MessageDialog.showOkCancel(“Continue with Operation”, “Confirm”)
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Table 8.1 MessageBox and MessageDia og Functions

Function Returns Comments
showError(string message, string title) None Display an error dialog to
you with the message and
title
showWarning(string message, string title) None Display awarning dialog
to you with the message
and title

showlnformation(string message, string title) None Display aInformational
dialog to you with the
message and title
showPlain(string message, string title) None Display aplain dialog to
you with the message and
title

showY esNo(string message, string title) string Display a'Yes/No dialog
to you with the message
and title

showY esNoCancel (string message, string string Display a'Y es/No/Cancel
title) dialog to you with the
message and title

showOkCancel (string message, string title) string Display a Ok/Cancel
dialog to you with the
message and title

8.5 Headless Operation

Often it is desirable to run scripts in the "background” so that you do not
see the interactions or tables or graphics, but instead have the appropriate
functions executed or .png files created. Most math scripts do not write to
the screen, so thisis not anissue. If you call higher level functions, there
isthe potential that some dialogs may appear, especidly if there are errors.
The ListSelection class tries to figure out how you are running a script
and will only print messages if you are running it in the background, but
show message dialogs if your are running in the foreground. This means
that you can get different message dialog behavior if you run a script from
HEC-DSSV ue that accesses ListSelection than if you run it in abatch
mode.

85.1 Headless on Windows

On the PC, you can set the location of plots and tables off-screen so that
they are not visible to the user, create the .png or .jpg file, and then close
the plot or table. For example:

pl ot = Pl ot. newPl ot ()
pl ot. set Si ze( 600, 500)
pl ot. set Locati on(-10000, -10000)
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ol ot . showP! ot ()

b.l. ot.saveToPng("C:/tenp/ nyPl ot. png")
pl ot.cl ose()

85.2 Headless on UNIX

On UNIX, you must have an X-Window server on which to generate a
plot or table. Thisisdoneusing aVirtual X-Window server, such as
Xvfb. The programstreat this as anormal X-Window display. Likethe
PC, you run the scripts as normal, although you don’t need to set at
location:

pl ot = Pl ot. newPl ot ()
pl ot . set Si ze( 600, 500)

ol ot . showP! ot ()

|.3.I. ot.saveToPng("/tmp/ nyPl ot. png")
pl ot . cl ose()

For more information, refer to:
http://www.x.org/archive/X11R6.8.2/doc/ X vib.1.html

On UNIX it is generally advantageous to use the same script to run in an
interactive mode as well as abatch mode. This can be accomplished by
checking to seeif the DISPLAY environment variableis set. If itisn't,
then check that Xvfb isrunning and set the DISPLAY variableto ":1.0".
For example:

#! / bi n/ ksh
# PR R R R R RS SRR R R R R R R RS EEEEE R R R R R R R R R R EEER R R R EREEEREEREEREEEREESEESEEEESRESSE]
if [ "$DISPLAY" = "" ]
t hen
XvfbRunning="ps -ef | grep Xvfb | grep -v grep | w -1 | sed -e "s/ //g""
if [ $XvfbRunning -gt 0 ]
t hen
DI SPLAY=":1. 0"
export DI SPLAY
printf "\nWARNING : Using virtual display - *

printf "no graphics will be visible.\n\n"

el se
printf "\nWARNING : Virtual display server is not running."
printf "\n Set DI SPLAY variable or start Xvfb.\n\n"
return -1

fi
fi

# EIE R R S R S R R R R R R

# Execute the program here...
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8.5.3 Interactive and Batch Mode Scripts

A script issaid to beinteractiveif it is executed from the HEC-DSSVue
menu bar, tool bar, Script Selector, or Script Editor. With any of these
methods, the user interacts with the HEC-DSSV ue GUI to lauch a script.
Conversdly, ascript is said to be in batch modeif it is executed from a
command prompt or shortcut as a parameter to the HEC-DSSV ue
program.

To run ascript in batch mode, you specify the file name of the script asa
parameter to HEC-DSSV ue, following the program name; for example:

HEC- DSSVue. exe C.\ HecDSSVueDev\ HecDssVue\ scri pt s\ Cakvi |l | e. py

In Windows, this can be passed through a .bat file and then you can run
that .bat file; e.g., RunOakville.bat:

HEC- DSSVue. exe C:\ HecDSSVueDev\ HecDssVue\ scri pt s\ Cakvi |l | e. py

On Windows, a shortcut can be
utilized instead of abatch file. To

Dakville Properties @E

General | Shorteut | Compatibility

create a shortcut for a script, copy
the HEC-DSSV ue shortcut and
pass the script file namein
following the Target in the
Shortcuts Properties dialog box
(Figure 8.9). Right click onthe
original HEC-DSSV ue shortcut
on the desktop and click Copy.
Right click on an empty areaon
the desktop and click Paste.
Right-click on the copy and
Rename to an appropriate name
(.e.g., your script name), right
click again and click Properties.
Enter the script name following
the program name in the Target
area, as shown in Figure 8.9.

A Daakville

Target type: Application
Target location; HEC-DS5Yue
Target: SYuehHEC-DS5 5V ue.exe'’ C:AScriptsh0 akville. py

Start ir: |
Shortcut key:  |Mone

Run: Mormal window b

Comment:

Find Target... ] [ Change lcon... ] [ Advanced...

l 0K H Cancel ]

Figure 8.9 Shortcut Properties Dialog Box

In UNIX, afileis made executable by changing its mode to be executable,

e.g., RunOakville:

HEC- DSSVue [/ usr 1/ HecDssVue/ scri pt s/ Gakvi l | e. py

chnod 555 RunCakville

If abatch mode script requires parameters, they must be appended to the
command line (or target field in the shortcut) after the name of the script:
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HEC- DSSVue. exe C:.\ HecDSSVueDev\ HecDssVue\lscripts\xyz.py a b ¢

A script may determine whether it is executing in interactive or batch
mode by calling the isinteractive() ListSelection method in Table 8.3 (see
page 8-23).

One characteristic of batch mode scriptsis that they any GUI components
(plot, tables, etc...) displayed during their execution are destroyed when
the script completes. While this behavior is acceptable for generating files
containing tables and plot images, it is often desirable for a batch mode
script to display GUI components that persist until the user dismisses
them. A batch mode script may always utilize one of the M essageDialog
functions listed in Table 8.1. However, if abatch mode script uses one of
the window typeslisted in Table 8.2, it can call the stayOpen() method of
the window to gain persistence without the need for an extra dialog.

Table 8.2 Window Types with stayOpen() Method
Window

ListSelection

Plot (G2dDialog)
Table (HecDataT able)
CompareFiles
ExcelFrame

Math

SelectRecords

Undel eteRecords

The stayOpen() method causes the window to wait and stay open until the
window isclosed. Likethe M essageDialog functions, the stayOpen()
cannot beused in an interactive script. It will cause the program to
freeze. Plotswill stay open automatically when in an interactive mode.
An example use for Oakville.py is:

# Display the plot and wait for themto close
pl ot . st ayOpen() # Do not use in an interactive script

8.5.4 Modality in Scripts

Modality refers to whether an application window allows interaction with
other windows of the same application. A modal window prevents
interaction with other application windows as long as it is displayed.

Once the modal window is dismissed, interaction with other application
windows resumes. Conversely, modeless windows allow interaction with
other application windows while they are displayed. Most HEC-DSSVue
windows are model ess, although error dialogs and dialogs created with the
M essageBox functions described inTable 8.1 are modal. MessageDialog
functions described in Table 8.1 that are model ess, can not be executed in

8-21



Chapter 8 - Scripting

HEC-DSSVue User's Manual

interactive scripts unless they are called in a separate thread from the
graphics display. Writing multi-threaded scripts is beyond the scope of
this manual.

8.6 Accessing the Main Program Window

Situations arise that necessitate accessing the main HEC-DSSV ue program
window. Examples of such situations are:

m Having a script determine whether it is running in an interactive
mode or without a graphical display.

m Having a script gather information about interactively-selected
pathnames and time windows for automated processing.

m Having a script launch the interactive graphical editor.

The ListSelection classin the hec.dssgui module facilitates these
activities. Animport statement of the form "from hec.dssgui import
ListSelection” is necessary to usethe ListSelection class. (For CWMS-
VUE, the import statement is "from hec.cwmsVue import
CwmsListSelection").

If the script is executing in batch mode then amain program window will
not exist. If the script needs to have the user utilize the graphical editor,
the script will need to create a main program window for the duration of
the graphical edit session.

8.6.1 ListSelection Class

The static functions of the ListSelection class are listed in Table 8.3.

Table 8.3 ListSeection Static Functions
Function Returns Description
createMainWindow() | ListSelection | Returnsanew ListSelection object. This

should not be called unless the script is not
running in interactive mode.

getMainWindow() ListSelection | Returnsthe main program window
(ListSelection object) of the script. Returns
None if the script is not running in
interactive mode.

isinteractive() Boolean Returnsif the program is being run
interactively or in abatch mode.

At the end of abatch script that calls createMainWindow(), you should
close DSS files and exit the ListSelection call using the finish() method.
This function properly shuts down the program without altering any
properties. For example:
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mai nW ndow = Li st Sel ecti on. cr eat eMai nW ndow()

mai nW ndow. i ni sh()

Don't call finish() when running interactively (unless you want the
program to terminate). ListSelection objects can be used to gather
information about pathnames and time windows that the user selected
interactively before launching the script. ListSelection objects can also be
used to launch the interactive graphical editor. The ListSelection methods

arelisted in Table 8.4.

Table 8.4 ListSeection Methods

M ethod Returns Description

addT ool BarButton(JButton b) None Adds a button to the main tool bar.

addToSel ection(String path) None Adds a pathname to the selection
list.

clear() None Clears selected pathnames.

close() None Close the current DSSfile.

copyPathnamesToClipboard() None Copies selected pathnames to the
clipboard

copyRecords(Boolean) None Copies selected records to the
second DSSfile opened if O, or
displays an open dialog

delete() None Deletes the selected records

duplicateRecords() None Duplicates the selected records

exitProgram() None Exits the program, saving settings

exportShef(String filename) None Exports the selected records to
SHEF in thefile given

exportShef(String filename, V ector None Exports the provided data to SHEF

timeSeriesContainers) inthefile given

exportToFile() None Exports images, etc. by opening a
Open dialog

fileCheck() None Runs afile check on the opened DSS
file

finish() None Exits without saving settings

getCustomMenu() JMenu Returns the custom menu

getDataM anager() CombinedData | Returns the combined data manager

Manager for the current file

getDisplayMenu() Jmenu Returns the Display menu

getDSSFilename() string Returns the current DSS file name

getEndTime() HecTime Returns the current end time of the
ListSelection as an HecTime object.!

getEditMenu() Jmenu Returns the Edit menu

getExport Menu() Jmenu Returns the Export menu

getFileMenu() Jmenu Returns the File menu

getlmportMenu() Jmenu Returns the Import menu

getNumber Sel ectedPathnames() integer Returns the number of selected
pathnames

getScriptMenu() Jmenu Returns the script menu

getSecondDataM anager() CombinedData | Returns the combined data manager

Manager for the second file
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M ethod Returns Description

getSel ectedDataContainers() List Reads data for the selected
pathnames and returnsit in alist of
data containers

getSelectionList() list of Returns alist of DataReference

DataReference | objectsthat represent the interactive
objects pathname and time window

selections.

getSel ectedPaths() Vector Returns a Vector of Strings of
pathnames in the open DSSfile.

getStartTime() HecTime Returns the current start time of the
ListSelection as an HecTime object.!

getTimeWindow(HecTime startTime, Boolean Returns whether the start time and

HecTime endTime) end time provided are defined

getToolBar() JoolBar Returns the tool bar

getViewMenu() Jmenu Returns the View menu

graphical Edit() None Launches the graphical editor for the
interactively-sel ected pathnames and
time windows.

graphical Edit(TimeSeriesContainer tsc) None Launches the graphical editor for the
specified TimeSeriesContainer.

graphical Edit(list tscList) None Launches the graphical editor for all
TimeSeriesContainersin the list.

importGenericFiles() None Launches afile open dialog to
import files

importlmages() None Launches afile open dialog to
import image files

importShef() None Launches afile open dialog to
import SHEF files

importShef(string filename) None Imports the SHEF file

isDssFileAccessible() Boolean Returns if the DSSfile set earlier is
accessible currently

isRemote() Boolean Returns whether the DSS file opened
is remote and accessed using
DSSManager

isVisible() Boolean Returns whether thedialog is
currently visible on the screen

math() None Reads the selected data and then
opens the math dialog

mergeFiles(string toDssFilename) None Copies dl the data from the opened
DSSfile into the one specified

openDSSFile (string DSSFileName) Boolean Opensthe DSS file name of the
ListSelection and returns whether it
was opened or not

pairedDataEntry() None Opens the paried data entry dialog

plot() None Reads the selected data and then
plotsit

read(string pathname) DataContainer | Reads the recorded specified by the
pathname

read(string pathname, HecTime start, DataContainer | Reads the recorded specified by the

HecTime end)

pathname and time window
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M ethod Returns Description
read(string pathname, String DataContainer | Reads the recorded specified by the
timeWindow) pathname and time window
refreshCatal og() None Refreshes the catalog for the opened

file
registerExportPlugin(Jmenultem None Adds the menu item to the export
menultem) menu
registerlmportPlugin(ImportPlugin None Adds the menu item to the import
importPlugin, Jmenultem menultem, menu and associates the plugin and
string dropAndDragExtension) drag and drop extension to that item
registerPlugin(integer menuNumber, None Adds the menu item to main menus.
Jmenultem menultem) Menu numbers are the following:
FILE=0;
EDIT = 1;
VIEW = 2;
DISPLAY =3;
GROUPS = 4;
DATA_ENTRY =5;
TOOLS=6;
CUSTOM =7,
SCRIPTS = 8; ADVANCED =9;
HELP = 10;
renameRecords() None Brings up the rename dialog for the
selected pathnames
runkile() None Reads the selected data and runs the
programs associated with them (e.g.,
.pdf, .mp3)
runFile(V ector pathnames) None Reads the selected pathnames and
runs the programs associated with
them (e.g., .pdf, .mp3)
save(DataContainer dataContainer) Boolean Saves the data container in the
opened DSSfile. Returnsif success
or not
saveAs(DataContainer dataContainer) Boolean Opensthe Save As dialog and saves
the data container in the opened DSS
file. Returnsif success or not
selectAll() Boolean Adds all pathnamesto the selection
list
setCustomM enu(string menuText) None Sets the text displayed on the menu
bar
setDssLogFile(string logFile) None Writes DSS messages to thefile
provided
setScriptM enu(string menuText) None Sets the text displayed on the menu
bar
setSel ectedPathnames(V ector None Sets the selected list of pathnames
sel ectedPathnames)
setTimeWindow(string timeWindow) None Sets the current time window of the
ListSelection using a string value to
define the start time and end time
setTimeWindow(string start, string None Sets the current time window of the
end) ListSelection using a string value to
define the start time and end time
setTimeWindow(HecTime start, None Sets the current time window of the

HecTime end)

ListSelection using an Hec Time
object to define the start time and
end time
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8.6.2

M ethod Returns Description

setVisible(Boolean visible) None Sets whether the dialog is visible on
the screen.

squeeze() None Squeezes the open DSSfile

tabulate() Jrame Tabulates the selected data

tabularEdit() Jrame Displays the tabular editor for the
selected data

textEntry() None Displays the text entry dialog

textFileEntry() None Displays an open dialog to read a
text file into text format

timeSeriesDataEntry() None Displays the time series data entry
didog

undeleteAll() None Undeletes all deleted recordsin the
DSSfile

undel eteSel ected() None Undel etes the selected records

updateCatal og() None Creates anew catalog, if needed
(refreshCatalog forces anew
catalog)

updateM essageFiel d(string message) None Puts the message in the message
field

! The current start and end times of a L istSelection object are not necessarily the same as the start and end times
of any DataRefer ence objectsin the ListSelection. Rather they represent the start and end times that will be

applied to subsequent selections.

DataReference Class

The getSelectionList() ListSelection method returns aVector of
DataReference objects that represent the interactive selections. Each

individual selection may hav

e adifferent DSS filename, pathname, and

time window than other selections. The methods of the DataRefer ence

classarelisted in Table 8.5.

Table 8.5 DataReference Methods

M ethod Returns Description
getFilename() string | Returns the name of the DSS file from which this selection
was made.
getNominal Pathname() string | Returns the nominal pathname for this selection. If a
condensed set, thiswill not be area pathname, but show
the date span in the D part
getPathname() string | Returns the pathname for this selection
getPathnameL.ist() Vector | Returnsalist of the pathnames for this selection. This will
be only more than one if a condensed reference
getTimeWindow( Boolean | Setsthe startTime and endTime parameters with the start
HecTime startTime, time and end time of the selection, respectively. Returns
HecTime endTime) Trueif atime window is defined for the selection. Returns
False otherwise.
hasTimeWindow() Boolean | Returns Trueif atime window is defined for the selection.
Returns Fal se otherwise.
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8.7 Reading and Writing to HEC-DSS Files

Retrieving and storing data from a HEC-DSS file is done through the class
HecDss in the hec.heclib.dss package. The older technique of using
DSSFile objects returned from DSS.open() calsis still supported, but
lacks the ability to operate directly with DataContainer objects. HecDss
inherits from DSSFilein HecMath and retains all the functionality of that
class for backwards compatibility. Thefirst call that should be made isthe
static member HecDss.open(string filename), which will return aHecDss
object to retrieve and store data, as well as perform math and other
functions,

Y ou need to import the classes that you use as well as the hec.script
package. To do this, include the follow lines at the beginning of your
script:

from hec.script inport *
from hec. heclib.dss inport *

8.7.1 HecDss Class

from hec. heclib.dss inport *

HecDss. open(string fil enane)

HecDss. open(string filenane, string startTime, string
endTi ne)

HecDss. open(string filenane, string timeWndow)
HecDss. open(string filenane, Boolean fil eMiust Exi st)

The HecDss classis used to gain access to an HEC-DSSfile, asillustrated
in Example 15. Y ou must import HecDss from hec.heclib.dss.

Example 15: Opening and Releasing a DSS File
from hec.heclib.dss import *
theFile = HecDss.open(“MyFile.dss”)
or

theFile = HecDss.open(“C:/temp/sample.dss”, 1)

# Finished using the file — release it
theFile.done()

Using one of the methods that specifies atime window affects the
operation of the get() and read() methods as described in Tables 8.6 and
8.8 of the Pattern Strings section.

Note: The preferred manner of releasing accessto an HEC-DSSfilein
most casesis to use the done() method and not the close() method. Thisis
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because HEC-DSS maintains information about file access and can grant
access to afile released with done() much more quickly than it can to one
released with close(). HEC-DSS will close files when a script exits or
when they have not been accessed for awhile. The only time that the
close() method should be called explicity is to perform some operating
system operation on it, such as renaming or deleting the file.

8.7.2 HecDss Retrieve and Store Functions

HecDss objects are used to retrieve and store data setsin aDSSfile, as
well as severa utility functions for DSSfiles. Dataisretrieved and stored
using DataContainers. DataContainersare simple classesthat are
database independent and are how most Hec classes exchange data.
DataContainers are a base class for several datatypes, such astime series
data, paired data, gridded data, etc. DataContainersand their related
classes are described following the HecDss class. If the data set you are
retrieving does not exist, the DataContainer will have the numberValues
set to O (zero).

HecDss, and most classes accessed through scripts, use Java Exceptions
for error handling. Use atry block to catch and process errors. If data
cannot be stored, HecDss will throw an exception. Refer to section 8.3.11
on Handling Exceptions for more information.

Tip: From the HEC-DSSVue main screen, select a pathname, right click
and select Copy Pathnamesto Clipboard. Y ou can then paste the
pathname into your script and avoid having to typeit. Y ou cannot use
condensed pathnames for these functions.

The HecDss primary retrieve and storage methods are described in Table
8.6. Additiona primary methods are shown in Table 8.7 and secondary
methods are shown in Table 8.6. Time Series Data Storage Methods
(Regular and Irregular) are shown in Table 8.9.

Pattern Strings

The pattern strings used with the getCatal ogedPathnames(...) methods
filter the list of returned pathnames in a user-specified manner. Pattern
strings can be specified in two modes. pathname mode and pathname part
mode. Both modes make use of pathname part filters:
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Table 8.6 HecDss Retrieval and Storage M ethods

Method

Returns

Description

get(String pathname) DataContainer

Retrieves data for the single pathname and
returnsin a DataContainer.
DataContainer will bea
TimeSeriesContainer,
PairedDataContainter, etc., depending
on the datatype. If adefault time window
has been set via one of the open() or
setTimeWindow() methods, the "D" part of
atime series pathnameisignored and the
data for the time window is retrieved.

get(string pathname, DataContainer

Boolean
getEntireDataSet)

Ignoresthe "D" part of time series data
and retrieves data for the entire date span
in the DSSfile.

get(DSSldentifier dssid) | DataContainer

Retrieves data for the pathname and time
window given in the dssid

put(DataContai ner
dataContainer)

None

Store the datain DataContainer in DSS.
The DataContainer must be a
TimeSeriesContainer or
PairedDataContainter, etc. Throws an
exception if the data cannot be stored

Table 8.7 HecDss Additional Primary Methods

M ethod Returns Description

done() None | TellsHEC-DSS that you are finished
using it and releases the file. Usethis
instead of close().

getPathnamelL ist() list Returns alist of the pathnamesin thefile.

getTimeSeriesExtents(String Boolean | Setsthe contents of the start and end

pathname, HecTime start, parameters to the date/time of the first

HecTime end) and last piece of datain the entire data
span. Returns whether the pathname
exists.

isOpened () Boolean | Returnsif the DSSfileisaccessible.

open(String dssFileName) HecDss | Opensthe DSSfile and returns a HecDss
object for further access. Createsthefile
if it does not exist. Throws an exception
if the file cannot be created or opened.

open(String dsskileName, HecDss | Opensthe DSSfile and returns a HecDss

Boolean fileMustExist) object for further access. Throws an
exception if you indicate the file must
exist and it does not.

recordExists(String pathname) | Boolean | Teststo seeif the single record exists.
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Example 16: Reading from DSS

from hec.script import *
from hec.heclib.dss import *
import java

try :
try :
myDss = HecDss.open(“C:/temp/sample.dss”)
flow = myDss.get(*/RUSSIAN/NR UKIAH/FLOW/01MAR2006/1HOUR//")
plot = Plot.newPlot(“Russian River at Ukiah”)

plot.addData(flow)
plot.showPlot()
except Exception, e :

except java.lang.Exception, e :

finally :
myDss.done()

MessageBox.showError(* ‘.join(e.args), “Python Error”)

MessageBox.showError(e.getMessage(), “Error”)

Russian River at Likiah
File Edit Yiew
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Figure 8.10 Example 16 Results

Table 8.8 HecDss Secondary Methods

M ethod Returns Description
close() None Close the DSSfile. Only call this
when you need the file closed (e.g.
to rename it); otherwise call done()
copyRecordsFrom(String integer Copy records from the open DSS
toDSSFilename, list of strings Success=0 |filetothe DSS file name specified
pathnameL.ist) Faill<0 inthe call.
copyRecordsFrom(String integer Copy records from the open DSS
toDSSFilename, Vector Success=0 |filetothe DSS file name specified
pathnameL.ist) Faill<0 inthe call.
copyRecordsl nto(String integer Copy records from the file
fromDSSFilename, list of strings | Success=0 | specifiedinthecal into the
pathnameL.ist) Faill<0 currently open DSSfile
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M ethod Returns Description
copyRecordsl nto(string integer Copy records from the file
fromDSSFilename, Vector Success=0 | specified inthe cal into the
pathnameL ist) Fail <0 currently open DSSfile
delete(list of strings integer Deletes the records corresponding
pathnameL ist) Success=0 |thelist of pathnames

Fail <0
delete(Vector pathnamelL ist) integer Deletes the records corresponding
Success=0 |thelist of pathnames
Fail <0

duplicateRecords(list of strings integer Duplicates the recordsin the first

pathnameL.ist, list of strings Success >0 | list giving the names in the second

newPathnamelL ist) Faill<0 list (same DSSfile)

duplicateRecords(V ector integer Duplicates the recordsin the first

pathnameL.ist, Vector Success >0 | list giving the namesin the second

newPathnamelL ist) Faill<0 list (same DSSfile)

getCatal ogedPathnames() list of strings | Returnsalist of all cataloged
pathnames without generating a
new catalog.

getCatal ogedPathnames(Boolean | list of strings | Returnsalist of all cataloged

forceNew) pathnames, optionally generating a
new catalog first.

getCatal ogedPathnames(string list of strings | Returnsalist of all cataloged

pattern) pathnames that match the specified
pattern without generating a new
catalog.

getCatal ogedPathnames(string list of strings | Returnsalist of all cataloged

pattern, Boolean forceNew) pathnames that match the specified
pattern, optionally generating a
new catalog first.

getDataM anager() CombinedDat | Gets the data manager for this DSS

aManager | file

getEndTime() string Returns the end time set

getFileName() string Returns the name of the DSSfile

getStartTime() String Returns the start time set

isRemote() Boolean Returnsif the DSSfileisbeing
served on a remote machine
(client/server mode)

read(string pathname)* HecMath Returns an HecM ath object that
holds the data set specified by
pathname. If a default time
window has been set via one of the
open() or setTimeWindow()
methods, the "D" part of atime
series pathname isignored and the
datafor the time window is
retrieved.

read(string pathname, string HecMath Returns an HecM ath object that

timeWindow) *

holds the data set specified by
pathname with the specified time
window.
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M ethod Returns Description

read (string pathname, string HecMath Returns an HecMath object that

startTime, string endTime) * holds the data set specified by
pathname with the specified time
window.

renameRecords (list of strings integer Renames the records in the first

pathnameL.ist, list of strings Success >0 | list to those in the second list.

newPathnamelL.ist) Faill<0

renameRecords (Vector integer Renames the records in the first

pathnameL.ist, Vector Success >0 | list to those in the second list.

newPathnamelL.ist) Faill<0

setlrregularStoreMethod (integer None See table following

storeM ethod)

setRegularStoreMethod (integer None See table following

storeM ethod)

setTimeWindow(string None The default time window for this

timeWindow) DSSFile.

setTimeWindow(string startTime, None The default time window for this

string endTime) DSSFile.

setTrimMissing(Boolean trim) None Sets whether TimeSeriesMath
objects retrieved viacalls to
read(...) will have missing data
trimmed from the beginning and
end of the time window. 2

write(HecMath dataset) * integer Write the data set to the DSSfile.
A return value of zero indicates
success.

write (TimeSeriesMath integer See table following

timeSeriesData, string

storeM ethod)

! Currently, theread(...) and write(...) methods can operate only on time-series data, paired data stream rating
data, and text data represented by TimeSeriesM ath, PairedDataM ath, StreamRatingMath, and TextMath
objects, respectively. Other record types, such astext data and gridded data are not yet supported by these
methods.

2 By default, TimeSeriesM ath objects retrieved viacalls to read(...) contain data only between the first non-
missing value and the last non-missing value within the specified time window. Calling setTrimMissing
(False) causesthe data retrieved to include all data for the specified time window, including blocks of missing
values at the beginning and end of the time window.

m Pathname mode = /Afilter/Bfilter/Cfilter/Dfilter/Efilter/Ffilter/
m Pathname part mode = [A=Afilter] [B=Bfilter] [C=Clfilter]
[D=Dfilter] [E=Afilter] [F=Ffilter]

In pathname mode, filters must be supplied for all pathname parts. In
pathname part mode, only those parts that will not match everything must
be specified.

Filters are comprised of the following components:
m Normal text characters. These characters areinterpreted as they

appear. For example, apattern string of "B=XY Z" specifies
matching every pathname that has a B-part of "XYZ".
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Example 17: Reading a complete data set from DSS

from hec.script import *
from hec.heclib.dss import *
import java

try

finally :

try
myDss = HecDss.open(“C:/temp/sample.dss”)
flow = myDss.get(“/MISSISSIPPI/ST. LOUIS/FLOW//1DAY/OBS/”, 1)

if flow.numberValues ==0:
MessageBox.showError(“No Data”, “Error”)
else:
plot = Plot.newPlot(“Mississippi”)
plot.addData(flow)
plot.showPlot()

except Exception, e :
MessageBox.showError(* ‘.join(e.args), “Python Error”)
except java.lang.Exception, e :
MessageBox.showError(e.getMessage(), “Error”)

myDss.done()
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Figure 8.11 Example 17 Results

m Special characters. The specia characters are comprised of the
following list:

e '@ or'*' (used interchangeably). This character can be
specified as the first and/or last character of afilter and
specifies matching a string of zero or more characters. For
example, apattern string of "B=XY Z@" specifies matching
every pathname that as a B-part that beginswith "XYZ". A
pattern string of "B=* XY Z" specifies matching every
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Example 18: Writingtime seriesdatato DSS

from hec.script import *
from hec.heclib.dss import *
from hec.heclib.util import *
from hec.io import *

import java

try :
try :

myDss = HecDss.open(“C:/temp/test.dss”)

tsc = TimeSeriesContainer()

tsc.fullName = “/BASIN/LOC/FLOW//IHOUR/OBS/"

start = HecTime(“04Sep1996”, “1330")

tsc.interval = 60

flows =[0.0,2.0,1.0,4.0,3.0,6.0,5.0,8.0,7.0,9.0]

times =]

for value in flows :
times.append(start.value())
start.add(tsc.interval)

tsc.times = times

tsc.values = flows

tsc.numberValues = len(flows)

tsc.units = “CFS”

tsc.type = “PER-AVER”

myDss.put(tsc)

except Exception, e :
MessageBox.showError(* ‘.join(e.args), “Python Error”)
except java.lang.Exception, e :
MessageBox.showError(e.getMessage(), “Error”)
finally :
myDss.done()

Output:
----- DSS---ZOPEN: New File Opened, File: C:/temp/test.dss
Unit: 71; DSS Version: 6-QD
----- DSS---ZWRITE: /BASIN/LOC/FLOW/01SEP1996/1HOUR/OBS/
----- DSS---ZCLOSE Unit: 71, File: C:/temp/test.dss
Pointer Utilization: 0.25
Number of Records: 1
File Size: 70.2 Kbytes
Percent Inactive: 0.0

pathname that has a B-part that ends with "XYZ". A pattern
string of “B=* XY Z*” specifies matching every pathname
that "XYZ" anywherein the B-part. Note that the @ or *
character must be the first and/or last character of the filter
(e.g. apattern string of "B=ABC*XYZ" isinvalid).

e '# or'!" (used interchangeably). This character must be
specified as the first character of afilter and specifies
matching of every string except the remainder of the filter
(e.g. it negates the remainder of the filter). A pattern string
of "B=IXYZ*" specifies matching every pathname that does
not have a B-part that begins with "XYZ".
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Table 8.9 Time Series Data Storage Methods (Regular and Irregular)

I nteger String Description
0 REPLACE_ALL Overwrite every
valuein the existing
data

1 REPLACE_MISSING_VALUES ONLY | Don’'t overwrite non-
missing valuesin the
existing data

2 REPLACE_ALL_CREATE REPLACE_ALL +if
new data has entire
records of missing
data, create empty
records in existing
data

3 REPLACE_ALL_DELETE REPLACE_ALL + if
new data has entire
records of missing
data, delete records
from existing data

4 REPLACE_WITH_NON_MISSING Overwrite every
valuein the existing
dataonly if
replacement is non-
missing

0 MERGE Result for time
window will be
combination of
existing and specified
Irregular data

1 DELETE_INSERT Result for time
window will be
specified data only

Regular

m No character. The absence of any character specifies an empty
filter, which matches a blank pathname part. Both of the following
pattern strings match every pathname that has a blank A-part:

o /[X[*[*[x[*]"
e "A="

Using getCatal ogedPathnames(...) with a pattern string utilizes the
pathname matching in the underlying DSS library. To accomplish more
sophisticated pathname filtering, use one of the

getCatal ogedPathnames(...) methods in conjunction with python text
parsing and matching utilities.

Time Windows

Dates and times used to specify time windows should not contain blank
characters and should include the 4 digit year. An example date and time
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iIs"04MAR2003 1400". If asingle string is used to specify the time
window, the starting date and time must precede the ending date and time,
for example dssFile.setTimeWindow ("04M AR2003 1400 06APR2004
0900"). A relative time may be used in the single string command, where
the letter "T" represents the current time, and the days or hours can be
subtracted or added to that. For example dssFile.setTimeWindow(" T-14D
T-2H") would specify the starting time as current time minus fourteen
days and the ending time as the current time minus two hours.

Time Windows (specified by starting time and ending time) effect how the
DSSFileread(...) method operates for the various data types.

m Time-seriesdata. Thetimewindow supplied to DSS.open(...) or
dssFile.setTimeWindow(...) specifies the default time window for
all subsequent dssFile.read(...) operations. If no timewindow is
supplied to DSS.open(...) then the default time window is
undefined until dssFile.setTimeWindow(...) is called. If the default
time window is undefined, then all dssFile.read(...) operations
involving time-series data must specify atime window either
implicitly viathe D-part of the specified pathname or explicitly via
the startTime and endTime parameters. The order of precedence
for time windows is asfollows:

e Explicit timewindow. Specified in dssFile.read(pathname,
startTime, endTime) or dssFile.read(pathname,
timeWindow). The D-part of the pathnameisignored and
may be empty.

e Default timewindow. Specified in DSS.open(filename,
startTime, endTime) or DSS.open(filename, timeWindow) or
dssFile.setTimeWindow(startTime, endTime) or
dssFile.setTimeWindow(timeWindow). The D-part of the
pathname is ignored and may be empty. The default time
window can be set to undefined by calling
dssFile.setTimeWindow("” , “").

e Implicit timewindow. Specified asthe D-part of the
pathname supplied to dssFile.read(pathname) when the
default time window is undefined. The D-part of the
pathname must not be empty.

m Paired data. Time windows have no effect on reading paired data
records.

m Stream rating data. Stream rating data are comprised of atime-
series of individual rating records for acommon location. The
reading of stream rating data is not affected by default time
windows. Theimplicit time window for reading stream rating data
isthe entire time span covered by the rating records. An explicit
time window may be supplied by using the dssFile.read(pathname,
startTime, endTime) method. If an explicit timewindow is
specified, a (possible) subset of the rating recordsis retrieved that
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cover the specified time window. The explicit timewindow is
interpreted as the time window containing all time-series data that
isto be rated viathe stream rating data. The set of rating records
retrieved for an explicit time window meets the following criteria

e The earliest record retrieved isthe latest rating that is on or
before the start of the time window. If no such record exists,
the earliest record in the rating time-seriesis retrieved.

e Thelatest record retrieved isthe earliest rating that is on or
after the end of the time window. If no such record exists,
the latest record in the rating time-seriesis retrieved.

e All rating records between the earliest and latest retrieved
records are also retrieved.

m Text data. Timewindows have no effect on reading text records.

8.8 DataContainer Class

The HecDss get() method returns a DataContainer object and the put()
method takes a DataContainer object as aparameter. DataContainers
are abase for different types of data. The TimeSeriesContainer and
PairedDataContainer classes discussed below are both types of
DataContainer classes. DataContainer objects have no methods that
can be called by the user, but al datafields of DataContainer objects are
directly accessible. DataContainer datafields are described in Table 8.10.

Y ou can also exchange DataContainer swith HecM ath objects. Both
TimeSeriesContainer and PairedDataContainer classes are extracted
from HecM ath objects using the getData() method as documented in
Section 8.15.35. HecM ath objects can be updated from DataContainer
objects using the setData() method as documented in Section 8.15.109.

Table 8.10 DataContainer Data Fields
Field Type Description

fullName string | The full name associated with the data in the data store (DSS
pathname, if the DataContainer is associated with a DSSfile)

location string | The location associated with the data (DSS pathname B-part if
the DataContainer is associated with aDSSfile).

subVersion | string | The sub-version associated with the data.

version string | The version associated with the data (DSS pathname F-part if the
DataContainer is associated with a DSSfile).

watershed | string | The watershed associated with the data (DSS pathname A-part if
the DataContainer is associated with aDSSfile).
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Example 19: Extracting a DataContainer from HecMath

from hec.script import *

from hec.hecmath import *

theFile = DSS.open(“myFile.dss”)

flowDataSet = theFile.read(“/BASIN/LOC/FLOW/01NOV2002/1HOUR/OBS/")
theFile.done()

flowData = flowDataSet.getData()

thisWatershed = flowData.watershed

8.8.1 TimeSeriesContainer Class

TimeSeriesContainer is atype of DataContainer that contains information
about time series data. TimeSeriesContainer objects are returned by the
get () method and are required in the put() method of HecDss objects.
TimeSeriesContainer objects have al the datafields described Section 8.8
(DataContainerClass) in addition to those described in Table 8.11. New
TimeSeriesContainer objects can be created by a script if the
TimeSeriesContainer class has been imported from the hec.io module (e.g.
"from hec.io import *" or "from hec.io import TimeSeriesContainer").
The new object can be created by calling TimeSeriesContainer () (e.0.
"myTSC = TimeSeriesContainer ()").

Table8.11 TimeSeriesContainer Data Fields
Field Type Description

endTime Integer’ The end time of the time window. If the data
were retrieved, the end time may be later
than the last time in the times list.

interval Integer Theinterval, in minutes, between each set of
consecutive timesin the timeslist. For
irregular-interval times, the interval field is

set to 1.
numberValues Integer The length of values and times lists.
parameter string The parameter associated with the data.
quality list of integers® | The optional list of quality flags. If thislist

is present, there must be a quality for each
valueinthevaluesarray. If thislistisnot
present, the quality field is set to None.

startTime integer? The start time of the time window. [f the
data were retrieved, the start time may be
earlier than the first timein thetimeslist.

subL ocation string The sub-location associated with the data.
subParameter string The sub-parameter associated with the data.
times list of integers' | Thelist of times. There must be atime for

each value in the values list, and times must
increase from one index to the next.

timeZonelD string Thetime-zone for timesinthe timeslist. If
unknown, the timeZonel D field is set to
None
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Field Type Description

timeZoneRawOffset integer The offset, in milliseconds, from UTC to the
time zone for thetimesin the times list.

type string Thetype of the data (e.g. "INST-VAL",
"INST-CUM", "“PER-AVER", "PER-
CUM™).

units string The units of the data.

values list of floating- | The data values, each of which hasa

point corresponding time in the times list and

optionally a corresponding quality in the
quality list. All lists must be the same
length.

! Integer times from this field can be converted to string representations by using the set() and dateAndTime()
methods of HecTime objects and can be generated by the HecTime value() method.
2 Quality values are interpreted according to Table 8.12.

Table 8.12 Data Quality Bits

Bit(s)

Description

1

Set when the datum has been tested (screened).

2

Set when the datum passed all tests.

Set when the datum is missing (either originally missing or set to missing by
atest).

Set when at least one test classified the datum as questionabl e.

Set when at least one test classified the datum as rejected.

Set by the RANGE test. Interpreted as a 2-bit unsigned integer with values
having the following meanings:

0 value of datum < than 1% limit or no range test applied

1 1% limit <= value of datum < 2™ limit

2 2" [imit <= value of datum < 3 limit

3 3 limit <= value of datum

Set when the datum has been changed from the original value.

9-11

Datum replacement indicator. Interpreted as a 3-bit unsigned integer with
values having the following meanings:

datum was not replaced (original value)

datum was replaced by an automated tool

datum was replaced by an interactive tool (e.g., fill operaton)
datum was replaced by manual edit in an interactive tool
original value was accepted or restored in an interactive tool
57 reserved for future use

A WNEFLO

12-15

Datum replacement value computation method. Interpreted as a 4-bit
unsigned integer with values having the following meanings:

0 datum was not replaced (origina value)

1 datum value computed by linear interpolation

2 datum value was entered manually

3 datum value was replaced with amissing value

4 datuma val ue was entered graphically

5-15 reserved for future use

16

set when datum failed an absolute magnitude test

17

set when datum failed a constant value test
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Bit(s) Description

18 set when datum failed arate of change test

19 set when datum failed arelative magnitude test

20 set when datum failed a duration magnitude test

21 set when datum failed a negative incremental value test

22 reserved for future use

23 set when datum is excluded from testing (e.g. DATCHK GAGEFILE entry)

24 reserved for future use

25 set when datum failed a user-defined test

26 set when datum failed a distribution test

27-31 | reserved for future use

32 set when datum is protected from being replaced

Example 20: Using a TimeSeriesContainer Object

from hec.script import *

from hec.heclib.dss import *

from hec.io import TimeSeriesContainer
from hec.heclib.util import HecTime

watershed = “"GREEN RIVER”

loc = “OAKVILLE"

param = “STAGE”

ver = “OBS”

startTime = “120c¢t2003 0100”

values = [12.36, 12.37, 12.42, 12.55, 12.51, 12.47, 12.43, 12.39]

hecTime = HecTime()

tsc = TimeSeriesContainer()

tsc.watershed = watershed

tsc.location = loc

tsc.parameter = param

tsc.version = ver

tsc.fullName = “/%s/%s/%s//IHOUR/%s/” % \
(watershed, loc, param, ver)

tsc.interval = 60

hecTime.set(startTime)

times =[]

for value in values :
times.append(hecTime.value())
hecTime.add(tsc.interval)

tsc.values = values

tsc.times = times

tsc.startTime = times[0]

tsc.endTime = times[-1]

tsc.numberValues = len(values)

tsc.units = “FEET”

tsc.type = “INST-VAL”

dssFile = HecDss.open(*myFile.dss”)

dssFile.put(tsc)

dssFile.done()
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8.8.2

PairedDataContainer Class

PairedDataContainer is atype of DataContainer that contains
information about paired data. PairedDataContainer objects are returned
by the get () method. PairedDataContainer objects are described in
Section 8.8 in addition to those described in Table 8.13. New
PairedDataContainer objects can be created by a script if the
PairedDataContainer class has been imported from the hec.io module
(e.g. "from hec.io import *" or "from hec.io import
PairedDataContainer"). The new object can be created by calling
PairedDataContainer () (e.g. "myPDC = PairedDataContainer ()").

Table 8.13 PairedContainer Data Fields

Field Type Description

date string The date associated with the paired-data.

datum floating-point | The zero-stage elevation of a stream gauge.

labels list of strings | Thelist of labels used to identify each of the y-
ordinateslists. If thereisonly 1 y-ordinates list
(e.g. numberCurves == 1), the labelsfield is set
to None.

labelsUsed Boolean A flag specifying whether labels are used. This
field isset to Trueif thereis morethan 1 y-
ordinates list and False otherwise.

numberCurves integer The number of y-ordinates lists.

numberQrdinates integer The length of the x-ordinates list and each of the
y-ordinates lists.

offset floating-point | The offset value of a stream rating.

shift floating-point | The shift value for a stream rating.

transformType integer Type of transformation to use (1 ="LINLIN", 2
="LOGLOG")

xOrdinates list of floating- | The x-ordinate values. Each y-ordinate values

point list must be of the same length as thisfield.

Xparameter string The parameter of the x-ordinates.

xtype string The type of the x-ordinates ("UNT" for unitary
or "LOG" for logarithmic).

Xunits string The units of the x-ordinates.

yOrdinates list of lists of They-ordinate values. Each list of y-ordinate

floating-point values must be of the same length asthe list of

x-ordinate values. The nth value of each y-
ordinates list is associated with the nth value of
the x-ordinates list.

yparameter string The parameter of the y-ordinates.

ytype string The type of the y-ordinates ("UNT" for unitary
or "LOG" for logarithmic).

yunits string The units of the y-ordinates.
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Example 21: Using a PairedDataContainer Object

from hec.script import *
from hec.heclib.dss import *
from hec.io import PairedDataContainer

watershed = “"GREEN RIVER”

loc = “OAKVILLE"

xParam = “STAGE”

yParam = “FLOW”

date = “120ct2003”

stages =[0.4, 0.5, 1.0, 2.0, 5.0, 10.0, 12.0]

flows =[0.1, 3, 11, 57, 235, 1150, 3700]

pdc = PairedDataContainer()

pdc.watershed = watershed

pdc.location = loc

pdc.parameter = param

pdc.version = ver

pdc.fullname = “/%s/%s/%s-%s///%s/” % \
(watershed, loc, xParam, yParam, date)

pdc.xOrdinates = stages

pdc.yOrinates = [flows]

pdc.numberCurves = 1

pdc.numberOrdinates = len(stages)

pdc.labelsUsed = False

pdc.xunits = “FEET”

pdc.yunits = “CFS”

pdc.xtype = “LOG”

pdc.ytype = “LOG”

pdc.xparameter = xParam

pdc.yparameter = yParam

pdc.date = date

pdc.transformType = 2dssFile = HecDss.open(*myFile.dss”)

dssFile.put(pdc)
dssFile.done()

8.9 HecTime Class

Table 8.14 HecTime Methods

HecTime objects are used to manipul ate dates and times and to convert
dates and times among different formats. To use HecTime objects, the
HecTime class must be imported from the hec.heclib.util module (e.g.
"from hec.heclib.util import *" or "from hec.heclib.util import HecTime").
After importing the class, a new HecTime object can be created by calling
HecTime() (e.g. "myTime = HecTime()"). HecTime methods are
described in Table 8.14.

M ethod Returns Description
add(HecTime increment) None Adds the specified increment to the
object’s date and time.
add(integer increment) None Adds the specified increment in
minutes to the object’ s date and
time.
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M ethod Returns Description
addDays(integer days) None Adds the specified number of days
to the time
addHours (integer hours) None Adds the specified number of hours
to the time
addMinutes (integer minutes) None Adds the specified number of
minutes to the time
addSeconds (integer seconds) None Adds the specified number of
secondsto the time
adjustT ol nterval Offset(integer None Changes the time to be at the
intervalMinutes, integer offset) standard time for that interval,
according to HEC-DSS. For
example, will adjust daily data to
2400 hours of that day.
compareTimes(HecTime other) integer Returns one of the following
values:
-1 Theobject'sdateandtimeis
less than the other object's
0 Theobjects dates and times
are equal
1 Theobject'sdate and timeis
greater than the other
object's
computeNumberintervals(HecTime | integer Determines the number of periods
otherTime, integer intervallnMins) between the time set and the time
passed in, where intervalInMinsis
the interval length.
convertTimeZone(HecTime None Changes the time passed in from the
hecTime, TimeZone first time zone to the second time
fromTimeZone, TimeZone zone. Adjustsfor daylight savings
toTimeZone) time, according to the time given.
date() string Returns a string representation of
the object’s date. Same as date(2).
date(integer format) string Returns a string representation of
the object’s date, formatted
according to the integer parameter.
dateAndTime() string Returns a string representation of
the object’s date and time. Same as
dateAndTime(2).
dateAndTime(integer format) string Returns a string representation of
the object’s date and time,
formatted according to the integer
parameter. *
day() integer Returns the day portion of the
object’s date as an integer
dayOfWeek() integer Returns the day of the week with
Sunday starting as 1, Monday 2
dayOfWeekName() string Returns the name of the day of the

week, such as " Sunday"
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M ethod Returns Description

dayOfYear() integer Returns the Julian day of the year,
with Jan.1 returned as"1".

equal To(HecTime other) Boolean | Returns Trueif the object's date and
timeisequal to the other object's
date and time. Returns False
otherwise.

greaterThan(HecTime other) Boolean | Returns True if the object's date and
timeisgreater (later) than the other
object's date and time. Returns
False otherwise.

greaterThanEqual To(HecTime Boolean | Returns True if the object's date and

other) timeisgreater (later) than or equal
to the other object's date and time.
Returns False otherwise.

getJavaDate(integer Date Returns the Java Date for thistime

minutesTimezoneOffset)

getMinutes() long Returns the number of milliseconds
since Jan 1, 1900

getTimelnMillis() long Returns the number of milliseconds
since January 1, 1970, 00:00:00
GMT

getTimeWindow (String userLine, integer | Takesauser entered line with start

HecTime startTime, HecTime Success=0 | date/time and end date/time and

endTime) Faill =-1 | convertsto HecTime.

getXMLDateTime (integer string Returnsthe datein XML format

minutesTimezoneOffset)

hour() integer Returns the hours portion of the
object’ stime as an integer

isDefined() Boolean | Returns Trueif the objectissettoa
valid date and time and False if not.

isDateDefined() Boolean | Returns Trueif the date portionis
valid (ignorestime) and False if
not.

isTimeDefined() Boolean | Returns Trueif thetime portionis
valid (ignores date) and False if not.

increment(integer numberPeriods, None Adds the number of periodsto the

integer minutesl nPeriod) date

isoDate() integer Returnsthe date in SO format
(YYMMDD)

isoTime() integer Returnsthe timein SO format
(HHMMSS)

lessThan(HecTime other) Boolean | Returns Trueif the object's date and
timeisless (earlier) than the other
object's date and time. Returns
False otherwise.

lessThanEqual To(HecTime other) Boolean | Returns Trueif the object's date and

timeisless (earlier) than or equal to
the other object's date and time.
Returns False otherwise.
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M ethod Returns Description

julian() integer | Returns the number of days since
Jan 1, 1900

minute() integer | Returns the minutes portion of
the object’stime as an integer

month() integer | Returns the month portion of the
object’s date as an integer

notEqual To(HecTime other) Boolean | ReturnsFalseif the object's date

and timeis equal to the other
object's date and time. Returns
True otherwise.

second() integer | Returns the seconds portion of
the object’ stime as an integer

setCurrent() None Sets the date/time to the current
time.

set (integer time) None Sets the object to the date and

time represented by the integer
(minutes since 31Dec1899
00:00)

set(string dateAndTime) integer | Setsthe object to the date and
time represented by the string,
and returns zero if successful.

set (string date, string time) integer | Setsthe object to the date
represented by the date string
and the time represented by the
time string, and returns zero if

successful.

set (HecTimetime) None Sets the object to the date and
time represented by the HecTime
parameter.

setDate(string date) integer | Setsthe object to the date

represented by the string, and
returns zero if successful. The
time portion of the object is not
modified.

setTime(string time) integer | Setsthe object to the time
represented by the string, and
returns zero if successful. The
date portion of the object is not

modified.
setJulian(integer julian) None Sets the date to the Julian days
(Since Jan 1, 1900)
setXML (String dateTime) integer | Setsthe date and time according
Success=0 | tothe XML string
setUndefined() None Sets the object to represent an

undefined time, asif the object
had just been created.

showTimeAsBeginningOfDay(Boolean None Specifies whether the object isto
showBeginning) show midnight times as 00:00
(vs 24:00)
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8.10

M ethod Returns Description

subtract(HecTime increment) None Subtracts the specified increment
from the object’ s date and time.

subtract(integer increment) None Subtracts the specified increment
in minutes from the object’s date
and time.

time() string Returns a string representation of
the object’stime.

toString() string Returnsthe date and time in
string format, for format style 2

toString(integer format) string Returnsthe date and time in
string format, for format style
given

value() integer | Returns the object's date and
time asin the number of minutes
since 31Dec1899 0000.

year() integer | Returnsthe year portion of the

object’s date as an integer

! The format of the string returned by the date(integer format) method and the date portion of the string returned
by the dateAndTime(integer format) method are displayed in Table 8.15.

Table 8.15 HecTime Date Formats

June 2,1985] 10
Jun2,1985] 11
2June1985]| 12

June 1985] 13
02Jun1985]| 14
2Jun1985| 15
Jun1985| 16

02 Jun 1985] 17
2Jun1985] 18

0
1
2
3
4
5
6
7
8
9 Jun 1985] 19

June 2, 85
Jun 2, 85
2 June 85

June 85
02Jun85
2Jun85
Jun85
02 Jun 85
2Jun 85
Jun 85

100 JUNE2,1985| 110 JUNE 2, 85
101 JUN 2,1985| 111 JUN 2, 85
102 2JUNE 1985| 112 2 JUNE 85
103 JUNE 1985| 113 JUNE 85
104 02JUN1985| 114 02JUNS85
105 2JUN1985| 115 2JUN8S
106 JUN1985| 116 JUNS5
107 02 JUN 1985| 117 02 JUN 85
108 2JUN 1985| 118 2 JUN 85
109 JUN 1985]| 119 JUN 85

Plotting Basics

Thetitle, viewport, axis label, axistics, and legend of aplot, each of
which are accessible via scripts, are identified in Figure 8.12.

Example 22: Creating a Plot

myPlot = Plot.newPlot()
or

thePlot = Plot.newPlot(“Elevation vs Flow”)
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Figure 8.12 Plot Components

8.10.1 Plot Class

Pl ot . newPl ot ()
Pl ot . newPl ot (string title)

The Plot classin the hec.script moduleis used to create a new Plot dialog.
It contains two methods to create a Plot dialog, each of which returns a
G2dDiaog object.

8.10.2 Changing Plot Component Attributes

Not al Plot Component attributes are visible by default, and setting the
attribute may not make that attribute visible. Often it is necessary to set
the visibility of the attribute by calling setAttributeVisible(True). Reading
aflow data set from a DSSfile, plotting the data set, setting the minor Y
grid color to black and making it display areillustrated in Example 23.

8.10.3 G2dDialog Class

G2dDialog objects are the dialog that plots display in. G2dDialog
methods are described in Table 8.16.
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Example 23: Plotting DSS Data

from hec.script import *

from hec.script.Constants import TRUE, FALSE

theFile = HecDss.open(“myFile.dss”)

thePath = “/BASIN/LOC/FLOW/01NOV2002/1HOUR/OBS/”

flowDataSet = theFile.get(thePath)
thePlot = Plot.newPlot()
thePlot.addData(flowDataSet)
thePlot.showPlot()
viewportO=thePlot.getViewport(0)
viewport0.setMinorGridYColor(“black”)

viewport0.setMinorGridYVisible(TRUE)

# open myFile.dss

# read a path name

# create the plot

# add the flow data set to the plot

# show the plot

# get the first viewport
# set the viewport’s minor Y grid to black
# tell the minor Y grid to display

Table 8.16 G2dDiaog Methods

M ethod

Returns

Description

addData(DataContainer dc)

None

Add the DataContainer
specified by dc to the
plot. Must be called
before showPlot(). Do
not use thisif a
PlotLayout object is
used on this plot.

applyTemplate(string templ ateFile)

None

Apply the given
template to this plot

configurePlotL ayout()

None

Display the "Configure
Plot Layout" dialog for
this plot

configurePlotL ayout(PlotLayout
layout)

None

Configuresthe plot
layout for this plot
according to the
specified PlotLayout
object. If thismethod is
used, do not use the
addData() method with
the same plot.

close()

None

Closes the plot

configurePlotTypes()

None

Display the configure
plot types dialog

copyToClipboard()

None

Copy the plot to the
system clipboard

defaultPlotProperties()

None

Display the default plot
properties dialog

exportProperties()

None

Allows you to save the
properties of the plot to
adisk.

exportProperties(string
templateName)

None

Allows you to save the
properties of the plot to
the file specified by
templateName.

getCurve(HecMath filenam)

G2dLine

Return the G2dLine for
the DataSet specified by
dataSet
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M ethod Returns Description

getCurve(string dssPath) G2dLine Return the G2dLine for
the path specified in
dssPath

getHeight() integer Return the height of the
dialog in screen
coordinates.

getL egendL abel (DataContainer dc) G2dL abel Return the legend | abel
object for the specified
data container.

getL ocation() Point Return the location of
the dialog in screen
coordinates.

getPlotTitle() G2dTitle Return the title for the
G2dDialog

getPlotTitleText() string Return the text of the
title for the G2dDialog

getSize() Dimension Return the dimensions
of the dialog in screen
coordinates.

getViewport(HecMath filenam) Viewport Return the Viewport that
contains the curve
specified by dataSet
getViewport(integer viewportl ndex) Viewport Return the viewport at
index specified by
viewportlndex
getViewport(string dataSetPath) Viewport Return the Viewport that
contains the curve
specified by dataSetPath

getWidth() Integer Return the width of the
dialog in screen
coordinates.

hide() None Hide the dialog
iconify() None Minimize (iconify) the
dialog
isPlotTitleVisible() Boolean Return the visibility

state of thetitle of this
plot.

maximize() None Maximize the dialog
minimize() None Minimize (iconify) the
dialog
newPlotLayout() PlotLayout Return a PlotLayout
object that can be used

to configure the layout
of thisplot.

plotProperties() None Display the plot
properties dialog for this
plot

print() None Display the print dialog
for this plot
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M ethod

Returns

Description

printMultiple()

None

Display the print
multiple dialog for this
plot

printPreview()

None

Display the print
preview dialog for this
plot

printToDefault()

None

Prints using the printer
defaults such as page
format and printer. This
method does not display
the printer dialog for
user interaction.

repaint()

None

Forces the plot to be
refreshed.

restore()

None

Restore the dialog from
aminimized or
maximized state

saveAs()

None

Display the saveAs
dialog for this plot

saveToJpeg(string filename)

None

Save the plot to the Jpeg
file specified by
fileName

saveToJpeg(string filename, integer
quality)

None

Save the plot to the Jpeg
file specified by
filename, with the
specified quality®

saveToMetafile(string filename)

None

Save the plot to the
Windows Metafile
specified by filename

saveToPng(string filename)

None

Save the plot to the
Portable Network
Graphicsfile specified
by filename

saveT oPostscript(string filename)

None

Save the plot to the
PostScript file specified
by filename

setl egendBackgound(string color)

None

Sets the background
color of the legend.

setlegendL abel Text(DataContainer
dc, string text)

None

Setsthe legend label text

setlegendL ocation(string location)

None

Sets the location of the
legend®.

setLocation(integer x,integer y)

None

Sets the location of the
dialog in screen
coordinates.

setPlotTitleText(string text)

None

Sets the text of thetitle
for this plot

setPlotTitleVisible(Boolean state)

None

Sets the visibility of the
title for this plot
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M ethod Returns Description

setSize(integer width, integer height) None Setsthe size of the
dialog in screen
coordinates.

setVisible(Boolean visible) None Makes the plot visible

showPlot() None Show the dialog

stayOpen() None Keeps the plot on the
screen for batch mode
only

tabulate() HecDataT ableFrame | Display the table view of

this plot

! The coordinate system used is a graphics coordinate system, where X increases to theright and Y increases
downward from the origin (0,0) which islocated in the top left corner of the display. Locations set or retrieved
refer to the top left corner of the plot in reference to this coordinate system.

2 The specified quality is limited to an effective range of 0— 100, inclusive. Higher qualities produce larger
files and take longer to generate. The saveToJpeg(fileName) call currently produces the same results as

saveToJpeg(fileName, 75).

% valid legend locations are "Right" and "Bottom"

Example 24: Plot Dialog

from hec.script import *
from hec.heclib.dss import *
theFile = HecDss.open(“myFile.dss”)

flowDataSet = theFile.get(thePath)
thePlot = Plot.newPlot()
thePlot.addData(flowDataSet)
thePlot.showPlot()
thePlot.setLocation(50,50)

# for Plot class
# for DSS class
# open myFile.dss
thePath = “/BASIN/LOC/FLOW/01NOV2002/1HOUR/OBS/"
# read a path name
# create a new Plot
# add flow data container
# show the plot
# moves plot to 50,50

PlotL ayout objects hold information about the layout of the plot dialog.
The use of ViewportL ayout objects, in conjunction with PlotL ayout
objects, allows scripts to specify the same layout information accessible
interactive viathe "Configure Plot Layout” dialog. A PlotL ayout object
is obtained by calling Plot.newPlotLayout(). PlotL ayout methods are

8.10.4  PlotLayout Class
described in Table 8.17.
8.10.5  ViewportLayout Class

ViewportL ayout objects hold information about the layout of an
individual viewport within the plot dialog. The use of ViewportL ayout
objects, in conjunction with PlotL ayout objects, allows scripts to specify
the same layout information accessible interactive viathe "Configure Plot
Layout” dialog. A ViewportL ayout object is obtained by calling one of
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Table 8.17 PlotLayout Methods

M ethod

Returns

Description

addViewport()

ViewportLayout

Adds a ViewportLayout to the
PlotLayout with a default weight
of 100. Returnsareference to the
new ViewportLayout.

addViewport(floating-point

weight)

ViewportLayout

Adds a ViewportLayout to the
PlotLayout with the specified
weight. Returnsareferenceto
the new ViewportLayout.

hasL egend()

Boolean

Returns whether this PlotLayout
is configured to display the
legend.

hasT oolbar()

Boolean

Returns whether this PlotLayout
is configured to display the
toolbar.

getViewportCount()

integer

Returns the number of
ViewportLayout objects currently
in the PlotLayout object.

getViewports()

java.util.List of
ViewportLayouts

Returns the ViewportLayout
objects currently in the
PlotLayout object.

getViewportWeights() list of floating-points | Returns the weights of the
ViewportLayout objects currently
in the PlotLayout object.

setHaslegend(Boolean None Configures the PlotLayout object

state) to display the legend or not,
depending upon the specified
state.

setHasT ool bar(Boolean None Configures the PlotLayout object

state)

to display the toolbar or not,
depending upon the specified
state.

the addViewport methods of a PlotL ayout object. ViewportL ayout
objects are only used to configure the plot layout. Manipulation of axis
labels, background colors, etc. is performed using Viewport objects as
described in table below. ViewportL ayout methods are described in

Table 8.18.
Table 8.18 ViewportLayout Methods
M ethod Returns Description
addCurve(string axis, DataContainer None Adds the specified curve to the
curve) specified axis of the
ViewportLayout object.

getMajorGridX StyleString() string
getMajorGridy StyleString() string
getMinorGridX StyleString() string
getMinorGridY StyleString() string
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M ethod Returns Description

getY 1Data() List Returns ajava.util.List of all
curvesthat have been added to
the Y1 axis of this object

getY 2Data() List Returns ajava.util.List of all
curvesthat have been added to
the Y 2 axis of this object

hasY 1Data() Boolean | Returns whether any curves
have been added to the Y1 axis
of this object

hasY 2Data() Boolean | Returns whether any curves
have been added to the Y2 axis
of this object

setMagjorGridX StyleString( string None

majorGridX Style)

setMajorGridY StyleString( string None

majorGridY Style)

setMinorGridX StyleString( string None

minorGridX Style)

setMinorGridY StyleString( string None

minorGridY Style)

setlinear(string axisName) None

setl ogarithmic(string axisName) None

scaleAxisFromOpposite( string axis) None

The script in Example 25 reads precipitation, stage and flow data set from
aDSSfile, and configures aplot to display the precipitation ontopin a
viewport that occupies thirty percent of the available space and to display
the stage and flow on separate axes of a bottom viewport that occupies the
remaining seventy percent of available space.

Example 25: PlotLayout and ViewportL ayout Objects

from hec.script import * # for Plot class
from hec.heclib.dss import * # for DSS class
theFile = HecDss.open(“myFile.dss”) # open myFile.dss

precipPath = “/BASIN/LOC/FLOW/01NOV2002/1HOUR/OBS/"
stagePath = “/BASIN/LOC/FLOW/01NOV2002/1HOUR/OBS/"
flowPath = “/BASIN/LOC/FLOW/01NOV2002/1HOUR/OBS/"

precipData = theFile.get(precipPath) # read the precip
stageData = theFile.get(stagePath) # read the stage
flowData = theFile.get(flowPath) # read the flow

thePlot = Plot.newPlot() # create a new Plot
layout = Plot.newPlotLayout() # create a new PlotLayout
topView = layout.addViewport(30) # get the top viewport
bottomView = layout.addViewport(70) # get the bottom viewport
topView.addCurve(*Y1”, precipData) # add the precip to top
bottomView.addCurve(*Y1", stageData) # add the stage to bottom
bottomView.addCurve(*Y2", flowData) # add the flow to bottom
thePlot.configurePlotLayout(layout) # configure the plot
thePlot.showPlot() # show the plot
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8.10.6  Viewport Class

Viewport objects hold the data set curves. Viewport methods are
described in Table 8.19.

Table 8.19 Viewport Methods

M ethod Returns Description
addAxisMarker(AxisMarker marker) None Adds a marker line described
by the AxisMarker parameter
addXAxisMarker() None Display the Axis Marker

Properties Dialog for a marker
line to add to the X axis

addX AxisMarker(floating-point val ue) None Add an X Axis marker at the
location specified by value

addX AxisMarker(string value) None Add a X Axis marker at the
location specified by value

addY AxisMarker() None Display the Axis Marker

Properties Dialog for a marker
lineto add tothe Y axis

addY AxisMarker(string value) None Add aY Axismarker at the
location specified by value
editProperties() None Display the Edit Properties
dialog for this Viewport
getAxis(string axisName) AXxis Return the Axis specified by
axisName for this Viewport
getAxisLabel (string axisName) AxisLabel | Returnthe AxisL abel for the

axis specified by axisName
for this Viewport
getAxisTics(string axisName) AxisTics | Returnthe AxisTicsfor the
axis specified by axisName
for this Viewport

getBackground() Color Return the background color
for the Viewport as a Color.

getBackgroundString() string Return the background color
name for the Viewport asa
string.

getBorderColor() Color Return the border color for the
Viewport asa Color.

getBorderColorString() string Return the background color
name for the Viewport asa
string

getBorderWeight() float Return the border weight for
this Viewport

getFillPatternString() string Return the fill pattern for this
Viewport asa String

getMajorGridX Color() Color Return the color of the vertical

lines of the major grid for this
Viewport asa Color
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M ethod Returns Description

getMajorGridX ColorString () string Return the color of the vertical
lines of the major grid for this
Viewport asastring

getMajorGridXWidth () floating | Return the width of the
point vertical lines of the major grid
for this Viewport
getMajorGridY Color () Color Return the color of the

horizontal lines of the major
grid of this Viewport asa
Color

getMajorGridY ColorString () string Return the color of the
horizontal lines of the major
grid for this Viewport asa
string

getMajorGridY Width () floating | Return the width of the

point vertical lines of the major grid
for this Viewport

getMinorGridX Color() Color Return the color of the vertical
lines of the minor grid for this
Viewport as a color

getMinorGridX ColorString() string Return the color of the vertical
lines of the minor grid for this
Viewport asastring

getMinorGridXWidth() floating | Return the width of the
point vertical lines of the minor grid
for this Viewport

getMinorGridY Color() Color Return the color of the
horizontal lines of the minor
grid for this Viewport asa
Color.

getMinorGridY ColorString() string Return the color of the
horizontal lines of the minor
grid for this Viewport asa

string
getMinorGridY Width() floating | Return the width of the
point vertical lines of the minor grid
for this Viewport
isBackgroundVisible() Boolean | Return whether the
background is drawn for this
Viewport
isBorderVisible() Boolean | Return whether the border is
drawn for this Viewport
isMajorGridX Visible() Boolean | Return whether the vertical

lines of the major grid are
drawn for this Viewport

isMajorGridY Visible () Boolean | Return whether the horizontal
lines of the major grid are
drawn for this Viewport
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M ethod Returns Description
isMinorGridXVisible() Boolean | Return whether the vertical
lines of the minor grid are
drawn for this Viewport
isMinorGridY Visible () Boolean | Return whether the horizontal
lines of the minor grid are
drawn for this Viewport
setBackground(string colorString) None Set the background to the
color specified by colorString
setBorderColor(string borderColor) None Set the border color for this
Viewport
setBorderWeight(floating- None Set the border weight for this
point borderWeight) Viewport
setBackgroundVisible(Boolean state) None Set whether to draw the
background for this Viewport
setBorderVisible(Boolean state) None Set whether to draw the
border for this Viewport
setFillPattern(string pattern) None Set the fill pattern for this
Viewport
setGridColor(string colorString) None Set the color of the horizontal
and vertical lines of the major
and minor grids for this
Viewport.
setGridX Color(string colorString) None Set the color of the vertical
lines of the major and minor
grids for this Viewport.
setGridY Color(string colorString) None Set the color of the horizontal
lines of the major and minor
gridsfor this Viewport.
setMagjorGridX Color(string None Set the color of the vertical
majorGridX Color) lines of the mgjor grid for this
Viewport.
setMagjorGridXVisible(Boolean state) None Set whether to draw the
vertical lines of the major grid
for this Viewport
setM g orGridX Width(fl oating-point None Set the width of the vertical
gridLineWidth) lines of the major grid for this
Viewport
setMajorGridY Color(string None Set the color of the horizontal
majorGridY Color) lines of the major grid for this
Viewport.
setMajorGridY Visible(Boolean state) None Set whether to draw the
horizontal lines of the major
grid for this Viewport
setMgjorGridY Width(fl oating-point None Set the width of the horizontal
gridLineWidth) lines of the major grid for this
Viewport
setMinorGridX Color(string None Set the color of the vertical

minorGridX Color)

lines of the minor grid for this
Viewport.
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M ethod Returns Description

setMinorGridX Visible(Boolean state) None Set whether to draw the
vertical lines of the minor grid
for this Viewport

setMinorGridX Width(floating- None Set the width of the vertical

point gridLineWidth) lines of the minor grid for this
Viewport

setMinorGridY Color(string None Set the color of the horizontal

minorGridY Color) lines of the minor grid for this
Viewport.

setMinorGridY Visible(Boolean state) None Set whether to draw the
horizontal lines of the minor
grid for this Viewport

setMinorY GridWidth(floating-point None Set the width of the horizontal

gridLineWidth) lines of the minor grid for this
Viewport

8.10.7

AxisMarker Class

AxisMarker objects hold complete descriptions of marker linesto be
added to viewports. AxisMarker objects have fields that are settable by
the user to create marker lines of various styles. New AxisMarker
objects are created by callsto AxisMarker() (e.g., myMarker =

AxisMarker()).

AxisMarker fields are described in Table 8.20.

Table 8.20 AxisMarker Fields

Field Type Description Default
axis string | "X" or"Y" "y"
fillColor string | Color of thefilled area. "black"
fillPattern string | Pattern of thefilled area. "solid"
fillStyle string | Specifies whether the filled areaisto be "none"
above or below the marker line, or to not
fill at all.
label Alignment string | Specifies whether the label text isto appear "left"
left justified, right justified or centered.
labelColor string | Color of the label text "black"
label Font string | The font to use for the label . None
label Position string | Specifies whether the label text isto appear | “above"
above, below, or in the center of the marker
line
label Text string | Text to appear with marker line
lineColor string | Color of the marker line "black"
lineStyle string | Style of the marker line "solid"
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Field Type Description Default
lineWidth floating | Width of the marker line 1.0
point
value string | Location of marker on axis (e.g. "712.5" or "0
"23Aug2003 1015")

! Fonts are specified as name{,style],size]] where styleis Plain, Bold, Italic, or Bold Italic (e.g.
"Arial,Boldltalic,12", "Lucida Console,Plain,10").

The script in Example 26 reads a data set from a DSSfile, plots that data
set, sets the Viewport's background to light gray and adds a marker line on
theY axis.

Example 26: Viewport Class
from hec.script import * # for Plot class

from hec.script.Constants import TRUE, FALSE

from hec.heclib.dss import * # for DSS class

theFile = HecDss.open(“myFile.dss”) # open myFile.dss

thePath = “/BASIN/LOC/FLOW/01NOV2002/1HOUR/OBS/"

flowDataSet = theFile.read(thePath) # read a path name

thePlot = Plot.newPlot() # create a new Plot

thePlot.addData(flowDataSet) # add the flow data

viewportO=thePlot.getViewport(0) # get the first Viewport

viewport0.setBackground(“lightgray”) # set the Viewport’s bg

viewport0.setBackgroundVisible(TRUE) # tell Viewport to draw bg

marker = AxisMarker() # create a new marker

marker.axis = “Y” # set the axis

marker.value = “20000” # set the value

marker.labelText = “Damaging Flow” # set the text

8.10.8

marker.labelColor = “red”
marker.lineColor = “red”
marker fillColor = “red”
marker fillType = “above”

maker fillPattern = “diagonal cross”
viewport0.addAxisMarker(marker)

# set the text color

# set the line color

# set the fill color

# set the fill type

# set the fill pattern

# add the marker to the
# viewport

Axis Class

Table 8.21 Axis Methods

AXxis methods are described in Table 8.21.

M ethod Returns Description
getLabel() string Return the Axis label
getMajorTic() floating-point | Return the mgjor tic interval

for this Axis
getMinorTic() floating-point | Return the minor tic interval
for this Axis
getNumTicLabelLevels() integer Return the number of tic
label levels for this Axis
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M ethod Returns Description

getScaledLabel() String Return the label with
scientific notation

getScaleMax() floating-point | Return the maximum value
for this Axis

getScaleMin() floating-point | Return the minimum value
for this Axis

getTicColor() Color Return thetic color

getTicColorString() String Returnthe Tic color asa
String

getTicTextColor() Color Return thetic text color

getTicTextColorString() String Return thetic text color asa
String

getViewMax() floating-point | Return the maximum value
for the (possibly) zoomed
view for this Axis

getViewMin() floating-point | Return the minimum value
for the (possibly) zoomed
view for this Axis

isComputingMajorTics() Boolean Return if mgjor ticsare to be
computed

isComputingMinorTics() Boolean Return if minor tics areto be
computed

isReversed() Boolean Returns whether the Axisis
reversed.!

setComputeM gjor Tics(Bool ean state) None Set whether to compute
major tics

setComputeMinorTics(Bool ean state) None Set whether to compute
minor tics

setl abel (string label) None Set the label of this Axis

setLinear() None

setLogarithmic None

setMgjorTiclnterval (floating-point None Set the magjor tic interval for

interval) this Axisto interval

setMinorTiclnterval (floating-point None Set the minor tic interval for

interval) this Axisto interval

setNumTicL abel Levels(integer layers) None Set the maximum number of
tic label layersto specified
number. -1 is unrestricted.
Used mostly for time series
axis.

setReversed(Boolean state) None Set the reversed state of the
Axis!

setScal eLimits(fl oating-point min, None Sets the minimum and

floating-point max) maximum values for the axis
(range of un-zoomed view)

setTicColor(String colorString) None Set thetic color to the color

represented by colorString
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M ethod Returns Description

setTicTextColor(String colorString) None Set thetic text color to the
color represented by
colorString

setViewLimits(floating-point min, None Zooms based on world

floating-poin max) coordinates

unZoom() None Returns the view to the full
axis range.

zoomByFactor(floating-point factor) None Change the zoom scaling by
the given factor

! The coordinate system used is a graphics coordinate system with the origin (0,0) located at the top left corner
of the display, with X increasing to theright and Y increasing downward. The reversed stateis in respect to
this coordinate system (i.e. Y isreversed if it increases upward).

The script in Example 27 reads a data set from a DSSfile, adds that data
set to anew Plot, and zoomsin onthe Y Axis.

Example 27: Using Axis Objects

from hec.script import * # for Plot class
from hec.heclib.dss import * # for DSS class
thePlot = Plot.newPlot() # create a Plot

dssFile = HecDss.open(“C:/mydb.dss”)  # open the DSS file
flow = dssFile.get(*/BASIN/LOC/FLOW/01NOV2002/1HOUR/OBS/")
# read a data set

thePlot.addData(flow) # add the data set
thePlot.showPlot() # show the plot
viewport0 = thePlot.getViewport(0) # get the first Viewport
yaxis = viewport0.getAxis(“Y1") # get the Y1 axis
yaxis.setScaleLimits(0., 25000.) # set the scale
yaxis.zoomByFactor(."5") # zoom in

8.10.9 AXxisTics Class
AXxisTics methods are described in Table 8.22.

The script in Example 28 creates a new Plot with a data set read from DSS
and tells the data set's axis tics to draw its minor tic marks.

Table8.22 AxisTics Methods

M ethod Returns Description

areMgjorTicLabelsVisible() Boolean Return whether the major tic
labelsare visible.

areMgjorTicsVisible() Boolean Return whether the major tics
arevisible

areMinorTicLabelsVisible() Boolean Return whether the minor tic
labelsare visible

areMinorTicsVisible() Boolean Return whether the minor tics
arevisible
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M ethod Returns Description
computeRatingFromOppositeAxis() None When used on theright (Y 2)
AXxisTics object, with related
curvesonthe Y1 and Y2 axes
(e.g. stage and flow, or elevation
and storage), causes the
AxisTicsto behavein anon-
linear fashion such that Y1 and
Y 2 curves are coincident.
editProperties() None Display the Edit Properties
Dialog for the AxisTics
getAxis() Axis Returns areference to the axis
that this object draws
getAxisTicColor() Color Return thetic color
getAxisTicColorString() String Return the tic color as a String
getFontSizes() tupleof 3 | Return the regular, tiny, min and
integers max font sizes for this AxisTics
getMagjorTicLength() Integer Return the major tic length
getMinorTicLength() integer Return the minor tic length
setAxisTicColor(string colorString) None Set thetic color to the color
represented by colorString
setFontSizes(integer sz,integer tiny, None Set the regular, tiny, min and
integer min, intege max) max font sizes for this AxisTics
setMajorTicLabelsVisible(Boolean None Set the visibility of the major tic
state) labels
setMajorTicLength(int ticLength) None Set the major tic length
setMajorTicsVisible(Boolean state) None Set the visibility of the major
tics
setMinorTicLabelsVisible(Boolean None Set the visibility of the minor tic
state) labels.
setMinorTicLength(int ticLength) None Set the minor tic length
setMinorTicsVisible(Boolean state) None Set the visibility of the minor
tics
Example 28: Using AxisTics Objects
from hec.script import * # for Plot class
from hec.script.Constants import TRUE, FALSE
from hec.heclib.dss import * # for DSS class
thePlot = Plot.newPlot() # create a Plot

dssFile = HecDss.open(“C:/mydb.dss”) # open the DSS file
flow = dssFile.get(*/BASIN/LOC/FLOW/01NOV2002/1HOUR/OBS/")
# read a data set

thePlot.addData(flow) # add the data set

thePlot.showPlot() # show the plot

viewport0 = thePlot.getViewport(flow) # get the viewport for the #flow data set
yAXxisTics = viewport0.getAxisTics("Y1") # get the axis tics for the #Viewport
yAXxisTics.setMinorTicsVisible(TRUE) # tell axis tics to show tics
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8.10.10 G2dLine Class

G2dL ine methods are described in Table 8.23.

Table 8.23 G2dLine Methods

M ethod Returns Description

areSymbolsAutol nterval () Boolean | Return whether the symbols for
thisline are placed at program-
decided intervals

areSymbolsVisible() Boolean | Return whether thisline draws its
symbols

editLineProperties() None Method that allows the editing of
line properties. This method
displaysavisible dialog for line
editing.

getFillColor() Color Return the fill color for thisline

getFillColorString() string Return the fill color for thisline as
a String

getFillPatternString() string Return the fill pattern for thisline
asaString

getFill TypeString() string Return the Fill type for thisline as
a string.

getFirstSymbol Offset() integer | Return the offset for the first
symbol for thisline

getLineColor() Color Return the line color for thisline

getLineColorString() string Return the line color for thisline
asaString

getLineStepStyleString() string Return the line step style for this
line as a String

getLineStyleString() string Return the line style for thisline as
astring

getLineWidth() floating- | Return the Line Width of the line

point

getNumPoints() integer | Returns the Number of Points that
thisline has

getSymbol FillColor() Color Return the symbol fill color for
thisline's symbols

getSymbol Fill ColorString() string Return the symbol fill color for
thisline’'s symbols as a String

getSymbolInterval () integer | Return the interval of data points
(>0) on which symbols are drawn.

getSymbol LineColor() Color Return the symbol line color for
thisline's symbols

getSymbol LineColorString() string Return the symbol line color for
thisline’'s symbols as a String

getSymbol Size() floating- | Return the symbol size for thisline

point
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M ethod Returns Description

getSymbol SkipCountl () integer | Return the number of points
skipped between symbols (same as
getSymbollnterval () — 1)

getSymbol TypeString() string Return the symbol type for this
line as a string

isLineVisible() Boolean | Returnthislineisdrawn

setFillColor(string fillColor) None Set the fill color for thisline

setFillPattern(string fill Pattern) None Set the fill pattern for thisline

setFill Type(string fil Type) None Set the Fill type for thisline

setFirstSymbol Offset(integer offset) None

Set the offset for first symbol for
thisline

setLineColor(string lineColor) None Set the line color for thisline
setLineStepStyle(string stepStyle) None Set the line step style for thisline
setLineStyle(string style) None Set the line style for thisline
setLineVisible(Boolean state) None Set whether to draw thisline
setLineWidth(floating-point width) None Set the width for thisline
setSymbol Fill Color(string None Set the symbol fill color for this
symbolFillColor) line's symbols
setSymbol I nterval (integer interval) None Set the interval of data points (>0)
on which symbols are drawn.
setSymbol LineColor(string None Set the symbol line color for this
symbolLineColor) line's symbols
setSymbolsAutol nterval (Boolean None Set whether to have the program
state) decide the interval at which to
draw symbols
setSymbol Size(fl oating-point size) None Set the symbol size for thisline
setSymbol SkipCount(integer count) None Set the number of points skipped
between symbols.
setSymbolsVisible(Boolean state) None Set whether to draw the symbols
for thisline

setSymbol Type(string symbol Type) None

Set the symbol type for thisline

The script in Example 29 creates a plot with a data set read from DSS, the
script then tells that data set's curve to draw its symbols auto skipped.

Example 29: Using G2dLine Objects

from hec.script import *

from hec.script.Constants import TRUE, FALSE
from hec.heclib.dss import *

thePlot = Plot.newPlot()

dssFile = HecDss.open(“C:/mydb.dss”)

thePlot.addData(flow)

thePlot.showPlot()

stageCurve = thePlot.getCurve(stage)
stageCurve.setSymbolsAutolnterval(TRUE)

flow = dssFile.get(*/BASIN/LOC/FLOW/01NOV2002/1HOUR/OBS/")

# for Plot class

# for DSS class
# create a Plot
# open the DSS file

# read a data set
# add the data set
# show the plot
# get the stage curve
# turn on symbols auto skip
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8.10.11 G2dLabel, G2dTitle, and AxisLabel Classes

G2dL abd, G2dTitle and AxisL abel methods are described in Table

8.24.
Table 8.24 Label Methods
M ethod Returns Description

editProperties() None Display the Edit Properties Dialog for
the label

getAlignmentString() string Return the text alignment for this
label asa String

getBackground() Color Return the background color for the
label*

getBackgroundString() string Return the background color for the
label asa String"

getBorderStyleString() string Return the border style for thislabel
asastring

getBorderWeight() floating- | Return the border weight for thislabel

point

getFillColor() Color Return the fill color for thislabel asa
Color*

getFillColorString() string Return the fill color for thislabel asa
string*

getFillPatternString() string Return the fill pattern for thislabel as
astring

getFontFamily() string Return the font family for the label

getFontSize() integer | Return the font size for the label

getFontSizes() tuple of 3 | Return the regular, tiny, min and max

integers | font sizes for thislabel

getFontString() string Return the font for the label asa
string®.

getFontStyleString() string Return the font style for the label asa
String

getForeground() Color | Return the foreground color for the
[abel

getForegroundsString() string Return the foreground color for the
label asa String

getlcon() Icon Return the Icon to display for this
[abel

getlconPath() string Return the Icon path to display for this
[abel

getRotation() integer | Return the text rotation for thislabel

getSpacing() integer | Return the spacing around this label

getText() string Return the text for the label

isBackgroundVisible() Boolean | Return whether the background is
visible

isBorderVisible() Boolean | Return whether the border isvisible

setAlignment(string alignment) None | Set thetext alignment for this label
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M ethod Returns Description
setBackground(string colorString) None | Set the background color for the label®
setBackgroundVisible(Boolean None | Set the background visibility for the
state) [abel
setBorderColor(string colorString) None | Set the border color for thislabel
setBorderStyle(string style) None | Set the border style for this|abel
setBorderVisible(Boolean state) None | Set the border visibility for thislabel
setBorderWeight(fl oati ng-point None | Set the border weight for this label
weight)
setFillColor(string color) None | Set thefill color for this label®
setFillPattern(string pattern) None | Set thefill pattern for thislabel®
setFont(string font) None | Set the font for the label®.
setFontFamily(string fam) None | Set the font family for the label
setFontSize(integer sz) None | Setthefont size for the label
setFontSizes(integer sz, integer None | Settheregular, tiny, min and max font
tiny, integer min, integer max) sizes for thislabel
setFontStyle(string style) None | Set the font style for the label
setForeground(string colorString) None | Set the foreground color for the label
Setlcon(lcon icon) None | Setthelcon to display for this label
Setl con(string iconPath) None | Set thelcon to display for this label
setRotation(integer rotation) None | Set thetext rotation for thislabel
setSpacing(integer space) None | Set the spacing around this label
SetText(string text) None | Setthetext for the label

! In the current version, fill color and background color are synonymous (e.g. fills are performed with the
background color). Future version may support separate fill and background colors.

2 Fonts are specified as name],styl €] size]] where styleis Plain, Bold, Italic, or Bold Italic (e.g.
“Arial,Bolditalic,12”, “Lucida Console,Plain,10").

The script in Example 30 creates a plot from a DSS data set and sets the
Y 1 axislabel text to blue.

Example 30: Using AxisL abel Objects

from hec.script import * # for Plot class

from hec.heclib.dss import * # for DSS class
thePlot = Plot.newPlot() # create a Plot
dssFile = HecDss.open(“C:/mydb.dss”) # open the DSS file

flow = dssFile.get(*/BASIN/LOC/FLOW/01NOV2002/1HOUR/OBS/")
# read a data set

thePlot.addData(flow) # add the data set
thePlot.showPlot() # show the plot

viewport0O = thePlot.getViewport(0) # get the first viewport

yaxislabel = viewport0.getAxisLabel("Y1") # get the Y1 axis label
yaxislabel.setForeground(“blue”) # set the Y1 axis label text to blue

8-65



Chapter 8 - Scripting HEC-DSSVue User's Manual

8.10.12 Templates

Template files saved interactively from HEC-DSSV ue may be applied to
plots viascripting. When saving atemplate interactively from the plot
window viathe "Save Template..." entry on the "File" menu, HEC-
DSSVue:

1. Choosesthe "My Documents” subdirectory of the directory
specified in the USERPROFILE environment variable as the
default location for the template file.

2. Appends“.template” to the end of the specified file name.

The applyTemplate(string filename) G2dDialog method requires the actual
file name for the template file. To apply atemplate saved in the default
directory, the complete template file name must be re-created as
demonstrated in Example 31.

Example 31: Applying Template Saved in Default Directory

import os # for getenv() & sep
from hec.script import * # for Plot class
from hec.heclib.dss import * # for DSS class
thePlot = Plot.newPlot() # create a Plot
dssFile = HecDss.open(“C:/mydb.dss”) # open the DSS file

flow = dssFile.get(*/BASIN/LOC/FLOW/01NOV2002/1HOUR/OBS/")
# read a data set

thePlot.addData(flow) # add the data set
thePlot.showPlot() # show the plot
templateName = “myTemplate” # template base name
templateFileName = \ # re-create the file name

os.getenv(“userprofile”) \

+ 0s.sep \

+ “My Documents” \

+ 0s.sep \

+ templateName \

+ “.template”
thePlot.applyTemplate(templateFileName) # apply the template

8.11 Plot Component Properties

The following tables are the valid values to be used when calling plot
related functions that take a color (setBackground(string color), €tc...), an
alignment (setAlignment()), a rotation (setRotation()), afill pattern
(setFillPattern()), afill type (setFill Type()), aline style (setLineStyle()), a
step style (setLineStepStyle()).or a symbol type (setSymbol Type()).
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8.11.1

8.11.2

8.11.3

8.11.4

8.11.5

8.11.6

Colors

Colors can be specified either by a Sring or by ajava.awt.Color object. If
setting a color through the use of a String object the String can either be a
standard color name (i.e. "darkred") or an RGB string (i.e. "255,20,20").
Standard color names are listed in Table 8.25.

Table 8.25 Standard Colors

black darkmagenta  green lightorange orange
blue darkorange lightblue lightpink pink
cyan darkpink lightcyan lightpurple purple
darkblue darkpurple lightgray lightred red
darkcyan darkred lightgreen lightyellow white
darkgray darkyellow lightmagenta magenta yellow
darkgreen gray

Alignment

Supported text aignments are:  Left, Center, and Right.

Positions

Supported text positionsare: Above, Center, and Below.

Rotation

Supported text rotation values are: 0, 90, 180, 270.

Fill Patterns

Supported fill patterns are listed inTable 8.26.

Table 8.26 Fill Patterns

Solid Horizontal Vertical
Cross FDiagonal BDiagonal
Diagonal Cross None

Fill Types

Supported fill types are: None, Above, and Below.
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8.11.7

8.11.8

8.11.9

8.12

8.12.1

Line Styles
Supported line style values are listed in Table 8.27.

Table 8.27 Line Styles

Solid Dash Dot
Dash Dot Dash Dot-Dot
Step Style

Supported step style values are: Normal, Step, and Cubic.

Symbol Types
Supported symbol type values are listed in Table 8.28.

Table 8.28 Symbol Types

Asterisk Backdash Backdlash Square
Circle Diamond Forwardshlash
Forwarddash Square Hash Hash Diamond
Hash Square Hash Triangle Hash Triangle2
Hourglass Open Circle Open Diamond
Open Hourglass Open Square Open Triangle
Open Triangle2 Pipe Pipe Diamond
Pipe Square Plus Plus Circle
Plus Diamond Plus Square Square
Triangle Triangle2 X
X Circle X Square X Triangle
X Triangle2

Tables

Tables allow you to view datain avertical scrolling window that shows
the ordinates, the dates and times and the values for the selected data sets.

Tabulate Class

Tabul at e. newTabl e()
Tabul at e. newTabl e(string title)
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The Tabulate class in the hec.script moduleis used to create anew Table
dialog. It containstwo functionsto create a Table dialog, each of which
returns as a HecDataT abl eFrame object.

Creation of atableisillustrated in Example 32.

Example 32: Creating a Table

from hec.script import *
myTable = Tabulate.newTable()
or

from hec.script import *

myTable = Tabulate.newTable(“Elevation vs Flow")

HecDataTableFrame Class

HecDataT ableFrame methods are described in Table 8.29.

Table 8.29 HecDataT ableFrame Methods

M ethod Returns Description
addData(DataContainer dc) integer Adds Data Set to the table.
close() None Closesthetable
export() None Brings up the Table Export

Options diaog.
export(string fileName, None Exports table to specified file
TableExportOptions options) with specified options
exportAsHTML (string fileName) None Exportstablein HTML format
to specified file with no title
and elements indented with
tabs
exportAsHTML (string fileName, string None Exportstablein HTML format
title, string indent) to specified file with specified
title and indentation string
exportAsXML (string fileName) None Exportstablein XML format to
specified file with no title and
elements indented with tabs
exportAsX ML (string fileName, string None Exportstablein XML format to
title, string indent) specified file with specified
title and indentation string
getCellBackground(integer row, Color Returns the background color
integer column) of the specified cell asa Color
getCellBackgroundString(integer row, string Returns the background color
integer column) of the specified cell asastring
getCellForeground(integer row, integer Color Returns the foreground color of
column) the specified cell asa Color
getCellForegroundString(integer row, string Returns the foreground color of

integer column)

the specified cell asastring
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M ethod Returns Description
getColumn(DataContainer dc) integer Returns the number of the
column that contains the
specified data, if the parameter
istime series data, or the
number of the column that
contains the x-ordinates if the
parameter is paired data
getColumn(string header) integer Returns the number of the
column that has the specified
header text. Line breaksinthe
header text are specified as"\n"
getColumnBackground(integer Color Returns the background color
column) of the specified column asa
Color
getColumnBackgroundString(integer string Returns the background color
column) of the specified column as a
string
getColumnFForeground(integer column) Color Returns the foreground color of
the specified column as a Color
getColumniForegroundString(integer string Returns the foreground color of
column) the specified column as a string
getColumnHeaderBackgroung( integer Color Returns the background color
column) of the header of the specified
column as a Color
getColumnHeaderBackgroungString( string Returns the background color
integer column) of the header of the specified
column as a string
getColumnHeaderFontString( integer string Returns the font of the header
column) of the specified column as a
string.!
getColumnHeaderForegroung( integer Color Returns the foreground color of
column) the header of the specified
column as a Color
getColumnHeaderForegroungString( string Returns the foreground color of
integer column) the header of the specified
column as a string
getColumnL abel (integer colNum) string Returns the column header text
for the specified column
getColumnL abel () list of Returns the column header text
strings for all columns
getColumnWidth(integer colNum) integer Returns the width of the
specified column in pixels
getColumnWidths() list of Returnsalist of all the column
integers | widthsin pixels
getCommasState() Boolean | Get whether the commas are
shown
getDateTimeAsTwoColumnsState() Boolean | Get whether date/time columns

areshown as 1 or 2 columnsin
the table
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M ethod Returns Description
getExportString(TableExportOptions string Returns a string representation
options) of the table exported according
to the specified options

getHeight() integer Return the height of thetablein
screen coordinates.

getHTM LExportString() string Returns a string representation
of the table exported in HTML
format with no title and
elements indented with tabs

getHTM L ExportString(string title, string Returns a string representation

string indent) of the table exported in HTML
format with the specified title
and indentation string

getL ocation() Point Returns the location of the
table in screen coordinates’.

getRowBackground(integer row) Color Returns the background color
of the specified row as a Color

getRowBackgroundString(integer row) string Returns the row background
color of the specified column
asastring

getRowForeground(integer row) Color Returns the foreground color of
the specified row as a Color

getRowForegroundString(integer row) string Returns the row foreground
color of the specified column
asastring

getSize() Dimension | Return the dimensions of the
table in screen coordinates.

getTableTitle() GzdTitle | Returnsthetitle of the
HecDataT ableFrame object as
aG2dTitle object.

getTableTitleText() string Returns the title of the
HecDataT ableFrame object as
astring.

getWidth() integer Return the width of thetablein
screen coordinates.

GetXMLExportString() string Returns a string representation
of the table exported in XML
format with no title and
elements indented with tabs

getX ML ExportString(string title, string string Returns a string representation

indent) of the table exported in XML
format with the specified title
and indentation string

hide() None Hide the table

iconify() None Minimize (iconify) the table

maximize() None Maximize the table

minimize() None Minimize (iconify) the table

8-71



Chapter 8 - Scripting

HEC-DSSVue User's Manual

M ethod Returns Description
newTable() HecDataTab | Static, same as
leFrame | Tabulate.newTable()
newT able(string title) HecDataTab | Static, same as
leFrame | Tabulate.newTable(title)
print() None Display the print table
restore() None Restore the table from a
minimized or maximized state
setCellBackgound(integer row, integer None Sets the background color of
column, string color) the specified cell to the
specified color
setCell Foreground(integer row, integer None Sets the foreground color of the
column, string color) specified cell to the specified
color
setColumnBackgound(integer column, None Sets the background color of
string color) the specified column to the
specified color
setColumnForeground(integer column, None Sets the foreground color of the
string color) specified column to the
specified color
setColumnHeaderBackgound(integer None Sets the background color of
column, string color) the header of the specified
column to the specified color
setColumnHeaderFont(integer column, None Setsthe font of the header of
string font) the specified column to the
specified font.!
setColumnHeaderForeground( integer None Sets the foreground color of the
column, string color) header of the specified column
to the specified color.
setColumnL abel (integer column, string None Sets the column header text of
label) the specified column to the
specified label.
setColumnL abel 5(list labels) None Sets the column header text of
al columnsto the labels
specified in the list of strings
setColumnPrecision(integer colNum, None Sets the number of decimal
integer precision) places to display for the
specified column
setColumnWidth(integer colNum, None Sets the width of the specified
integer width) column in pixels
setColumnWidths(list widths) None Setsthe width in pixels of all
the columns to those specified
in the parameter (list of
integers)
setCommasState(Boolean None Set state to show commas or
showCommas) not
setDateTimeAsTwoColumnsState( None Set whether date/time columns

integer showDateTimeAs2Columns)

should show as 1 or 2 columns
in the table
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M ethod Returns Description
setLocation(integer X, integer y) None Setsthe location of the tablein
screen coordinates’.
setSize(int width, int height) None Setsthe size of the tablein
screen coordinates.
setRowBackgound(integer row, string None Sets the background color of
color) the specified row to the
specified color
setRowForeground(integer row, string None Sets the foreground color of the
color) specified row to the specified
color
setTableTitleText(string title) None Setsthettitle of the
HecDataT ableFrame object.
showTable() None Show thetable

! Fonts are specified as name{ styl € ,size]] where style is Plain, Bold, Italic, or Bold Italic (e.g.
"Arial,Boldltalic,12", "Lucida Console,Plain,10").

2 The coordinate system used is a graphics coordinate system, where X increases to theright and Y increases
downward from the origin (0,0) which is located in the top left corner of the display. Locations set or retrieved
refer to the top left corner of the plot in reference to this coordinate system.

8.13 TableExportOptions Class

TableExportOptions objects hold compl ete descriptions of options for
exporting tables to fixed-column-width or column-delimited text files.
TableExportOptions objects have fields that are settable by the user to
create marker lines of various styles. New TableExportOptions objects
are created by calls to TableExportOptions() (e.g., myOptions =
TableExportOptions()). TableExportOptions fields are described in

Table 8.30.
Table 8.30 TableExportOptions Fields
Field Type Description Default
delimiter string (one | Placed between fields if \t' (tabcharacter)
character) | fixedWidthCol is False
quotedStrings Boolean Specifies whether to enclose text | False
in quotes
title string Title of the table None
fixedWidthCols | Boolean Specifies whether fields are False

exported as fixed-width columns
or fields separated by delimiter

columnHeader | Boolean Specifies whether the column True
headers are to be exported

rowHeader Boolean Specifies whether the row False
headers are to be exported

gridLines Boolean Specifies whether the table will False

be exported with text "lines"
between the rows and columns
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The script in Example 33 creates atable from two DSS data sets and
exports the table as a comma-separated-val ue text file.

Example 33: Filling, Displaying and Exporting a Table

from hec.heclib.dss import * # for DSS

from hec.script import * # for Tabulate

file = “C:/mydb.dss" # specify the DSS file
dssfile = HecDss.open(file) # open the file

# read 2 records
stage = dssfile.get("//AXEMA/STAGE/01OCT2001/1IHOUR/OBS/")
flow = dssfile.get("//AXEMA/FLOW/010CT2001/1IHOUR/OBS/")

theTable = Tabulate.newTable() # create the table
theTable.setTitle("Test Table") # set the table title
theTable.setLocation(5000,5000) # set the location of the table
off

the screen
theTable.addData(flow) # add the data
theTable.addData(stage)
theTable.showTable() # show the table
flowCol = theTable.getColumn(flow) # adjust columns

stageCol = theTable.getColumn(stage)

flowWidth = theTable.getColumnWidth(flow)
stageWidth = theTable.getColumnWidth(stage)
theTable.setColumnPrecision(flowCol, 0)
theTable.setColumnPrecision(stageCol, 2)
theTable.setColumnWidth(flowCol, flowWidth - 10)
theTable.setColumnWidth(stageCol, stageWidth + 10)
# get new export options

# delimit with commas

# set the title

# set the output file name

# export to the file

# close

8.14 HecMath Class

The objects returned from the HecDss..read(...) methods and supplied to
the HecDss.write(...) method are HecMath objects. There are currently
three types of HecMath classes: TimeSeriesMath class, PairedDataM ath
class, and StreamRatingMath class which represent time-series data,
paired data, and stream rating data, respectively.

An HecMath object can be created for writing to new DSS data by first
creating a new DataContainer as discussed in Sections 8.8.1
(TimeSeriesContainer Class) and 8.8.2 (), and then calling the
HecMath.createl nstance() function with the DataContainer object as the
only parameter (e.g. myTimeSeriesMath =

HecMath.createl nstance(myTimeSeriesContainer)). The methods for
HecMath Objects, which are described in Section 8.14, are listed inTable
8.31.
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Table 8.31 HecMath Methods

Description

Method Returns Section
abs() HecMath 8.15.1
accumulation() TimeSeriesMath 8.15.2
acos() HecMath 8.15.3
add(floating-point constant) HecMath 8.15.4
add(TimeSeriesMath dataset) TimeSeriesMath 8.15.5
applyMultipleLinearRegression( TimeSeriesMath 8.15.6
string startTimeString, string endTimeString,
sequence datasets, floating-point minLimit,
floating-point maxLimit)
asin() HecMath 8.15.7
atan() HecMath 8.15.8
ceil() HecMath 8.15.9
centeredM ovingAverage(integer number, TimeSeriesMath 8.15.10
Boolean onlyValid, Boolean useReduced)
coniclnterpolation(TimeSeriesM ath dataset, TimeSeriesMath 8.15.11
string inputType, string outputType, floating-
point storageFactor)
convertToEnglishUnits() HecMath 8.15.12
convertToMetricUnits() HecMath 8.15.13
correlationCoefficients(TimeSeriesMath dataset) | LinearRegression 8.15.14

Statistics
cos() HecMath 8.15.15
cyclicAnalysis() sequence of 8.15.16
TimeSeriesMath

decayingBasinWetnessParameter(TimeSeries TimeSeriesMath 8.15.17
Math tsPrecip, floating-point decayRate)
divide(floating-point constant) HecMath 8.15.18
divide(TimeSeriesM ath dataset) TimeSeriesMath 8.15.19
estimateForMissingPreci pV al ues(integer TimeSeriesMath 8.15.20
maxMissing)
estimateForMissingValues( integer maxMissing) | TimeSeriesMath 8.15.21
exp() HecMath 8.15.22
exponentiation(floating-point constant) HecMath 8.15.23
exponentiation(HecMath tsMath) HecMath 8.15.24
extractTimeSeriesDataFor TimeSpecification( TimeSeriesMath 8.15.25
string timeLevel, string range, Boolean
isinclusive, integer interval Window, Boolean
setAslrregular)
firstvValidDate() integer 8.15.26
firstValidvaue() floating-point 8.15.27
floor() HecMath 8.15.28
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Description

M ethod Returns Section
flowA ccumul atorGageProcessor(TimeSeries TimeSeriesMath 8.15.29
Math dataset)
fmod(HecMath tsMath) HecMath 8.15.30
forwardM ovingAverage(integer number) TimeSeriesMath 8.15.31
forwardM ovingAverage(integer Hecmath 8.15.32
number ToAverageOver, Boolean
OnlyValidValues, Boolean useReduced)
generateDataPairs(TimeSeriesMath dataset, PairedDataM ath 8.15.33
Boolean sort)
generateRegularl nterval TimeSeries( string TimeSeriesMath 8.15.34
startTime, string endTime, string timel nterval,
string timeOffset, floating-point initialValue)
getData() DataContainer 8.15.35
getType() string 8.15.36
getUnits() string 8.15.37
gmean(list of HecMath tsMathArray) HecMath 8.15.38
hmean(list of HecMath tsMathArray) HecMath 8.15.39
integerDivide(floating-point constant) HecMath 8.15.40
integerDivide(HecMath tsMath) HecMath 8.1541
interpolateDataAtRegularInterval (string TimeSeriesMath 8.15.42
timel nterval, string timeOffset)
inverse() HecMath 8.15.43
isEnglish() Boolean 8.15.44
isMetric() Boolean 8.15.45
isMuskingumRoutingStable( integer string 8.15.46
subReachCount, floating-point muskingumK,
floating-point muskingumX)
lastValidDate() integer 8.15.47
lastValidvVaue() floating-point 8.15.48
log() HecMath 8.15.49
l0g10() HecMath 8.15.50
max() floating-point 8.15.51
max(list of HecMath tsMathArray) HecMath 8.15.52
maxDate() integer 8.15.53
mean() floating-point 8.15.54
mean(list of HecMath tsMathArray) HecMath 8.15.55
med(list of HecMath tsMathArray) HecMath 8.15.56
mergePairedData(PairedDataM ath dataset) PairedDataM ath 8.15.57
mergeTimeSeries(TimeSeriesMath dataset) TimeSeriesMath 8.15.58
min() floating-point 8.15.59
min(list of HecMath tsMathArray) HecMath 8.15.60
minDate() integer 8.15.61
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Description

M ethod Returns Section
modifiedPul sRouting(TimeSeriesM ath dataset, TimeSeriesMath 8.15.62
integer subReachCount, floating-point
muskingumX)
modul o(floating-point constant) HecMath 8.15.63
modulo(HecMath tsMath) HecMath 8.15.64
multipleL inearRegression(sequence datasets, PairedDataM ath 8.15.65
floating-point minLimit, floating-point
maxLimit)
multiply(floating-point constant) HecMath 8.15.66
multiply(TimeSeriesM ath dataset) TimeSeriesMath 8.15.67
muskingumRouting(integer subReachCount, TimeSeriesMath 8.15.68
floating-point muskingumK, floating-point
muskingumX)
neg() HecMath 8.15.69
numberlnvalidValues() integer 8.15.70
numberMissingValues() integer 8.15.71
numberQuestionedV alues() integer 8.15.72
numberRejectedVaues() integer 8.15.73
numberValidValues() integer 8.15.74
olympicSmoothing(integer number, Boolean TimeSeriesMath 8.15.75
onlyValid, Boolean useReduced)
pl(list of HecMath tsMathArray) HecMath 8.15.76
p2(list of HecMath tsMathArray) HecMath 8.15.77
p5(list of HecMath tsMathArray) HecMath 8.15.78
p10(list of HecMath tsMathArray) HecMath 8.15.79
p20(list of HecMath tsMathArray) HecMath 8.15.80
p25(list of HecMath tsMathArray) HecMath 8.15.81
p75(list of HecMath tsMathArray) HecMath 8.15.82
p80(list of HecMath tsMathArray) HecMath 8.15.83
p89(list of HecMath tsMathArray) HecMath 8.15.84
p90(list of HecMath tsMathArray) HecMath 8.15.85
p95(list of HecMath tsMathArray) HecMath 8.15.86
p99(list of HecMath tsMathArray) HecMath 8.15.87
periodConstants(TimeSeriesM ath dataset) TimeSeriesMath 8.15.88
polynomial Transformation(TimeSeriesMath TimeSeriesMath 8.15.89
dataset)
polynomial TransformationWithintegral (TimeSeri | TimeSeriesMath 8.15.90
esMath dataset)
product(list of HecMath tsMathArray) HecMath 8.15.91
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Description

M ethod Returns Section
ratingT abl el nterpolation(TimeSeriesM ath TimeSeriesMath 8.15.92
dataset)
replaceSpecificV alues(HecDouble from, HecMath 8.15.93
HecDouble to)
reverseRatingT abl el nterpolation( TimeSeriesMath 8.15.94
TimeSeriesMath dataset)
rms(list of HecMath tsMathArray) HecMath 8.15.95
round() HecMath 8.15.96
roundOff(integer digits, integer place) HecMath 8.15.97
screenWithConstantV al ue(String durationStr, HecMath 8.15.98

floating-point rejectTolerance, floating-point
guestionTolerance, floating-point minThreshold,
integer maxMissing)
screenWithDurationMagnitude(String HecMath 8.15.99
durationStr, floating-point minRejectLimit,
floating-point minQuestionLimit, floating-point
maxRejectLimit, floating-point
maxQuestionLimit)

screenWithForwardM ovingAverage(integer HecMath 8.15.100
number ToAverageOver, floating-point

changeLimit)

screenWithForwardM ovingAverage(integer TimeSeriesMath 8.15.101

number, floating-point changeLimit, Boolean
setMissing, string invalidQuality)

screenWithMaxMin(floating-point min, floating- | TimeSeriesMath 8.15.102
point max, floating-point rate, Boolean
setMissing, string invalidQuality)

screenWithM axMinfloating-point HecMath 8.15.103
minValueLimit, floating-point maxValueLimit,
floating-point changeLimit)

screenWithM axMin(fl oati ng-point HecMath 8.15.104
minValueLimit, floating-point maxValueLimit,
floating-point changeLimit, Boolean
setinvalidToSpecified, floating-point
invalidV alueReplacement, string
qualityFlagForlnvalidValue)

screenWithM axMin(fl oati ng-point HecMath 8.15.105
minRejectLimit, floating-point
minQuestionLimit, floating-point
maxQuestionLimit, floating-point
maxRejectLimit)
screenWithRateOf Change(fl oating-point HecMath 8.15.106
minRejectLimit, floating-point
minQuestionLimit, floating-point
maxQuestionLimit, floating-point
maxRejectLimit)

setCurve(string name) None 8.15.107
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Description

M ethod Returns Section
setCurve(integer number) None 8.15.108
setData(DataContainer data) None 8.15.109
setlocation(string location) None 8.15.110
setParameter(string parameter) None 8.15.111
setPathname(string pathname) None 8.15.112
setTimel nterval (string interval) None 8.15.113
setType(string type) None 8.15.114
setUnits(string units) None 8.15.115
setVersion(string version) None 8.15.116
setWatershed(string watershed) None 8.15.117
shiftAdjustment(TimeSeriesM ath dataset) TimeSeriesMath 8.15.118
shiftlnTime(string timeShift) TimeSeriesMath 8.15.119
sign() HecMath 8.15.120
sin() HecMath 8.15.121
skewCoefficient() floating-point 8.15.122
snapToRegularlnterval (string timelnterval, string | TimeSeriesMath 8.15.123
timeOffset, string timeBackward, string
timeForward)
sart() HecMath 8.15.124
standardDeviation() floating-point 8.15.125
standardDeviation (list of HecMath tsMathArray) HecMath 8.15.126
straddleStaggerRouting(integer avgCount, integer | TimeSeriesMath 8.15.127
lagCount, integer subReachCount)
subtract(floating-point constant) HecMath 8.15.128
subtract(TimeSeriesMath dataset) TimeSeriesMath 8.15.129
successiveDifferences() TimeSeriesMath 8.15.130
sum() floating-point 8.15.131
sum (list of HecMath tsMathArray) HecMath 8.15.132
tan() HecMath 8.15.133
timeDerivative() TimeSeriesMath 8.15.134
transformTimeSeries(string timelnterval, string TimeSeriesMath 8.15.135
timeOffset, string functionType)
transformTimeSeries(TimeSeriesM ath dataset, TimeSeriesMath 8.15.136
string functionType)
truncate() HecMath 8.15.137
twoV ariableRating T abl el nterpol ation( TimeSeriesMath 8.15.138
TimeSeriesMath dataset1, TimeSeriesMath
dataset2)
variance(list of HecMath tsMathArray) HecMath 8.15.139
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8.15

8.15.1

8.15.2

Math Functions

Math functions are accessible through the general class called HecM ath.
HecM ath objects hold data sets and allow you to perform mathematical
operations on them. They can also be passed to plots and tablesto display
thedata. A HecMath object iseither aTimeSeriesMath object or a
PairedDataM ath object, which handle time series and paired data sets,
respectively.

Before using PairedDataM ath methods, be sure to read the description
for the setCurve method. Paired data sets may contain multiple curves.
The setCurve method provides user control over which paired data curve
is operated upon by subsequent function calls.

Absolute Value

abs()

Derive anew time series or paired data set from the absolute value of
values of the current data set. For time series data, missing values are kept
asmissing. For paired data sets, use the setCurve method to first select the
paired data curve(s).

See also: set Curve()

Parameters. Takes no parameters

Example: NewDat aSet = dat aSet . abs()

Returns. A new HecM ath object of the same type as the current
object

Accumulation (Running)

accumulation()

Derive anew time series by computing a running accumulation of the
current time series.

For time points in which the current time series value are missing, the
value in the accumulation time series remains constant (same as the
accumulated value at the last valid point location).

Parameters. Takes no parameters
Example: NewTi neSeries = tinmeSeries.accunmul ati on()
Returns. A new TimeSeriesM ath object

8-80



HEC-DSSVue User's Manual Chapter 8 - Scripting

8.15.3

8.15.4

8.15.5

Arccosine Trigonometric Function

Add

Add

acos()

Derive anew time series or paired data set from the arccosine of values of
the current data set. The resultant data set values are in radians. For time
series data, missing values are kept as missing.

For paired data sets, use the setCurve (see Sections 8.15.07 and 8.15.08)
function to first select the paired data curve (or al curves) to apply the
function. By default the function is applied to all paired data curves.

See also: setCurve()

Example: newDat aSet = dat aSet . acos()

Parameters. Takes no parameters

Returns. A HecMath object of the same type as the current object

a Constant

add(fl oati ng- poi nt constant)

Add the value constant to al valid values in the current time series or
paired data set. For time series data, missing values are kept as missing.

For paired data, constant is added to y-values only. Use the setCurve
method to first select the paired data curve(s).

Seealso: add(HecMath dataSet)
setCurve()
Example: newDat aSet = dat aSet . add( 2. 5)
Parameters. constant - A floating-point value
Returns. A new HecM ath object of the same type as the current
object

a Data Set

add( Ti neSeri eshMat h t sDat a)

Add the values in the data set tsData to the values in the current data set.
The function only appliesto time series data sets.

When adding one time series data set to another, there is no restriction that
timesin the two data sets match exactly. However, only values with
coincident times will be added. Timesin the current time series data set
that cannot be matched with times in the second data set are set to missing.
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Valuesin the current data set that are missing are kept as missing. Either
or both data sets may be regular or irregular interval time series. This
function will not merge data sets. Use the mergeTimeSeries (for time
series data sets) or the mergePairedData (for paired data sets) functions
for this purpose.

Seealso:  add(floating-point constant)
mergeTimeSeries(TimeSeriesM ath)
mergePairedData(PairedDataM ath)

Example: newTsData = tsDat a. add( ot her TsDat a)

Parameters. tsbata - A TimeSeriesMath object

Returns. A new TimeSeriesM ath object

8.15.6  Apply Multiple Linear Regression Equation

applyMultipleLinearRegression(string startTi meString,
string endTi neString,
sequence tsDat aSet Sequence,
floating-point mninunLint,
fl oating-point maximunlimt)

Apply the regression coefficients contained in the current paired data set
to the array of time series data sets in tsDataSetSequence to develop a
new time series data set. The applyMultipleLinear Regression function
applies the multiple linear regression coefficients computed with the
multipleLinear Regression function (see Section 8.15.65).

For the general linear regression equation, a dependent variable, Y, may
be computed from a set independent variables, Xn:

Y = BO+B1*X1+B2*X2 +B3*X3
where Bn are linear regression coefficients.

For time series data sets, an estimate of the original time series data set
values may be computed from a set of independent time series data sets
using regression coefficients such that:

TsEstimate(t) = BO + BI*TSL(t) + B2*TS2(t) + ... + Bn*TSn(t)

where Bn are the set of regression coefficients and TSn are the time series
data sets contained in tsDataSetSequence.

The number of regression coefficientsin the current PairedDataM ath
object must be one more than the number of independent time series data
sets in tsDataSetSequence. The collection of selected time series data sets
must be in the same order as when the regression coefficients were
computed with the multipleLinear Regression method.
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All the time series data sets must be regular interval and have the same
timeinterval. The function filters the data to determine the time period
common to all time series data sets and uses only those pointsin the
regression anaysis. For any giventime, if avalueis missing in any time
series, the value in resultant time seriesis set to missing.

The parameters minimumLimit and maximumLimit can be used to specify
the range of valid values for the resultant data set. Values which fall
outside the specified range are set to missing. minimumLimit or
maximumLimit may be entered as Constants. UNDEFINED to ignore the
minimum or maximum value check.

If startTimeString or endTimeString are blank strings, the start and end
time of the resultant time series will be defined by the time period
common to all time series data sets in tsDataSetSequence. Otherwise the
time series start and end may be defined using startTimeString and
endTimeString which have the usual HEC time window format (e.g.
"01JAN2001 1400").

Names, parameter type and unit labels for the new time series data set are
copied over from the first time series data set in tsDataSetSequence. The
F-part in the new data set is set to "COMPUTED".

Parameters:
start Ti meString — A string containing an HEC time (e.g.
"01JANZ2001 1400") specifying the start time of the resultant time
series data set. May beblank (" ")
endTi meString — A string containing an HEC time (e.g.
"01JAN2001 1400") specifying the ending time of the resultant time
seriesdataset. May be blank (" ")
t sDat aSet Sequence — Seguence of TimeSeriesM ath objects. Must
all beregular interval and have the same time interval.
m ni munti mit — A floating-point value specifying the minimum
valid value in the resultant time series data set. Set to
Constants. UNDEFINED to ignore this option.
maxi munti m t — A floating-point value specifying the maximum
valid value in the resultant time series data set. Set to
Constants. UNDEFINED to ignore this option.

Example:
newlsData =
pai r edDat a. appl yMul ti pl eLi near Regr essi on(
“01Jan2000 0000",
“31Dec2000 2300",
(tsDatal, tsData2, tsData3),
Const ant s. UNDEFI NED,
Const ant s. UNDEFI NED)

Returns. A new regular interval TimeSeriesMath object
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Generated Exceptions. Throws a HecMathException if the number of
data sets in tsDataSetSequence is not equal to the number of regression
coefficients -1, or if the data sets in tsDataSetSequence are not regular
interval time series data sets with the same interval time.

8.15.7  Arcsine Trigonometric Function

asin()

Derive anew time series or paired data set from the arcsine of values of
the current data set. The resultant data set values are in radians. For time
series data, missing values are kept as missing.

For paired data sets, use the setCurve (see Sections 8.15.107 and 8.15.108)
function to first select the paired data curve (or al curves) to apply the
function. By default the function is applied to all paired data curves.

See also: setCurve()

Example: newDat aSet = dat aSet . asin()

Parameters. Takes no parameters

Returns. A HecMath object of the same type as the current object

8.15.8  Arctangent Trigonometric Function

atan()

Derive atime series or paired data set computed from the arctangent of
values of the current data set. For time series data, missing values are kept
asmissing. If the cosine of the current time series value is zero, the value
IS set missing.

For paired data sets, use the setCurve method to first select the curve(s).

Seealso: setCurve()

Example: newDat aSet = dat aSet . at an()

Parameters. Takes no parameters

Returns. A new HecM ath object of the same type as the current
object

8.15.9  Ceiling Function

ceil()
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Derive atime series or paired data set with values of the current time
series rounded up to the nearest whole number that is greater to or equal to
the value. For time series data, missing values are kept as missing.

For paired data sets, use the setCurve method to first select the curve(s).

Seealso: setCurve(), floor()

Example: newDat aSet = dataSet. ceil ()

Parameters. Takes no parameters

Returns. A new HecM ath object of the same type as the current
object

8.15.10 Centered Moving Average Smoothing

centeredMovingAverage(i nt eger numnber ToAver ageOver,
bool ean onl yVal i dVal ues,
bool ean useReduced)

Derive anew time series from the centered moving average of
number ToAverageOver valuesin the current time series.
numberToAverageOver must be an odd integer greater than two.

If onlyValidValuesis set to true, then if any points in the averaging
interval are missing, the point in the new time seriesis set to missing. If
onlyValidValuesis set to false and missing values are contained in the
averaging interval, a smoothed point is still computed using the remaining
valid valuesintheinterval. If thereareno valid valuesin the averaging
interval, the point is set to missing.

If useReduced is set to true, then centered moving average points can still
be computed at the beginning and end of the time series, even if there are
less than number ToAverageOver valuesin the averaging interval. If
useReduced is set to false, then the first and last number ToAverageOver/2
points of the resultant time series are set to missing.

Parameters:
nunber ToAver ageOver — An integer containing the number of
values to average over for computing the centered moving average.
Must be odd and greater than two.
onl yVal i dval ues — Either True or False, specifying whether all
values in the averaging interval must be valid for the computed point
in the new time series to be valid.
useReduced — Either True or False, specifying whether to allow
points at the beginning and end of the resultant time seriesto be
computed from areduced ( less than number ToAverageOver) set of
points.
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Example:
avgbat a = tsDat a. cent eredMovi ngAverage (5, TRUE, TRUE)

Returns. A new TimeSeriesM ath object
Generated Exceptions. Throws a HecMathException if the
number ToAverageOver is less than three or not odd.

8.15.11 Conic Interpolation from Elevation/Area Table

coniclnterpolation(Ti meSeri esMat h t sDat a,
string inputType,
string output Type,
fl oati ng-poi nt storageScal eFactor )

Use the conic interpolation table in the current paired data set to develop a
new time series data set from the interpolation of tsData.

The current paired data should be an Elevation-Areatable. However, the
first data pair istheinitial conic depth, and the storage value at the first
elevation in thetable. If theinitial conic depth is undefined, the function
will calculate avaue. Elevation-Areavauesin the table must bein
ascending order.

tsData is either atime series of reservoir elevation or storage. Thetypeis
specified by setting inputType as "S(TORAGE)" or "E(LEVATION)".
The desired output time seriestype is similarly set using outputType. The
valid settings for outputType are "S(TORAGE)", "E(LEVATION)" or
"A(REA)". inputType and outputType must not be the same.

storageScaleFactor is an optional parameter used to scale input (by
multiplying) and output (by dividing) storage values. For example, if the
areain the conic interpolation table is expressed in square fest,
storageScal eFactor could be set to 43,560 to convert the storage output to
acre-feet.

Parameter type in the new time seriesis set according to outputType. |If
the output time series values are elevation, the time series units are set to
the paired datax-units label. If the output time series values are area, the
time series units are set to the paired data y-units label. If the output is
storage, the units are not set and should be set by the user with the setUnits
function.

See also: setUnits()

Parameters:
t sDat a — A TimeSeriesMath object representing elevation or
storage.
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i nput Type — A string specifying the parameter type for the input

time series, either "S(TORAGE)" or "E(LEVATION)". Only the

first character of the string is interpreted by the function.

out put Type — A string specifying the parameter type for the output

time series, either "S(TORAGE)", "E(LEVATION)" or "A(REA)".

Only thefirst character of the string is interpreted by the function.

st or ageScal eFact or — A floating-point number used to scale input

(by multiplying) and output (by dividing) storage values.
Examples:

tsStorage =

coni cEl evAr eaCurve. coni cl nt er pol ati on(

t sEl ev,

“El evation”,

“Storage”,
1.0)

tsArea =

coni cEl evAreaCurve. coni cl nt er pol ati on(
t skl ev,

“El evati on”,

“Area”,

1.0)

Returns. A new TimeSeriesM ath object

Generated Exceptions. Throws a hec.hecmath.HecMathException if
inputType or outputType cannot be interpreted as one of the allowed
values; if inputType and outputType are the same parameters; if values
in the conic interpolation table are not in ascending order.

8.15.12 Convert Values to English Units

convertToEnglishUnits()

Perform unit conversion of data values and unit l1abels in the current time
series or paired data set from Metric (SI) units to English units.
Determination of the unit system will be based upon the current units
labels and parameter types. If the data units are already in English units or
the unit system cannot be determined, no conversion occurs.

For paired data, both x and y values are converted. For time series data,
missing values remain missing.

See also: convertToMetricUnits(), isEnglish(), isMetric()

Example: engli shDat aSet = si Dat aSet . convert ToEngl i shUni t s()
Parameters. Takes no parameters

Returns. A HecMath object of the same type as the current object

8.15.13 Convert Values to Metric (Sl) Units

convertToMetricUnits()
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Perform unit conversion of data values and unit labels in the current time
series or paired data set from English units to Metric (SI) units.
Determination of the unit system will be based upon the current units
labels and parameter types. If the units are already in Metric units or the
unit system cannot be determined, no conversion occurs.

For paired data, both x and y values are converted. For time series data,
missing values remain missing.

See also: convertToEnglishUnits(), isEnglish(), isMetric()
Parameters. Takes no parameters

Example: si Dat aSet = engl i shDataSet.convert ToMetri cUnits()
Returns. An HecMath object of the same type as the current object

8.15.14 Correlation Coefficients

correlationCoefficients(Ti neSeri esvat h t sDat a)

Computes the linear regression and other correlation coefficients between
datain the current time series and tsData. Vauesin the current time
series and tsData are matched by time to form data pairs for the
correlation analysis. The data sets may be either regular or irregular time
interval data.

The correlations statistics computed by the function are:

Number of Valid Vaues

Regression Constant

Regression Coefficient

Determination Coefficient

Standard Error of Regression
Adjusted Determination Coefficient
Adjusted Standard Error of Regression

These values are contained in a L inear Regr essionStatistics object. The
current TimeSeriesM ath object forms the values of the independent
variable (x-values), while values of the second time series comprise the
dependent variable (y-values). The linear regression coefficients thus
express how values in the second data set can be derived from valuesin
the primary data set:

TS2(t) = a+ b * TSL(t)

where "a" isthe regression constant and "b" the regression coefficient.
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See also: LinearRegressionStatistics
Parameters: tsData - A TimeSeriesM ath object that forms the
dependent variable for the regression analysis

Example:
| i near Regressi onData =
tsDat a. correl ati onCoef fi ci ents(ot her TsDat a)

Returns. A Linear RegressionStatistics object holding the correlation
data.

Generated Exceptions. Throws an hec.hecmath.HecMathException if
the times in the current time series do not exactly match timesin
tsData.

8.15.15 Cosine Trigonometric Function

cos()

Derive anew time series or paired data set from the cosine of values of the
current data set. The resultant data set values are in radians. For time
series data, missing values are kept as missing.

For paired data sets, use the setCurve (see Sections 8.15.107 and 8.15.108)
function to first select the paired data curve (or al curves) to apply the
function. By default the function is applied to all paired data curves.

See also: setCurve()

Example: newDat aSet = dat aSet. cos()

Parameters. Takes no parameters

Returns. A HecMath object of the same type as the current object

8.15.16 Cyclic Analysis (Time Series)

cyclicAnalysis()

Derive aset of cyclic statistics from the current regular interval time series
data set. Thetime series data set must have atime interval of "1HOUR",
"1IDAY" or "IMONTH". The function sorts the time series values into
statistical "bins’ relevant to thetime interval. Valuesfor the IHOUR
interval data are sorted into twenty-four bins representing the hours of the
day, 0100 to 2400. The 1DAY interval datais apportioned to 365 bins for
the days of the year. The IMONTH interval datais sorted into tweleve
bins for the months of the year.

The format of the resultant data setsis as a "pseudo” time series for the
year 3000. For example, the cyclic anaysis of one month of hourly
interval datawill produce pseudo time series data sets having twenty-four
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hourly values for the day January 1, 3000. If the statistical parameter is
the "maximum" value, then the twenty-four values represent the maximum
value occurring at that hour of the day in the current time series. The
cyclic analysis of daily interval datawill produce pseudo time series data
sets having 365 daily values for the year 3000. The cyclic analysis of
monthly interval data will result in pseudo time series data sets having
twelve monthly values for the year 3000.

Fourteen pseudo time series data sets are derived by the cyclic analysis
function for the following statistical parameters:

Number of values processed for each timeinterval
Maximum value

Time of maximum value

Minimum value

Time of minimum value

Average value

Probability exceedence percentiles for 5%, 10%, 25%, 50%
(median value), 75%, 90%, and 95%

Standard deviation

The fourteen pseudo time series of cyclic statistics are returned by the
function as an array of time series data sets. The parameter part of the
record path for each time seriesis modified to indicate the type of the
statistical parameter. For aflow record, the parameter "FLOW" would
become "FLOW-MAX" for the maximum values statistics, "FLOW-P5"
for the five percent percentile statistics, etc.

Parameters. Takes no parameters

Example: cyclicbata = tsData. cyclicAnal ysis()

Returns. A sequence of fourteen TimeSeriesM ath objects, each of
which is a pseudo time series data sets representing a statistical
parameter.

Generated Exceptions. Throws a hec.hecmath.HecMathException if
the time seriesis not regular interval or does not have atimeinterval of
"1HOUR", "1DAY", or "1IMONTH".

8.15.17 Decaying Basin Wetness Parameter

decayingBasinWetnessParameter( Ti neSeri esMat h t sPreci p,
fl oati ng-poi nt decayRate)

Compute atime series of decaying basin wetness parameters from the
regular interval time series data set of incremental precipitation, tsPrecip,
by:
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TSResult(t) = Rate* TSResult(t-1) + TSPrecip(t)
where Rate is decayRate, and 0 < Rate < 1.

Thefirst value of the resultant time series data set, TSResult(1), is set to
thefirst value in the current time series data set. The current time series
data set can be the same time series data set astsPrecip. Missing values
in the precipitation time series are taken as zero when applying the above
eguation.

Parameters:
t sPreci p —A regular interval TimeSeriesMath object representing
precipitation
decayRat e — afloating-point number in the range O < decayRate < 1.

Example:
tsWet ness =

t sPreci p. decayi ngBasi nWet nessPar anet er (
t sPrecip,
0. 87)

Returns. A new TimeSeriesM ath object

8.15.18 Divide by a Constant

divide(fl oati ng- poi nt constant)

Divide dl valid valuesin the current time series or paired data set by the
value constant. For time series data, missing values are kept as missing.
For paired data, constant divides the y-values only. Use the setCurve
method to select the paired data curve(s).

See also: divide(TimeSeriesMath tsData); setCurve()
Parameters:

constant - A floating-point value to divide the valuesin the
current data set (cannot be zero)

Example: newbDat aSet = dat aSet . di vi de(1. 1)

Returns. A new HecM ath object of the same type as the current
object

8.15.19 Divide by a Data Set

divide(Ti neSeri esivat h t sDat a)

Divide valid values in the current data set by the corresponding valuesin
the data set tsData. Both data sets must be time series data sets.
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When dividing one time series data set by another, there is no restriction
that timesin the two data sets match exactly. However, only values with
coincident times will be divided. Timesin the current time series data set
that cannot be matched with times in the second data set are set to missing.
Valuesin the current data set that are missing are kept asmissing. If a
value in the second data set is zero or missing, the value in the resultant
data set is set to missing (divide by zero not alowed). Either or both data
sets may beregular or irregular interval time series.

See also: divide(floating-point constant)

Parameters. tsData - A time seriesdata set

Example: newTsData = tsDat a. di vi de( ot her TsDat a)
Returns. A new TimeSeriesM ath object

8.15.20 Estimate Values for Missing Precipitation Data

estimateForMissingPrecipValues(i nt eger nmaxM ssi ngAl | owed)

Linearly interpolate estimates for missing values in the current regular or
irregular interval time series data set. The current data set is expected to
be cumulative precipitation and the data must be of type "INST-CUM".
Use the estimateFor MissingValues method for filling missing valuesin
other types of time series data.

The rules used for interpolation of missing cumulative precipitation data
are:

m If the values bracketing the missing period are increasing with
time, only interpolate if the number of successive missing values
does not exceed the value of maxMissingAllowed.

m If the values bracketing the missing period are decreasing with
time, do not estimate for any missing values.

m If the values bracketing the missing period are equal, then estimate
any number of missing values.

See also: estimateForMissingValues()
Parameters. maxM ssi ngAl | owed - aninteger valuefor the
maximum number of consecutive missing values between valid values

Example:
newPreci p =tsPreci p. esti mat eFor M ssi ngPr eci pVal ues(5)

Returns. A new TimeSeriesM ath object

8.15.21 Estimate Values for Missing Data

esti mat eFor M ssi ngVal ues (integer maxMissingAllowed)
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Linearly interpolate estimates for missing values in the current regular or
irregular interval time series data set. Do not interpolate if the number of
successive missing values exceeds maxMissingAllowed.

Seealso: estimateForMissingPrecipVaues()

Parameters. maxM ssi ngAl | owed - aninteger value for the
maximum number of consecutive missing values allowed for
interpolation

Example: newTsData = tsData. esti mat eFor M ssi ngVal ues(5)
Returns. A new TimeSeriesMath object

8.15.22 Exponent

exp()

Derive anew time series or paired data set which is the e raised to the
values of the current time series. For time series data, values that are
missing in the current time series remain missing in the new time series.
Also, valuesless than 0.0 will be set to missing the new time series.

For paired data sets, use the setCurve method to first select the paired data
curve(s).

Seealso: setCurve()

Parameters. Takes no parameters

Example: squar edDat aSet = dat aSet . exp()

Returns. A new HecM ath object of the same type as the current
object

8.15.23 Exponentiation Function

exponentiation(fl oati ng- poi nt constant)

Derive anew time series or paired data set from the exponentiation of
valuesin the current data set by constant, by:

T2 (i) = T23i)™™"

For time series data, values that are missing in the current time series
remain missing in the new time series.

For paired data sets, use the setCurve method to first select the paired data
curve(s).

See also: setCurve()
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Parameters. const ant —afloating-point value representing the
exponent.

Example: squar edDat aSet = dat aSet. exponenti ation(2.)
Returns. A new HecM ath object of the same type as the current
object

8.15.24 Exponentiation Timeseries Function

exponentiation(HecMat h t sMat h)

Raise values in the current time series to the power of the parameter time
series, tsMath. A new time series will be created which duplicates the
time points of the current time series. Where time points match for the
current time series and tsM ath, the value in the current timeseries will be
raised to the power of the value in tsM ath provided both values are valid
(not missing). Pointsin the current time series which cannot be matched
tovalid pointsin tsMath are set to missing. Vauesin the current time
series which are missing remain missing in the new time series.The new
time series will aways have quality defined. If a specific quality valuein
the parameter time series is questionable or rejected, that quality will be
copied to the new time series.

Parameters. tsMath the time series of exponents for the current time
series.

Example: squaredDat aSet = dat aset . exponent i at i on(HecMath
tsMath)

Returns: anew time series resulting from the subtraction operation..
Derive anew time series or paired data set from the exponentiation of
valuesin the current data set by constant, by:

T2 (i) = T2(3)o

For time series data, values that are missing in the current time series
remain missing in the new time series. For paired data sets, use the
setCurve method to first select the paired data curve(s).

Seealso: setCurve()

Parameters. const ant —afloating-point value representing the
exponent.

Example: squaredDat aSet = dat aSet. exponenti ation(2.)
Returns. A new HecM ath object of the same type as the current
object.

8.15.25 Extract Time Series Data at Unique Time Specification

extractTimeSeriesDataForTimeSpecification(
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string tineLevel String,
string rangeString,

bool ean i sl ncl usi ve,

i nteger interval W ndow,
bool ean set Aslrregul ar )

Select/extract data points from the current regular or irregular interval time
series data set based upon user defined time specifications. For example,
the function may be used to extract from hourly interval data, the values
observed every day at noon.

timeLevelString defines the time level/interval for extraction (year,
month, day of the month, day of the week, or twenty-four hour time).

rangeString defines the interval range for data extraction applicable to
thetimelevel. For example, if timeLevelSring is"MONTH”, avalid
range would be "JAN-MAR". TherangeString variable can definea
singleinterval value (e.g. "JAN" - select data from January only) or a
beginning and ending range (e.g. "JAN-MAR" - select data for January
through March). The valid timeLevel String and rangeString values are
shown in Table 8.32.

Table 8.32 Valid timelevel String and rangeString Values

timeL evelString rangeString ExamplerangeString
"YEAR" Four-digit year value "1938" or "1938-1945"
"MONTH" Standard three-character abbreviation | "JAN" or "JAN-MAR"
for month or
“OCT-FEB”
"DAYMON(TH)" | Day of the month or "LASTDAY" "15" or "1-15 or "27-5"
string or
"16-LASTDAY"
"DAYWEE(K)" | Standard three-character abbreviation | "MON" or "SUN-TUE"
for day of the week or
"FRI-WED"
"TIME" Four digit 24-hour military-style "'2400" or "0300-0600"
clock time or
"2200-0130"

If desired, you may use one of the enumerated string constants to specify

timeLevel String:
Year TimeSeriesMath.LEVEL_YEAR_STRING
Month TimeSeriesMath. LEVEL_MONTH_STRING

Day of Month TimeSeriesMath. LEVEL_DAYMONTH_STRING
Day of Week TimeSeriesMath.LEVEL_DAYWEEK_STRING
24-hour time TimeSeriesMath.LEVEL_TIME_STRING
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The parameter islnclusive determines whether the data extraction
operation is either inclusive or exclusive of the specified range. For
example, if isinclusiveis"True" and the rangeis set to "JAN-MAR" for
the"MONTH" time level, the extracted datawill include al datain the
months January through March for al the years of time series data. If
isinclusive is"False" for this example, the extracted data covers the time
April through December (is exclusive of the period January through
March).

intervalWindow is only used when the timeLevel Sring is"TIME.”
intervalWindow is the minutes before and after the time of day within
which the datawill be extracted. intervalWindow effectively increases the
time range at the beginning and end intervalWindow minutes. For
example, with arangeString of "0300" and an intervalWindow of 10, data
will be extracted from the selected time series if times falls within in the
period 0250 to 0310.

setAslrregular defines whether the extracted data is saved as regular
interval or irregular interval data. Most often the time series data formed
by the extraction process will no longer be regular interval, and
setAslrregular should be set to "True". Setting setAslrregular to "False"
will force an attempt to save the data as regular interval time data.

Parameters:
ti meLevel String —A string specifying the time level selection.
rangeSt ri ng — A string specifying time or time range for selection.
Must be consistent with timeLevel String.
i sl nclusive —Either True or False, value. If true, datais
extracted inclusive of the range specified by rangeString. If false,
datais extracted exclusive of the range specified by rangeString.
i nt er val W ndow— An integer value representing the minutes before
and after the time of day within which the data will be extracted.
Only applied when the timeLevel Sring is"TIME".
set Asl rregul ar — Either True orFalse, value. If true, datais
automatically set asirregular time interval data. If false, the function
will attempt to classify the data as regular time interval data

Example:
Sel ectedData =
t sDat a. ext ract Ti meSer i esDat aFor Ti neSpeci fi cati on(
“ DAYMONTH"
“16- LASTDAY”,
TRUE,
0,
TRUE)
Returns:. A new TimeSeriesM ath object
Generated Exceptions. Throwsa hec.hecmath.HecMathException if
the function could not successfully interpret timelLevel Sring or

rangestring.
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8.15.26 First Valid Date

firstvalidData()
Find the date and time of thefirst valid time series value

Seealso: firstvVaidvaue()

Parameters. Takes no parameters

Example: squar edDat aSet = dataSet.firstValidData()
Returns: An integer representing the date and time of thefirst valid
value as an integer value trandlatable by HecTime.

8.15.27 First Valid Value

firstvalidvalue()
Find thefirst valid value in the time series

Seealso: firstValidDate()

Parameters. Takes no parameters

Example: squaredDat aSet = dataSet.firstValidval ue ()
Returns. The floating-point value of the first valid time series value

8.15.28 Floor Function

floor()

Derive atime series or paired data set with values of the current time
series rounded down to the nearest whole number that is less than or equal
to the value. For time series data, missing values are kept as missing.

For paired data sets, use the setCurve method to first select the curve(s).

See also: setCurve(), ceil()
Example: newDataSet = dataSet. fl oor ()
Parameters. Takes no parameters

Returns. A new HecM ath object of the same type as the current
object

8.15.29 Flow Accumulator Gage (Compute Period Average
Flows)

flowAccumulatorGageProcessor( Ti meSeri esMat h t sCount s)
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Derive anew time series of period-average flows from aflow accumulator
type gage. The current time series is assumed to containe the accumul ated
flow data, while the parameter time series, tsCounts, is assumed to have
the corresponding time series of counts. The two time series data sets
must match times exactly. The two time series are combined to compute a
new time series of period average flow:

TsNew(t) = (TsAccHow(t) - TsAccFlow(t-1) ) /( TsCount(t) - TsCount(t-1))

where TsAccFlow is the gage accumulated flow time series and TsCount is
the gage time series of counts.

In the above equation, if TsAccHow(t), TsAccHow(t-1), TsCount(t) or
TsCount(t-1) are missing, TsNew(t) is set to missing. The new time series
is assigned the data type "PER-AVER".

Parameters. tsCounts —A TimeSeriesMath object containing the
counts.

Example:
t sPer AvgFl ow =
t sAccuntl ow. f | owAccumul at or GagePr ocessor (t sCount s)

Returns: A new TimeSeriesMath object.
Generated Exceptions. Throws a hec.hecmath.HecMathException if
timesin the current object do not exactly match the timesin tsCounts,

8.15.30 Modulo Function with both Arguments are Greater
than Zero

fmod( HecMat h t sMat h)

Return the remainder of integer division of current time series by the
parameter time series, tsMath. A new time series will be created which
duplicates the time points of the current time series, where time points
match for the current time series and tsM ath, the value in the current time
series will be devided by the value in tsMath provided both values are
valid (no missing). Devide by zero is not allowed.When thetsMath time
series value is zero, the value for the new time series will be set to
missing. Also, pointsin the current time series which can not be match to
valid pointsin tsMath are set to missing. For time series data, missing
values are kept as missing. The new time series will always have quality
defined. If a specific quality value in the parameter time seriesis
guestionable or rejected, that quality will be copied to the new time series.

For paired data sets, use the setCurve method to first select the curve(s).

See also: setCurve(),modulo()
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Parameters:
tsMath the time seriesto be divided into the current time series.
const ant — afloating-point value representing the exponent.
Example: squaredDat aSet = dataSet . fnod(2.)
Returns. A new HecM ath object of the same type as the current
object.

8.15.31 Forward Moving Average Smoothing

forwardMovingAverage(i nt eger nunber ToAver ageOver)

Derive anew time series from the forward moving average of

number ToAverageOver values in the current time series.

number ToAverageOver must be an integer greater than two. If the
averaging interval contains amissing value, the smoothed valueis
computed from the remaining valid valuesin the interval. However, if
there are less than two valid values in the interval, the value in the
resultant data set is set to missing.

Parameters. nunber ToAver ageOver —An integer containing the
number of values to average over for computing the forward moving
average.

Example: tsAveraged = tsDat a. forwar dMovi ngAver age( 4)
Returns: A new TimeSeriesM ath object.

Generated Exceptions. Throws a hec.hecmath.HecMathException if
the number ToAverageOver isless than two.

8.15.32 Forward Moving Average Smoothing of Time Series

forwardMovingAverage(i nt eger nunber ToAver ageOver, Bool ean
onl yVval i dval ues, Bool ean useReduced)

Derive anew time series from the forward moving average of the last
number ToAverageOver values of the current time series. If
onlyValidValuesis set to true, then if pointsin the averaging interval are
missing values, the point in the new time seriesis set to missing. If
onlyValidValuesis set to false and missing values are contained in the
averaging interval, a smoothed point is still computed using the valid
valuesin theinterval. If there are no valid valuesin the averaging
interval, the point in the new time seriesis set to missing.

If useReduced is set to true, then forward moving average points can be
still be computed at the beginning of the time series even if there are less
than number ToAverageOver valuesin theinterval. If useReduced is set to
false, then the first number ToAverageOver points of the new time series
are set to missing.
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Parameters:
nunber ToAver ageOver — An integer containing the number of
valuesto average over for computing the forward moving average.
onl yVal i dval ues — Either True or False, specifying whether al
valuesin the averaging interval must be valid for the computed point
in the new time series to be valid.
useReduced — Either True or False, specifying whether to allow
points at the beginning and end of the resultant time seriesto be
computed from areduced ( less than number ToAverageOver) set of
points.

Example: tsAveraged = tsDat a. f or war dMovi ngAver age
(4, TRUE, TRUE)

Returns. A new time series computed from the forward moving
average of current time series.

Generated Exceptions. Throws a hec.hecmath.HecMathException if
the number ToAverageOver isless than two.

8.15.33 Generate Data Pairs from Two Time Series

generateDataPairs(Ti neSeri esMath tsData, Bool ean sort)

Generate a paired data set by pairing values (by time) from the current
time series data set and the time series data set tsData. The values of the
current time series form the x-ordinates, while values from tsData form
the y-ordinates of the resulting paired data set. Thetimesin the two time
series data sets must match exactly. If avauefor atimeismissingin
either time series, no data value pair is formed or added to the paired data
set. If sortis"True", datapairsin the paired data set are sorted by
ascending x-value.

The units and parameter type from the current time series data set are
assigned to the paired data set x-units and x-parameter type. The units and
parameter type from tsData are assigned to the paired data set y-units and
y-parameter type.

An example application of the function would be to mate a time series
record of stage to one of flow to generate a stage-flow paired data set.

Parameters:
tsData —A TimeSeriesMath object that forms the y-ordinates of
the resulting paired data set.
sort — Either True or False, value. If true, sort datapairsin
ascending x-value. If false, leave unsorted.
Example ratingCurve = tsStage. gener at eDat aPai r s(tsFl ow)
Returns: A PairedDataM ath object with x-ordinates from the current
time series, and y-ordinates from tsData.
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Generated Exceptions: Throws a hec.hecmath.HecMathException if
times from the current time series and tsData do not match exactly.

8.15.34 Generate a Regular Interval Time Series

generateRegularintervalTimeSeries(string startTi meStri ng,
string endTi neString,
string tinelnterval String,
string tineCffsetString,
fl oating-point initial Val ue)

Generate anew regular interval time series data set from scratch with
times and values specified by the parameters. Thisisafunction provided
by the TimeSeriesM ath module, and not an object method.

The parameters startTimeString and endTimeString are strings used to
specify the beginning and ending time of the generated data set. These
two parameters have the form of the standard HEC time string (e.g.
"01JAN2001 0100").

Theregular timeinterval is specified by timelnterval Sring, and isavalid
HEC time increment string (e.g. "1IMIN", "15MIN", "1IHOUR",
"6HOUR", "1DAY", "IMONTH?").

timeOffsetSring is used to shift timesin the resultant time series from the
standard interval time. Asan example, the offset could be used to shift
timesin regular hourly interval data from the top of the hour to six
minutes past the hour. The parameter has the form "nT", where"n" isan
integer number and "T" is one of the time increments: "M(INUTES)",
"D(AYS)", "H(OUR)", "W(EEKS)", "MON(THS)" or "Y (EARS)" (
charactersin the parenthesis are optional ). For example, atime offset of
nine minutes would be expressed as"9M" or "9MIN".

Vauesin the time series data set are initialized to initial Value.

Parameters:
start Ti meStri ng - astring specifying a standard HEC time
defining the time series data start date/time.
endTi meSt ri ng - astring specifying a standard HEC time defining
the time series data end date/time.
ti mel nterval String - astring specifying avalid DSS regular time
interval which defines the time interval of the new time series.
ti meOf f set St ri ng —astring specifying the offset of the new time
points from the regular interval time. This string may be an empty
string or None.
i nitial Val ue - afloating-point number set to the initial value for
all time series points. Set to HecMath.UNDEFINED to set all vaues
to missing.
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Example:
newTsDat a=Ti meSer i eshat h. gener at eRegul ar | nt er val Ti meSeri es(

“01FEB2002 0100,
“28FEB2002 2400”,
“ 1HOUR’,
“OM,
100.)
Returns. A new regular interval TimeSeriesM ath object initialized to
initialValue. Data units and type are unset.
Generated Exceptions. Throws a hec.hecmath.HecMathException if
time parameters cannot be successfully interpreted.

8.15.35 Get Data Container
getData()

Returns a copy of the hec.io.DataContainer for the current data set. For
time series data sets, returns a hec.io. TimeSeriesContainer. For paired
data sets, returns a hec.io.PairedDataContainer.

The hec.io.TimeSeriesContainer contains the time series values for atime
series data set. The hec.io.PairedDataContainer contains the paired data
values for apaired data set.

Parameters. Takes no parameters
Example: contai ner = dat aset . get Dat a()
Returns: A hec.io.DataContainer

8.15.36 Get Data Type for Time Series Data Set
getType()
Get the datatype for atime series data set.

Parameters. Takes no parameters

Example: dataSet.getType()
Returns. A string - "INST-CUM", "INST-VAL", "PER-AVER" or

"PER-CUM".

8.15.37 Get Units Label for Data Set

getuUnits()

Get the units label of the current data set. For a paired data set, returns the
y-units label.
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Parameters. Takes no parameters
Example: dat aSet. get Uni ts()
Returns: A string

8.15.38 Gmean

gnean(list of HecMath tshMathArray)

Determine the geometric mean of the current time series and the each time
seriesin the parameter, tsMathArray. A new time series will be created
which duplicates the time points of the current time series. Wheretime
points match for the current and tsMathArray, the values will be the
geometric mean of all time series for that time, provided the values for all
time series are valid values (not missing). Points in the current time series
which cannot be matched to valid pointsin tsMathArray are set to
missing. Vauesin the current time series which are missing remain
missing in the new time series.

The new time series will always have quality defined. For a specific time,
if any of the quality valuesin the current or parameter time seriesis
guestionable or rejected, the quality value for that time in the new time
series will be set to the most severe quality for that time (e.g. if
guestionable and rejected are both encountered, the new quality will be set
to rejected.)

Parameters. tsMathArray the array of time series to be compared with
the current time series.

Example: newDat aSet = dataSet. gmean(list of HecMath
t sMat hAr r ay)
Returns. anew time series representing the geometric mean of all

time series.

8.15.39 Hmean

hmean(list of HecMath tsMathArray)

Determine the harmonic mean of the current time series and the each time
seriesin the parameter, tsMathArray. A new time series will be created
which duplicates the time points of the current time series. Wheretime
points match for the current and tsMathArray, the values will be the
harmonic mean of all time series for that time, provided the values for all
time series are valid values (not missing). Points in the current time series
which cannot be matched to valid pointsin tsMathArray are set to
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missing. Vauesin the current time series which are missing remain
missing in the new time series.

The new time series will always have quality defined. For a specific time,
if any of the quality valuesin the current or parameter time seriesis
guestionable or rejected, the quality value for that time in the new time
series will be set to the most severe quality for that time (e.g. if
guestionable and rejected are both encountered, the new quality will be set
to rejected.)

Parameters. tsMathArray the array of time series to be compared with
the current time series.

Example: newbDat aSet = dataSet. hmean(list of HecMath
t sMat hAr r ay)

Returns. anew time series representing the harmonic mean of al time
series.

8.15.40 Integer Division by a Constant

integerDivide(fl oati ng- poi nt constant)

Divide valuesin the current time series by a constant and truncate the
result to an integer value. Timesin which values are missing in the
current time series remain missing in the new time series.

Parameters. constant the value to divide valuesin current time series.
Example: dat aSet . i nt eger Di vi de(2. 0)

Returns: anew time series resulting from the integer division
operation.

8.15.41 Integer Divison by an Object

integerDivide( HecMat h t siat h)

Divide the current time series by the parameter time series, tsMath and
truncate the result to an integer value. A new time series will be created
which duplicates the time points of the current time series. Wheretime
points match for the current time series and tsM ath, the value in the
current time series will be divided by the value in tsM ath provided both
values arevalid (not missing). Divide by zeroes are not alowed. When
thetsMath time series value is zero, the value for the new time series will
be set to missing. Pointsin the current time series which cannot be
matched to valid pointsin tsMath are set to missing. Vauesinthe
current time series which are missing remain missing in the new time
series.
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The new time series will always have quality defined. If a specific quality
value in the parameter time seriesis questionable or rejected, that quality
will be copied to the new time series.

Parameters: tsMath the time seriesto be divided into the current time

series.

Example: newDat aSet = dat aset . i nt eger Di vi de( HecMat h
t sMat h)

Returns. anew time series resulting from the integer division
operation.

8.15.42 Interpolate Time Series Data at Regular Intervals

interpolateDataAtRegularinterval(
string tinelnterval String,string timefsetString)

Derive aregular interval time series data set by interpolation of the current
regular or irregular interval time series data set.

The new timeinterval is set by timelnterval String which must be avalid
HEC timeinterval string (e.g. "IMIN", "15MIN", "1IHOUR", "6HOUR",
"1DAY", "IMONTH").

Times in the resultant time series may be shifted (offset) from the regular
interval time by the increment specified by timeOffsetSring. Asan
example, the offset could be used to shift times from the top of the hour to
six minutes past the hour. If no offset is used timeOffsetSring should be a
blank or empty string.

Whether the time series datatypeis"INST-VAL", "INST-CUM", "PER-
AVE", or "PER-CUM" controls how the interpolation is performed.
Interpolated values are derived from "INST-VAL" or "INST-CUM" data
using linear interpolation. Values are derived from "PER-AVE" data by
computing the period average value over thetime interval. Values are
derived from "PER-CUM" data by computing the period cumulative value
over the new time interval.

For example, if the original data set is hourly data and the new regular
interval data set isto have asix hour timeinterval:

Thevaluefor "INST-VAL" or "INST-CUM" type datais computed from
the linear interpolation of the hourly points bracketing the new six hour
time point.

The value for "PER-AVE" type data is computed from the period average
value over the six hour interval.
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The value for "PER-CUM" type datais computed from the accumul ated
value over the six hour interval.

The treatment of missing value datais also dependent upon data type.
Interpolated "INST-VAL" or "INST-CUM" points must be bracketed or
coincident with valid (not missing) valuesin the original time series,
otherwise the interpolated values are set as missing. Interpolated "PER-
AVE" or "PER-CUM" data must contain all valid values over the
interpolation interval; otherwise the interpolated value is set as missing.

Parameters:
ti mel nterval String— A string specifying the regular time interval
for the resultant time series.
ti meOf fset String —A string specifying the offset of the new time
points from the regular interval time. This variable may be an empty
string (" ).
Example:
newlsData =
t sDat a. i nt er pol at eDat aAt Regul ar | nt er val (
“15M N,
)
Returns. A new regular interval TimeSeriesMath object.

8.15.43 Inverse (1/X) Function

inverse()

Derive anew time series or paired data set from the inverse (1/x) of values
of the current data set. The inverse value is computed by 1.0 divided by
the value of the current data set. If adatavaueisequa to 0.0, the value
in the resultant data set is set to missing. For time series data, if the
original value is missing, the value remains missing in the resultant data
Set.

For paired data sets, use the setCurve method to first select the paired data
curve(s).

Seealso: setCurve()

Parameters. Takes no parameters

Example: newDat aSet = dataSet. i nverse()

Returns. A HecMath object of the same type as the current object.

8.15.44 Determine if Datais in English Units

iseEnglish()
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Determine if the current time series or paired data set isin English units.
The function examines the data set parameter type and units label to
establish the unit system.

See also: isMetric(); convertToEnglishUnits()

Parameters: No parameters

Example: if dataSet.isEnglish() : print “English Units”
Returns. Trueif the data set units are English, otherwise False.
Generated Exceptions. Throws a hec.hecmath.HecMathException if
the unit system cannot be determined (parameter type and units label
undefined).

8.15.45 Determine if Data is in Metric Units

isMetric()

Determineif the current time series or paired data set isin Metric (Sl)
units. The function examines the data set parameter type and units label to
establish the unit system.

See also: isEnglish(); convertToMetricUnits()

Parameters. Takes no parameters

Example: if dataSet.isMetric() : print “Sl Units”
Returns: Trueif the data set units are Metric, otherwise False.
Generated Exceptions: Throws a hec.hecmath.HecMathException if
the unit system cannot be determined (parameter type and units label
undefined).

8.15.46 Determine if Computation Stable for Given
Muskingum Routing Parameters
isMuskingumRoutingStable(i nt eger numnber Subr eaches,

fl oating-poi nt nuski ngunk,
fl oati ng-poi nt nuski ngumX)

Check for possible instability for the given Muskingum Routing
parameters.
Test if the input parameters satisfy the stability criteria
1/(2(1-x)) <= K/deltaT <= 1/2x
where deltaT = (time series time interval)/number Subreaches
Parameters:

nunber Subr eaches —integer specifying the number of routing
subreaches.
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muski ngunK —floating-point number specifying the Muskingum "K"
parameter, in hours.

muski ngunX - floating-point number specifying the Muskingum "x"
parameter, between 0.0 and 0.5 (inclusive).

Example:
war ni ng = tsDat aSet. i sMuski ngunRout i ngSt abl e(
reachCount,
kval ,
xVal )
if warning :
print warning
return
Returns. A string if the stability criteriais not met. The string
contains a warning message detailing the specific instability problem.
Otherwise returns None.
Generated Exceptions: Throws a hec.hecmath.HecMathException if
the current time seriesis not aregular interval time series, or if values

for number Subreaches or muskingumX are invalid.

8.15.47 Last Valid Value's Date and Time

lastValidDate()

Find and return the date and time of the last valid (non-missing) valuein a
time series data set.

Parameters. Takes no parameters

Example: tsData. | ast Val i dDat e()

Returns:. An integer value trandatable by HecTime representing the
date and time of the last valid time series value.

8.15.48 Last Valid Value in a Time Series

lastvalidvalue()

Find and return the last valid (non-missing) value in atime series data set.

Parameters. Takes no parameters

Example: tsData. | ast Val i dval ue()

Returns: A floating-point value representing the last valid time series
value.

8.15.49 Natural Log, Base "e" Function

log()
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Derive anew time series or paired data set from the natural log (log base
"e") of values of the current data set. Missing valuesin the origina data
set remain missing. Values less than or equal to 0.0 will be set to missing.

For paired data sets, use the setCurve method to first select the paired data
curve(s).

See also: 10g10(), setCurve()

Parameters. Takes no parameters

Example: newDat aSet = dataSet. | og()

Returns. A new HecM ath object of the same type as the current
object.

8.15.50 Log Base 10 Function
10g10()

Derive anew time series or paired data set from the log base 10 of values
of the current data set. Missing valuesin the original data set remain
missing. Values lessthan or equal to 0.0 will be set to missing.

For paired data sets, use the setCurve method to first select the paired data
curve(s).

Seealso: 1og(), setCurve()

Parameters. Takes no parameters

Example: newDat aSet = dat aSet .| 0g10()

Returns. A new HecM ath object of the same type as the current
object.

8.15.51 Maximum Value in a Time Series

max( )

Find and return the maximum value of the current time series data set.
Missing values are ignored.

Parameters. Takes no parameters

Example: maxVval = tsData. max()

Returns. A floating-point value representing the maximum value of
the current time series,
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8.15.52 Maximum Value in a Time Series (tsMathArrary)

max(list of HecMath tsMathArray)

Determine the maximum of the current time series and the each time series
in the parameter, tsMathArray. A new time series will be created which
duplicates the time points of the current time series. Where time points
match for the current and tsMathArray, the values will be the maximum of
all time seriesfor that time, provided the values for all time series are
valid values (not missing). Points in the current time series which cannot
be matched to valid pointsin tsMathArray are set to missing. Vauesin
the current time series which are missing remain missing in the new time
series.

The new time series will always have quality defined. For a specific time,
if any of the quality valuesin the current or parameter time seriesis
guestionable or regjected, the quality value for that time in the new time
series will be set to the most severe quality for that time (e.g. if
guestionable and rejected are both encountered, the new quality will be set
to regjected.)

Parameters. tsMathArray the array of time series to be compared with
the current time series,

Example: newDat aSet = dataSet.max(list of HecMath
t sMat hAr r ay)

Returns. anew time series representing the maximum values of all
time series.

8.15.53 Maximum Value's Date and Time

maxDate()

Find and return the date and time of the maximum vaue for the current
time series data set. Missing values are ignored.

Parameters. Takes no parameters

Example: maxDat eTi ne = tsDat a. maxDat e()

Returns. An integer value trandatable by HecTime representing the
date and time of the maximum time series value.

8.15.54 Mean Time Series Value

mean()
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Compute the mean value of the current time series data set. Missing
values are ignored.

Parameters. Takes no parameters

Example: neanval = tsData. mean()

Returns: A floating-point value representing the mean value of the
current time series.

8.15.55 Mean Time Series Value (tsMathArray)

mean(li st of HechMath tsMat hArray)

Determine the arithmetic mean of the current time series and the each time
seriesin the parameter, tsMathArray. A new time series will be created
which duplicates the time points of the current time series. Wheretime
points match for the current and tsMathArray, the values will be the
arithmetic mean of all time series for that time, provided the values for all
time series are valid values (not missing). Points in the current time series
which cannot be matched to valid pointsin tsMathArray are set to
missing. Vauesin the current time series which are missing remain
missing in the new time series.

The new time series will always have quality defined. For a specific time,
if any of the quailty valuesin the current or parameter time seriesis
guestionable or rejected, the quality value for that time in the new time
series will be set to the most severe quality for that time (e.g. if
guestionable and rejected are both encountered, the new quality will be set
to regjected.)

Parameters. tsMathArray the array of time series to be compared with
the current time series.

Example: newDat aSet = dat aSet.mean(list of HecMath
t sMat hAr r ay)
Returns. anew time series representing the arithmetic mean of all

time series.

8.15.56 Median Time Series Value

med(list of HecMath tsMathArray)

Determine the median (50th percentile) of the current time series and the
each time series in the parameter, tsMathArray. A new time serieswill be
created which duplicates the time points of the current time series. Where
time points match for the current and tsMathArray, the values will be the
median of all time series for that time, provided the values for all time
series are valid values (not missing). Points in the current time series
which cannot be matched to valid pointsin tsMathArray are set to
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missing. Vauesin the current time series which are missing remain
missing in the new time series.

The new time series will always have quality defined. For a specific time,
if any of the quailty valuesin the current or parameter time seriesis
guestionable or rejected, the quality value for that time in the new time
series will be set to the most severe quality for that time (e.g. if
guestionable and rejected are both encountered, the new quality will be set
to rejected.

Parameters. tsMathArray the array of time series to be compared with
the current time series.

Example: newDat aSet = dataSet.med(list of HecMath
t sMat hAr r ay)

Returns. anew time series representing the median of al time series.

8.15.57 Merge Paired Data Sets

mergePairedData( Pai r edDat avat h pdDat a)

Merge the current paired data set with the paired data set pdData. The
resultant paired data set includes al the paired data curves from the
current data set. Depending upon a previous use of the setCurveMethod
on pdData, a single selected paired data curve or all curves from pdData
are appended to the merged data set. The x-values for the two paired data
sets must match exactly.

See also: setCurve()

Parameters. pdDat a - a paired data set with x-ordinates matching
those of the current data set.

Example: nmer gedCurve = curve. ner gePai r edDat a( anot her Cur ve)
Returns. A new PairedDataMath object.

8.15.58 Merge Two Time Series Data Sets

nmer geTi neSeri es(TimeSeriesMath tsData)

Merge data from the current time series data set with the time series data
set tsData. The resultant time series data set includes all the data points in
the two time series, except where the data points occur at the same time.
When data points from the two data sets are coincident in time, valid
valuesin the current time series take precedence over valid values from
tsData. However, if acoincident point is set to missing in the current time
series data set, avalid value from tsData will be used for timein the
resultant data set. If the values are missing for both data sets, the value is
missing in the resultant data set.
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The data sets for merging may have either regular or irregular time
interval time series data. The data sets are tested to determine if they both
have the same regular time interval. If not, the resultant data set is typed
asanirregular interval data set.

Parameters. tsData - atime series data set for merging with the
current time series data set.

Example: tsMerged = tsData. mergeTi neSeri es(ot her TsDat a)
Returns: A new TimeSeriesM ath object.

8.15.59 Minimum Value in a Time Series
min()

Find and return the minimum value of the current atime series data set.
Missing values are ignored.

Parameters. Takes no parameters

Example: minval = tsData.mn()

Returns. A floating-point value representing the minimum value of
the current time series,

8.15.60 Minimum Value in a Time Series (tsMathArray)

min(list of HecMath tshathArray)

Determine the minimum of the current time series and the each time series
in the parameter, tsMathArray. A new time series will be created which
duplicates the time points of the current time series. Where time points
match for the current and tsMathArray, the values will be the minimum of
all time seriesfor that time, provided the values for all time series are
valid values (not missing). Points in the current time series which cannot
be matched to valid pointsin tsMathArray are set to missing. Vauesin
the current time series which are missing remain missing in the new time
series.

The new time series will always have quality defined. For a specific time,
if any of the quailty valuesin the current or parameter time seriesis
guestionable or regjected, the quality value for that time in the new time
serieswill be set to the most severe quality for that time (e.g. if
guestionable and rejected are both encountered, the new quality will be set
to regjected.)

Parameters. tsMathArray the array of time series to be compared with
the current time series,
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Example: newDat aSet = dataSet.m n(list of HecMath tsMathArray)
Returns. anew time series representing the minimum values of all
time series.

8.15.61 Minimum Value's Date and Time

minDate()

Find and return the date and time of the minimum value for the current
time series data set. Missing values areignored.

Parameters. Takes no parameters

Example: mi nDat eTi me = t sDat a. ni nDat e()

Returns. Aninteger value trandlatable by HecTime representing the
date and time of the minimum time series value.

8.15.62 Modified Puls or Working R&D Routing Function

modifFiedPulsRouting(Ti neSeri eshMat h t sFl ow,
i nt eger nunber Subr eaches,
fl oati ng-poi nt ruski ngumX)

The current data set is a paired data set containing the storage-discharge
table for Puls routing, where the x-values are storage and the y-values are
discharge. The function derives a new time series data set from the
Modified Puls or Working R& D routing of the time series data set tsFlow.
number Subreaches is the number of routing subreaches.

The Working R& D method provides a means of including the effects of
inflow on reach storage by use of the Muskingum "x" wedge coefficient.
The Working R& D method is activated in the computation if
muskingumX is greater than 0.0. However, muskingumX cannot be
greater that 0.5.

Parameters:
t sFl ow— A regular interval time series data set for routing.
nunber Subr eaches — Number of routing subreaches.
muski ngunmX - Muskingum " X" parameter, between 0.0 and 0.5
(inclusive). Enter 0.0 to route by the Modified Puls method, or a
value greater than 0.0 to apply the Working R&D.

Example:
rout edFl ow =
stor Di char eCurve. nodi fi edPul sRout i ng(
t sFl ow,
reachCount ,
coefficient)
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Returns: A new TimeSeriesM ath object.

Generated Exceptions: Throws a hec.hecmath.HecMathException if
thetsMath isnot aregular interval time series; if muskingumXisless
than 0.0 or greater than 0.5; if the current paired data set does not have
both ascending x and y values.

8.15.63 Modulo

modulo(fl oati ng- poi nt constant)

Return the remainder of integer division of current time seriesby a
constant. Times in which values are missing in the current time series
remain missing in the new time series.

Parameters. constant the value to divide valuesin current time series.
Example: newDat aSet = dat aSet. nodul o( fl oati ng-poi nt constant)
Returns. anew time series resulting from the operation.

8.15.64 Modulo (tsMath)

modulo( HecMat h t sMat h)

Return the remainder of integer division of current time series by the
parameter time series, tsMath. A new time series will be created which
duplicates the time points of the current time series. Where time points
match for the current time series and tsMath, the value in the current time
serieswill be divided by the value in tsM ath provided both values are
valid (not missing). Divide by zeroes are not allowed. When the tsMath
time series value is zero, the value for the new time series will be set to
missing. Pointsin the current time series which cannot be matched to
valid pointsin tsMath are set to missing. Vauesin the current time series
which are missing remain missing in the new time series.

The new time series will always have quality defined. If a specific quality
value in the parameter time series is questionable or rejected, that quality
will be copied to the new time series.

Parameters. tsMath the time series to be divided into the current time
series.

Example: newDat aSet = dat aSet. nodul o( HecMat h t sMat h)
Returns. anew time series resulting from the operation.
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8.15.65 Multiple Linear Regression Coefficients

multipleLinearRegression( sequence tsDat aSequence,
floating-point mninunlint,
fl oati ng-point maxi nunlinit)

Compute the multiple linear regression coefficients between the current
time series data set and the array of independent time series data setsin
tsDataSequence. The function stores the regression coefficientsin a new
paired data set. This paired data set may be used with the
multipleLinear Regression function to derive a new estimated time series
data set.

For the general linear regression equation, a dependent variable, Y, may
be computed from a set independent variables, Xn:

Y = BO+B1*X1+ B2*X2 + B3*X3
where Bn are linear regression coefficients.

For time series data sets, an estimate of the original time series data set
values may be computed from a set of independent time series data sets
using regression coefficients such that:

TsEstimate(t) = BO + B1*TSL(t) + B2*TS2(t) + ... + Bn*TSn(t)

where Bn are the set of regression coefficients and TSn are the time series
data sets contained in tsDataSequence.

The parameters minimumLimit and maximumLimit may be used to exclude
out of range values in the current time series data set from the regression
determination. minimumLimit or maximumLimit may be entered as
"Constants. UNDEFINED" to ignore the minimum or maximum value
check.

See also: applyMultipleLinearRegression()

Parameters:
t sDat aSequence — sequence of TimeSeriesMath objects, which
form the independent variables in the regression equation. Must al
be regular interval and have the same time interval .
m ni munti mi t — A floating-point value. Valuesin the current time
series exceeding minimumLimit are excluded from the regression
analysis. Set to Constants. UNDEFINED to ignore this option.
maxi munti mi t — A floating-point value. Valuesin the current time
series exceeding maximumLimit are excluded from the regression
analysis. Set to Constants. UNDEFINED to ignore this option.
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Example:
regression = tsFl ow mul tipl eLi near Regressi on (
[tsUpstrFlowl, tsUpstrFl ow2, tsUpstrFl ow3],
0.,
100000. )
Returns. A new PairedDataM ath object containing the computed
regression coefficients.
Generated Exceptions. Throws a hec.hecmath.HecMathException if
the current data set and the data sets in tsDataSequence are not regular
interval time series data sets with the same interval time.

8.15.66 Multiply by a Constant

multiply(fl oati ng-point constant)

Multiply the value constant to all valid values in the current time series or
paired data set. For time series data, missing values are kept as missing.
For paired data, constant multiplies the y-values only. Usethe
setCurveMethod to first select the paired data curve(s).

Seealso: multiply(TimeSeriesMath tsData); setCurve()
Parameters. constant - A floating-point precision value.
Example: newDat aSet = dataSet.multiply(1.5)

Returns. A new HecM ath object of the same type as the current
object.

8.15.67 Multiply by a Data Set

multiply(Ti meSeri eshMath tsDat a)

Multiply valid valuesin the current data set by the corresponding valuesin
the data set tsData. Both data sets must be time series data set.

When multiplying one time series data set to another, thereis no
restriction that times in the two data sets match exactly. However, only
values with coincident times will be multiplied. Timesin the current time
series data set that cannot be matched with timesin the second data set are
set to missing. Valuesin the current data set that are missing are kept as
missing. Either or both data sets may be regular or irregular interval time
series.

See also: multiply(floating-point constant)

Parameters. tsData - A time series data set.

Example: newTsData = tsData. nul tiply(other TsDat a)
Returns. A new TimeSeriesMath object.
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8.15.68 Muskingum Hydrologic Routing Function

muskingumRouting(i nt eger nunber Subr eaches,
fl oating-poi nt nuski ngunk,
fl oati ng-poi nt nuski ngumX)

Route the current regular interval time series data set by the Muskingum
Routing method. The current data set must be aregular interval time
series data set. muskingumK isthe Muskingum "K" parameter, in hours,
and muskingumX is the Muskingum "x" parameter. muskingumX cannot
be less than 0.0 or greater than 0.5.

The set of Muskingum routing parameters may potentially produce
numerical instabilities in the routed time series. Use the function
isMuskingumRoutingStable() to test if the Muskingum routing parameters
may potentially have instabilities.

See also: isMuskingumRoutingStable()

Parameters:
nunber Subr eaches — An integer specifying the number of routing
subreaches.
muski ngunK — A floating-point number specifying the Muskingum
"K" parameter in hours.
muski ngunX — A floating-point number specifying the Muskingum
"X" parameter, between 0.0 and 0.5

Example:
rout edFl ows = t sFl ows. muski ngunmRout i ng(reachCount, K, x)

Returns: A new TimeSeriesMath object.

Generated Exceptions. Throws a hec.hecmath.HecMathException if
the current time seriesis not aregular interval time series; if
muskingumX is less than 0.0 or greater than 0.5.

8.15.69 Negation Function

negative()

Derive anew time series composed of the negatives of the values of the
current time series.Values which are missing in the original time series
will be missing in the new time series.

Parameters. Takes no parameters

Example: newDat aSet = dat aSet . neg()

Returns. A new time series composed of the negatives of the values of
the current time series,
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8.15.70 Number of Invalid Values in a Time Series

numberInvalidvalues()

Count and return the number of invalid values in the current time series
data set.

Parameters. Takes no parameters

Example: inval i dCount = tsData. nunber | nval i dVal ues()
Returns: Aninteger of the count of invalid (non-missing) time series
values.

8.15.71 Number of Missing Values in a Time Series

numberMissingValues()

Count and return the number of missing valuesin the current time series
data set.

Parameters. Takes no parameters
Example: m ssingCount = tsData. nunber M ssi ngVal ues()
Returns: Aninteger of the count of missing time series values.

8.15.72 Number of Questioned Values in a Time Series

numberQuestionedValues()

Count and return the number of questioned values in the current time
series data set.

Parameters. Takes no parameters

Example: qui esti onedCount = tsData. nunber Quest i onedVal ues()
Returns. Aninteger of the count of questioned (non-missing) time
series values.

8.15.73 Number of Rejected Values in a Time Series

nunber Rej ect edVal ues()

Count and return the number of rejected values in the current time series
data set.

Parameters. Takes no parameters
Example: rej ect edCount = tsData. nunber Rej ect edVal ues()
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Returns. Aninteger of the count of rgected (non-missing) time series
values.

8.15.74 Number of Valid Values in a Time Series

numberValidvalues()

Count and return the number of valid valuesin the current time series data
Set,

Parameters. Takes no parameters

Example: val i dCount = tsData. nunber Val i dVal ues()
Returns: Aninteger of the count of valid (non-missing) time series
values.

8.15.75 Olympic Smoothing

olympicSmoothing(i nt eger nunber ToAver ageQver,
bool ean onl yVal i dVal ues,
bool ean useReduced)

Derive anew time series from the Olympic smoothing of

number ToAverageOver values in the current time series.

number ToAverageOver must be and odd integer and greater than. Similar
to centered moving average smoothing, except that the minimum and
maximum values over the averaging interval are excluded from the
computation.

If onlyValidValuesis set to true, then if any valuesin the averaging
interval are missing, the point in the resultant time seriesis set to missing.
If onlyValidValuesis set to false and there are missing values in the
averaging interval, a smoothed point is still computed using the remaining
valid valuesintheinterval. If thereareno valid valuesin the averaging
interval, the point in the resultant time seriesis set to missing.

If useReduced is set to true, then moving average values can be still be
computed at the beginning and end of the time series even if there are less
than number ToAverageOver valuesin theinterval. If useReduced is set to
false, then the first and last number ToAverageOver/2 points of the
resultant time series are set to missing.

Parameters:
nunber ToAver ageOver — An integer specifying the number of
values to average over for computing the smoothed time series. Must
be an odd integer greater than two.
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onl yVal i dval ues — Either True or False, specifying whether al
valuesin the averaging interval must be valid for the computed point
in the resultant time seriesto be valid.
useReduced - Either True or False, specifying whether to allow
points at the beginning and end of the smoothed time series to be
computed from areduced ( less than number ToAverageOver)
number of values. Otherwise, set the first and last
number ToAver ageOver/2 points of the new time series to missing.
Example: avgbData = tsDat a. ol ynpi cSnoot hi ng(5, )
Returns: A new TimeSeriesMath object.
Generated Exceptions. Throws aHecMathException if the
number ToAverageOver is less than three or not odd.

8.15.76 P1 Function

pl(list of HechMath tsMat hArray)

Determine the first percentile of the current time series and the each time
seriesin the parameter, tsMathArray. A new time series will be created
which duplicates the time points of the current time series. Wheretime
points match for the current and tsMathArray, the values will be the 1st
percentile of al time series for that time, provided the values for al time
series are valid values (not missing). Points in the current time series
which cannot be matched to valid points in tsMathArray are set to
missing. Vauesin the current time series which are missing remain
missing in the new time series.

The new time series will always have quality defined. For a specific time,
if any of the quailty valuesin the current or parameter time seriesis
guestionable or regjected, the quality value for that time in the new time
series will be set to the most severe quality for that time (e.g. if
guestionable and rejected are both encountered, the new quality will be set
to regjected.)

Parameters. tsMathArray the array of time series to be compared with
the current time series,

Example: newDat aSet = dataSet.pl(list of HecMath
t sMat hAr r ay)

Returns: anew time series representing the first percentile of al time
series.

8.15.77 P2 Function

p2(list of HechMath tsMat hArray)
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Determine the 2nd percentile of the current time series and the each time
seriesin the parameter, tsMathArray. A new time series will be created
which duplicates the time points of the current time series. Wheretime
points match for the current and tsMathArray, the values will be the 2nd
percentile of al time series for that time, provided the values for al time
series are valid values (not missing). Points in the current time series
which cannot be matched to valid pointsin tsMathArray are set to
missing. Vauesin the current time series which are missing remain
missing in the new time series.

The new time series will always have quality defined. For a specific time,
if any of the quailty valuesin the current or parameter time seriesis
guestionable or regjected, the quality value for that time in the new time
series will be set to the most severe quality for that time (e.g. if
guestionable and rejected are both encountered, the new quality will be set
to regjected.)

Parameters. tsMathArray the array of time series to be compared with
the current time series,

Examples: newDat aSet = dataSet.p2(list of HecMath tsiathArray)
Returns. anew time series representing the 2nd percentile of al time
series.

8.15.78 P5 Function

p5(1ist of HechMath tsMat hArray)

Determine the fifth percentile of the current time series and the each time
seriesin the parameter, tsMathArray. A new time series will be created
which duplicates the time points of the current time series. Wheretime
points match for the current and tsMathArray, the values will be the fifth
percentile of al time series for that time, provided the values for al time
series are valid values (not missing). Pointsin the current time series
which cannot be matched to valid pointsin tsMathArray are set to
missing. Vauesin the current time series which are missing remain
missing in the new time series.

The new time series will always have quality defined. For a specific time,
if any of the quailty valuesin the current or parameter time seriesis
guestionable or regjected, the quality value for that time in the new time
series will be set to the most severe quality for that time (e.g. if
guestionable and rejected are both encountered, the new quality will be set
to rejected.)

Parameters. tsMathArray the array of time series to be compared with
the current time series,
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Example: newDat aSet = dataSet.p5(list of HecMath tsMathArray)
Returns. anew time series representing the fifth percentile of all time
series.

8.15.79 P10 Function

plO(list of Hechath tshathArray)

Determine the tenth percentile of the current time series and the each time
seriesin the parameter, tsMathArray. A new time series will be created
which duplicates the time points of the current time series. Wheretime
points match for the current and tsMathArray, the values will be the tenth
percentile of al time series for that time provided the values for al time
series are valid values (not missing). Pointsin the current time series
which cannot be matched to valid pointsin tsMathArray are set to
missing. Vauesin the current time series which are missing remain
missing in the new time series.

The new time series will always have quality defined. For a specific time,
if any of the quality valuesin the current or parameter time seriesis
guestionable or rejected, the quality value for that time in the new time
series will be set to the most severe quality for that time (e.g. if
guestionable and rejected are both encountered, the new quality will be set
to rejected.)

Parameters. tsMathArray the array of time series to be compared with
the current time series.

Example: newDat aSet = dataSet.plO(list of HecMath tsMathArray)
Returns: anew time series representing the tenth percentile of al time
Series.

8.15.80 P20 Function

p20(li st of HecMath tshathArray)

Determine the 20th percentile of the current time series and the each time
seriesin the parameter, tsMathArray. A new time series will be created
which duplicates the time points of the current time series. Wheretime
points match for the current and tsMathArray, the values will be the 20th
percentile of al time series for that time, provided the values for al time
series are valid values (not missing). Points in the current time series
which cannot be matched to valid pointsin tsMathArray are set to
missing. Vauesin the current time series which are missing remain
missing in the new time series.
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The new time series will always have quality defined. For a specific time,
if any of the quailty valuesin the current or parameter time seriesis
guestionable or regjected, the quality value for that time in the new time
series will be set to the most severe quality for that time (e.g. if
guestionable and rejected are both encountered, the new quality will be set
to regjected.)

Parameters. tsMathArray the array of time series to be compared with
the current time series.

Example: newDat aSet = dataSet. p20(list of HecMath tsMathArray)
Returns. anew time series representing the 20th percentile of all time
series.

8.15.81 P25 Function

p25(1ist of HecMath tshathArray)

Determine the 25th percentile of the current time series and the each time
seriesin the parameter, tsMathArray. A new time series will be created
which duplicates the time points of the current time series. Wheretime
points match for the current and tsMathArray, the values will be the 25th
percentile of al time series for that time, provided the values for al time
series are valid values (not missing). Points in the current time series
which cannot be matched to valid pointsin tsMathArray are set to
missing. Vauesin the current time series which are missing remain
missing in the new time series.

The new time series will always have quality defined. For a specific time,
if any of the quailty valuesin the current or parameter time seriesis
guestionable or regjected, the quality value for that time in the new time
series will be set to the most severe quality for that time (e.g. if
guestionable and rejected are both encountered, the new quality will be set
to regjected.)

Parameters. tsMathArray the array of time series to be compared with
the current time series,

Example: newDat aSet = dataSet. p25(1ist of HecMath tsMathArray)
Returns. anew time series representing the 25th percentile of all time
series.

8.15.82 P75 Function

p75(list of HecMath tshathArray)

Determine the 75th percentile of the current time series and the each time
seriesin the parameter, tsMathArray. A new time series will be created
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which duplicates the time points of the current time series. Wheretime
points match for the current and tsMathArray, the values will be the 75th
percentile of al time series for that time, provided the values for al time
series are valid values (not missing). Points in the current time series
which cannot be matched to valid pointsin tsMathArray are set to
missing. Vauesin the current time series which are missing remain
missing in the new time series.

The new time series will always have quality defined. For a specific time,
if any of the quailty valuesin the current or parameter time seriesis
guestionable or regjected, the quality value for that time in the new time
series will be set to the most severe quality for that time (e.g. if
guestionable and rejected are both encountered, the new quality will be set
to regjected.)

Parameters. tsMathArray the array of time series to be compared with
the current time series,

Example: newDat aSet = dataSet.p75(list of HecMath tsMathArray)
Returns. anew time series representing the 75th percentile of all time
series.

8.15.83 P80 Function

p80(li st of HecMath tshathArray)

Determine the 80th percentile of the current time series and the each time
seriesin the parameter, tsMathArray. A new time series will be created
which duplicates the time points of the current time series. Wheretime
points match for the current and tsMathArray, the values will be the 80th
percentile of al time series for that time, provided the values for al time
series are valid values (not missing). Points in the current time series
which cannot be matched to valid pointsin tsMathArray are set to
missing. Vauesin the current time series which are missing remain
missing in the new time series. The new time series will always have
quality defined. For aspecific time, if any of the quailty valuesin the
current or parameter time series is questionable or regjected, the quality
value for that time in the new time series will be set to the most severe
quality for that time (e.g. if questionable and rejected are both
encountered, the new quality will be set to rejected.)

Parameters. tsMathArray the array of time series to be compared
with the current time series.

Example: newDat aSet = dataSet.p80(list of HecMath tsMathArray)
Returns. anew time series representing the 80th percentile of all time
Series.
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8.15.84 P89 Function

p89(list of Hechath tshathArray)

Determine the 89th percentile of the current time series and the each time
seriesin the parameter, tsMathArray. A new time series will be created
which duplicates the time points of the current time series. Wheretime
points match for the current and tsMathArray, the values will be the 89th
percentile of al time series for that time, provided the values for al time
series are valid values (not missing). Points in the current time series
which cannot be matched to valid pointsin tsMathArray are set to
missing. Vauesin the current time series which are missing remain
missing in the new time series. The new time series will always have
quality defined. For a specific time, if any of the quailty valuesin the
current or parameter time series is questionable or rejected, the quality
value for that time in the new time series will be set to the most severe
quality for that time (e.g. if questionable and rejected are both
encountered, the new quality will be set to rejected.)

Parameters. tsMathArray the array of time series to be compared with
the current time series,

Example: newDat aSet = dataSet. p89(list of HecMath tsMathArray)

Returns. anew time series representing the 89th percentile of all time
series.

8.15.85 P90 Function

p90(list of HecMath tshathArray)

Determine the 90th percentile of the current time series and the each time
seriesin the parameter, tsMathArray. A new time series will be created
which duplicates the time points of the current time series. Wheretime
points match for the current and tsMathArray, the values will be the 90th
percentile of al time series for that time, provided the values for al time
series are valid values (not missing). Points in the current time series
which cannot be matched to valid pointsin tsMathArray are set to
missing. Vauesin the current time series which are missing remain
missing in the new time series. The new time series will always have
quality defined. For a specific time, if any of the quailty valuesin the
current or parameter time series is questionable or rejected, the quality
value for that time in the new time series will be set to the most severe
quality for that time (e.g. if questionable and rejected are both
encountered, the new quality will be set to rejected.)

Parameters: tsMathArray the array of time series to be compared with
the current time series.
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Example: newbDat aSet = dataSet.p90(list of HecMath tsMathArray)
Returns: anew time series representing the 90th percentile of al time
series.

8.15.86 P95 Function

p95(list of HecMath tshathArray)

Determine the 95th percentile of the current time series and the each time
seriesin the parameter, tsMathArray. A new time series will be created
which duplicates the time points of the current time series. Wheretime
points match for the current and tsMathArray, the values will be the 95th
percentile of al time series for that time, provided the values for al time
series are valid values (not missing). Points in the current time series
which cannot be matched to valid pointsin tsMathArray are set to
missing. Vauesin the current time series which are missing remain
missing in the new time series. The new time series will always have
quality defined. For aspecific time, if any of the quailty valuesin the
current or parameter time series is questionable or regjected, the quality
value for that time in the new time series will be set to the most severe
quality for that time (e.g. if questionable and rejected are both
encountered, the new quality will be set to rejected.)

Parameters. tsMathArray the array of time series to be compared with
the current time series,

Example: newDat aSet = dataSet. p95(list of HecMath tsMathArray)

Returns. anew time series representing the 95th percentile of all time
series.

8.15.87 P99 Function

p99(li st of HechMath tshathArray)

Determine the 99th percentile of the current time series and the each time
seriesin the parameter, tsMathArray. A new time series will be created
which duplicates the time points of the current time series. Wheretime
points match for the current and tsMathArray, the values will be the 99th
percentile of al time series for that time, provided the values for al time
series are valid values (not missing). Points in the current time series
which cannot be matched to valid pointsin tsMathArray are set to
missing. Vauesin the current time series which are missing remain
missing in the new time series. The new time series will always have
quality defined. For a specific time, if any of the quailty valuesin the
current or parameter time series is questionable or rgjected, the quality
value for that time in the new time series will be set to the most severe
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quality for that time (e.g. if questionable and rejected are both
encountered, the new quality will be set to rejected.)

Parameters. tsMathArray the array of time series to be compared with
the current time series,

Example: newDat aSet = dataSet. p99(list of HecMath tsMathArray)

Returns. anew time series representing the 99th percentile of all time
series.

8.15.88 Period Constants Generation

periodConstants( Ti neSeri esivat h t sDat a)

Derive anew time series data set by applying values in the current time
series data set to the times defined by the time series data set tsData. Both
time series data sets may be regular or irregular interval. Valuesin anew
time series are set according to:

ts1(j) < tsnew(i) < tsl(j+1), TSNEW() = TSI1()

wheretsl is thetimein the current time series, TS1 isthe valuein the
current time series, tsnew isthe timein the new time series, TSNEW isthe
value in the new time series.

If timesin the new time series precede the first data point in the current
time series, the value for these timesis set to missing. If timesin the new
time series occur after the last data point in the current time series, the
value for these times is set to the value of the last point in the current time
series. Theinterpolation of values with the periodConstants function is
shown in Figure 8.13.

X Interpolated value

® Original TS data

Missing Values

/|

X X

Figure 8.13 Interpolation of Time Series VValues Using Period Constants Function

Parameters. tsData - aregular or irregular interval time series data
Set.
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Example: tsConstants = tsVal ues. peri odConst ant s( t sDat a)
Returns. A new TimeSeriesM ath object.

8.15.89 Polynomial Transformation

polynomialTransformation(Ti neSeri esMat h t sDat a)

Compute a polynomial transformation of aregular or irregular interval
time series data set, tsData, using the polynomial coefficients stored in the
current paired data set. Missing valuesin tsData remain missing in the
resultant data set.

A new time series can be computed from an existing time series with the
polynomial expression:

TS2 (1) = B1* TSA(t) + B2* TSA(t) % + ... + Bn* TS1(t) "
where Bn are the polynomial coefficients for term “n.”

Valuesfor the polynomial coefficients are stored in the x-values of the
current paired data set. Before the above equation is applied, valuesin the
input time series are adjusted by subtracting off the paired data “datum”
valueif defined. The unitslabel and parameter type for the resultant time
series are copied from the current paired data set x-units and parameter

type.

See also: polynomial TransformationWithintegral ()

Parameters. tsData - aregular or irregular interval time series data
Set.

Exewnple: t sXf orm = pdCoef . pol ynoni al Tr ansf or mati on(t sDat a)
Returns: A new TimeSeriesM ath object.

8.15.90 Polynomial Transformation with Integral

pol ynom al Tr ansf or mati onW t hil nt egr al (TimeSeriesMath tsData)

Compute a polynomial transformation with integral of aregular or
irregular interval time series data set, tsData, using the polynomial
coefficients stored in the current paired data set. Missing valuesin tsData
remain missing in the resultant data set.

Thisfunction is similar to the polynomia Tranformation method, and the
same set of polynomial coefficientsisused. The equation for the
polynomial transform is modified so that the transform of tsData is
computed from the integral of the polynomial coefficients:

8-129



Chapter 8 - Scripting

HEC-DSSVue User's Manual

TS2 (t) = B1* TS1(t) 42 + B2*TSL(t)*/3+ ... + Bn* TS1(t) "Y/(n+1)
where Bn are the polynomia coefficients for term "n".

Values for the polynomial coefficients are stored in the x-values of the
current paired data set. Before the above equation is applied, valuesin the
input time series are adjusted by subtracting off the paired data "datum”
valueif defined. The units label and parameter type for the resultant time
series are copied from the current paired data set X-units and parameter

type.

See also: polynomial Transformation()
Parameters: tsData - aregular or irregular interval time series data
Set.

Example: t sXform = pdCoef . pol ynomi al Transf ormati onWth
I ntegral (tsData)

Returns: A new TimeSeriesM ath object.

8.15.91 Product Function

product(list of HecMath tsMathArray)

Multiply the current time series with the each time series in the parameter,
tsMathArray. A new time series will be created which duplicates the time
points of the current time series. Where time points match for the current
and tsMathArray, the values will be multiplied provided the values for all
time series are valid values (not missing). Pointsin the current time series
which cannot be matched to valid points in tsMathArray are set to
missing. Vauesin the current time series which are missing remain
missing in the new time series. The new time series will always have
quality defined. For a specific time, if any of the quailty valuesin the
current or parameter time series is questionable or rejected, the quality
value for that time in the new time series will be set to the most severe
quality for that time (e.g. if questionable and rejected are both
encountered, the new quality will be set to rejected.)

Parameters. tsMathArray the array of time series to be multiplied
with the current time series.

Example: newDat aSet = dat aset. product (list of HecMath
t sMat hAr r ay)

Returns: anew time series representing the multiplication of the two
time series

8.15.92 Rating Table Interpolation

ratingTablelnterpolation(Ti meSeri esivat h t sDat a)
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Transform/interpolate values in the time series data set tsData using the
rating table x-y values stored in the current paired data set. For example,
you can use the function to transform atime series of stage to atime series
of flow using a stage-flow rating table. tsData may be aregular or
irregular timeinterval dataset. Missing valuesin tsData are kept missing
in the resultant data set.

Create the paired data set with the rating table option to set values for
"datum”, "shift", and "offset". By default these values are 0.0. The shiftis
added to and the datum subtracted from all input time series values. If the
rating table is Log-Log, the table x-values are adjusted by subtracting the
offset.

Units and parameter type in resultant time series data set are defined by
the y-units label and parameter type of the current paired data set. All
other names and labels are copied over from tsData.

See also: reverseRatingT abl el nterpol ation()
Parameters. tsData - aregular or irregular interval TimeSeriesM ath
object.
Example: tsFl ow =
st ageFl owCur ve. rati ngTabl el nt erpol ati on(tsSt age)

Returns: A new TimeSeriesM ath object.

8.15.93 Replace Specific Values

replaceSpecificvValues(HecDoubl e from HecDoubl e to)
Replace specific values for another in the time series.

The function searches through the time series array and replaces values
that match the "from" value with the "to" value. HecDouble controls the
precision to which the value is compared (e.g., 12.345 is to three places
after the decimal).

Parameters. from value which will be replaced to value with which to
replace with

Examples. newDat aSet = dat aset . repl aceSpeci fi cVal ues
(HecDoubl e from HecDoubl e to)

Returns. acopy of the current time series with the specific values
replaced.

8.15.94 Reverse Rating Table Interpolation

reverseRatingTablelnterpolation(Ti neSeri esMath tsDat a)
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Transform/interpolate values in the time series data set tsData using the
reverse of the rating table stored in the current paired data set. For
example, the function may be used to transform atime series of flow to a
time series of stage using a stage-flow rating table. tsData may be a
regular or irregular timeinterval dataset. Missing valuesin tsData are
kept missing in the resultant data set.

The paired data set should be created with the rating table option to set
values for "datum”, "shift", and "offset". By default, these values are 0.0.
The shift is subtracted from, and the datum added to all input time series
values. If therating table is Log-Log, the table x-values are adjusted by
subtracting the offset. Refer to the ratingTabl el nterpolation() description
for comparison to this function.

Units and parameter type in resultant time series data set are defined by
the x-units label and parameter type of the current paired data set. All
other names and labels are copied over from the tsData.

See also: ratingTablelnterpolation

Parameters. tsData - aregular or irregular interval TimeSeriesM ath
object.

Example: tsStage = stageFl owCurve. reverseRati ngTabl e

I nterpol ation(tsFl ow)

Returns. A new TimeSeriesMath object.

8.15.95 RMS Function

rms(list of HecMath tsiMathArray)

Determine the root mean sgquare (rms, or quadraticharmonic mean) of the
current time series and the each time series in the parameter, tsMathArray.
A new time series will be created which duplicates the time points of the
current time series. Where time points match for the current and
tsMathArray, the values will be the rms of all time series for that time,
provided the values for all time series are valid values (not missing).
Points in the current time series which cannot be matched to valid points
in tsMathArray are set to missing. Vauesin the current time series which
are missing remain missing in the new time series.

The new time series will always have quality defined. For a specific time,
if any of the quailty valuesin the current or parameter time seriesis
guestionable or regjected, the quality value for that time in the new time
series will be set to the most severe quality for that time (e.g. if
guestionable and rejected are both encountered, the new quality will be set
to rejected.)
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Parameters. tsMathArray the array of time series to be compared with
the current time series.

Example: newDat aSet = dataset.rns(list of HecMath tsMathArray)
Returns. anew time series representing the rms of all time series.

8.15.96 Round to Nearest Whole Number

round()

Rounds values in atime series or paired data set to the nearest whole
number. The function rounds up the decimal portion of a number if equal
to or greater than .5 and rounds down decimal valueslessthan .5. For
example:

10.5 isroundedto 11.
10.499 isrounded to 10.

The x-vauesin paired data sets are unaffected by the function, only the y-
value data are rounded. For time series data sets, missing values are kept
missing.

For paired data sets, use the setCurve() method to first select the paired
data curve(s).

Seealso: roundOff(); truncate(); setCurvey).

Parameters. Takes no parameters

Example: roundedData = dat aSet. round()

Returns. A new HecM ath object of the same type as the current
object.

8.15.97 Round Off to Specified Precision

roundOff(i nteger significantDigits, integer powerO TensPl ace)

Round valuesin atime series or paired data set to a specified number of
significant digits and/or power of tens place. For the power of tens place,
-1 specifies rounding to one-tenth (0.1), while +2 rounds to the hundreds
(100). For example:

1234.123456 will round to:

1230.0 for number of significant digits=3, power of tens place = -1
1234.1 for number of significant digits =6, power of tensplace=-1
1234 for number of significant digits =6, power of tensplace= 0
1230 for number of significant digits =6, power of tensplace= 1
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The x-vauesin paired data sets are unaffected by the function, only the y-
value data are rounded. For time series data sets, missing values are kept
missing.

For paired data sets, use the setCurve() method to first select the paired
data curve(s).

Seealso: round(); truncate(); setCurve().
Parameters:
significantDigits —Aninteger specifying the number of
significant digitsto use in the rounding.
power Of TensPl ace —An integer specifying the power of tens place
to use in the rounding.
Example: roundedDat a = dat aSet.roundCff (5, -2)
Returns. A new HecM ath object of the same type as the current
object.

8.15.98 Screen for Erroneous Values Based on Constant
Value

screenWithConstantValue(string duration
fl oating-point rejectTol erance,
fl oating-point questionTol erance,
fl oati ng-poi nt ni nThreshol d,
i nteger maxM ssi ng)

Flag values in time series whose values do not change more than a
specified amount over a specified duation as questionable or rejected.

Valuesin the time series are screened for quality. All (non-missing)
values whose difference over the specified duration is below
rejectTolerance are marked with aregjected quality flag. Other values
whose difference are over the specified duration is below
guestionTolerance are marked with a questioned quality flag. Other
values are marked with an okay quality flag unless they are already
marked as rejected or questioned. Only values above the specified
minThreshold value are screened as described. Only time periods that
contain no more that maxMissing missing values are screened as
described.

Parameters:
tsc - The time seriesto derive from.
durationStr - The time period over which to perform the test, of the
form nX, whereinisaninteger and X is one of Minutes, Hours, or
Days, which can be abbreviated to one or more characters.
rejectTolerance - Values will be marked as rejected if they do not
differ by more than this amount over the specified duration. To
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disable marking values as rejected, set this tolerance to less than
zero.

guestionTolerance - Values will be marked as questioned if they do
not differ by more than this amount over the specified duration. To
disable marking values as questioned, set this tolerance to less than
zero.

minThreshold - Vaues will be screened only if they are greater than
thisvaue.

maxMissing - The maximum number of missing valuesto toleratein
the specified duration for screening purposes.

Example:
newDat aSet = dat aset.screenWt hConst ant Val ue(string
dur ati on,
fl oating-point rejectTol erance,
fl oati ng- poi nt questionTol erance,
fl oating-point mnThreshol d,
i nt eger maxM ssi ng)

Returns: A copy of the time series with values with the quality set as
described.

8.15.99 Screen for Erroneous Values Based on Duration
Magnitude

screenWithDurationMagnitude(string durationStr,
floating-point mnRejectLimt,
floating-point mnQuestionLint,
floating-point nmaxRejectLimt,
floating-point nmaxQuestionLimnt)

Flag values in time series whose accumul ation over a specified period lies
minimum/maximum limits values as questionabl e or rejected.

Valuesin the time series are screened for quality. All (non-missing)
values whose accumulated value for the specified duration is below
minRe ectLimit or above maxRejectLimit are marked with arejected
quality flag. Other values whose accumulated value for the specified
duration is below minQuestionLimit or above maxQuestionLimit are
marked with a questioned quality flag. Other values are marked with an
okay quality flag unless they are already marked as rejected or questioned.

Parameters:
DurationStr - The time period over which to perform the test, of the
form nX, whereinisaninteger and X is one of Minutes, Hours, or
Days, which can be abbreviated to one or more characters.
minReg ectLimit - Vaues whose accumulated value for the specified
duration is below thiswill be marked as rejected.
minQuestionL imit - Vaues whose accumulated value for the
specified duration is below this, but not below
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minReg ectLimit - will be marked as questioned.
maxQuestionL imit - Vaues whose accumulated value for the
specified duration is above this, but not above

maxRej ectLimit - will be marked as questioned.

maxRe ectLimit - Vaues whose accumulated val ue for the
specified duration is above thiswill be marked as rejected.

Example:
screenedDat a = tsDat a.
screenW t hDur ati onMagni tude(string durationStr,
floating-point mnRejectLimt,
fl oati ng-point mnQuestionLint,
fl oating-point maxRejectLinit,
fl oati ng-point maxQuestionLinmnit)
Returns. A copy of the time series with values with the quality set as
described.

8.15.100 Screen for Erroneous Values Based on Forward
Moving Average

screenWithForwardMovingAverage(i nt eger nunber ToAver ageOver,
fl oati ng-point changeLimt)

Flag values in time series exceeding maximum change from aforward
moving average. A running forward moving average of valid valuesis
progressively computed over number ToAverageOver points. Vaues
exceeding the moving average computed for the preceeding point location
by more than changeLimit are flagged or set to the "Missing” value
depending upon the settings for setlnvalidToMissingValue or
gualityFlagForInvalidValue parameters. Values failing the quality test are
excluded from the forward moving average computation for the
subsequent points. The maximum change comparison is done only when
consecutive values are not flagged.

Parameters:
number ToAverageOver - the number of values to average over for
computing the forward moving average. Must be greater than two.
changeL imit - allowed deviation in the tested value from the
forward moving average.

Example:
screenedDat a = t sDat a. screenW t hFor war dMovi ngAver age(
i nt eger nunber ToAver ageOver, fl oati ng-point
changeLinit)
Returns. acopy of the time series with values failing the quality test
set to undefined and with the quality flag set to missing.
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8.15.101 Screen for Erroneous Values Based on Forward
Moving Average (Missing Values)

screenWithForwardMovingAverage(i nt eger
nunber ToAver ageOver ,
fl oating-point changeLinmt,
bool ean setlnval i dToM ssi ngVal ue,
string qualityFl agForl nvalidVal ue)

Screen the current time series data set for possible erroneous values based
on the deviation from the forward moving average over

number ToAverageOver values computed at the previous point. If the
deviation from the moving average is greater than changeLimit, the value
failsthe screening test. Data values failing the screening test are assigned
aquality flag and/or are set to missing.

Missing values and values failing the screening test are not counted in the
moving average and the divisor of the averageisless one for each such
value. At least two values must be defined in the moving average else the
moving average is undefined and value being examined is screened
acceptable.

If setinvalidToMissingValueistrue, values failing the screening test are
Set to missing.

If qualityFlagForinvalidValueis set to a character or string recognized as
avalid quality flag, the quality flag will be set for tested values. If thereis
no previoudly existing quality available for the time series, the quality flag
array will be created for the time series. Valuesfailing the quality test are
set to the user specified quality flag for invalid values. If thereisexisting
quality data and the time series value passes the quality test, the existing
quality flag for the points is unchanged. If there was no previously
existing quality and the time series value passes the quality test, the
quality flag for the point is set to "Okay".

The acceptable values for qualityFlagForinvalidvalue strings are: "M™ or
"Missing”, "R" or "Regjected”, "Q" or "Questionable”. A blank string (" )
is entered to disable the setting of the quality flag.

For the example:

resul t ant Dat aSet = dat aSet. screenW t hFor war dMovi ngAver age
(16, 100., TRUE, "R'")

the forward moving average will be computed over 16 values, values
deviating from the moving average by more than 100.0 will be set to
missing and flagged as rejected.

8-137



Chapter 8 - Scripting HEC-DSSVue User's Manual

Parameters:
nunber ToAver ageOver — An integer specifying the number of
averaging values. Must be at least two.
changeLi m t —A floating-point number specifying the maximum
change allowed in the tested value from the forward moving average
value.
set | nval i dToM ssi ngVal ue — Either True or False, specifying
whether time series values failing the screening test are set to the
"Missing" value.
qual i t yFl agFor | nval i dVal ue - A string representing the quality
flag setting for values failing the screening test. The accepted
character stringsare: "M" or "Missing”, "R" or "Rejected"”, "Q" or
"Questionable". An empty string (" ") is entered to disable the
setting of the quality flag.

Example:

screenedDat a = t sDat a. screenW t hFor war dMovi ngAver age

(16, 100., TRUE, “R’)

Returns: A new TimeSeriesMath object.
Generated Exceptions. Throws a HecMathException if
number ToAverageOver isless than two; if an unrecognized quality flag
is entered for qualityFlagForinvalidValue or if setinvalidToMissing
Valueisfalse and qualityFlagForinvalidvalueis blank (no action
would occur).

8.15.102 Screen for Erroneous Values Based on

Maximum/Minimum Range (Missing Values)

screenW t hMaxM n(Floating-point minValueLimit,
floating-point maxValueLimit,
floating-point changeLimit,
boolean setlnvalidToMissingValue,
string qualityFlagForilnvalidvalue)

Flag values in atime series data set exceeding minimum and maximum
[imit values or maximum change limit.

Valuesin the time series are screened for quality. Vaues below
minValueLimit or above maxValueLimit or with a change from the
previous time series value greater than changeLimit fail the screening test.
The maximum change comparison is done only when consecutive values
are not flagged.

If setinvalidToMissingValueis set to true, values failing the screening test
are set to the "Missing” value.
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If qualityFlagForinvalidValueis set to a character or string recognized as
avalid quality flag, the quality flag will be set for tested values. If thereis
no previousy existing quality available for the time series, the quality flag
array will be created for the time series. Vaues failing the quality test are
set to the user specified quality flag for invalid values. If thereisexisting
quality data and the time series value passes the quality test, the existing
quality flag for the pointsis unchanged. If there was no previously
existing quality and the time series value passes the quality test, the
quality flag is set to "Okay".

For example:

resul t ant Dat aSet = dat aSet.screenWthMaxM n (0.0, 1000.,
100., FALSE, “R")

time series values less than 0.0, or greater than 1000., or with achange
from a previous point greater than 100 will be flagged as "Rejected".
Flagged points however will not be set to the "Missing” value.

Parameters:
m nVal ueLi nmi t —A floating-point number specifying the minimum
valid value limit.
maxVal ueLi mit - A floating-point number specifying the maximum
valid value limit.
changeLi m t - A floating-point number specifying the maximum
change allowed in the tested value from the previous time series
value.
set I nval i dToM ssi ngVal ue - Either True, or False, specifying
whether time series values failing the screening test are set to the
"Missing" value.
qual i t yFl agFor | nval i dVal ue - A string representing the quality
flag setting for values failing the screening test. The accepted
character strings are: "M" or "Missing”, "R" or "Rejected”, "Q" or
"Questionable". An empty string (" ") is entered to disable the
setting of the quality flag.

Example:

screenedData = tsData.screenWthMaxM n(0., 1000., 100.,
FALSE, “R’)

Returns: A new TimeSeriesM ath object.

Generated Exceptions. Throws a HecMathException if an
unrecognized quality flag is entered for
qualityFlagForinvalidValue or if setlnvalidToMissingVvalue iS
false and qualityFlagForiInvalidvalue isblank (no action would
occur).
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8.15.103 Screen for Erroneous Values Based on
Maximum/Minimum Range

screenWithMaxMin(fl oati ng- poi nt m nVal ueLini t,
fl oati ng-point nmaxVal ueLinit,
fl oati ng-point changeLimt)

Flag values in time series exceeding minimum and maximum limit values
or maximum change limit.

Valuesin the time series are screened for quality. Vaues below
minValueLimit or above maxValueLimit or with a change from the
previous time series value greater than changeLimit fail the quality test.
The maximum change comparison is done only when consecutive values
are not flagged.

Valuesfailing the screening test are set to the "Missing” value.

Parameters:
minVaueLimit - minimum valid value limit.
maxValueLimit - maximum valid value limit.
changeLimit - maximum change alowed in the tested value from the
previous time series val ue.

Example: screenedData = screenWt hMaxM n(fl oati ng- poi nt
m nVal ueLinit, floating-point maxVal ueLinmt, floating-
poi nt changeLimt)

Returns. acopy of the time series with values failing the quality test
set to missing.

8.15.104 Screen for Erroneous Values Based on
Maximum/Minimum Range (Quality)

screenWithMaxMin(fl oati ng- poi nt m nVal ueLinit,
fl oati ng-poi nt maxVal uelLinit,
fl oating-poi nt changelLimt,
bool ean setlnval i dToM ssi ngVal ue,
fl oating-point invalidVal ueRepl acenent,
string qualityFl agForlnvali dVval ue)

Flag values in time series exceeding minimum and maximum limit values
or maximum change limit.

Vauesin the time series are screened for quality. Vaues below
minValueLimit or above maxValueLimit or with a change from the
previous time series value greater than changeLimit fail the quality test.
The maximum change comparison is done only when consecutive values
are not flagged.
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Parameters:
minValueLimit - minimum valid value limit.
maxValueLimit - maximum valid value limit.
changeLimit - maximum change alowed in the tested value from the
previous time series value.
setinvalidValueToSpecified - if true, time series values failing the
quality test are set to the specified value.
invalidValueReplacement - The value to use for replacing invalid
valuesis setlnvalidToSpecifiedValueis set to "true".
qualityFlagForinvaidValue - character string representing the
quality flag setting for values failing the quality test. The accepted
character strings are: "M" or "Missing”, "R" or "Rejected”, "Q" or
"Questionable”.

Example: screenedData = tsData. screenWt hMaxM n(fl oati ng-
poi nt minVal ueLinit, floating-point maxVal ueLimt,

fl oating-point changeLimt,

bool ean setlnval i dToM ssi ngVal ue,

fl oating-point invalidVal ueRepl acerent,

string qualityFl agForl nval i dval ue)

Returns. acopy of the time series with values failing the quality test
set to missing.

8.15.105 Screen for Erroneous Values Based on
Maximum/Minimum Range (Limits)

screenWithMaxMin(fl oati ng- point m nRejectLinit,
floating-point minQuestionLint,
fl oating-point nmaxQuestionLint,
floating-point nmaxRejectLimt)

Flag values in time series exceeding minimum and maximum limit values
as questionable or regjected. Vauesin the time series are screened for
quality. Vaues below minRejectLimit or above maxReectLimit are
marked with areected quality flag. Other values below minQuestionLimit
or above maxQuestionLimit are marked with a questioned quality flag.
Other values are marked with an okay quality flag unless they are already
marked as rejected or questioned.

Parameters:
minRejectLimit - Vaues below thiswill be marked as rejected.
minQuestionLimit - Vaues below this, but not below
minRejectLimit will be marked as questioned.
maxQuestionLimit - Values above this, but not above
maxRejectLimit will be marked as questioned.
maxRejectLimit - Values above this will be marked as rejected.

Example: screenedData = tsData. screenWthMaxM n(fl oati ng-
point mnRejectLimt,
floating-point mnQuestionLimnt,
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floating-point nmaxQuestionLint,

floating-point maxRejectLimt)
Returns. A copy of the time series with values with the quality set as
described.

8.15.106 Screen for Erroneous Values Based on Rate of
Change

screenWithRateOfChange(fl oati ng-point m nRejectLinit,
floating-point minQuestionLimnt,
floating-point nmaxQuestionLinmt,
floating-point nmaxRejectLimt)

Flag values in time series whose rate of change from the last valid value
exceed minimum/maximum limits values as questionable or rejected.

Valuesin the time series are screened for quality. Vaues whose rate of
change from the last valid value is below minRe ectLimit or above

maxRe ectLimit are marked with areected quality flag. Other whose rates
of change from the last valid value are values below minQuestionLimit or
above maxQuestionLimit is marked with a questioned quality flag. Other
values are marked with an okay quality flag unless they are already
marked as rejected or questioned.

Rates are computed in units per hour.

Parameters:
minRejectLimit - Vaues whose rate of change from the last valid
value are below thiswill be marked as rejected.
minQuestionLimit - Vaues whose rate of change from the last valid
value are below this, but not below
minRejectLimit - will be marked as questioned.
maxQuestionLimit - Values whose rate of change from the last valid
value are above this, but not above maxRejectLimit will be marked
as gquestioned.
maxRejectLimit - Vaues whose rate of change from the last valid
value are above thiswill be marked as rejected.

Example: newDat aSet = dat aset. screenW t hRat eOf Change(
floating-point mnRejectLimt,

floating-point mnQuestionLint,

fl oating-point nmaxQuestionLint,

fl oating-point maxRejectLimt)
Returns. A copy of the time series with values with the quality set as
described.
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8.15.107 Select a Paired Data Curve by Curve Label

setCurve(string curveNane)

Select, by curve label, the paired data curve for performing subsequent
arithmetic operations or math functions. By default, a paired data set
loaded from file has all curves selected.

A paired data set may contain more than one set of y-values. However, a
user may wish to modify only one curve of the data set. For example,
using the function ".add( 2.0 )" would by default add 2.0 to all y-values for
all curves. The setCurve() call may be used to limit the operation to just
one selected set of y-values. The function searches the paired data set list
of curve labels for amatch to curveName. If amatch isfound, that curve
is set as the selected curve.

Seealso: setCurve( integer curveNumber )

Example: damageCur ve. set Cur ve(* RESI DENTI AL”)
Parameters. curveName— The curve label (a string) to set asthe
selected curve.

Returns. Nothing

Generated Exceptions. Throws aHecMathException —if
curveName is not found in the paired data set curve labels.

8.15.108 Select a Paired Data Curve by Curve Number

setCurve(i nt eger curveNunber)

Select, by curve number, the paired data curve for performing subsequent
arithmetic operations or math functions. By default, a paired data set
loaded from file has all curves selected.

A paired data set may contain more than one set of y-values. However, a
user may wish to modify only one curve of the data set. For example,
using the function ".add( 2.0 )" would by default add 2.0 to all y-values for
all curves. The setCurve() call can be used to limit the operation to just
one selected set of y-values. The function sets a curve index internal to
the paired data set. The option isto select one curveor al curves.

Curve numbering begins with "0". If a paired data set has two curves, the
first curveis selected by, "setCurve(0)". To select the second curve, use
"setCurve(1)".

All curvesin apaired data set are selected by setting curveNumber to -1.

See also: setCurve( String curveName)
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Parameters. curveNumber — An integer specifying the curveto set as
the selected curve. Curve numbering beginswith 0. Set to —1 to select
all curves.

Example: rul eCurve. set Curve(-1)

Returns. Nothing

8.15.109 Set Data Container

setData( hec. i 0. Dat aCont ai ner cont ai ner)

Sets the data container for the current data set. For time series data sets,
thisisahec.io.TimeSeriesContainer. For paired data sets, container
should be a hec.io.PairedDataContainer. Containers are generated by
some of the other functions.

The hec.io.DataContainer class and the hec.io.TimeSeriesContainer and
the hec.io.PairedDataContainer subclasses contain the time series and
paired data values.

Parameters: container — A hec.io. TimeSeriesContainer for time series
data sets, or a hec.io.PairedDataContainer for paired data sets.
Example: dat aSet . set Dat a( TSCont ai ner)

Returns. Nothing

Generated Exceptions: Throws aHecMathException if container is
not of type hec.io.TimeSeriesContainer for time series data sets or not
of type hec.io.PairedDataContainer for paired data sets.

8.15.110 Set Location Name for Data Set

setLocation(String | ocati onNane)

Set the location name for a data set, which changes the B-Part of the HEC-
DSS pathname. The new pathname will be used in plots, tables, and in the
write() method of DSSFile objects.

Parameters. locationName — A string specifying the new location
name for the data set.

Example: dat aSet. set Locati on(*“ QAKVI LLE")

Returns. Nothing

8.15.111 Set Parameter for Data Set

setParameterPart(Stri ng paranet er Nane)
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Set the parameter name for a data set, which changes the C-Part of the
HEC-DSS pathname. The new pathname will be used in plots, tables, and
in the write() method of DSSFile objects.

Parameters. parameterName — A string specifying the new parameter
name for the data set.

Example: dat aSet . set Par anet er Part (“ ELEV")

Returns. Nothing

8.15.112 Set Pathname for Data Set

setPathname( Stri ng pat hnane)

Set the pathname for a data set to the specified pathname. Subsequent
operations using the data set such as getData() or DSSFile.write() will use
or reflect the new pathname.

Parameters. pathname — A string specifying the new pathname for the
data set.

Example: dat aSet . set Pat hnane(“// QAKVI LLE/ STAGE/ / 1HOUR/ CBS/ ")
Returns: Nothing

8.15.113 Set Time Interval for Data Set

setTimelnterval(String interval)

Set the time interval for a data set, which changes the E-Part of the
pathname. The new pathname will be used in plots, tables, and in the
write() method of DSSFile objects.

Parameters. interval — A string specifying the new interval for the
data set.

Example: dat aSet. set Ti mel nt erval (“ 1HOUR")

Returns. Nothing

8.15.114 Set Data Type for Time Series Data Set
setType(string typeString)
Set the data for atime series data set.
Parameters. typeString — A string specifying the data type for the data

set. Thisshould be"INST-CUM", "INST-VAL", "PER-AVER" or
"PER-CUM"
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Example: dat aSet. set Type(“ PER- AVER")
Returns. Nothing

8.15.115 Set Units Label for Data Set

setUnits(String unitsString)

Set the units label for adata set. For apaired data set, the call setsthe y-
units label.

Parameters. unitsString — A string specifying the units label for the
data set.

Example: dat aSet. set Uni ts(“CFS”)

Returns. Nothing

8.15.116 Set Version Name for Data Set

setVersion(String versi onName)

Set the version name for a data set, which changes the F-Part of the
pathname. The new pathname will be used in plots, tables, and in the
write() method of DSSFile objects.

Parameters. version— A string specifying the new location for the
data set.

Example: dat aSet . set Ver si on(* OBSERVED")

Returns. Nothing

8.15.117 Set Watershed Name for Data Set

setWatershed(String wat er shedNane)

Set the watershed (or river) name for a data set, which changes the A-Part
of the pathname. The new pathname will be used in plots, tables, and in
the write() method of DSSFile objects.

Parameters. watershedName — A string specifying the new watershed
name for the data set.

Example: dat aSet . set Wat er shed(“ OAK RI VER)

Returns. Nothing.
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8.15.118 Shift Adjustment of Time Series Data

shiftAdjustment(Ti neSeri esMat h tsDat a)

Derive anew time series data set by linear interpolation of valuesin the
current time series data set at the times defined by the time series data set
tsData. If timesin the new time series precede the first data point in the
current time series, the value for these timesis set to 0.0. If timesin the
new time series occur after the last data point in the current time series, the
value for these timesiis set to the value of the last point in the current time
series. Interpolation of values with the shiftAdjustment function is shown
in Figure 8.14.

X Interpolated value

® Original TS data

N N2
L 7N

Figure 8.14 Interpolation of Time Series Values using Shift Adjustment Function

Both time series data sets may be regular or irregular interval.
Interpolated points must be bracketed or coincident with valid (not
missing) valuesin the original time series; otherwise the values are set as
missing.

Parameters. tsData— A regular or irregular interval time series data
Set.

Example: tsinterp = tsVal ues. shiftAdj ust ment (tsDat a)
Returns: A new TimeSeriesM ath object.

8.15.119 Shift Time Series in Time

shiftInTime(string timeShiftString)

Shift the times in the current time series data set by the amount specified
with timeShiftSring. The data set may be regular or irregular interval time
series data. Data set values are unchanged.

timeShiftString has the form "nT", where "n" is an integer number and
"T" is"M"(inute), "H"(our), "D"(ay), "W"(eek), "Mo"(nth),or "Y"(ear).
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Only thefirst character is significant for "T", except for "Month", which
requires at least two characters.

Parameters. timeshiftSring — A string specifying the time increment
to shift times in the current time series data set.

Example: TsShifted = tsData.shiftlnTime(*3H")

Returns: A new TimeSeriesM ath object.

8.15.120 Sign Function

sign()

Derive anew time series composed of the signs of the values of the
current time series. Values which are missing in the original time series
will be missing in the new time series. Valuesin the current time series
will be represented as-1.0, 0.0 or 1.0 in the derived time series, depending
on whether the origina valueis &It; 0.0, 0.0 or &gt; 0.0.

Parameters. Takes no Parameters

Example: newDat aSet = dat aSet . si gn()

Returns. A new time series composed of the negatives of the values of
the current time series

8.15.121 Sine Trigonometric Function

sin()

Derive anew time series or paired data set from the sine of values of the
current data set. The resultant data set values are in radians. For time
series data, missing values are kept as missing.

For paired data sets, use the setCurveMethod to first select the paired data
curve(s).

Seealso: setCurve()

Parameters. Takes no parameters

Example: newDat aSet = dat aSet . sin()

Returns. A new HecM ath object of the same type as the current
object

8.15.122 Skew Coefficient

skewCoefficient()
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Compute the skew coefficient of the current time series data set. Missing
values are ignored.

Parameters. Takes no parameters

Example: skewCoefficient = dataSet.skewCoefficient()
Returns: A floating-point value representing the skew coefficient of
the current time series.

8.15.123 Snap Irregular Times to Nearest Regular Period

snapToRegularinterval(string timelnterval String,
string tineOffsetString,
string tineBackwardString,
string tinmeForwardString)

"Snap" datafrom the current irregular or regular interval time seriesto
form anew regular interval time series of the specified interval and offset.
For example, atime series record from a gauge recorder collects readings
6 minutes past the hour. The function may be used to “snap” or shift the
time pointsto the top of the hour.

The regular interval time of the resultant time seriesis specified by
timelnterval Sring. timelnterval String is avalid HEC time increment
string (e.g. "1IMIN", "15MIN", "1IHOUR", "6HOUR", "1DAY",
"IMONTH").

Times in the resultant time series may be shifted (offset) from the regular
interval time by the increment specified by timeOffsetSring. Asan
example, the offset could be used to shift times from the top of the hour to
instead six minutes past the hour. Data from the original time seriesis
"snapped" to the regular interval if the time of the datafalls within the
time window set by the timeBackwardString and the timeForwardString.
That is, if the new regular interval is at the top of the hour and the time
window extends to nine minutes before the hour and fifteen minutes after
the hour, an original data point at 0852 would be snapped to the time 0900
while apoint at 0916 would be ignored.

timeOffsetSring, timeBackwardString and timeForwardString are time
increment strings expressed as "nT", where "n" is an integer number and
"T" isone of the timeincrements. "M(INUTES)", "D(AYS)" or
"H(OUR)" (charactersin the parenthesis are optional). For the example of
the previous paragraph, timelnterval Sring would be "1IHOUR",
timeOffsetSring would be "OM", timeBackwardString would be "9M™" (or
"9min") and timeForwardString would be "15M.” A blank string (" ") is
equivalent to "OM".
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By default valuesin the resultant regular interval time series data set are
set to missing unless matched to times in the current time series data set
within the time window tolerance set by timeBackwardString and
timeForwardString.

Parameters:
ti mel nterval String —A string specifying the regular time interval
for the resultant time series.
ti meOf fset String —A string specifying the offset of the new time
points from the regular interval time. This variable may be an empty
string (" ") or None.
ti meBackwar dSt ri ng — A string specifying the time to ook
backwards from the regular time interval for valid time points.
ti meForwar dSt ri ng —A string specifying the time to look forward
from the regular time interval for valid time points.

Example: rtsData = itsData. snapToRegul ar I nterval (“1HOUR’,
None, “5M n”, “5Mn")

Returns. A new regular interval TimeSeriesMath object.

8.15.124 Square Root

sqrt()

Derive anew time series or paired data set computed from the square root
of values of the current data set. For time series data, missing values are
kept as missing. Values less than zero are set to missing.

For paired data sets, use setCurveto first select the paired data curve(s).

Seealso: setCurve()

Parameters. Takes no parameters

Example: newDat aSet = dataSet.sqrt()

Returns. A new HecM ath object of the same type as the current
object.

8.15.125 Standard Deviation of Time Series

standardDeviation()

Compute the standard deviation value of the current time series data set.
Missing values are ignored.

Parameters. Takes no parameters

Example: stdDev = tsData. st andar dDevi ati on()

Returns: A floating-point value representing the standard deviation of
the current time series
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8.15.126 Standard Deviation of Time Series (tsMathArray)

standardDeviation(li st of HecMath tsMat hArray)

Determine the standard deviation of the current time series and the each
time seriesin the parameter, tsMathArray. A new time series will be
created which duplicates the time points of the current time series. Where
time points match for the current and tsMathArray, the values will be the
standard deviation of all time seriesfor that time, provided the values for
all time series are valid values (not missing). Pointsin the current time
series which cannot be matched to valid pointsin tsMathArray are set to
missing. Vauesin the current time series which are missing remain
missing in the new time series.

The new time series will always have quality defined. For a specific time,
if any of the quailty valuesin the current or parameter time seriesis
guestionable or rejected, the quality value for that time in the new time
series will be set to the most severe quality for that time (e.g. if
guestionable and rejected are both encountered, the new quality will be set
to rejected.)

Parameters. tsMathArray - the array of time series to be compared
with the current time series.

Example: stdDev = tsData.standardDevi ation(list of
HecMat h t sivat hArr ay)
Returns. anew time series representing the standard deviation of all

time series.

8.15.127 Straddle Stagger Hydrologic Routing

straddleStaggerRouting(i nt eger nunber ToAver age,
i nt eger nunber TolLag,
i nt eger nunber Subr eaches)

Route the current regular interval time series data set using the Straddle-
Stagger hydrologic routing method. number ToAverage specifies the
number of ordinates to average over (Straddle). numberTolLag specifies
the number ordinatesto lag (Stagger). The number of routing subreaches
is set by number Subreaches.

Parameters:
numberToAverage — An integer specifying the number of ordinates
to average over (Straddle).
numberToLag — An integer specifying the number of ordinatesto lag

(Stagger).
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numberSubreaches — An integer specifying the number of routing
subreaches.
Example: t sRout ed = tsFl ow. straddl eSt agger Rout i ng
(nunber Aver, 1ag, reachCount)
Returns: A new TimeSeriesM ath object.

8.15.128 Subtract a Constant

subtract(fl oati ng- poi nt constant)

Subtract the value constant from all valid values in the current time series
or paired data set. For time series data, missing values are kept as
missing.

For paired data, constant is subtracted from y-values only. Usethe
setCurve method to first select the paired data curve(s).

See also: subtract(HecMath hecMath); setCurve()

Parameters. constant - A floating-point value.

Example: newDat aSet = dat aSet . subtract (5. 3)

Returns. A new HecM ath object of the same type as the current
object.

8.15.129 Subtract a Data Set

subtract(Ti meSeri eshMat h t sDat a)

Subtract the values in the data set tsData from the values in the current
data set. Both data sets must be time series data set.

When subtracting one time series data set from another, thereis no
restriction that times in the two data sets match exactly. However, only
values with coincident times will be subtracted. Timesin the current time
series data set that cannot be matched with timesin the second data set are
set missing. Valuesin the current data set that are missing are kept as
missing. Either or both data sets may be regular or irregular interval time
series.

See also: subtract(floating-point constant)

Parameters. tsData - a TimeSeriesMath object.

Example: newDat aSet = dat aSet . subt ract (ot her Dat aSet )
Returns. A new TimeSeriesM ath object.
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8.15.130 Successive Differences for Time Series

successiveDifferences()

Derive a new time series from the difference between successive valuesin
the current regular or irregular interval time series data set. The current
data must be of type "INST-VAL" or "INST-CUM". A vaueinthe
resultant time seriesis set to missing if either the current or previous value
in the current time seriesis missing (need to have two consecutive valid
values). If the datatype of the current data set is"INST-CUM" the
resultant time series data set is assigned the type "PER-CUM", otherwise
the data type does not change.

See also: timeDirivative()

Parameters. Takes no parameters

Example: newTsData = tsData. successiveDifferences()
Returns: A new TimeSeriesM ath object.

Generated Exceptions. Throws a HecM athException if the current
data set is not of type"INST-VAL" or "INST-CUM".

8.15.131 Sum Values in Time Series

sum()

Sum the values of the current time series data set. Missing values are
ignored.

Parameters. Takes no parameters

Example: total = tsData.sun()

Returns: A floating-point value representing the sum of al valid
values of the current time series.

8.15.132 Sum Values in Time Series (tsMathArray)

sum(list of HecMath tsMathArray)

Add each of the time series in the parameter, tsMathArray, to the current
time series. A new time series will be created which duplicates the time
points of the current time series. Where time points match for the current
time series and each time seriesin tsMathArray, the values will be
summed provided values for al time series are valid values (not missing).
Points in the current time series which cannot be matched to valid points
in tsMathArray are set to missing. Vauesin the current time series which
are missing remain missing in the new time series.
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The new time series will always have quality defined. For a specific time,
if any of the quality valuesin the current or parameter time seriesis
guestionable or regjected, the quality value for that time in the new time
series will be set to the most severe quality for that time (e.g. if
guestionable and rejected are both encountered, the new quality will be set
to regjected.)

Parameters. tsMathArray - the array of time seriesto be added to the
current time series.

Example: tsData.sun(list of HecMath tsMathArray)

Returns. anew time series representing the sum of the two time series

8.15.133 Tangent Trigonometric Function

tan()

Derive atime series or paired data set computed from the tangent of
values of the current data set. For time series data, missing values are kept
asmissing. If the cosine of the current time series valueis zero, the value
IS set missing.

For paired data sets, use the setCurve method to first select the curve(s).

See also: setCurve()

Example: newDat aSet = dataSet.tan()

Parameters. Takes no parameters

Returns. A new HecM ath object of the same type as the current
object.

8.15.134 Time Derivative (Difference per Unit Time)

timeDerivative()

Derive anew time series data set from the successive differences per unit
time of the current regular or irregular interval time series data set. For
thetime“t”,

TS2(t) = (TSL(t) = TSL(t-1) )/ DT

where DT isthe time difference between t and t-1. For the current form of
the function, the units of DT are minutes.

A valuein the resultant time seriesis set to missing if either the current or
previous value in the original time seriesis missing (need to have two
consecutive valid values). By default, the data type of the resultant time
series data set is assigned as "PER-AVER".
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See also: successiveDifferences()

Parameters. Takes no parameters

Example: newTsData = tsData.timeDerivative()
Returns. A new TimeSeriesM ath object

8.15.135 Transform Time Series to Regular Interval

transformTimeSeries(string tinelnterval String,
string tineCffsetString,
string functionTypeString)

Generate anew regular interval time series data set from the current
regular or irregular time series. The new time seriesis computed having
the regular time interval specified by timelnterval Sring and time offset set
by timeOffsetString.

Vaues for the new time series are computed from the original time series
data set using one of seven available functions. The function is selected
by setting functionTypeString to one of the following types:

"INT" - Interpolate at end of interval
"MAX" - Maximum over interval

"MIN" - Minimum over interval

"AVE" - Averageover interval

"ACC" - Accumulation over interval

"ITG" - Integration over interval

"NUM" - Number of valid data over interval

where "interva” is the interval between time pointsin the new time series.

Theregular interval time of the new time seriesis specified by
timelnterval Sring. timelnterval String is avalid HEC time increment
string (e.g. “"1MIN", "15MIN", "1IHOUR", "6HOUR", "1DAY",
"IMONTH").

Times in the resultant time series may be shifted (offset) from the regular
interval time by the increment specified by timeOffsetString. Asan
example, the offset could be used to shift times from the top of the hour to
six minutes past the hour. Typically no offset is used.

The data type of the original time series data governs how values are
interpolated. Datatype"INST-VAL" (or "INST-CUM") considers the
value to change linearly over the interval from the previous data value to
the current datavalue. Datatype "PER-AVER" considers the value to be
constant at the current data value over theinterval. Datatype "PER-
CUM" considers the value to increase from 0.0 (at the start of the interval)
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up to the current value over theinterval. Interpolation of the three data
typesisillustrated in Figure 8.15.

X Interpolated value

INST-VAL PER-AVER PER-CUM
Figure 8.15 Interpolation of "INST-VAL", "PER-AVER" and "PER-CUM" Data

How interpolation is performed for a specific data type influences the
computation of new time series values for the selected function. For
example, if the datatype is"INST-VAL", the function "Maximum over
interval" is evaluated by: Finding the maximum value of the data points
from the original time series that are inclusive in the new time interval.
Linearly interpolate values at beginning and ending of the new time
interval, and determine if these values represent the maximum over the
interval.

Referring to the plots in Figure 8.15, the "Average over interval” function
is applied to atime series by integrating the area under the curve between
interpolated points and dividing the result by the interval time.

Seealso: transfornili meSeries( TinmeSeriesMath tsDat a,
string functionTypeString)

Parameters:
ti mel nterval String— A string specifying the regular time interval
for the resultant time series.
ti meOf fset String —A string specifying the offset of the new time
points from the regular interval time. This variable may be a blank
string (" ).
functionTypeString — A string specifying the method for
computing values for the new time series data set.

Example: newTsData = tsDat a. transfornili meSeri es(“1Day”,

“OM, “AVE")

Returns: A new regular interval TimeSeriesM ath object.

8.15.136 Transform Time Series to Irregular Interval

transformTimeSeries(Ti neSeri esMath tsData, string
functionTypeString)

8-156



HEC-DSSVue User's Manual Chapter 8 - Scripting

Generate a new time series data set from the current regular or irregular
time series. Thetimesfor the new data set are defined by the timesin
tsData, which may be aregular or irregular time series data set.

Values for the new time series are computed from the original time series
data set using one of seven available functions. The function is selected
by setting functionTypeString to one of the following types:

"INT" - Interpolate at end of interval
"MAX" - Maximum over interval

"MIN" - Minimum over interval

"AVE" - Averageover interval

"ACC" - Accumulation over interval

"ITG" - Integration over interval

"NUM" - Number of valid data over interval

where "interva" is the interval between time pointsin the new time series.

The data type of the original time series data governs how values are
interpolated. Datatype"INST-VAL" (or "INST-CUM") considers the
value to change linearly over the interval from the previous data value to
the current value. Datatype "PER-AVER" considers the value to be
constant at the current value over the interval. Datatype "PER-CUM"
considers the value to increase from 0.0 (at the start of the interval) up to
the current value over theinterval. Interpolation of the three datatypesis
illustrated in Figure 8.15 (page 8-156).

How interpolation is performed for a specific data type influences the
computation of new time series values for the selected function. For
example, if the datatypeis"INST-VAL", the function "Maximum over
interval" is evaluated by: Finding the maximum value of the data points
from the original time series that are inclusive in the new time interval.
Linearly interpolate values at beginning and ending of the new time
interval, and determine if these values represent the maximum over the
interval.

Referring to the plotsin Figure 8.15 (page 8-156), the "Average over
interval" function is applied to atime series by integrating the area under
the curve between interpolated points and dividing the result by the
interval time.

See also: transformTimeSeries( string timelnterval String, string
timeOffsetString, string functionTypeString )
Parameters:
t smvat h — A TimeSeriesMath object used to define the times for the
new data set.
functionTypeSt ri ng —A String specifying the method for
computing values for the new time series data set.
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Example: newTsData = tsVal ues. transfornili meSeri es
(tsTimeTenpl ate, “MAX")

Returns. A new TimeSeriesM ath object

8.15.137 Truncate to Whole Numbers

truncate()

Truncates valuesin atime series or paired data set to the nearest whole
number. For example:

10.99 is truncated to 10.

The x-valuesin paired data sets are unaffected by the function, only the y-
value data are truncated. Missing values remain missing.

For paired data, use the setCurve method to first select the curve(s).

See also: setCurve()

Parameters. Takes no parameters

Example: newDat aSet = dataSet.truncate()

Returns. A new HecM ath object of the same type as the current
object

8.15.138 Two Variable Rating Table Interpolation

twoVariableRatingTablelnterpolation(Ti neSeri esMat h
t sDat aX, Ti neSeri esMat h t sDat az)

Derive anew time series data set by using the x-y curvesin the current
paired data set to perform two-variable rating table interpolation of the
time seriestsDataX and tsDataZ. For two-variable rating table
interpolation, the current paired data set should have more than one curve
(multiple sets of y-values).

As an example, reservoir release is afunction of both the gate opening
height and reservoir elevation Figure 8.16 (page 8-159). For each gate
opening height, there is areservoir elevation-reservoir release curve,
where reservoir elevation is the independent variable (x-values) and
reservoir release the dependent variable (y-values) of a paired data set.
Each paired data curve has a curve label. Inthis case, the curvelabel is
assigned the gate opening height. Using the paired data set shown in
Figure 8.16 (page 8-159), the function may be employed to interpolate
time series values of reservoir elevation (tsDataX) and gate opening height
(tsDataZz) to develop atime series of reservoir release.
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No extrapolation is performed. If time series values from tsDataX or
tsDataZ are outside the range bounded by the paired data, the new time
seriesvalueis set to missing. Units and parameter type in the new time
series are set to the y-units label and parameter of the current paired data
set. All other names and labels are copied over from tsDataX.

Times for tsDataX and tsDataZ must match. Curve labels must be set for

curvesin the rating table paired data set and must be interpretable as

numeric values.

IIMABLE YALUESIELEV-FLOWIIWARIABLE GATE HEIGHTS!
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Figure 8.16 Example of two variable rating table paired data, reservoir release asa
function of reservoir elevation and gate opening height (curve labels)

Parameters:
t sDat aX — A regular or irregular interval TimeSeriesM ath object,
interpreted as x-ordinate values in the two variabl e interpol ation.

t sDat aZ — A regular or irregular interval TimeSeriesM ath object,
interpreted as z-ordinate values, (value defined by the paired data
curve labels).

Example: tsQutfl ow = gateCurve. twoVari abl eRati ngTabl e
I nterpol ation( tsEl evation, tsGateQpening)

Returns. A new TimeSeriesM ath object.
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Generated Exceptions. Throws a HecMathException if times do not
match for tsDataX and tsDataZ; if the paired data curve labels are
blank or cannot be interpreted as number values.

8.15.139 Variance Function

variance(list of HecMath tsiMathArray)

Determine the variance of the current time series and the each time series
in the parameter, tsMathArray. A new time series will be created which
duplicates the time points of the current time series. Where time points
match for the current and tsMathArray, the values will be the variance of
all time seriesfor that time, provided the values for all time series are
valid values (not missing). Pointsin the current time series which cannot
be matched to valid pointsin tsMathArray are set to missing. Vauesin
the current time series which are missing remain missing in the new time
series.

The new time series will always have quality defined. For a specific time,
if any of the quailty valuesin the current or parameter time seriesis
guestionable or rejected, the quality value for that time in the new time
series will be set to the most severe quality for that time (e.g. if
guestionable and rejected are both encountered, the new quality will be set
to rejected.)

Parameters. tsMathArray - the array of time seriesto be compared
with the current time series.

Example: newbDat aSet =
dat aSet.variance([tsl,ts2,ts3,ts4,ts5])

Returns: anew time series representing the variance of all time series.

8-160



HEC-DSSVue User's Manual Appendix A - Additional Plug-Ins

Appendix A

Additional Plug-Ins

Al Introduction

This appendix documents additional plug-insthat are provided with HEC-
DSSVue. A "plug-in" isan executable ".jar" file that is saved in the
"Plugins’ directory that can access and perform functions on top of HEC-
DSSVue. No modifications are needed to the original program to provide
this additional functionality. Access and use of a plug-in should appear
seamless to a user; generally their functionality is accessed through a
standard menu.

Plug-ins can be updated without changing the original program. The
HEC-DSSVue web site will provide updates for HEC plug-ins. Other
agencies may provide their own plug-ins to meet custom needs. The
HEC-DSSVue plug-in web siteis:

http://www.hec.usace.army.mil/software/hec-dss/pl ug-ins.htm

A.2 Pie Charts

The Pie Chart plug-in for HEC-DSSV ue allows you to plot a pie chart of
any value of interest (e.g., flow, stage, or reservoir storage) for asingle
date and time at multiple locations. Either atwo-dimensional (2D) or
three-dimensional (3D) plot can be created. The pie chart is plotted using
adefault color sequence, but you can change the color of each individual
dice. Thetransparency of the chart can also be adjusted. By default, all
sections are labeled with the site name, units, and percentage of the total.
The unit and percent labels can be individually turned off, or section labels
can be turned off altogether. A legend is created below the chart by
default, which can aso be turned off. The section labels and legend are
updated dynamically. The final product can be printed, or it can be saved
to agraphicsfileto beincluded in presentations, documents, or web
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A.2.1 Creating a Pie Chart

First, load adata set into DSSVue. Select the data type to plot by clicking
the drop-down list to select the C part of the DSS path. Select thetime
interval using the drop-down list for the D part of the path. Specific sites
and dates/times can be selected by Ctrl-clicking on each row of the table,
or al of the data can be used to create the plot by pressing Ctrl-A.

An example of creating a pie chart of daily reservoir storage data is shown
in Figure A.1. For thisfigure, all sitesand al dates/times were selected
for plotting, after filtering on the C and E parts of the DSS path. Click the

ReservoirStorage. dss - HEC-D55Vue |:||E|r>__(|
File Edit Wiew EMEEMM Groups DataEntry Tools Advanced Help

: Flat:
- ==
g g —  Plot Individual Data Sets
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Search A [MTOR-RES ECP vl E: |1DA\" b
ByParts: B: | v| D | v| F v

Mumnber Part & Part B Part C Part D PartE Part F
R E 1DAY

10
10
10
10
10
10

10
10
10
10
10

De-Select Clear Selections Restore Selections Set Time YWindow

| A Notime window set.

Figure A.1 Create New Pie Chart

Display menu, and then point to Charts, click Pie Chartsto open the
main pie chart window. A window with an empty chart panel will appear,
as shown in Figure A.2 (page A-3). Click the desired options, as
described below, and then click the Create Chart button at the bottom of
the window to create a new pie chart. If you need to change the selection
of datato be plotted, or otherwise do not wish to create a pie chart, the
window can be closed using either the Cancel button at the bottom of this
window, or from the File menu, click Close from the pie chart window.

A.2.2 Date/Time

Select the date and time from the Date/Time drop-down list at the top-left
of the main chart window. If only one date/time was selected from the data
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Figure A.2 Main Pie Chart Window

set before opening this window, only one date will appear in thislist.
Otherwise, al dates will be present, with the earliest date selected by

default.

A.2.3 Chart Dimension

A two-dimensional (2D) or three-dimensional (3D) chart can be created by
selecting 2D or 3D in the Dimension option box to the left of the plot

panel. An example of a2D plot isshown in Figure A.3, and a3D plot is
shown in Figure A.4 (page A-4).
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Figure A.3 2D Pie Chart, Transparency Turned Off
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Create Chart | | Concel |

Figure A.4 3D Pie Chart, Transparency Set to Thirty-Five Percent

A.2.4 Sort Type

The Sort Type optionsto the left of the plot panel allow you to specify
whether the data should be sorted by site name, by data value, or by the
order the datais listed in the DSSfile ("unsorted”). Click By Nameto
sort the plot alphabetically, starting with the first site name at the top of
the plot. This option allows quick identification of particular sites,
particularly if alarge number of sites were included.

Select By Value to sort the data by ascending or descending data val ues.
This option creates neat and visually appealing plots that can be used to
compare sites and quickly identify important differences between sites.

Select Unsorted to plot the datain the order in which it appears in the
DSSfile. Thisoption respects the order of the DSS file but usually will
not produce charts that are as clear or useful as those created using the By
Name or By Value options.

A.2.5 Sort Order

The Sort Order options at the |eft of the plot window alow you to specify
whether to sort the datain ascending or descending order. The Ascending
option sorts the data around the chart clockwise, with the first value
plotted at the top of the chart. Descending reverses the sort order by
plotting the datain increasing order counter-clockwise around the plot. If
Unsorted is selected for Sort Type, the Sort Order option will be
disabled.
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A.2.6 Transparency

The transparency of the entire pie chart can be changed to enhance the
clarity or visual appeal of the plot. Drag the slider in the Transparency
option box to the | eft to decrease the transparency and drag to the right to
increase transparency. The transparency is dynamically updated as the
dlider isdragged. To turn transparency off and create an opaque plot, drag
the dlider to thefar left. The 2D plot in Figure A-3 (page A-3) hasthe
transparency set to zero, while the 3D plot in Figure A-4 (page A-4) has
the transparency set to thirty-five percent.

A.2.7 Section Colors

The color of each individual slice in the pie chart can be altered by
clicking the Change Section Colors button. A color selection window
will appear (Figure A-5). Select the site name from the drop-down list to
the right of the window, and then click on acolor. The color of the

B=1E3

Swatches | Hog | RGE

Recent:

PIME FLAT 4

Preview

O -

D Sample Text Sample Text

Figure A.5 Color Chooser

selected diceis dynamically updated on the pie chart. Drag the color
chooser window to one side to view the changes in the main chart
window. Figure A-6 (page A-6) shows an example of the chart after
changing the colors of the slices representing the Pine Flat and Warm
Springs sites.

A.2.8 Printing and Saving

To print the pie chart, from the File menu, click Print of the pie chart
window.
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A.3

A3.1

e
Figure A.6 Slice Color Changed (Pine Flats and Warm Springs)

To save the pie chart to a graphicsfile, choose File — Save As from the
pie chart menu. The chart can be saved as either a JPEG or PNG file.
Select the desired extension in the Files of typefield, and then type a
name in the File namefield, or browse for an existing file to replace with
the current one. Then click Save. The selected extension will be appended
to the file name automatically.

North Carolina DWR Duration Hydrograph

The North Carolina Department of Water Resources developed a plug-in
to develop duration hydrographs for datain HEC-DSS. Thisisan
alternative approach to the built-in capability in HEC-DSSV ue in the Math
functions Statistics tab. This plug-in is supported by North Carolina
DWR. For gquestions, please contact them directly. Theweb siteis
http://www.ncwater.org/wrisars/dss.

Introduction

The North Carolina Department of Water Resources Duration Hydrograph
Plug-in can create Daily, Weekly, or Monthly Duration Hydrograph plots
with Simple, Detail, or Drought Monitor style for DSS datain HEC-
DSSVue. Thewindow that will appear is shown in Figure A.7 (page A-7.
Low-Flow frequency data dQr (e.g. 7Q10, 30Q2) for water, climatic, or
water year can be calculated on-the-fly and shown in the Duration
Hydrograph plot (see Figure A.8, page A-7).
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Creabe Duration Hydrograph For D55 File (NC DWR) =10 x|

File: [2:fwenlfWarks wrisars] desftest 7, dss

Cutput Pathe [z fwenliWarkswrsars| desltestT_DurationHydrograph. ipg

A part B part  part | [ part: E pert Fpat | k|
—r R e s e e e s e
HIWiASEE WALLEY RIVER AT TOMOTLA, NC FLOW (DAILY AVERAGED) 0171504 - Z7MarZDi8 |IDAY |(RONCSAISGES |OF5
IPPER: CAPE FEAR 8. EVERETT JORDAM DM AND LAKE P... [ELEVATION 1 Jan 1555 - 26Mar200% [10AY | CAONCS-LEACEfe - mel|

LPRER CATAWEA  [CATAWEN A MR, PLEASANT GARDENS, NC FLOW (DALY AVERAGED) 010ct1BE0 - 27Mar2009 [10AY |CRONCSLSGE |OFS
LPPER FRENCH B... FRENCH BROWD RIVER. AT ASHEVILLE, NC[FLOW (DALY AWERAGED) [010ct1898 - ZPMar200% [IDAY [CRONCS-LISGS [CFS |
LPPER FRENCH B, .. FRENCH BROAD RIVER AT BLANTYRE, NC [FLOW (DAILY AVERAGED)  D10ct] 530 - 2FMar200f [104Y  [CRONCS-UISGS |CFS
LUPPER FRENCH ... FRENCH BROAD RIVER. AT ROSMAN, NC  [FLOW (DALY AVERAGED)  D10CE1907 - Z7Mar2009 108y (CRONCSUSGES |[OF5
LPPER NELISE FALLS LAKE PROJECT ELEVATION 101May1361 - 26Mar2009[1DAY | RONCS-LISACE ft - msl |
LUPPER YADKIN LITTLE YADKIN RIVER AT DALTON, NC  [FLOW (DALY AVERAGED) 'Dilluglgﬁﬂ - 27Mar2009 [IDAY [CRAONOSEES |OFS |

WA TALNSO, RIVER NEAR SUGAR GROVE FLOW (DALY AWERAGED)  014ar]1 540 - 27k S 10y RO 33 F

.-uu-amw:hmd-ti

.- =

Selact| UnSelect | Selectl | Gear|  Start Bate | EndDats: | wit: [ -
Ho|  apert | Epart | C part | D part [Epart]  Fpat  [FromUnit| ToUnit|
12 WATAUGH [#ATADGA RIVER NEAR SLVGAR... FLOW (DAILY AVERAGED) [01Aprio4) - 27Mar2009 1047 [CRONCS-USGS CF5 KPS |
The: | sublite: [# APan [F BPat ¥ CPan [ FPart
Plak Corkent Ve Crienkation Interval oupt | & [ 7@ tmevews  Reference vehe
~ Smple " Mormd | % Lardscape | % Dby C FEG  Calandar Yaar
& Detal Loy  Partrait CWeey | Screen | | 7 cCimatic Year [ Create Chart
~ Crought Mankor  MorkHy i Water e — =

Figure A.7 Create Duration Hydrograph for DSS File (NC DWR)

WATAUGA - WATAUGA RIVER NEAR SUGAR GROVE, NC - FLOW (DAILY AVERAGED)
BASED ON DATA FROM 04/01/1940 TO 03/27/2009

(The values less than or equal to zero are setto 0.01)

MRl

100000

10000

1000

100

FLOW (DAILY AVERAGED) (CFS)

10

1J;n Feb Mar Apr May Jun Jul Aug Sep Oct Nov Dec
— Daily Minimum — Daily Maximum — Daily Median
Low-Flow 7Q10 for Climatic Year (Apr-Mar) (19.11 CFS)
YELLOW (LOWER) BAND = §- TO 10-PERCENTILE (VERY DRY CONDITIONS)
» GREEN (MIDDLE) BAMND = 25- TO 75-PERCENTILE (NORMAL CONDITIONS)
< BLUE (UPPER) BAND = 90- TO 95-PERCENTILE (VERY WET CONDITIONS)

Figure A.8 Create Duration Hydrograph for DSS File (NC DWR) - Plot

A-7



Appendix A - Additional Plug-Ins HEC-DSSVue User's Manual

A.3.2 Use

1. In HEC-DSSV ue, create anew DSS file or open an existing one.

2. Inthe HEC-DSSVue main window, highlight or select the DSS
path(s) you are interested in (if no path is selected, al pathsin the
DSSfilewill be considered as the interested paths), from the
Display menu, clickNC DWR Duration Hydrograph (Figure
A.9).

test7.dss - HEC-DSSYue

Flle Edit Wiew | Display Groups DataErtry  Tools Advanced Help
-V ER
A === U] Plak Diata Options »

File Name: Ia Tabulate B
Pathrnames Showi

supplemental Information Pathmames in File: 665 File Size: 351 MB

MC DWR Duration Hydrograph

Search A r C: I
By Parts: p: I =l o |
MNumber  / Part A Part B Part C Part D [ range
1 [CHOW AR AHOSHIE CREEM AT...[FLOW (DALY AVE... [01Feb1350 - 27Mar2009
2 [HAW WHITE DAk CR AT ... [FLCW (14-DAY AW 163ct2003 - 23Mar2009
3 [HAW WHITE Odk CR AT L FLCAW (30-DAY AW |01 Now2003 - 230ar2009
4 [HWWASSEE WALLEY RIVER AT ... [FLCW (DAILY AWE... |01 Jul1904 - 27kar 2009
5|UPPER CAPE FEAR E. EWERETT JORDA,... [ELEVATION 01 Jarl 953 - 26Mar2009
E[LUPPER CATAWES CATANEA R MR PL... [FLOW (DALY AVE... [010Och 950 - 27Mar2009
TIIDDFR FRERCH PR FRFERTH PR BRI FIht cmndl W aE M lard 200 TR 1003

AJPPER CAPE FEAR/E. EVERETT JORDAM DAM AMD LAKE PROJECTELEWATION Jan1983 - 26Mar2009/1 D2
JPPER FREMCH EROADVMFRENCH BROAD RIVER AT ASHEYILLE, MCFLOW (DALY AWVERAGED)I Jan1 599 -
JJPPER MELZEFALLE LAKE PROJECTELEY ATIOMMD Mary1 981 - 26Mar 200901 DAY ICROMOES-USACES

AATAIGAMATALUGA RIVER MEAR SUGAR GROWE, NCFLOWY (DAILY AWERAGED W Apr1940 - 27hiar200

Select De-Select | Clear Selections | Eestore Selection

| A Motime window set.

Figure A.9 Open NC DWR Duration Hydrograph

3. Inthenewly opened Create Duration Hydrograph For DSS File
(NC DWR) pandl, click the path(s) you want to create Duration
Hydrograph this time (Figure A.10).

Creste Duration Hydrograph For S5 File (NC DWR) = =10f x|
55 Fie: i: mnlWorks versars e best 7. dss
CuRput Palle [ (WanlPwWarks wisarsjdesftesT_Durationydeograph. g
o] _ Apwt | B part | cowt | opwt  [eost| vpat [ |
1 tw T g 't - s

!
{1 LIPER CAPE PEAR D, EVERETT JORDWM DM AND LACE PR, ELEVATION

ER AT ASHEVILLE, W AILY AVERAGE

Figure A.10 Choose Pathnamesto Create Duration Hydrograph

4. Select/customize the datafor your Duration Hydrograph chart.
e If you want limit the data to be used for creating the chart,
enter the Start and/or End Date with yyyy-mm-dd format.
e If you want to convert the unit for stream flow or reservoir,
select one conversion method from the unit drop down list
box (see Figure A.11, page A-9).
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5.

6.

o Click "Select” to select the path(s)  uit: [ |
you selected with the date
limitations and the unit Fpart o5 - mad
conversion. cfs -~ ac-ft/d
e Clicking "Select All" will put all ac-ftjd - mgd
the path(s) in the upper table to ac-ftfd --> cfs
the lower selected list table. te [ lac-ft - mg
e Youcanclick "Un-Select" to mad --> ac-ft/d
e ‘Years|Reservair 5-4-E

remove the path(s) from the
selected list.

e Clicking "Clear" will clear all the
selected path(s) in the lower table. The toolbar containing
the buttons mentioned above is shown in Figure A.12.

Figure A.11 Select Unitsfor
Conversion

Balact| un-Seisct | Select Ml | Oesr Start Date: [1960-1-1 EndDate:  [2006-12-31 Unit: | efs —> mgd =l

[ma]  apat | B part I Cpart [ Dpert [Enert]  Fpat | Fromurit[Ta Link]
2 |UPFER FRENCH ... FRENCH BROAD RIVER AT ASH... FLOW (DAILY AVERAGED) O1]ant950 - S1Dec2008 |10AY CROMOS-USGS |ds mgd
4 WATAUGS WATALIGA RIVER NEAR SUGAR ... FLOAW (DAILY AVERAGED) |01 Jani950 - 310ec2008 (104Y  CRONOS-USES (s mgd

Figure A.12 Select, Un-Select, Select All, and Clear buttons

By default, the title for the chart will be constructed from the A, B,
C, and D parts of the paths as below (Figure A.13).

Title: ITest 1 Subtitle: v & Part | BPart W CPart [ FPart
Figure A.13 Chart Title

e |f you want to include the F Part, check the check box for "F
Part”. F Part information will be added after the C Part in the
title.

e You can aso populate the "Title" textbox to add your own
title before the default title.

This plug-in can create Duration

Hydrograph with three styles. Y ou can Plat Content

choose one of them in the "Plot Content” ¢ Simple
group. The default is"Detail" style. ¥ Detail
(Fi gure_A.14). " Drought Monitar
e Simple: Plot the very dry, normal,
and very wet three bands (min to FigureA.14 Plot Content

percentile 25, percentile 25 to 75,
and percentile 90 to max), see Figure A.15 (page A-10).

e Detail: Plot Minimum, maximum, and median lines, in
addition to the very dry, normal, and very wet three bands
(percentile 5 to 10, percentile, 25 to 75, and percentile 90 to
95), see Figure A.16 (page A-10).

e Drought Monitor: Use Drought Monitor classification and
color schemato create Duration Hydrograph, see Figure A.17

(page A-10).
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YELLOW (LOWER) BAND = MIN- TO 10-PERCENTILE (VERY DRY COMDITIONS)
* GREEN (MIDDLE) BAND = 25- TO 75-PERCENTILE (NORMAL CONDITIONS)
» BLUE (UPPER) BAND = 90- TO MAX-PERCENTILE (VERY WET CONDITIONS)

Figure A.15 Simple Plot

i

— Daily Minimum — Daily Maximum — Daily Median

YELLOW (LOWER) BAND = 5- TO 10-PERCENTILE (VERY DRY CONDITIONS)
- GREEN (MIDDLE) BAND = 25- TO 75-PERCENTILE (NORMAL CONDITIONS)
' BLUE (UPPER) BAND = 90- TO 95-PERCENTILE (VERY WET CONDITIONS)

Figure A.16 Detailed Plot

#0to2(D4) « 210 5(D3) - 5t010(D2) 1010 20(D1)
20t030(D0) 301070 70to80 801090 «90to 95
= 951098 « 9810100

Figure A.17 Drought Monitor Plot

A-10



HEC-DSSVue User's Manual Appendix A - Additional Plug-Ins

7. 'You have the option to create your chart with normal Y-Axis or
Log Y-Axis. Thedefaultis"Normal". But generally it is better to
choose "Log" for streamflows (Figure A.18).

Y-fxis
" Maormal

Figure A.18 Y-Axis

8. You can control the image orientation by choosing the Landscape
or Portrait. (Figure A.19).

Orientation
% Landscape

" Partrait

Figure A.19 Image Orientation

9. By default, the Duration Hydrograph will be created on the daily
values. The Plug-in can also summarize the weekly or monthly
averages and then create weekly or monthly chart. (Figure A.20).

Inkerwal
% Daily

£ Weekly
" Manthly

Figure A.20 Chart Intervals

10. By default, the Duration Hydrograph image will be created to jpg
files, but not show on the screen. The file path and name is shown
in the "Output Path" textbox on the top of the whole Plug-in panel,
see Figure A.21. Y ou can change the "Output Path”. If multiple
images will be output, sequential numbers will be added before the
Jpg file extension.

Create Duration Hydrograph For DSS File (NC DAYR) O] x|

D55 File: IC:,l'WenIiIWDrks,fwrisars,fdssItest?.u:Iss

Cukput Path: |C:,l'WenIi,l'Wu:urks,l'wrisars,l'dss,l'test?_DuratinnHvdrograph.jpg
Figure A.21 Output Path
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11.

12.

If you want to see the Duration Hydrograph image on the screen
directly, choose the " Screen” output option. In this case, no jpg
fileswill be created. (Figure A.22) Y ou are not allowed to create
more than 20 Duration Hydrograph on the screen in one run.

Cukbpuk
" JPEG

* Screen

Figure A.22 View Duration Hydrograph Image

Y ou can choose to add Low-Flow dQr (e.g. 7Q10, or 30Q2, etc.)
line to the Duration Hydrograph image, see Figure A.23.

v | 7@

" Calendar Year
v Clirnatic Year
" \Water Year

Figure A.23 Add Low Flow dQr

e Thetextbox before the bold Q is how many consecutive days.
It must be an integer between 1 and 365.
e Thetextbox after the bold Q is how many years of recurrence
interval period. It must be an integer between 2 and 100.
e You can use threetypes of year for your calculation.
Calendar Year - January 1 to December 31
Climatic Year - April 1to March 31. Thisis used by
default.
Water Year - October 1 to September 31
e dQr calculation only uses the years that have at |east 365
daily data.

13. If you want to overlay somereal daily data over the Duration

Hydrograph, put the year numbers in the textboxes of the "Line
Years' group. Y ou can overlay oneto three years of data, see
Figure A.24.

Line Years

2009
2003

2002

ik

Figure A.24 Line Years
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14. Put anumeric value in the textbox under the "Reference Value", a
horizontal line represent that value will be shown in the Duration
Hydrograph chart, see Figure A.25.

Reference Yalue

"

Figure A.25 Reference Vaue

15. Click Create Chart at the bottom right corner to create a Duration
Hydrograph chart based on your customization.
16. If you need any help, you can click Help to open Help.
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Appendix B

Writing Plug-Ins

B.1 Introduction

If you are experienced with Java, you can write a plug-in for HEC-

DSSV ue to provide custom capabilities for your office. Interfacing a
plug-in is rather simple once you have written your own custom code. To
do so, you copy existing plug-in source code and modify it so that it calls
your custom code, call aregistration function, compile and add the class
filesto aplug-in jar, and then change the manifest to show your class. To
access your plug-in, simply copy thejar file to the Plugins directory and
run HEC-DSSV ue.

B.2 Code Overview

The"main" function of aplug-inisrelatively smple; it just creates a menu
or toolbar item, adds an action associated with that item, and registersit
with the main class, ListSdlection. We'll first work with the skeleton plug-
in GenericDssVuePlugin.

public class GenericDssVuePl ugin {

public static void main(Object[] args)

{
final GenericDssVuePlugin plugin = new Generi cDssVuePl ugi n();
final ListSelection listSelection = (ListSelection) args[O0];

JMenul t em generi cMenul tem = new JMenul tem( " Generic Plugin");
generi cMenul t em addAct i onLi st ener (new Acti onLi stener () {
public void actionPerforned(ActionEvent e){
pl ugi n. process(li st Sel ection);

K
i stSel ection.registerPlugin(ListSelection. TOOLS, genericMnulten);

}

In process, you tell ListSelection to read the selected data:

protected void process(ListSelection |istSelection) {
List[] dataList = listSelection.getSel ectedDataContai ners();
Li st tsContainers = dataList[O0];
bool ean success = processData(listSel ection, tsContainers);

}

B-1
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B.3

Procedure

To write a plug-in you need Java and a sample plug-in to start with. The
GenericDssVuePlugin is included with the program in the Samples
directory. The source codeislocated in that jar, along with the classfiles
and manifest.

Y ou will need to refer to the functions listed in the Scripting Chapter.
These include documentation of what isin a TimeSeriesContainer class,
how to use HecTime, and various ListSelection calls. All of the scriptable
calls are available for use in plug-ins.

1.

Y ou need a Java IDE (Integrated Development Environment), but
the examples shown will just be using the J2SE (Java 2 Standard
Edition) SDK (Software Development Kit). Y ou can download the
SDK from sun at: http://java.sun.com/|2se/. Y ou can get an
excellent Java IDE for free named Eclipse from:
http://www.eclipse.org/.

From the GenericDssV uePlugin.jar file, extract
"GenericDssVuePlugin.java' to ajava file named according to
your task. You can put it in any directory you desire if you are not
going to use a package name. If you use a package name, then you
have to put it into adirectory that is the same as the package name.
Edit the .javafile you copied:

a). Change the class name and the name in the main to the task
name you gave the .javafile. The examples do not specify a
package or directory, but you may want to.

b). Change the IMenultem text name to reflect your task.

). Register the plug-in with the appropriate HEC-DSSV ue
menu, or you can make atoolbar button and add it to the
main toolbar.

d). Modify the process function(s) to do what you want with the
data.

€). Comment or uncomment code to save changed data with the
same pathname or with a different pathname or alow the
user to change the pathname, as desired.

f). File you changes.

Compile your code. Add hec.jar, heclib.jar and rma.jar in your
class path:

javac -classpath "C: \ Program Fi | es\ Hec\ HEC- DSSVue\
jar\hec.jar; C\Program Fil es\ Hec\ HEC- DSSVue\ j ar
\heclib.jar; C\Program Fil es\ Hec\ HEC- DSSVue\ j ar\
rma. jar" MyPlugin.java

Copy the "GenericDssVuePlugin.jar” to ajar file named according
to your task in the HEC-DSSV ue\Plugins directory.

Use pkzip or other zip utility to open your .jar file. Add inthe
classfilesthat you generated in the compile (maybe more than
one). Don't include the directory names, unless you are using
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packages, where you will have to use a directory name that
matches the package. (Figure B.1).

&) WinZip - GenericPlugin. jar

File Actions Yiew Jobs Options Help

Hew Open Favorites Add Extract Encrypt Wiew Chs
Tvpe Path
: MF File meta-inf

I GenericDssYuePlugingl .cass CLASS File pluginst,
) GenericDssuePlugin. dlass CLASS File pluginsy
"ﬁ GenericDssYuePlugin,java Jawa Language Source file pluginsy,
< >
Selected O files, 0 bytes Total 4 files, 7KE (3 l;)

Figure B.1 GenericPlugin.jar Directory

Extract the Manifest.mf file with the path. Edit thisfile with
Wordpad and change the GenericDssV uePlugin name to the name
of your class. Add the modified file back to the .jar file and be
sure that you keep the path specified (meta-inf\). (Figure B.2).

=

File Edit ‘Wiews Insert Format Help

e S #

Manifest-Version: 1.0 2
Created-By: 1.6.2_04 (2un Microsystems Inc.)
HeclhssVuePlugin: plugins.GenerichssVuePlugin

For Help, press F1
Figure B.2 Manifest .mf File

Y ou should be good to go at this point. Run HEC-DSSV ue and
test your plug-in. (Figure B.3). If you have problems, compare
what you have to one of the ssmple example plug-ins. If therunis
successful, you will receive a confirmation asis shown in Figure
B.4 (page B-4).

sample.dss - HEC-DS5Vue

File Edit Wiew Display Groups DataEntry BEEEEN Scripts  Advanced
1 I fath Functions. ..
= _J == H fx X| Hechss M s |
: Compare L
File Name: |C:I‘I’empisample.dss Search for Walue
Pathrames Shown: 27 Pathrames Selected: 1 2]
Check File Integrity
sample.dss X | Squeeze
Search A | Script Editor —
By Parts: pE- | script Selectar —
|| Mumber Part & Part B M

Figure B.3 Run Generic Plu'gin
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B.4

“!J’) 1 data sets saved

Figure B.4 Successful Run Confirmation

Generic DssVuePlugin Source

package pl ugi ns;

import java.awt.event. ActionEvent;
import java.aw .event.ActionLi stener;
i mport javax.sw ng.JOpti onPane;
inmport java.util.*;

i mport hec. dssgui . Li st Sel ection;

i mport hec.io. Ti meSeri esCont ai ner;

i mport hec. heclib. dss. DSSPat hnane;

i mport javax.sw ng.JMenultem

public class GenericDssVuePl ugin

public static void main(Object[] args)

{

final GenericDssVuePl ugin plugin = new GenericDssVuePl ugi n();

final ListSelection listSelection = (ListSelection) args[0];

JMenul t em generi cMenul tem = new JMenul t en( " Generic Plugin");

generi cMenul t em addAct i onLi st ener (new Acti onLi stener() {

public void actionPerforned(ActionEvent e){
pl ugi n. process(|i st Sel ection);

1 . . o . .

l'i stSel ection.registerPlugin(ListSelection. TOOLS, genericMenulten);
}

protected void process(ListSelection |istSelection)

/! Reads data fromDSS and returns it in data containers in a list
of lists
List[] dataList = listSelection.getSel ectedDataContai ners();
if (dataList == null) {
JOpt i onPane. showvessageDi al og(li st Sel ection, "No records
sel ected"”,
"Cannot read data",
JOpt i onPane. WARNI NG_MESSACGE) ;
return;

/1l The first list contains a list of TineSeriesContainers
/1 The second is PairedDataContainers, third is text, fourth is
gri dded
Li st tsContainers = dataList[O0];
if ( (tsContainers !'= null) && (tsContainers.size() > 0)) {
bool ean success = processData(listSel ection, tsContainers);
if (!success) {
JOpt i onPane. showessageDi al og(listSel ection, "Error in
processi ng data",

}

el se {
JOpt i onPane. showivessageDi al og(listSel ection, "No time series data

"Error", JOptionPane. WARNI NG_MESSAGE) ;

read",
"No data found",
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JOpt i onPane. WARNI NG_MESSAGE) ;
}
}

protected bool ean processData(ListSelection listSelection, List
t sCont ai ners)

for (int i =0; i < tsContainers.size(); i++) {
Ti meSeri esCont ai ner tsc = (Ti neSeri esContai ner)
tsContainers.get(i);
/1 Do something with the data here
/1l For this exanple, we will add "10" to each val ue
for (int j=0; j<tsc.values.length; j++) {
tsc.values[j] += 10.0;

}

/1 Save the data, if needed

DSSPat hnanme path = new DSSPat hnane(tsc. ful | Nane) ;

path.setFPart (path.fPart() + " + MID');

tsc. full Nane = pat h. pat hnane();

/1 You can save or saveAs individual containers as you nodify
t hem

/11istSel ection.save(tsc);

/11istSel ection.saveAs(tsc);

/1 OR you can save the list of containers.

I'i stSel ection.save((Vector)tsContainers);

/1 Update the catalog if you added records

|istSelection.refreshCatal og();

/1 Display a confirnation nessage

JOpt i onPane. showmvessageDi al og(li stSel ection, tsContainers.size() + "
data sets saved",

"Wite Successful",

JOpti onPane. | NFORVATI ON_MESSAGE) ;

return true;

}

}

B.5 Primary Functions

B.5.1 ListSelection Functions

To register your plug-in with HEC-DSSV ue, the following functions are
available:

public static void main(Object[] args) {
final ListSelection listSelection = (ListSelection) args[0];

1. Register your plug-in with:

a public void registerPlugin(int nenuNurmber, JMenultem
nmenul t en)

where menuNumber is:

FILE = 0;

EDIT = 1;
VIEW = 2:

DI SPLAY = 3;
GROUPS = 4:
DATA ENTRY = 5;
TOOLS = 6:
CUSTOM = 7;
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B.5.2 DSSPathn

SCRI PTS = 8;
ADVANCED = 9;
HELP = 10;
b. public void registerlnportPlugin(lnportPlugin
i mport Pl ugin, JMenultem nenultem String
dr opAndDr agExt ensi on)

C. public void registerExportPl ugi n(JMenultem menul tem
d. public void addTool Bar Button(JButton button)

Y ou can put your plug-insin acustom menu that you can name

(e.0., listSelection.setCustomMenu(Our Math Functions): publ i c
voi d set Cust omMvenu(String menuText)

Read data for selected pathnames with getSelectedData

Containers():
List[O] will be a list of TimeSeriesContainer, or null if
none read.
List[1] will be a list of PairedDataContainer or null

List[2] will be a list of TextContainer

Write datato HEC-DSS:
bool ean save( Dat aCont ai ner dat aCont ai ner);
bool ean saveAs( Dat aCont ai ner dat aCont ai ner) ;
i nt save(Vector DataContainer);

Others:
Dat aRef er enceSet get Sel ect edPat hnanes()
voi d updat eCat al og();
bool ean set DSSFi | enane(String DSSFi | eNane) ;
String get DSSFi | enane();
voi d addToSel ecti on(String pat hnane)
public void setTi meWndow( String ti neW ndow)
voi d set Ti mreW ndow( String start, String end, bool ean appl yAll)
voi d set Ti mneW ndow( HecTi ne start, HecTine end, bool ean appl yAll)
voi d tabul at e(Li st sel ect edDat aCont ai ners);
voi d pl ot (Li st sel ectedDat aCont ai ners);

ame

hec.heclib.dss.DSSPathname

TableB.1 DSSPathname

Field Type Description
getPathname (); String | Returns the pathname
getAPart(); String | Getsthe A part
getBPart(); String | Getsthe B part
getCPart(); String | Getsthe C part
getDPart(); String | Getsthe D part
getEPart(); String | Getsthe E part
getFPart(); String | Getsthe F part
setAPart (String aPart); void Overrides the default A part
setBPart (String bPart); void Overrides the default B part
setCPart (String cPart); void Overrides the default C part
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Field Type Description
setDPart (String dPart); void Overrides the default D part
setEPart (String ePart); void Overrides the default E part
setFPart (String fPart); void Overrides the default F part
setPathname (String pathname); int sets the pathname and returns O if

successful

static getDefaultAPart(); String | Getsthe default A part
static getDefaultBPart(); String | Getsthe default B part
static getDefaultCPart(); String | Getsthe default C part
static getDefaultDPart(); String | Getsthe default D part
static getDefaultEPart(); String | Getsthe default E part
static getDefaultFPart(); String | Getsthe default F part
static setDefaultAPart (String aPart); void Setsthe default A part
static setDefaultBPart (String bPart); void Sets the default B part
static setDefaultCPart (String cPart); void Sets the default C part
static setDefaultDPart (String dPart); void Sets the default D part
static setDefaultEPart (String ePart); void Sets the default E part

static setDefaultFPart (String fPart); void Sets the default F part

TimeSeriesContainer

.i0.TimeSeriesContainer - contains the data read or to be written:

TableB.2 TimeSeriesContainter

Field Type Description

endTime; int The end time of the time window. If the data were
retrieved, the end time may be later than the last
timeinthetimeslist.

fullName; String Pathname

fileName; String Dssfilename

interval; int Theinterval, in minutes, between each set of
consecutive timesin the times list. For irregular-
interval times, theinterval field isset to -1.

location String The location associated with the data (DSS
pathname B-part if the DataContainer is
associated with the DSSfile).

numberValues; int The length of values and times lists.

parameter String The parameter associated with the data

precision = -1, int Digitsto the right of the decimal

quality int[ ] The optional list of quality flags. If thislistis
present, there must be a quality for each value

startTime; int The start time of the time window. If the data
were retrieved, the start time may be earlier than
thefirst timein thetimeslist.

subL ocation String The sub-location associated with the data.
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B.5.4

Field Type Description

subParameter String The sub-parameter associated with the data.

subVersion String The sub-version associated with the data.

times; int[] The array of times. Thereis a one-to-one
correspondence between the times array and the
values array .

timeZonelD String Thetime-zone for thisobject. Setto“” if none.

timeZoneRawOffset int The offset, in milliseconds, from UTC to the time
Zone.

type String Field containing the data type (PER-AVER, €tc)

units String The units of the data (CFS, etc)

values doubl€[] The data values, each of which hasa
corresponding time in the times array and
optionally a corresponding quality in the quality
array. All arrays must have the same length.

version String The version associated with the data (DSS
pathname F-part if the DataContainer is
associated with aDSSfile).

watershed String The watershed associated with the data (DSS

pathname A-part if the DataContainer is
associated with a DSSfile).

Table B.3 PairedDataContainter

PairedDataContainer

Field Type Description

endTime; int The end time of the time window. If the data
were retrieved, the end time may be later than the
last timein the times list.

fullName; String Pathname

fileName; String Dssfilename

interval; int The interval, in minutes, between each set of
consecutive timesin the times list. For irregular-
interval times, the interval field is set to -1.

location String The location associated with the data (DSS
pathname B-part if the DataContainer is
associated with the DSSfile).

numberValues; int The length of values and times lists.

parameter String The parameter associated with the data

precision = -1; int Digitsto theright of the decimal

quality int[ ] The optional list of quality flags. If thislistis
present, there must be a quality for each value

startTime; int The start time of the time window. If the data
were retrieved, the start time may be earlier than
thefirst timein the timeslist.

subL ocation String The sub-location associated with the data.

subParameter String The sub-parameter associated with the data.
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Field Type Description

subVersion String The sub-version associated with the data.

times; int[ ] The array of times. Thereis a one-to-one
correspondence between the times array and the
values array .

timeZonelD String Thetime-zone for thisobject. Setto“” if none.

timeZoneRawOffset int The offset, in milliseconds, from UTC to the time
zone.

type String Field containing the data type (PER-AVER, €tc)

units String The units of the data (CFS, etc)

values doublg[ ] | The datavalues, each of which hasa
corresponding time in the times array and
optionally a corresponding quality in the quality
array. All arrays must have the same length.

version String The version associated with the data (DSS
pathname F-part if the DataContainer is
associated with a DSSfile).

watershed String The watershed associated with the data (DSS
pathname A-part if the DataContainer is
associated with a DSSfile).

B.5.5 HecTime
TableB.4 HecTime
Field Type Description

endTime; int The end time of the time window. If the data
were retrieved, the end time may be later than the
last time in the times list.

fullName; String Pathname

fileName; String Dssfilename

interval; int The interval, in minutes, between each set of
consecutive timesin the times list. For irregular-
interval times, the interval field is set to -1.

location String The location associated with the data (DSS
pathname B-part if the DataContainer is
associated with the DSSfile).

numberValues; int The length of values and times lists.

parameter String The parameter associated with the data

precision = -1; int Digitsto theright of the decimal

quality int[ ] The optional list of quality flags. If thislistis
present, there must be a quality for each value

startTime; int The start time of the time window. If the data
were retrieved, the start time may be earlier than
thefirst timein the timeslist.

subL ocation String The sub-location associated with the data.

subParameter String The sub-parameter associated with the data.

subVersion String The sub-version associated with the data.
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Field Type Description

times; int[ ] The array of times. Thereis a one-to-one
correspondence between the times array and the
values array.

timeZonelD String Thetime-zone for thisobject. Setto“” if none.

timeZoneRawOffset int The offset, in milliseconds, from UTC to the time
zone.

type String Field containing the data type (PER-AVER, €tc)

units String The units of the data (CFS, etc)

values doublg[ ] | The datavalues, each of which hasa

corresponding time in the times array and
optionally a corresponding quality in the quality
array. All arrays must have the same length.
version String The version associated with the data (DSS
pathname F-part if the DataContainer is
associated with a DSSfile).

watershed String The watershed associated with the data (DSS
pathname A-part if the DataContainer is
associated with a DSSfile).

B.5.6 HecDouble

TableB.5 HecDouble

Field Type Description
isDefined(); boolean |falseif missing or not set
set(double value); void Setsthe value
set(double value, int void Sets the value and precision (the number
precision); of values past the decimal place to display)
set(String value); Sets the value and precision
setPrecision (int precision); int Sets the precision — the number of values

past the decimal placeto display. (does
not change what is stored)

string(); String | Returns a String of the value
string(boolean String | Returns a String of the value. If
printCommas); printCommas s true, commas are inserted

in the appropriate locations in the string.
string(boolean printCommas, String | Returns a String of the value, formatted

Decimal FormatSymbols according to the format given.
symbols);
value(); double | returnsthe actual number

B.5.7 HecDoubleArray

hec.heclib.util.HecDoubleArray - an array of HecDouble
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TableB.6 HecDoubleArray

M ethod Returns Description

element(int HecDouble | Returnsthe HecDouble object at that

elementNumber); location.

set (double values]]); void Sets the val ues.

setPrecision(int precision); int Sets the number of values to display past
the decimal point for all valuesin the array.

string(int String Returns the value at the element given asa

elementNumber); String

string(int elementNumber, String Returnsthe value at the element given asa

boolean printCommas); String. If printCommasis true, commas
are inserted at the appropriate locations.

B.6 ToTextPlugin

The ToTextPlugin takes selected time series data sets and writes the data
out to atext file. You can usethisto create an input filein acertain
format for other programs.

import java.awt.event.Acti onEvent;
import java.awt.event.ActionLi stener;
i mport javax.sw ng.JOpti onPane;
inmport java.util.*;

inmport java.io.*;

i mport hec. dssgui . Li st Sel ection;

i mport hec.io. Ti meSeri esCont ai ner;
import hec. heclib.util.HecTine;

import rma. awt. Fl at Panel Butt on;

i mport javax.sw ng. JFi | eChooser;
import hec. heclib.util.HecDoubl eArray;
i mport hec. dataTabl e. *;

public class ToTextPlugin

public static void main(Qoject[] args)
{
final ToTextPlugin plugin = new ToText Pl ugi n();
final ListSelection listSelection = (ListSelection) args[0];

Fl at Panel Button button = new Fl at Panel Button("To Text");
but t on. addAct i onLi st ener (new Acti onLi stener ()

public void actionPerfornmed(Acti onEvent e)

{

pl ugi n. process(li st Sel ection);

1)
|'i st Sel ection. get Tool Bar (). add(button);

}
protected void process(ListSelection |istSelection)

/! Reads data fromDSS and returns it in data containers in a
list of lists
List[] dataList = listSelection.getSel ectedDat aCont ai ners();
if (dataList == null) {
JOpt i onPane. showiessageDi al og(|i st Sel ection, "No records
sel ected"”,
"Cannot read data",
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JOpt i onPane. WARNI NG_MESSAGE) ;
return;

/1 The first list contains a list of TineSeriesContainers

/1 The second is PairedDataContainers, third is text, fourth is
gri dded

Li st tsContainers = dataList[O0];

if ( (tsContainers != null) && (tsContainers.size()

0) {
processDat a(l i st Sel ection, tsContainers);
}
el se {
JOpt i onPane. showessageDi al og(listSelection, "No tinme series
data read",

"No data found",
JOpt i onPane. WARNI NG_MESSAGE) ;

}
}

protected bool ean processDat a(Li stSel ection |istSelection,
Li st tsContainers) {
try {
/1l Get the nane of the text file to wite to.
JFi | eChooser chooser = new JFil eChooser();
chooser . set Accept Al |l Fil eFil terUsed(false);
chooser.setDial ogTitle("Enter file to save data to");
chooser.setFileFilter(new rma. util.RVAFi | enameFilter("txt",
"rotxt"));
chooser. showOpenDi al og(li st Sel ection);
java.io.File file = chooser. get Sel ectedFil e();
if (file == null)
return fal se;
String fileName = file.getAbsol utePath();
if (fileNane.endsWth(".txt") == fal se)
fileNane = fileName + ".txt";
PrintWiter textQut = new PrintWiter(new
FileWiter(fil eNane));
/!l Wite either as either data in a single colum or data
sets
/1 in multi-colum. The table software organizes data sets
with tines.
bool ean tabl eStyle = true;
if (tableStyle) {
wri t eTabl eFor mat (t ext Qut, tsContainers);

el se {
writeSingleSets(textQut, tsContainers);
}

textQut.close();
JOpt i onPane. showivessageDi al og( | i st Sel ecti on,
tsContainers.size() + " data
sets witten to " +
fil eNane,
"Wite Successful ",
pti onPane. | NFORMATI ON_MESSAGE) ;
return true;

}
catch (Exception e) {
JOpt i onPane. showvessageDi al og(li st Sel ection, e.toString(),
"Cannot wite to file",

JOpt i onPane. WARNI NG_MESSACE) ;
return fal se;

}
protected void witeSingleSets(PrintWiter textQut, List tsContainers)
HecTine time = new HecTi ne();

for (int i =0; i < tsContainers.size(); i++) {
Ti meSeri esContai ner tsc = (Ti neSeri esContai ner)
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tsContainers.get(i);
textQut.println(tsc. full Nane);
/'l HecDouble will take care of missing data and the precision
HecDoubl eArray val ues = new HecDoubl eArray();
val ues. set (tsc. val ues);
val ues. set Preci si on(tsc. preci sion);
for (int j =0; j < tsc.nunberValues; j++) {
time.set(tsc.times[j]);
textQut.println(tine.toString(4) +"; " +
val ues. el ement (j));

}
}

protected void witeTabl eFormat (PrintWiter textQut, List
tsCont ai ners) {
HecDat aTabl e dataTabl e = new HecDat aTabl e(nul I');
dat aTabl e. set Dat a(t sCont ai ners, false, 0);
/1 UndefinedStyle: 0 =""; 1 =-901.0; 2 ="M; 3 ="-M"
dat aTabl e. set Undef i nedStyl e(2);
/1 See HecTine (or heclib juldat) for date styles
dat aTabl e. set Dat eStyl e(4) ;
i nt nunber Col ums = dat aTabl e. get Col umCount () ;
int nunber Rows = dat aTabl e. get RowCount () ;
int starti ngRow = dat aTabl e. get Nunmber Header Rows() ;
for (int i=startingRow, i<nunberRows; i++) {
StringBuffer sb = new StringBuffer();
for (int j=0; j<nunberColums; j++) {
sh. append((dat aTabl e. get Val ueAt (i, j)).toString());
sb. append(" ");

}
textQut.println(sb.toString());
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Appendix C

Example Scripts

C.1 Introduction

This appendix provides several example scriptsto illustrate the use of
scripting with HEC-DSSVue. Documentation for the calls in these scripts
isprovided in Chapter 8 of the HEC-DSSSVue User Manual. The intent
of this appendix is to show variationsin scripts and how to implement
them.

Usually it is easiest to write a script by taking an example and modifying it
to meet your needs. The scriptsin this appendix are provided with the
program in the directory "Samples'. The datafor the scriptsis provided in
the sample.dssfile. Most scripts access thisfilein the"C:\temp"

directory. To execute the scripts, you will need to copy sample.dssto the
C:\temp directory, and the sample scripts to "HecDssVue\cripts"
directory, or you may import them with the Script Editor.

This section covers math scripts, export/import scripts, simple graphics,
"headless' operation (graphics in a background mode), complex graphics
and calling scripts from scripts.

C.2 Sample Math Scripts

Math scripts use the HecMath package, so no direct access to HEC-
DSSVueor ListSelection is needed. Y ou can also get a DataContainer
and access the data directly. The two approaches are shown in the
following two scripts, which both add the number "10" to each value.

AddTenTsc.py

# Add 10 to each val ue using Ti meSeriesCont ai ner
#

from hec. script inmport *

from hec. heclib.dss inport *

from hec. dat aTabl e i nmport *

fromjava import *

# Open the file and get the data
try:
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dssFile = HecDss.open("C:./tenp/sanpl e.dss", "10MAR2006 2400,
09APR2006 2400")
outflow = dssFile. get ("/AVERI CAN FOLSOM FLOW RES
QUT/ 01JAN2006/ 1DAY/ OBS/ ")
i =0
for value in outflow val ues :
outflow values[i] += 10.
i +=1

pat h = DSSPat hname(out f | ow. f ul | Narne)
fPart = path.fPart() + " + 10"

pat h. set FPart (f Part)

outflow. full Name = pat h. get Pat hnane()

dssFil e. put (out fl ow)

except java.lang. Exception, e :
# Take care of any missing data or errors
MessageBox. showError (e. get Message(), "Error reading data")

AddTenHecM ath.py

# Add 10 to each val ue using HechMath
#

from hec. script inmport *

from hec. hecmath inport *

fromjava inport *

# Open the file and get the data
try:
dssFile = DSS. open("C:./tenp/sanpl e.dss", "10MAR2006 2400,
09APR2006 2400")
outflow = dssFile.read("/AVER CAN FOLSOM FLOW RES
QUT/ 01JAN2006/ 1DAY/ OBS/ ")
newQut f | ow = out fl ow. add( 10.)

pat h = DSSPat hname( newCut f | ow. get Pat h())
fPart = path.fPart() + " + 10 HecMath"
pat h. set FPart (f Part)

newQut f | ow. set Pat hnane( pat h. get Pat hnane())

dssFile.wite(newQutfl ow)

except java.lang. Exception, e :
# Take care of any missing data or errors
MessageBox. showEr r or (e. get Message(), "Error reading data")

Unless the function you are using is hot something not supported
by HecMath, the HecM ath functions are easier to use than
manipulating the data directly in a DataContainer.

A routine functions suitable for scripting is estimating missing values.
Thisis done with the HecMath function estimateForMissingValues(). An
exampleis show for EstimateMissing.py.

# Fill in mssing val ues using HechMath
#

from hec. script inmport *

from hec. hecmath inport *

fromjava inport *
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# Qpen the file and get the data
try:

dssFile = DSS. open("C./tenp/sanpl e.dss", "10MAR2006 2400,
09APR2006 2400")

flow = dssFile.read("/ AVERI CAN FOLSOM FLOW RES
I N 01JAN2006/ 1DAY/ OBS/ ")

newf | ow = fl ow. esti mat eFor M ssi ngVal ues(10)

pat h = DSSPat hname( newf | ow. get Pat h())

fPart = path.fPart() + " + FILLED

pat h. set FPart (f Part)

newf | ow. set Pat hnane( pat h. get Pat hnane())

dssFile.wite( newfl ow)
except java.lang. Exception, e :

# Take care of any missing data or errors

MessageBox. showError (e. get Message(), "Error reading data")

Another useful function is smoothing, typically used for reservoir data. Of
course this could have been just an additional line added to the
EstimateMissing.py script.

Smoothing.py

# Snooth val ues using HecMath
from hec.script inport *

from hec. hecmath inport *

from hec. heclib.dss inport *
fromjava inport *

# Open the file and get the data
try:
dssFile = DSS. open("C:./tenp/sanpl e.dss", "10MAR2006 2400,
09APR2006 2400")
flow = dssFil e.read("/ AVERI CAN FOLSOM FLOW RES
I N 01JAN2006/ 1DAY/ OBS/ ")
newf | ow = fl ow. cent er edMovi ngAverage(7, 1, 0)
pat h = DSSPat hnane( newf | ow. get Pat h())
fPart = path.fPart() + " + SMOOTH'
path. set FPart (f Part)
newf | ow. set Pat hnane( pat h. get Pat hnarne())
dssFile.wite( newflow)
except java.lang. Exception, e :
# Take care of any missing data or errors
MessageBox. showError (e. get Message(), "Error reading data")

C.3 Sample Import and Export Scripts

Y ou can write scripts to import or export data with various formats. Y ou
can also write scripts to display a data entry table that can be used to enter
data manually.

C.3.1 Manually Entry Scripts

Both the manual time series data entry screen and paired data entry screen
can be brought up from a script. They both can be passed a pathname to
preset the dialog, and the time series dialog can be given a start time. For
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example, to display an initialized time series data entry screen (Figure
C.1), thefollowing DataEntry.py script can be used:

I Time Series Data Entry @

Pathname Parts
A |GREEN B |OAK G FLOWY

D: E: | 1DAY e F: OBS

Pathname: |fGREEMN/OAKIFLOWII DAYIOBSS

Start Date: |20 March 2004 Units:
Start Time: 0800 Type: |IMST-WAL 3
Manual Entry | automatic Generation
Ordinate Date Time Yalue
1 Z0Marz009 05:00 ”
z Z1Marz009 05:00
3 ZzZMarz009 05:00
v
’ Flat l [ Graphically Edit l [ Sane l [ Cancel

Figure C.1 Time Series Data Entry Screen

from hec.script inport *
from hec. dssgui inport *
fromhec. heclib.util inport *
i mport java

I s = ListSel ection. get Mai nW ndow()
| s.setlslnteractive(1,0) # Turn off popups
I s.open("C:/tenp/ nydb. dss")

time = HecTine()
time.setCurrent()
time.setTime("0800")
ti me. addDays(-5)

I's.timeSeriesDataEntry("/GREEN OQAK/ FLOW / 1DAY/ OBS",
time. dat eAndTi ne(4))
# Is.finish() # Batch node only

C.3.2 SHEF Import/Export Scripts

If the SHEF parameter files are setup correctly, asimple script can be
written to import or export SHEF data. Essentially, the same steps are
followed in the script as would be done interactively through the
ListSelection class. For example, FolsomT oShef.py:

from hec. script inport *
from hec. heclib.dss inport *
from hec. dssgui inport *
inmport java
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# Open the file and get the data
try:
dssFil e = HecDss. open("C./tenp/sanpl e. dss", "10MAR2006 2400, 09APR2006
2400")
precip = dssFile.get("/AVER CAN FOLSOM PRECI P-
BASI N 01JAN2006/ 1DAY/ OBS/ ")
stor = dssFile.get("/AVERI CAN FOLSOM STOR- RES EOP/ 01JAN2006/ 1DAY/ OBS/ ")
topcon = dssFile. get("/AMVERI CAN FOLSOM TOP CON
STOR/ 01JAN2006/ 1DAY/ OBS/ ")
sagca = dssFil e. get ("/AVERI CAN FOLSOM SAGCA/ TOP CON
STOR/ 01JAN2006/ 1DAY/ OBS/ ")
inflow = dssFile.get("/AVER CAN FOLSOM FLOW RES | N 01JAN2006/ 1DAY/ OBS/ ")
outfl ow = dssFil e. get("/AVER CAN FOLSOM FLOW RES
OUT/ 01JAN2006/ 1DAY/ OBS/ ")
except java.l ang. Exception, e :
# Take care of any missing data or errors
MessageBox. showError (e. get Message(), "Error readi ng data")

# Add Data

datasets = java.util.Vector()
dat aset s. add( preci p)

dat aset s. add(stor)

dat aset s. add(t opcon)

dat aset s. add( sagca)

dat aset s. add(i nfl ow)

dat aset s. add(out fl ow)

I's = ListSel ection. get Mai nW ndow()
Is.setlslnteractive(1,0) # Turn off popups
| s. export Shef (" C:/tenp/ Fol sonthef Dat a. shef", datasets)

#ls.finish() # Batch node only

Thefile FolsomShefData.shef will contain:

. E FOLSOM 200906 Z DY0603102400/ PR/ DI D1/ 0. 79000002/ 0. 31999999/ 0. 25999999

. E FOLSOM 200906 Z DY0603132400/ PR/ DI D1/ 0. 20999999/ 1. 08/ 0. 050000000/ 0. 30000001

. E FOLSOM 200906 Z DY0603172400/ PR/ DI D1/ 0. 76999998/ 0. 039999990/ 0. 020000000

. E FOLSOM 200906 Z DY0603202400/ PR/ DI D1/ 0. 38999999/ 0. 14/ 0. 020000000/ 0. 020000000

Instead of reading the data and passing to exportShef(), the time window
could have been set and the pathnames set selected in ListSelection just as
well.

Importing SHEF datais easy; you essentially call the function
importShef(String fileName), passing in the name of the file to import.

from hec. script inport
from hec. dssgui inport *
i nport java

I s = ListSel ection. get Mai nW ndow()

| s.setlslnteractive(1,0) # Turn off popups
I s.open("C:./tenp/ nyDb. dss")

| s.inmport Shef (" C:/tenp/ Fol sontShef Dat a. shef ")

#ls.finish() # Batch mode only

C.3.3 Exporting to Excel

The export to Excel function uses code from HecDataT able; writing to
Excel issimilar to creating atable. The script FolsomExcel.py not only
puts the datain an Excel file, but runs Excel too (Figure C.2):
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E4 Microsoft Excel - HecDssExcel5133095241365959206.xis ([=0(E3]

File Edit Wiew Insert Format Tools Data ‘Window Help Adobe FDF ;Iilﬁ
DEEds &RV RS - @z A A MY e -0 - B U 2
T 5 | | @0 Snagit window -
H24 | = 7937
& B © D E F G H =

1 A AMERICARN AMERICAN AMERICARN AMERICAN  AMERICARN AMERICAN — —
2 B FOLSOM FOLSOM FOLSOM=0LSOM-SAGCA FOLSOM FOLSOM

3 C FRECIP-BASIN STOR-RES EOP "OF COM STOR| TOP CON STOR| FLOW-RES IN FLOW-RES OUT

4 E

5 F 083 0B3 OBS OBs 083 0B3

4] Units INCHES ACFT ACFT ACFT CFS CF3

7 Type PER-CLM PER-AVER INST-VAL INST-VAL PER-AVER PER-AVER

g 1 10mMar2008 0.79 607779 559500 427200 9916 4459

9 2 1Mar2008 032 514636 551000 434500 2080 5280

10 3 12Mar2006 0.26 6166598 593200 443900 8808 5327

11 4 13Mar2008 021 623248 595900 452700 8704 7646

12 5 l4Mar2006 1.08 628356 5559600 461100 10541 7212

13 6 15Mar2008 0.05 531250 554200 4659500 9772 71588

14 7 16Mar2008 0.30 536655 556200 478400 8771 77

15 8 17Mar2006 0.77 540026 592800 487200 9768 7050

16 9 18Mar2008 0.04 642130 597800 496000 9478 7753

17 100 19Mar2006 0.0z 543964 603200 504700 §3595 7273

15 11 20Mar2008 039 544147 604200 513100 g362 7388

19 12 21Mar2008 0.14 545064 B08200 522300 7609 7517

20 130 22Mar2006 0.0z2 644783 613500 530700 8121 7090
4[> M} Sheetl / |«

Ready

Figure C.2 Export to Excel

If you would rather specify the Excel file name, you can do that by giving
the name of the file following the datasets. Y ou can also just create an
Excel file, without running it, by using the function createExcelFile. This
is shown in the script FolsomSaveExcel .py:

from hec.script inmport *
from hec. heclib.dss inport *
from hec. dat aTabl e i nport *
inmport java

# Open the file and get the data
try:
dssFil e = HecDss. open("C./tenp/sanpl e.dss", "10MAR2006 2400, 09APR2006
2400")
precip = dssFile.get("/AVER CAN FOLSOM PRECI P-
BASI N 01JAN2006/ 1DAY/ OBS/ ")
stor = dssFile.get("/AVERI CAN FOLSOM STOR- RES EOP/ 01JAN2006/ 1DAY/ OBS/ ")
topcon = dssFile. get("/AMVER CAN FOLSOM TOP CON
STOR/ 01JAN2006/ 1DAY/ OBS/ ")
sagca = dssFil e. get ("/AVERI CAN FOLSOM SAGCA/ TOP CON
STOR/ 01JAN2006/ 1DAY/ OBS/ ")
inflow = dssFile.get("/AVER CAN FOLSOM FLOM RES | N 01JAN2006/ 1DAY/ OBS/ ")
outfl ow = dssFil e. get ("/ AMERI CAN FOLSOM FLOW RES
OUT/ 01JAN2006/ 1DAY/ OBS/ ")
except java.lang. Exception, e :
# Take care of any missing data or errors
MessageBox. showError (e. get Message(), "Error readi ng data")

# Add Data

datasets = java.util.Vector()
dat aset s. add( preci p)

dat aset s. add(stor)

dat aset s. add(t opcon)

dat aset s. add(sagca)

dat aset s. add(i nfl ow)

dat asets. add(out fl ow)

# For this code, jython sees a List before a Vector
#list = java.awt. List()

list =[]

I'i st.append(dat asets)

tabl e = HecDat aTabl eToExcel . newTabl e()
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# |If you want to run Excel with a specific nane and not a tenp nane
tabl e. runExcel (1ist, "myWrkbook. x| s")

# O, if you would just rather create an Excel file, but not run it:
#t abl e. cr eat eExcel Fi | e(dat asets, "nyWrkbook. xI s")

C.3.4 Importing Other Formats

If you can
HEC-DSS

parse aformat, you can write a script to enter your datainto
by using a DataContainer. DataContainers are generic database

independent classes that hold data used by the various functionsin HEC-

DSSVue.

The following example, WriteDss.py, shows the use of a
TimeSeriesContainer with made-up data. 1n this example, HecTimeis
used to generate the times needed and the TimeSeriesContainer is
imported from hec.io:

from hec
from hec
from hec
from hec

i mport j

try :
try :
ny Ds
tsc
tsc.
star
tsc.

.script inmport *
.heclib.dss inport *
.heclib.util inport *
.io inmport *

ava

s = HecDss. open("C:./tenp/test.dss")

= Ti meSeri esCont ai ner ()

full Name = "/BASI N LOC/ FLOW / 1HOUR/ OBS/ "
t = HecTi ne("04Sepl1996", "1330")
interval = 60

flows = [0.0,2.0,1.0,4.0,3.0,6.0,5.0,8.0,7.0,9.0]

time
for
ti
st
tsc.
tsc.
tsc.
tsc.
tsc.

nmy Ds

except
Mess
except
Mess

s =[]

value in flows :

mes. append(start.val ue())
art.add(tsc.interval)
tinmes = tines

val ues = fl ows
nunber Val ues = | en(fl ows)
units = "CFS"

type = "PER- AVER'

S. put (tsc)

Exception, e :
ageBox. showkrror (' '.join(e.args), "Python Error")
java. |l ang. Exception, e :
ageBox. showError (e. get Message(), "Error")

finally :

nmyDss.

cl ose()

C.3.5 Sample Graphics Scripts

Generdly,

graphics scripts may be broken into five segments; 1) Retrieve

thedata; 2) Initidizetheplot; 3) Bring the plot into existence with
showPlot(); 4) Changethe plot; and 5) Save the plot to file and close.
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Most people are tripped up with the function showPlot(). Thisfunction
puts all the parts together and creates the plot. One would think that this
would be called at the end of the script, but to the contrary, it needs to be
called near the beginning. For example, you can not change or set a
curve's color until the curve exists, and the showPlot() function is what
creates curves. Scripting is emulating the steps that you would do
interactively; it is not acommand language.

HecDss uses exceptions for error processing, such as indicating missing
data. You need to usetry: except loops to catch errors, otherwise an
exception message will be written to the output and that exception may not
be very clear.

A simple plot (Figure C.3) example that illustrates these pointsis one for
Oakville:

File Edit VYiew

a0
@ 85

DEGREES

8,000

5,000

7,000

§,000
=.5,000
24,000
£ 3,000
L 2,000

1,000 rr"‘

u]

r—T 11T T 1T T T"T T T T T T T T T T TT
12 2 4 & 6 7 2 9 10 11 12 12 14 15 16 17 18 19 20 21

bl 31892
0AKMVILLE OBS FLOW-RES OUT

OAKNMILLE OBS AIRTEWP

Figure C.3 Oakville Output - Plot

from hec. script inmport * # al ways needed
fromhec. heclib.dss inmport * # Used to access HEC DSS
i mport java # Provide access to java

# Open the file and get the data
try :
dssFil e = HecDss. open("C:/tenp/sanpl e. dss")
ai rTenp = dssFile.get("/GREEN
Rl VER/ QAKVI LLE/ Al RTEMP/ 01MAY1992/ 1HOUR/ OBS/ ")
outflow = dssFil e. get ("/GREEN Rl VER/ QAKVI LLE/ FLOW RES
QUT/ 01MAY1992/ 1HOUR/ OBS/ ")
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dssFi |l e. done()
except java.l ang. Exception, e :
# Take care of any missing data or errors
MessageBox. showError (e. get Message(), "Error reading data")

# Initialize the plot and add data
pl ot = Plot.newPl ot ("Cakville")

pl ot . addDat a( ai r Tenp)

pl ot . addDat a( out f | ow)

# Create plot

pl ot. set Si ze( 600, 600)

pl ot. set Locati on(100, 100)
to see it

pl ot . showP! ot ()

# Mve off screen if you don't want

# Change the pl ot
out Curve = plot.getCurve(outflow)
out Cur ve. set Li neCol or (" dar kgreen")

# Save the plot and cl ose

pl ot . saveToPng("C: /tenp/ Gakvil | e. png")
#plot.close() # Do this if you only want the plot
# as a .png and not on screen

This example shows a more complex plot where we break the rule of
showPlot() of creating the plot prior to changing it. Inthis case,
configurePlotLayout() will also create the plot. In this plot of Folsom
Lake (Figure C.4), we create three separate viewports and size them
according to the different datatypes. Without too much work, we produce
apretty fancy plot.

Folsom - American River Basin Q@E|

File Edit Wiew

- o
=
= 1.0
B 207
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a0
800,000
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—1- 650,000 Eu“
- 600,000 &
- 550,000 &
- 500,000
- 450,000
400.000
40,000
% ]
S 20,000
= ]
E DIIIIIIIIIIIIIIIIIIIIIIIIIIIIII
11 13 16 17 18 2 23 26 27 28 3 2z 4 6 &
Mar2008 | Apr2006
FOLSOM OBS PRECIP-BASIN — FOLSOM OBS STOR-RES EOP
FOLSOM OBS TOP COM STOR: FOLSOM-SAGCA OBS TOP CON STOR
FOLSOM OBS FLOWY-RES IN FOLSOM OBS FLOW-RES OUT

Figure C.4 Folsom Lake Plot
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Folsom.py

from hec.script inport *

from hec. script.Constants inmport TRUE, FALSE
from hec. heclib.dss inport *

i mport java

# Open the file and get the data
try:
dssFile = HecDss.open("C:/tenp/sanpl e.dss", "10MAR2006 2400,
09APR2006 2400")
preci p = dssFile.get("/AVER CAN FOLSOM PRECI P-
BASI N 01JAN2006/ 1DAY/ OBS/ ")
stor = dssFile.get("/AMVERI CAN FOLSOM STOR- RES
EOP/ 01JAN2006/ 1DAY/ OBS/ )
topcon = dssFile.get ("/AMERI CAN FOLSOM TOP CON
STOR/ 01JAN2006/ 1DAY/ OBS/ ")
sagca = dssFile.get("/AVERI CAN FOLSOW SAGCA/ TOP CON
STOR/ 01JAN2006/ 1DAY/ OBS/ ")
infl ow = dssFile. get("/AMER CAN FOLSOM FLOW RES
I N/ 01JAN2006/ 1DAY/ OBS/ ")
outflow = dssFil e. get ("/AVERI CAN FOLSOM FLOW RES
QUT/ 01JAN2006/ 1DAY/ OBS/ ")
except java.lang. Exception, e :
# Take care of any missing data or errors
MessageBox. showError (e. get Message(), "Error reading data")

# Initialize the plot and set viewport size in precent
pl ot = Pl ot.newPl ot ("Fol som- Anmerican R ver Basin")

| ayout = Pl ot.newPl ot Layout ()

topVi ew = | ayout . addVi ewport (10.)

m ddl eVi ew = | ayout . addVi ewport ( 60.)

bottomVi ew = | ayout. addVi ewport (30.)

# Add Data in specific viewdorts
topVi ew. addCurve("Y1", precip)

m ddl eVi ew. addCurve("Y2", stor)

m ddl eVi ew. addCurve("Y2", topcon)
m ddl eVi ew. addCur ve("Y2", sagca)
bott omVi ew. addCurve("Y1", inflow)
bott omVi ew. addCurve("Y1", outfl ow)

panel = plot. get Pl ot panel ()
prop = panel . getProperties()
prop. set Vi ewport SpaceSi ze(0)

# Break our first rule - actually this creates the plot to
change
pl ot . confi gurePl ot Layout (| ayout)

panel = plot. get Pl ot panel ()
prop = panel . getProperties()
prop. set Vi ewport SpaceSi ze( 0)

# Invert the precip and nake pretty
viewd = plot.getViewport(0)

yaxis = view0. get Axi s("Y1")

yaxi s. set Rever sed( FALSE)

preci pCurve = plot. get Curve(precip)
preci pCurve. setFi || Col or ("bl ue")
preci pCurve. setFi | | Type(" Above")
preci pCurve. set Li neVi si bl e( FALSE)
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# Set the inflow and outflow colors
i nfl owCurve = plot.get Curve(inflow)
i nfl owCurve. set Li neCol or (" magent a")
out fl owCurve = plot.getCurve(outflow)
out f| owCur ve. set Li neCol or (" purpl e")

pl ot . showP! ot ()

C4a Sample Table Script

Creating atable from ascript is easier than plots as thereisless to do.
Like plots, you retrieve the data, add the data to a Vector, create atable
and set the data, and then show the table. The same data shown in the plot
iseasily displayed in tabular form (Figure C.5) by the following

FolsomT able.py script:

Folsom - American River Basin

Filz Edit Wiew
FOLSOM FOLSOM FOLSOM FOLSOM-5AG. .. FOLSOM FOLSOM
Ordinate Date | Time PRECIP-BASIN | STOR-RES ECP | TOP COMSTOR | TOP COM STOR, | FLOW-RES IN | FLOW-RES OUT
OBS QBS OBS OBS CBS OBS

1 10 Mar 2006, 24:00 0.79 07779 589500 427200 9916 4459 | -~
S 14 Mar 2006, 24:00 1.08 628398 559600 461100 10541 7ilz
2 11 Mar 2006, 24:00 0.32 614636 591000 434500 9050 5250
& 17 Mar 2006, 24:00 0.77 640026 592800 457200 9765 7050
3 12 Mar 2006, 24:00 0.26 616698 593200 443900 8808 5327
[&] 15 Mar 2006, 24:00 0.05 631290 594200 469500 977z 7155
4 13 Mar 2006, 24:00 0.21 623248 595300 452700 5704 FE46
7 16 Mar 2006, 24:00 0.30 HI6658 596200 478400 G771 72TV
El 18 Mar 2006, 24:00 0.04 642130 597300 496000 9475 FT53
10 19 Mar 2006, 24:00 0.02 543964 603200 504700 8395 7273
11 20 Mar 2006, 24:00 0.39 644147 604200 513100 8362 7385
16 25 Mar 2006, 24:00 1.66 474002 606100 553900 16606 7957
1z 21 Mar 2006, 24:00 0.14 645064 BOG200 522500 709 7517
17 26 Mar 2006, 24:00 0.09 BB2753 611300 561500 14838 7937
13 22 Mar 2006, 24:00 0.0z 644759 613500 530700 G121 7595
15 27 Mar 2006, 24:00 0.11 BR2592 616300 S62000 121358 FEES
19 28 Mar 2006, 24:00 0.65 702053 616400 576500 13054 726

1d ZalaE Z0ne Sann 0z FdiEre PR S3E700 Z405 Zere | Y

Figure C.5 Folsom Lake Tabular Display

fromfromhec.script inport *
from hec. heclib.dss inport *
from hec. dataTabl e i nport *

i mport java

# Open the file and get the data
try:
dssFil e = HecDss. open("C:/tenp/sanpl e.dss", "10MAR2006 2400,
09APR2006 2400")
preci p = dssFile.get("/AVERI CAN FOLSOM PRECI P-
BASI N/ 01JAN2006/ 1 DAY/ OBS/ ")
stor = dssFile.get("/AMVERI CAN FOLSOM STOR- RES
EOP/ 01JAN2006/ 1 DAY/ OBS/ ")
topcon = dssFile. get ("/AMERI CAN FOLSOM TOP CON
STOR/ 01JAN2006/ 1DAY/ OBS/ ")
sagca = dssFil e. get("/AVERI CAN FOLSOW SAGCA/ TOP CON
STOR/ 01JAN2006/ 1DAY/ OBS/ ")
inflow = dssFil e. get("/AVERI CAN FOLSOM FLOW RES
I N/ 01JAN2006/ 1DAY/ OBS/ ")
outflow = dssFil e. get ("/AVER CAN FOLSOM FLOW RES
QUT/ 01JAN2006/ 1DAY/ OBS/ ")
except java.lang. Exception, e :
# Take care of any missing data or errors
MessageBox. showEr ror (e. get Message(), "Error reading data")
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# Add Data
datasets = java.util.Vector()
dat aset s. add( pr eci p)
dat aset s. add( st or)
dat aset s. add(t opcon)
dat aset s. add( sagca)
dat aset s. add(i nfl ow)
dat aset s. add(out f | ow)

tabl e = HecDat aTabl eFr ane. newTabl e(" Fol som - American River Basin")
t abl e. set Dat a( dat aset s)
t abl e. showTabl e()

C.5 Complex Graphics Scripts

A report-ready script for displaying monthly reservoir data and a script
that uses arguments to define what is to be plotted are presented in the
following sections.

Note: Animportant detail to keep in mind is that you need to call
showPlot() early on. Scripting emulates what you would do interactively;,
itisnot a* command driven” procedure. You cannot change features on
a plot until they exist and the showPlot() function causes the plot object to
come into existence.

C.5.1 Coyote Valley Dam Reservoir Plot

Thisisaplot showing reservoir data for the month of March (Figure C.6).
The plot shows precipitation, storage, top of conservation, inflow, outflow
and downstream flows.

Lake Mendocine (Coyote Valley Dam) - Russian River Basin
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Figure C.6 Mendocino Reservoir Datafor March
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The script for Coyote Valley is:

from hec.script inport *

from hec. script.Constants inmport TRUE, FALSE
from hec. heclib.dss inport *

i mport java

# grid pattern - 2 solid pixels followed by 8 bl ank ones
dotPat =[2., 8.]
datasets = []

# Cet the data
Try
dssFile = HecDss.open("C:/tenp/sanpl e.dss", "01MAR2006 2400,
30MAR2006 2400")
precip = dssFile.get("/EF RUSSI AN COYOTE/ PRECI P-
I NC/ 01MAR2006/ 1HOUR/ TB/ ")
dat aset s. append( pr eci p)
stor = dssFile.get("/EF RUSSI AN COYOTE/ STOR- RES
EOP/ 01MAR2006/ 1HOUR/ /")
dat aset s. append(stor)
topcon = dssFile.get("/EF RUSSI AN COYOTE/ TOP CON
STOR/ 01JAN2006/ 1DAY/ /™)
dat aset s. append(t opcon)
i nfl ow =dssFil e. get ("/EF RUSSI AN COYOTE/ FLOW RES
I N 01MAR2006/ 1HOUR/ SMOOTH ")
dat aset s. append(i nfl ow)
outflow = dssFile.get("/EF RUSSI AN COYOTE/ FLOW RES
QOUT/ 01MAR2006/ 1HOUR/ /")
dat aset s. append( out f | ow)
uki ah = dssFile. get("/RUSSI AN NR UKI AH FLOWV 01MAR2006/ 1HOUR/ /™)
dat aset s. append( uki ah)
hopl and = dssFil e. get ("/RUSSI AN NR HOPLAND/ FLOW 01MAR2006/ 1HOUR/ /")
dat aset s. append( hopl and)
except java.lang. Exception, e :
MessageBox. showEr r or (e. get Message(), "Error reading
data")

# Create the view ports

pl ot = Pl ot. newPl ot ("Lake Mendoci no")
| ayout = Pl ot.newPl ot Layout ()

topVi ew = | ayout. addVi ewport (10.)

m ddl eVi ew = | ayout . addVi ewport ( 60.)
bott onVi ew = | ayout . addVi ewport (30.)

# Add the data

topVi ew. addCurve("Y1", precip)

m ddl eVi ew. addCurve("Y2", stor)

m ddl eVi ew. addCur ve("Y2", topcon)
bott omVi ew. addCurve("Y1", inflow)
bott omVi ew. addCurve("Y1", outfl ow)
bott omVi ew. addCur ve("Y1", uki ah)
bott omVi ew. addCurve("Y1", hopl and)
pl ot . confi gurePl ot Layout (| ayout)

# For headl ess operation (batch node), draw the plot off the screen
pl ot . set Locati on(-10000, -10000)
pl ot . set Si ze( 1000, 800)

##H####H | mportant — showPl ot () creates the plot objects ######
# (You cannot set or change things that do not exist yet)
pl ot . showPl ot ()
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# Make the |l egend | abels ook nice
for dataset in datasets:

| abel = plot.getlLegendLabel (dat aset)
| abel . set Font Si ze( 16)

| abel . set Font ("Arial Bl ack, Pl ain, 14")
| abel . set For egr ound( " bl ack")

# Set the | abel text

| abel = plot.getlLegendLabel (precip)

| abel . set Text( "Basin Precipitation")
| abel = plot.getlLegendLabel (stor)

| abel . set Text (" Reservoir Storage")

| abel = plot.getlLegendLabel (topcon)

| abel . set Text (" Top of Connservaion")
| abel = plot.getLegendLabel (infl ow)

| abel . set Text ("1 nfl ow")

| abel = plot.getlLegendLabel (outfl ow)

| abel . set Text ("Qutfl ow")

| abel = plot.getLegendLabel (uki ah)

| abel . set Text (" Russi an near Uki ah")

| abel = plot.getLegendLabel (hopl and)

| abel . set Text (" Russi an near Hopl and")

# Set the plot title

plot.setPlotTitleText("Lake Mendoci no (Coyote Vall ey Dam -

Ri ver Basin")

tit = plot.getPlotTitle()
tit.setFont("Arial Black")
tit.setFontSize(18)

pl ot.setPlotTitleVisibl e( TRUE

# Make the viewports right next to each other
panel = plot. get Pl ot panel ()
panel . set Hori zont al Vi ewport Spaci ng(0)

# Set the Y axis |abels

viewd = pl ot. getViewort(0)

yaxi s = vi ew0. get Axi s("Y1")

yaxi s. set Rever sed( FALSE)

yaxi s. set Label (" PPT")

viewl = plot.getViewiort(1)

yaxi sl = viewl. get Axi s("Y2")

yaxi sl. set Label ("Storage (ACFT)")
yaxi sl. set Scal eLi mts(0., 140000.)
yaxi sl.setViewLimts(0., 140000.)

# Mark the gross pool |evel
mar ker = Axi sMarker ()

mar ker.axis = "Y"

mar ker . val ue = "118000"

mar ker . | abel Text = "G oss Pool "
mar ker . | i neCol or = "Bl ue"

mar ker . | abel Position = "center"
vi ewl. addAxi sMar ker (mar ker)

# Set the curve colors and fill
preci pCurve = plot. get Curve(precip)
preci pCurve. setFi || Col or ("bl ue")
preci pCurve. setFi | | Type(" Above")
preci pCurve. set Li neCol or (" bl ue")

conCurve = plot. getCurve(topcon)
conCurve.setFill Color("lightGay")
conCurve. setFi | | Type(" Bel ow")

Russi an
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conCurve. setLi neCol or ("li ght Gray")

storCurve = plot.getCurve(stor)
st or Curve. set Li neCol or (" bl ue")
storCurve. setLineWdth(1.)

out Curve = plot.getCurve(outflow)
out Cur ve. set Li neCol or (" dar kgreen")
out Curve. setLineWdth(1.)

i nCurve = plot.getCurve(inflow)
i nCurve. set Li neCol or ("red")
i nCurve. setLi neWdth(1.)

uki ahCurve = pl ot. get Curve(uki ah)
uki ahCurve. set Li neCol or (" magent a")
uki ahCurve. set Li neWdt h(1.)

hopl andCurve = pl ot. get Curve( hopl and)
hopl andCur ve. set Li neCol or (" bl ue")
hopl andCur ve. setLi neWdth(1.)

# Set grid style

view0d = plot. get Vi ewport (0)
prop = view0. get Properties()
prop. set Maj or XG'i dStyl e(dot Pat)
prop. set Maj or YG i dSt yl e( dot Pat)
viewl = plot.getViewort (1)
prop = viewl.getProperties()
prop. set Maj or XGri dSt yl e( dot Pat)
prop. set Maj or YGri dSt yl e( dot Pat)
view2 = plot.getViewiort(2)
prop = view2.getProperties()
prop. set Maj or XGri dSt yl e( dot Pat)
prop. set Maj or YGri dSt yl e( dot Pat)

# Now that it is conplete, save to a png and close it
pl ot . saveToPng(" C:./tenp/ Coyot e. png")
pl ot. cl ose()

C.5.2  Scripts with Arguments

Often you will want to setup a plot or other function and apply it to
different locations, variables or times. Instead of duplicating the script for
each instance, which leads to maintenance and manageability issues, it is
usually advantageous to write one script and pass in arguments that may
vary.

To access arguments passed into the script you must include the
following: import sys (sm = globals())

Arguments are passed into a python script using a " name-space
dictionary"”, which gives the keyword followed by a colon and then the
parameter. Inside the script, the keyword will be replaced with the
parameter. For example, in the GagePlot script, the name-space
dictionary could be:
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"location" : "denfir", "version" : "OBS"

Wherever the string location or version isin the script will be substituted
with GlenFir (Figure C.7) and Obs, respectively.

EBEX

File Edit ‘iew
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Figure C.7 Glenfir Plot

Flow

The GagePlot script is designed to produce a standard plot for a gage
where there is both a stream flow gage and a precipitation gage. Here you
can have one script that you call from another script multiple times, with a
different argument for the location. Theindividual scripts may be run
using the function "exec" for in-line scripts or "execFile" for scriptson
disk. For example, a RunGages script can be written to run GagePlot for
several locations:

Script RunGages

from hec.script inport *

glenFirArgs = {"location" : "denfir", "version" : "OBS"}
execfil e("C: / HecDSSVueDev/ HecDssVue/ scri pt s/ GagePl ot . py", {},
gl enFirArgs)

madr onAr gs = {"location" : "Madron", "version" : "OBS"}
execfil e("C: / HecDSSVueDev/ HecDssVue/ scri pt s/ GagePl ot . py", {},
madr onAr gs)

oakTr eeAr gs = {"location" : "Madron", "version" : "OBS"}

execfil e("C: / HecDSSVueDev/ HecDssVue/ scri pt s/ GagePl ot . py", {},
0akTr eeAr gs)
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The GagePlot Scriptis:

# Both | ocati on=nane version=ver nust be defined as argunents
# To run: GagePl ot |ocation=d enfir versi on=0BS

from hec. script inmport *

from hec. heclib.dss inport *

i mport sys

i mport java

from hec. script.Constants inmport TRUE, FALSE

# Access argunents
sm = gl obal s()

# "location" and "version" will be replaced with the argunents
passed in

# Retrieve data
try :
# |f you wanted to use a relative tinme w ndow, you could do
sonet hing |ike:
# dssFile = HecDss.open("C:./tenp/sanple.dss", "T-30D, T")
dssFil e = HecDss. open("C:/tenp/sanpl e.dss", " 01MAY1992
2400", " 20MAY1992 2400")
flowPath = "/GREEN RIVER/" + |l ocation + "/FLOW/1HOUR/ OBS/ "
preci pPath = "/GREEN RIVER/" + | ocation + "/ PRECI P-
I NC/ / 1HOUR/ OBS/ "
preci p = dssFil e. get(precipPath)
flow = dssFil e. get (fl owPat h)
except java.lang. Exception, e :
MessageBox. showError (e. get Message(), "Error readi ng data")

# Create plot and viewports

pl ot = Pl ot. newPl ot ()

| ayout = Pl ot.newPl ot Layout ()

topVi ew = | ayout . addVi ewport (15.)
bottonmVi ew = | ayout. addVi ewport (85.)

# Add data

topVi ew. addCurve("Y1", precip)
bott omVi ew. addCurve("Y1", flow)
pl ot . confi gurePl ot Layout (| ayout)
pl ot . set Si ze( 600, 500)

# Add title

pl ot.setPlotTitleText(location)
tit = plot.getPlotTitle()
tit.setFont("Arial Black")
tit.setFontSize(18)

pl ot.setPlotTitleVisibl e( TRUE)

# This actually creates the plot - cannot access any conponents
until done
pl ot . showP! ot ()

# Now we can change conponents

panel = plot. get Pl ot panel ()

# Renopbve space between viewports
panel . set Hori zont al Vi ewpor t Spaci ng(0)

# Invert the precip

viewd = plot.getViewport(0)
yaxis = view0. get Axi s("Y1")
yaxi s. set Rever sed( FALSE)
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# Make the precip pretty

preci pCurve = plot. get Curve(precip)
preci pCurve. setFi || Col or ("bl ue")
preci pCurve. setFi || Type(" Above")
preci pCurve. set Li neCol or (" bl ue")

# Make the flow pretty

flowCurve = plot.getCurve(flow

fl owCur ve. set Li neCol or ("dar kgreen")
fl owCurve. set Li neWdth(2.)

# Set the |legend | abels
pl ot . set LegendLabel Text (fl ow, "Fl ow")
pl ot . set LegendLabel Text (precip, "Rainfall")

# Done (should | ook Iike we want now)

# |f you wanted this to run in the background, you could add
the follow ng

# plot.setLocation(-10000, -10000)

# plot.saveToPng("C:/tenp/ GagePl ot. png")

# plot.close()

Another example of calling scripts from scriptsisthe script tester.py:

from hec.script inport *
i mport time
i nport java

R R #

# sone code to eval () #

S #

get Current Ti neSni ppet = "tine.ctime(tine.time())"
R R #

# a sinple script #

o R #

scriptText ="'""

def myFunc()
gl obal startTime, endTine
startTime = tinme.tine()
for i in range(3)
print("Sleeping for 1 second at %" %tine.time())
time. sl eep(1)
endTinme = tinme.tine()

nyFunc()
print("Start time

print("End tine

%" %time.ctime(startTine))
%" %tine.ctinme(endTine))

R #
# wite the script out to a file #
R #
script Fil enane = "nyFunc. py"

scriptFile = open(scriptFilenane, "w')
scriptFile.wite(scriptText)
scriptFile.close()

R #
# Use eval () to evaluate some code #
R #
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print("\nCalling eval ()")
print("The local time is %" % eval (get CurrentTi meSni ppet))

R R T #

# set up a separate scope for execution #
e R T #

otherdobals = {"tine" : tine, "startTinme" : None, "endTi ne"
None}

ot herLocals = {}

He o m e #

# exec some text in a separate scope #

He o m e #

print("\nCalling exec in a separate scope")
exec scriptText in otherd obals, otherLocals

try print("dobal variable startTine = %" %startTi ne)
except : print("dobal variable startTime is not defined.")
try : print("d obal variable endTinme = %" % endTi ne)
except : print("d obal variable endTinme is not defined.")
e I #

#execfile the same script in a separate scope #
e R #

print("\nCalling execfile in a separate scope")
execfil e(scriptFilename, otherd obals, otherLocals)

try print("dobal variable startTine = %" %startTi ne)
except : print("d obal variable startTine is not defined.")
try : print("dobal variable endTine = %" % endTi me)
except : print("d obal variable endTinme is not defined.")
R R #

# exec the sanme text in our own scope #

R #

print("\nCalling exec in the current scope")
exec script Text

try print("Gdobal variable startTine = %" %startTi ne)
except : print("dobal variable startTinme is not defined.")
try :oprint("d obal variable endTinme = %" % endTi ne)
except : print("dobal variable endTinme is not defined.")
e PR #

#execfil e the same script in our own scope #
e R T TP #

print("\nUndefining global variables startTinme and endTi ne")
del globals()['startTime']

del globals()['endTine']

print("\nCalling execfile in the current scope")

execfil e(scriptFil enane)

try D oprint("Gobal variable startTine = %" %startTi ne)
except : print("dobal variable startTinme is not defined.")
try :oprint("d obal variable endTinme = %" % endTi ne)

except : print("dobal variable endTinme is not defined.")
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